
 

 

User Guide 

 
Cashflow Manager 

Wages Manager 

GOLD 
 

 



2  

Table of Contents 

Introduction ..................................................................................................................................................................................................... 6 

Functions Common to All Programs ........................................................................................................................................................... 8 

Getting Started ................................................................................................................................................................................................ 8 
Open the Program ....................................................................................................................................................................................... 8 
Create a New Business File .......................................................................................................................................................................... 8 
Getting Around ........................................................................................................................................................................................... 8 
Menus ......................................................................................................................................................................................................... 9 
Page / Screen Layouts and Buttons ............................................................................................................................................................. 9 
Calendars and Date Selection ..................................................................................................................................................................... 9 

Reports .......................................................................................................................................................................................................... 10 
Step 1: Select a Report .............................................................................................................................................................................. 10 
Step 2: Report Options .............................................................................................................................................................................. 10 
Step 3: Print Options ................................................................................................................................................................................. 10 
Drill-Down Reports .................................................................................................................................................................................... 11 
Save Reports ............................................................................................................................................................................................. 12 
Email Reports ............................................................................................................................................................................................ 12 

Grid Font Size ................................................................................................................................................................................................. 14 

Cheque Writer - Printing Cheques .................................................................................................................................................................. 14 
Activate ‘Cheque Writer’ ........................................................................................................................................................................... 14 
Print Cheques ............................................................................................................................................................................................ 15 

Make Corrections when Printing Cheques ................................................................................................................................................ 16 
Helpful Hints for Printing Cheques ............................................................................................................................................................ 16 

Electronic Payments ...................................................................................................................................................................................... 16 
Activate Electronic Payments .................................................................................................................................................................... 16 
Master Electronic Payments File Details ................................................................................................................................................... 17 
Individual Electronic Payment File Details ................................................................................................................................................. 17 
Record Electronic Payments ...................................................................................................................................................................... 17 
Advanced .................................................................................................................................................................................................. 18 

Save, Back-up and Restore ............................................................................................................................................................................ 19 
Back up Your Records ................................................................................................................................................................................ 19 
Restore Your Data ..................................................................................................................................................................................... 19 

Reminders ...................................................................................................................................................................................................... 20 

Passwords ...................................................................................................................................................................................................... 20 

Purge Old Data .............................................................................................................................................................................................. 21 

Technical Information .................................................................................................................................................................................... 22 
Uninstall the program ............................................................................................................................................................................... 22 
File Locations ............................................................................................................................................................................................ 22 
Specifications (System Requirements) ...................................................................................................................................................... 23 
Trademarks ............................................................................................................................................................................................... 23 

Cashflow Manager ................................................................................................................................................................................... 49 

Getting Started .............................................................................................................................................................................................. 49 
Introduction to Cashflow Manager ........................................................................................................................................................... 49 
Create a New Business File – Cashflow Manager ...................................................................................................................................... 49 
Import Data from an Earlier Version File ................................................................................................................................................... 51 
Manage your Bank Accounts ..................................................................................................................................................................... 51 

The Cashflow Manager Menus .................................................................................................................................................................. 52 
Options – Cashflow Manager .................................................................................................................................................................... 53 
The Cashflow Manager Sections (Tabs) ..................................................................................................................................................... 54 
Change to a Different Month .................................................................................................................................................................... 54 



3  

Change to a Different Section ................................................................................................................................................................... 54 
Customise Columns ................................................................................................................................................................................... 55 

Record Money In and Money Out .................................................................................................................................................................. 59 

Money In - Overview ................................................................................................................................................................................. 59 
How to Record Money In (Money Received)............................................................................................................................................. 59 
Money Out - Overview .............................................................................................................................................................................. 60 
How to Record Money Out (Payments) .................................................................................................................................................... 61 
Credit Card Payments................................................................................................................................................................................ 62 
At the End of the Month ........................................................................................................................................................................... 62 
Helpful Hints for Recording Money In and Money Out ............................................................................................................................. 63 

Bank Reconciliation ....................................................................................................................................................................................... 68 
What is a Bank Reconciliation? ................................................................................................................................................................. 68 
Bank Reconciliation and Financial Institution Settings .............................................................................................................................. 68 
Map your Downloaded Bank Statement ................................................................................................................................................... 69 

Record Your Opening Bank Balance .......................................................................................................................................................... 71 
Processing your Bank Reconciliation ......................................................................................................................................................... 72 
What to do if you cannot reconcile ........................................................................................................................................................... 77 

Cash Reconciliation ........................................................................................................................................................................................ 78 
What is a Cash Reconciliation? .................................................................................................................................................................. 78 
Record Your Opening Cash Balance .......................................................................................................................................................... 78 
Reconcile Your Cash .................................................................................................................................................................................. 78 

Bank Feeds .................................................................................................................................................................................................... 80 
Adding bank feeds to subscription ............................................................................................................................................................ 80 
Connecting to bank feeds ......................................................................................................................................................................... 81 
Using Bank Feeds ...................................................................................................................................................................................... 86 
Adding records to Money In/Out .............................................................................................................................................................. 86 
Linking bank Description ........................................................................................................................................................................... 87 
Approve records ........................................................................................................................................................................................ 87 

Bank Feed functions .................................................................................................................................................................................. 88 
Edit a record .............................................................................................................................................................................................. 88 
Add Cash records ...................................................................................................................................................................................... 89 
Approve all ................................................................................................................................................................................................ 89 

Reconcile and Lock .................................................................................................................................................................................... 90 
Manage Links ............................................................................................................................................................................................ 91 
Refresh Feed ............................................................................................................................................................................................. 91 
Connect Accounts ..................................................................................................................................................................................... 92 

Reports – Cashflow Manager ........................................................................................................................................................................ 93 
Reports and the GST ................................................................................................................................................................................. 93 
Report Options – Cashflow Manager ........................................................................................................................................................ 93 
Types of Reports – Cashflow Manager ...................................................................................................................................................... 94 
Lodge BAS Online ...................................................................................................................................................................................... 97 
Lodge BAS via Standard Business Reporting ............................................................................................................................................. 97 

Budget ........................................................................................................................................................................................................... 98 
Account-based Budget .............................................................................................................................................................................. 98 
Business-based Budget ........................................................................................................................................................................... 100 
Helpful Hints to Create a Budget ............................................................................................................................................................. 102 

Tips and Tricks ............................................................................................................................................................................................. 103 
Cancelling or Amending Cheques for a Previous Month ......................................................................................................................... 103 
Duplicate an Account. ............................................................................................................................................................................. 103 
Lock and Unlock your Records ................................................................................................................................................................ 103 
Providing Information to your Accountant .............................................................................................................................................. 104 
Import an Account from another Cashflow Manager File ....................................................................................................................... 109 
Rename an Account or Business File Name ............................................................................................................................................ 110 

Troubleshooting ........................................................................................................................................................................................... 111 

Invoice Manager ...................................................................................................................................................................................... 99 



4  

Getting Started ............................................................................................................................................................................................. 99 
Introduction to Invoice Manager ............................................................................................................................................................. 99 
Open Invoice Manager ............................................................................................................................................................................. 99 

Create a New Invoice Manager Account .................................................................................................................................................. 99 
Import Data from a pre-version 7 File .................................................................................................................................................... 100 
Menus - Invoice Manager ...................................................................................................................................................................... 101 
Icons – Invoice Manager ........................................................................................................................................................................ 102 
Options – Invoice Manager .................................................................................................................................................................... 102 
Customer Types ..................................................................................................................................................................................... 103 
Invoice Layouts ...................................................................................................................................................................................... 104 
Sections (Tabs) in Invoice Manager ........................................................................................................................................................ 106 

Customers and Sales ................................................................................................................................................................................... 106 
Add, Modify or Manage a Customer ...................................................................................................................................................... 106 
Show a Hidden Customer ....................................................................................................................................................................... 107 
Customer Diary ...................................................................................................................................................................................... 107 
Customer Inquiry ................................................................................................................................................................................... 107 
Change Decimal Points ........................................................................................................................................................................... 107 

Opening Balances (Customers) .............................................................................................................................................................. 108 
Sales Invoices ......................................................................................................................................................................................... 108 
Adjustment (Credit) Notes ..................................................................................................................................................................... 114 
Money In ................................................................................................................................................................................................ 115 

Apply Credit Amounts ............................................................................................................................................................................ 116 
Remove Credit Amounts ........................................................................................................................................................................ 117 
Statements ............................................................................................................................................................................................. 117 
Reports (Customers and Sales) .............................................................................................................................................................. 118 

Suppliers and Purchases (GOLD) ................................................................................................................................................................. 120 
Suppliers ................................................................................................................................................................................................ 120 
Purchase Orders ..................................................................................................................................................................................... 122 
Purchase Invoices ................................................................................................................................................................................... 122 
Opening Balances (Suppliers) ................................................................................................................................................................. 124 
Returns ................................................................................................................................................................................................... 124 
Money Out ............................................................................................................................................................................................. 125 

Apply Overpayments .............................................................................................................................................................................. 126 
Remove an Overpayment ...................................................................................................................................................................... 127 
Reports (Suppliers and Purchases) ......................................................................................................................................................... 127 
Types of Reports – Suppliers/Purchases ................................................................................................................................................. 127 

Inventory .................................................................................................................................................................................................... 129 
Inventory Items ...................................................................................................................................................................................... 129 
Categories .............................................................................................................................................................................................. 132 

Modify Prices ......................................................................................................................................................................................... 133 
Reports (Inventory) ................................................................................................................................................................................ 134 

Other Functions .......................................................................................................................................................................................... 135 
Customise Layouts ................................................................................................................................................................................. 135 

Print Invoices with Microsoft Word........................................................................................................................................................ 139 
Job Numbers (GOLD Only) ..................................................................................................................................................................... 146 
Reports (Jobs) ........................................................................................................................................................................................ 147 
Email An Invoice, Order, Report, Statement, etc.................................................................................................................................... 148 
Import Customers, Suppliers and Inventory ........................................................................................................................................... 148 
Export Data ............................................................................................................................................................................................ 152 
Change the GST Rate .............................................................................................................................................................................. 152 
Restoring Default Column Widths .......................................................................................................................................................... 152 
Taxable Payments Reporting for the Building and Construction Industry .............................................................................................. 152 

Troubleshooting .......................................................................................................................................................................................... 155 

Wages Manager ..................................................................................................................................................................................... 157 

Getting Started ........................................................................................................................................................................................... 157 
Introduction to Wages Manager ............................................................................................................................................................ 157 



5  

Open Wages Manager............................................................................................................................................................................. 157 
Terminology ............................................................................................................................................................................................ 157 
Create a New Wages Manager Account .................................................................................................................................................. 158 

Import Data from an Earlier Version File ................................................................................................................................................. 160 
Menus - Wages Manager ........................................................................................................................................................................ 161 
Options – Wages Manager ...................................................................................................................................................................... 162 
Withholding Payer Number (WPN) ......................................................................................................................................................... 163 
Sections (Tabs) in Wages Manager ......................................................................................................................................................... 165 

Employees ................................................................................................................................................................................................... 165 
Add an Employee .................................................................................................................................................................................... 166 
Modify an Employee’s Details ................................................................................................................................................................. 166 
Employee’s Tax Withholding Scale .......................................................................................................................................................... 166 
Employee Details .................................................................................................................................................................................... 167 
Employee Diary ....................................................................................................................................................................................... 185 

Terminate an Employee .......................................................................................................................................................................... 185 
Re-instate an Employee .......................................................................................................................................................................... 186 
Holiday Makers Tax ................................................................................................................................................................................. 186 
Domestic Violence Leave ........................................................................................................................................................................ 187 

Process Pays ................................................................................................................................................................................................ 189 
Pay Single Employee (Hourly & Salary) ................................................................................................................................................... 189 
Pay Single Employee (Nominated Gross) ................................................................................................................................................ 191 

Pay Single Employee (Piece Work) .......................................................................................................................................................... 191 
Pay Employee Options/Buttons .............................................................................................................................................................. 193 
Multiple Pays ........................................................................................................................................................................................... 200 
Pay Employees by Cash ........................................................................................................................................................................... 201 

Pay Employees by Cheque or Internet Banking ....................................................................................................................................... 201 
Pay Employees Electronically .................................................................................................................................................................. 202 
Daily Hours .............................................................................................................................................................................................. 202 
Transfers ................................................................................................................................................................................................. 203 
Termination Pays ..................................................................................................................................................................................... 204 
Lump Sum Payments ............................................................................................................................................................................... 206 
Employment Termination Payments (ETP) .............................................................................................................................................. 206 
Fringe Benefits ........................................................................................................................................................................................ 206 

Single Touch Payroll ..................................................................................................................................................................................... 207 
Lodger Details ......................................................................................................................................................................................... 207 
Running Single Touch Payroll .................................................................................................................................................................. 208 
Validating data ........................................................................................................................................................................................ 208 
Other Functions ...................................................................................................................................................................................... 208 
Confirming Lodgement is Successful ....................................................................................................................................................... 208 
Final payevents ....................................................................................................................................................................................... 208 

Superannuation ........................................................................................................................................................................................... 209 
Superannuation Guarantee ..................................................................................................................................................................... 209 
Calculating the Correct Amount of Superannuation ............................................................................................................................... 209 

Superannuation Contribution Payment and Reporting Rules .................................................................................................................. 209 
Superannuation Guarantee Audits .......................................................................................................................................................... 210 
Add a Superannuation Fund .................................................................................................................................................................... 211 

Record Superannuation Payments .......................................................................................................................................................... 211 
View/Delete Superannuation Payment History ...................................................................................................................................... 212 
Delete/Hide Superannuation Funds ........................................................................................................................................................ 212 

SuperStream ................................................................................................................................................................................................ 212 

SuperStream – Manual Method .............................................................................................................................................................. 214 
SuperStream – File Method .................................................................................................................................................................... 215 

Reports ........................................................................................................................................................................................................ 217 
Report Options – Wages Manager .......................................................................................................................................................... 218 
Types of Reports – Wages Manager ........................................................................................................................................................ 218 

End of Year Requirements ............................................................................................................................................................................ 220 



6  

Employee PAYG Payment Summaries ..................................................................................................................................................... 220 
Tax Office Reporting ................................................................................................................................................................................ 220 
Commence a New Financial Year ............................................................................................................................................................ 220 

Tips, Tricks & Other Features ....................................................................................................................................................................... 221 
Lodge Tax File Number Declarations via Standard Business Reporting ................................................................................................... 221 
View Previous Financial Year Records ..................................................................................................................................................... 221 
Minutes Converter .................................................................................................................................................................................. 222 
Tax Office Changes to Withholding Scales .............................................................................................................................................. 222 

Assets Manager ...................................................................................................................................................................................... 223 

What is a Depreciating Asset? ..................................................................................................................................................................... 223 
Definitions ............................................................................................................................................................................................... 224 
Recording Depreciating Assets ................................................................................................................................................................ 225 
Options – Assets Manager ...................................................................................................................................................................... 229 

Reports ........................................................................................................................................................................................................ 231 
Report Options – Assets Manager ........................................................................................................................................................... 231 

Assets Dashboard ........................................................................................................................................................................................ 233 

Loans Manager ....................................................................................................................................................................................... 235 

Loans List ................................................................................................................................................................................................. 236 
Loan Calculator ....................................................................................................................................................................................... 239 
Loan Reports ........................................................................................................................................................................................... 241 

Customer Support ................................................................................................................................................................................... 244 

Type of Support ....................................................................................................................................................................................... 244 
Contact Us ............................................................................................................................................................................................... 244 

 

 

Introduction 

Congratulations on your purchase of Cashflow Manager. This product has been developed 

specifically for small businesses because most of the other available options either require an 

understanding accounting or expenditure of considerable time and money attending training 

courses. 

Our goal is to provide a bookkeeping system so simple anyone can use it, whether you 

understand accounting or not. It also keeps excellent business records that makes it easy for your 

accountant. 

The bottom line is that we want to empower you to successfully manage your own business 

records. 

Cashflow Manager takes pride in our efforts to make life simpler for our business clients so that 

you have more time to do the things you love. Version 14 is our simplest ever and we have 

developed a brand-new navigation interface that enables you to jump between the sections of the 

program with a single click of the mouse. We trust you will find the program easy to use and a 

great help in running your business. 

The Cashflow Manager suite of small business bookkeeping products includes: 

Cashflow Manager 

Cashflow Manager records the money coming in and going out of your business. Simply record 

your transactions in columns. You don’t need to know anything about accounting, and 

everything is right there on the screen for you to review. Each column has a ‘GST’ type that 

automatically calculates the GST and makes your BAS Statement a breeze. You can also prepare 

invoices and manage money owed to you for sales on credit. 
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Wages Manager 

Wages Manager is designed to make pay day simple for employers. You can easily meet your 

tax and superannuation obligations with Wages Manager. It is uniquely designed to protect 

employers by automating as much as possible in accordance with the tax laws and Tax Office 

rulings. Wages Manager is very comprehensive but is amazingly simple for anyone to use 

whether you have one employee or a hundred. 

Cashflow Manager GOLD 

Cashflow Manager Gold is the complete small business bookkeeping solution. It manages your 

cash flow, prepares and manages invoices for both sales and purchases, looks after employee 

wages, superannuation, and manages depreciating assets through the one amazingly simple 

package. You can even manage your inventory on items that are purchased and sold. 

Cashflow Manager is not designed to replace your accountant. It is designed to be a ‘win-win’ 

for both you and your accountant. 

Cashflow Manager is not a double-entry general ledger program that requires you to understand 

all about debits and credits, journals, and the difference between the various types of accounting 

classifications. Even if you know nothing about accounting, you will be able to provide your 

accountant with excellent records that are reconciled to your bank. 

Your accountants will be able to efficiently complete your accounts and tax returns and spend 

more time on helping you run a better business. 

With Cashflow Manager you can keep excellent records that make your accountant’s job easier 

and give you the information you need to manage your business without you having to learn how 

to be an accountant to achieve this. 

This will allow you to focus on the things that you must do to run a successful business, and cost 

effectively maximise the benefit of your Accountant's expertise. 
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Functions Common to All 
Programs 

Getting Started 

There are several functions and features that are common throughout the programs, whether you 

are in Cashflow, Invoices or Wages, so we will review them in this section.  

 

Open the Program 

When you install the program from the installation CD or download, the program icon 

will be put on your desktop. Click on the icon to open the program.  

You can also open Cashflow Manager by clicking on Start, Programs, Cashflow 14, 

Cashflow Manager 14. 

The first thing you will see when you open the program is the Cashflow Manager Welcome 

Screen. This screen will display your recently opened files, as well as some options to manage 

your account and create new business files. Click on the option  you require. 

 

 

Create a New Business File 

The program is designed to have a separate file for each business you operate. This is different 

from earlier versions where Cashflow Manager had a separate file for each bank account and 

Invoice Manager and Wages Manager were separate programs. 

To create a new file, simply click on the Create New Business File option from the Start-up 

Options window. Alternatively, select Create New Business File from the File menu in the top 

left hand corner of the program. 

The program lets you setup an account for each bank, credit card or other account you wish to 

track in your business. A Wizard will assist you to set up a file for your business. Each of the 

steps in the wizard will have instructions on what to do. 

For more information, see ‘Create a New Account’ for each specific program. 

 

Getting Around 

The programs are designed to be very easy to find your way around. Each section is accessed by 

the new Side Panel on the Dashboard. Simply click on the tab for the function you want. 

On each page, there are buttons that perform various processes. For example, buttons that relate 

to the page you are on, or move you through a ‘wizard’ are at the bottom of the page. Buttons 

that move you to a new process or function are located on the right side of the page. 

Other functions are accessible from the Menu or by clicking on the icons. 
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Menus 

At the top of the screen, you will find the File, and Tools menus that provide you with 

functions to use from time to time. 

When you click on these menus, a drop-down menu will appear. Position your mouse pointer 

over the option you require and click to select it. 

File, and Tools are the standard menu selections. The File and Tools menu items will change 

depending on the section of the program that is active. Consequently, you will find more 

information on the menu items in the User Guide information for each specific section. 

 

Page / Screen Layouts and Buttons 

The programs are designed for consistency in the way they look and their functionality. 

For example, each section is accessed by ‘tabs’ on the new Side Panel. Sub-sections are also 

located on the Side Panel. 

The programs also use several buttons to perform functions. Functions that perform an additional 

function are generally located on the right. When you click on these buttons you will move to 

another page that performs another function. 

Buttons at the bottom of the page (screen) generally perform functions that relate to that page. 

For example, the [Save] button will save the information you have recorded or edited on that 

page. 

The [Cancel] button will cancel any changes you have made since you last clicked on the [Save] 

button and close the page you are in. 

So, to save your changes and then exit the page, click on the [Save] button and then on [Cancel]. 

If you just click on [Cancel] your changes will be lost. 

When you are in a sequenced process the [Back] button will take you back to previous page, 

also without saving. 

Throughout the User Guide the buttons are indicated by brackets such as the [Save] and 

[Cancel] buttons referred to here. 

 

Calendars and Date Selection 

When dates are entered, you have the option to click on the drop-down arrow to display a 

calendar that will allow you to quickly scroll through months and years to select the right date. 

Some tips for using the calendar are: 

❖ Click on the day you want to select. 

❖ Use the left and right arrows to scroll back and forth through the months. 

❖ Left-click on the month displayed to show a list of all months. 

❖ Left-click on the year displayed to show up and down arrows to scroll through the years. 

❖ The circled day is today’s date. Initially, today’s date is shown when opening the calendar. 

❖ Right-click anywhere in the calendar to go to today’s date, assuming your computer has the 

right date set. 
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Reports 

The Reports have two purposes: 

1. To give you information to help you understand your business better, and 

2. Provide information to help you and your accountant follow the transactions you have 

recorded to prepare your taxes. 

Each section has its own specific reports, and we will discuss those in the User Guide 

information for each specific section. However, the process for selecting and printing reports is 

consistent throughout all sections and programs. The process is as follows. 

 

Step 1: Select a Report 

Click on the Reports tab to view the list of available reports listed with a description of the 

report. 

Click on the Report you require and then click on [Continue]. 

 

Step 2: Report Options 

The Report Options are separated into 3 areas. 

1. Account/Customer/Supplier/Employee Options 

Depending on the report you have selected, Cashflow Reports has the options for All, Current or 

Selected Accounts. Invoice Reports has options for All, or Selected Customers/Suppliers and 

Wages Reports has options for All or Selected Employees. 

2. Date Options 

There are generally four options. 

This Month sets the dates to the month you are working in. 

This Quarter sets the dates to the quarter for the month you are working in. 

This Year sets the dates for the Financial Year you are working in. 

Custom lets you select the period you want to report for. 

Note: If you click on the drop-down arrows to select a date from the calendar the Select a Date 

Period will change to Custom. 

3. Other Options 

Some reports include other options such as including information from Invoices or Wages 

sections with Cashflow Reports, or printing Summary or Detailed reports etc. 

 

Step 3: Print Options 

Once you have selected the Report Options you can preview or print the report, or you can save 

the report in a different format including a HTML format, Microsoft Excel and Word formats, an 

Acrobat PDF format, as well as TIFF and tab delimited Text formats. 

Make your choice by clicking on the [Excel], [Save As], [Preview] or [Print] or buttons. 

When you choose [Excel], the file will be saved in a format that is specifically designed to make 

it easier to work in Excel. They are saved in a comma separated value (.csv) and you will need to 
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open the reports in Excel and in the Excel ‘Text Import Wizard’ select ‘Delimited’ and then on 

the next screen select ‘Comma’ as the Delimiter. 

These are different to the other Excel Reports under the [Save As] option as they would not 

ordinarily fit on a page for printing and are designed for easier manipulation in Excel. 

When you choose [Save As], click on the Save files as type selector to access the different 

formats. 

When you choose [Preview], you can Print the report, email a PDF copy of the report, or Send 

to an Excel spread sheet, an Acrobat PDF file or a Rich Text File (.rtf) document. 

Click on the Zoom icons at the bottom left of the Preview to zoom in and out on your report. 

You can also view different pages using the page selector icons at the bottom left of screen. 

We recommend that you print your reports every month, so you have a printed copy in the event 

of a computer catastrophe. 

 

Drill-Down Reports 

Once a report is selected, there are options to select different parameters for the generation of the 

report. Different reports have different options such as the ability to select accounts, a date range 

or specific type of report. 

 

A variety of Version 14 Reports can “Drill-Down” collective amounts and transactions. This 

allows the user to locate and view individual transactions that make up these amounts. 

 

Transactions can then be selected to view and adjust, and the program will then automatically 

update collective amounts on the reports. 

 

The following reports can drill-down: 

 

Cashflow Manager 

Balance Sheet 

Cashflow 

General Ledger Listing 

Monthly Summary 

Profit & Loss 

Transaction Listing 

Trial Balance 

 

Invoice Manager 

 

Adjustment Note List 

Aged Debtors 

Sales GST (Detailed Only) 

Order Status 

Sales by Customer (Detailed Only) Creates a Sales Invoice List Drill Down 

Sales Invoice List 

Statements 
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Aged Creditors 

Purchases GST 

Purchases by Supplier (Detailed Only) 

Supplier Balance (Detailed Only) 

Taxable Payments (Detailed Only) 

 
Inventory Movement (Summary Only) 

Inventory Adjustments 

Inventory Valuation 

Items List 

Price List 

 

Wages Manager 

 

Combined Payroll Summary 

Pay Advice Summary 

Pay History 

PAYG Summary List 

Save Reports 

The program can save reports in several different formats for convenience of transferring to 

another program, for your employees, or for your accountant. 

To save a report in the format of a: HTML webpage (HTM), Excel spread sheet (XLS), Word 

document (DOC), PDF document (PDF), text file (TXT) or TIF image (TIF), click the [Save 

As...] button on the Print Options screen. 

You will be prompted with a standard Windows Save window, where you can choose the 

location to save the file, the filename, and the type of file format. Click the [Save] button 

when ready or click [Cancel] to close the Save window without saving. 

To save a report in the format of a: rich text document (RTF), Excel spread sheet (XLS) or 

PDF document (PDF), click the [Preview] button on the Print Options screen, which will load a 

print preview of the report, then click the [Save As…] button. The standard Windows Save 

window will appear where you can choose the location to save the file, the filename and the type 

of file format. Click the [Save] button when ready or click [Cancel] to close the Save window 

without saving. 

The default location for saving reports will be the Cashflow Reports folder: 

“C:\Users\Username\AppData\Roaming\CFM\Cashflow14\Reports”. 

 

Email Reports 

Emailing a report will automatically save the report as an Adobe PDF document (PDF) readable 

by the program Adobe Reader (if installed into the default location, the folder will be in: 

‘C:\Users\Username\AppData\Roaming\CFM\Cashflow14\Reports’). You must have an 

Email Client program such as Outlook or Outlook Express configured for your email for the 

Email option to work. 

Webmail (e.g. Hotmail, Yahoo, or others accessed through a web page) will NOT work with this 
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option. 

It is also advisable to have the latest version of Adobe Reader installed. This will apply also to 

the recipient of the email, who will need Adobe Reader to open the attached PDF file. 

To email a report in Wages Manager, you must first preview the report. Once you have the 

preview on screen, click the [Email] button. 

A new window will appear with information about the email document. Type in the recipient’s 

email address in the box marked Send To. 

A subject is not required but can be filled in the box marked Subject. 

The third box shows a list of files attached to the email. The report just generated will be 

attached here. You can add other attachments by clicking the [Add Attachment] button at the 

bottom. This will bring up an Open Dialog window to browse and find the documents you 

require. When ready, click the [Open] button to add the items. 

To remove any added attachments, select the attachment item from the list, and click the 

[Remove Attachment] button at the bottom. 

There is a field where you can enter additional information for the email, which will be the email 

message body. Click in the ‘Message’ and type your message or select from the Email 

Templates. 

Another button at the bottom, [Show Employee Emails], will give a list of recorded email 

addresses of employees, so you can see the correct email address to send to. Click this button to 

show a tab called Email List. 

When you are ready to send click the [Send] button. 

Also Note: Some email programs are designed to block other programs sending emails for 

security and privacy reasons. As the program tries to send an email, you may get a message or 

messages asking if you wish to allow access to send this email. You need to allow or accept this 

or the email will not be sent 

 

Email Templates 

As a time-saver, you can create email message templates to auto-fill the message. 

 

Add, Edit or Delete Templates 

Click on the [Templates] button to add, edit or delete templates. 

To add a template, click the ‘Add’ option and type a name for the template. Click in the message 

area and type the template email message. Click [OK]. 

To edit a template, click the ‘Edit’ option and select the template from the drop-down menu. Edit 

the template and click [Save]. 

To delete an existing template, click the ‘Delete’ option and select the template from the drop- 

down menu. Click [Delete]. 

 

Use Email Templates 

To use an email template when completing an email, click on the down arrow and select the 

template you require. Click on [Fill]. 
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Grid Font Size 

Cashflow Manager Programs are designed to have your computer’s font size set to the smallest. 

Version 14 allows you to change the “Grid Font Size” within the program. 

The program will default the grid font size to 8.25. The grid font size cannot be below this. 

To increase the Grid Font Size, click Tools/Options/Grid Font Size. Here, you can type in a 

font size applicable to you. 

The size of the grid will then change accordingly. 

This is a universal option, which you can access in Cashflow, Invoice, and Wages Manager. 

 

Cheque Writer - Printing Cheques 

Activate ‘Cheque Writer’ 

The program will also allow you to print either individual or multiple cheques, saving labour 

costs and time handwriting cheques and doubling up on recording the information into Cashflow 

Manager. 

You must switch this option on to print cheques. Click on the Options icon at the top of your 

screen. Click on Advanced Preferences and then Use Cheque Writer. Click on [Save]. 

A new Cheque Writer icon will appear on your tool bar. 
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Print Cheques 

1. Record the cheques (including the cheque numbers) in your Money Out section. 

2. Right click on the grey selector box at the left side of the transaction row. 

To select multiple cheques, click in the grey selector box at the left side of the row for the 

first cheque, then hold down the ‘Ctrl’ key on your keyboard as you select the others that 

you wish to include. (If all the cheques you wish to select are together you can also hold 

down your ‘Shift’ key on your keyboard and click on the first and last.) They will all be 

highlighted to show they have been selected. Right click on the grey selector box for one of 

the highlighted cheques to activate the functions. 

3. Click on Add to Cheque Writer to add the cheque to the list of cheques to be printed. 

4. When all cheques have been selected and you are ready to print them, click on the Cheque 

Writer icon on the icon bar at the top of your screen. 

The Cheque Writer window will open. 

If you are printing cheques for the first time, select to print one of the cheques and print a 

blank sheet of paper. Place the test cheque over a piece of cheque stationery and hold up to 

the light to check that the information prints in the correct places. If your margins need 

adjustment, see Margin Settings & Preview information in ‘Helpful Hints for Printing 

Cheques. Print again if necessary but remember to make sure your cheque numbers are 

correct before printing the actual cheques. 

5. Your list of cheques will appear in the order that you selected them. If you do not wish any 

cheque to print, click on the Selected box in the last column for that cheque to uncheck it. 

6. Make sure the cheque numbers on your stationery match the actual cheque numbers to be 

printed. Type the number of the cheque immediately before the first cheque number 

available to be printed in the Last Cheque Number box and press Enter on your keyboard. 

The cheque numbers in your list will be changed to match the cheque numbers available to 

be printed. When your cheques have been printed the cheque numbers in your Money Out 

section will also be changed to reflect the numbers allocated when printing. 

7. Click on the [Print] button. 

8. A message will appear asking "Are you sure you wish to print the selected cheques?' Click 

on [Yes] to continue. 

9. Another message will appear advising that cheques must be printed on pre-printed cheque 

stationery. If you have the correct stationery, click on [Yes] to continue. 

10. Another message will appear saying "Please insert cheques into your printer paper tray" and 

advising the cheque numbers. Once you have done this, click on [Yes]. 

11. A preview screen of your first cheque will now appear. Click on the [Print] button to 

proceed. 

12. Return to the Money-Out Record and ensure that the cheque number for each cheque agrees 

with the number on the printed cheque. If needed you can manually change the cheque 

number but this should not generally be necessary. 

To order cheque stationery, contact Forms Express on 1300 790 632 or email 

enquiries@formsexpress.com.au 

In addition to the cheque itself there are two information vouchers on your cheque stationery. 

One of the vouchers also includes information about the column(s) to which the amount has been 

entered in your Money Out record. Use these as directed by your accountant to assist in keeping 

excellent business records. 

mailto:enquiries@formsexpress.com.au
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Make Corrections when Printing Cheques 

It is important that the cheque numbers printed agree with the cheque numbers in your records. 

There may be times when a cheque gets destroyed in your printer, or two cheques are stuck 

together as they go through the printer thus causing an error in your records. 

Return to the Money-Out Record, click into the Cheque Number column for the first cheque 

that needs adjustment and type in the correct cheque number. Press 'Enter' to accept and then 

arrow to the next cheque number column for the next cheque that needs correcting. Do this for 

all cheques that need correcting. 

If a cheque needs to be printed again, add it to Cheque Writer again. Print the cheque again, 

ensuring that the cheque number in the Last Cheque box is correct (one number less than the first 

available cheque for printing). 

If you have incorrectly added a cheque to be printed and wish to remove it from the list, click on 

the Name cell for the cheque you wish to remove and press F9 on your keyboard. A message 

will appear saying "Remove line?" Click on [OK] to continue. 

 

Helpful Hints for Printing Cheques 

Margin Settings and Preview 

The Cheque Writer may need adjustment with some printers so that the information prints in the 

right place. 

Click on [Margin Settings & Preview] button on the Cheque Writer window. 

A preview of the cheque layout will appear. Type in the margin adjustments required from the 

Top and Left sides in centimetres. 

You can also swap the Payee Name and Total in Words fields, show a dollar sign in front of 

the dollar value if your cheque does not already have it, and print the Payee Address if it is 

available. 

Click on [Save] when finished. 

 

Cancel a Printed Cheque 

To cancel a cheque that has been printed, return to the Money Out section. Click on the Details 

column for the cheque and record Cancelled. Then change all amounts on the row to 0.00. 

 

Electronic Payments 

Activate Electronic Payments 

The program also allows you to create an electronic payments file that can be transmitted to your 

bank if you have that facility. Note that this is not making payments via BPay or Funds Transfer 

options offered by your bank. It involves the creation of an electronic payments file that includes 

multiple transactions that are processed as a batch by your bank. If you do not have this facility 

and would like to know more, contact your bank. 

As not all businesses use this facility you must switch this option on to use it. 

Click on the Options icon on the tool bar at the top of your screen. Select Advanced 

Preferences and click on the Use Electronic Payments option. Click [Save]. 
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Master Electronic Payments File Details 

To make electronic payments you need to record your bank details and information required to 

communicate electronically with your bank when you create your first electronic payments file. 

1. Open the electronic payments module by clicking on the Electronic Payments icon on your 

tool bar. 

2. Record your name of your bank account as recorded by the Bank in Account Name. Refer 

to your Bank Statement or your Bank for this information. 

3. Your User ID will be supplied by your bank when you apply for Online Banking Approval. 

Type this in the User ID box. 

4. The Bank Code is a 3-letter code that identifies your bank. For example, the code for 

Westpac is WBC. Other valid bank codes are ADL, ANZ, BML, CBA, CBL, NAB and 

STG. Your bank will advise you of their code when giving you Online Banking Approval. 

5. Record the BSB (Bank State Branch) number in the BSB Number box. This is a 6-digit 

number with a hyphen in the middle. Refer to your Bank Statement for this information. 

6. Record the number of your account in the Account Number box. 

7. Some banks require a balancing entry to be included with any electronic payment file. If 

your bank has this requirement, tick the Include Balancing Entry box under the Individual 

Electronic Payments File Details. 

 

Individual Electronic Payment File Details 

These details are recorded for each individual electronic payment file that you create. 

1. Record the date on which you want the bank to process your electronic payments in the File 

Processing Date box. This date can be selected by clicking on the down arrow at the side of 

the box and selecting the date from the calendar. 

2. Record a description of your file in the File Description box. For example, if your file 

includes all wages you may call your file 'Wages’. 

 

Record Electronic Payments 

1. Record the payments (including a reference number if you require) in the Payments section 

by following the steps outlined in the How to Record Payments. 

2. Right click on the grey selector box at the left side of the transaction row. 

To select multiple transactions, click in the grey selector box at the left side of the row for 

the first cheque, then hold down the ‘Ctrl’ key on your keyboard as you select the others that 

you wish to include. (If all the cheques you wish to select are together you can also hold 

down your ‘Shift’ key on your keyboard and click on the first and last.) They will all be 

highlighted to show they have been selected. Right click on the grey selector box for one of 

the highlighted cheques to activate the functions. 

3. Click on Add to Electronic Payments to add the payment to the list to be processed 

electronically. 

4. When you are ready to create your electronic payment file, click on the Electronic 

Payments icon on the tool bar at the top of your screen. 

5. Your payments will appear in the order that you selected them in the Payments Record. If 

you do not wish for a specific transaction to be included, click on the Selected box in the last 

column for that payment so there is no tick in the box. 
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Each transaction must include the details necessary for processing. 

Description: This is the description to appear on your payee’s bank records 

Account Name: The payee’s bank account name. If you have previously paid this person 

electronically, click on the selector button and select the account name (which will also 

include the BSB and Account Number.) If it is a new payee, click on the selector button to 

add the details for this person. 

BSB Number: The payee’s BSB Number 

Account Number: The payee’s bank account number 

Transaction Type: There are two different transaction types. Type 50 is for general 

purchases and type 53 is for pay cheques. 

Remitter Name: The name of your bank account 

Amount: The amount of the payment 

6. Once you have selected all of your payments, click on the [Create File] button. 

7. Review your file and click on the [Destination File Name] button. A Windows Save As 

screen will appear giving you options for the name and location of your saved file. The 

default location is where your Cashflow Manager application file is installed. To change 

this, click on the down arrow next to Save In and select the location you require. 

Note: You may wish to set up a folder in the Cashflow 14 directory for Electronic 

Payments. 

The file name is your 3 letter Bank Code with the file type .ABA. This file type should not 

be changed as it meets the requirements of your bank to accept your file. 

The file name should be unique to match your description if required to make file 

identification easier. (E.g. Creditors 2014-03.ABA) 

8. Click on the [Save] button to save the file and return you to the Online Banking Preview. 

9. Click on the [Print Report] button to print a list of your Online Banking payments. 

10. Click on the [Save] button (or [Cancel] if you do not wish to proceed.) A message will 

appear advising that the file has been created. If you click on [OK] you will be finished. If 

you click on the [Cancel] button you will be taken back to the Preview. 

11. Send your file to the bank. This usually involves using the Bank's software, although some 

Banks now accept an electronic payments file through their internet banking sites or on a 

floppy disk. If your bank uses its own software, you will need to download or obtain a copy 

of this software to install to process the electronic file with the bank. 

If the bank accepts disks or email, then save the electronic file to disk or attach it to an email 

ready to send to your bank. 

 

Advanced 

Each time an Electronic Payments file is created, the details are used in the Bank Reconciliation. 

If that file is not sent to the bank, then it needs to be excluded from the reconciliation. Click on 

the [Advanced] button and select the file that has not been sent to the bank. Then click on the 

[Save] button. 
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Save, Back-up and Restore 

Cashflow Manager saves your data in a database file that is located in the 

C:\Users\Username\AppData\Roaming\CFM\Cashflow14\Data folder unless you have 

changed it to another location. 

‘Username’ is the name Windows uses for your account. For example, Bill Smith might have a 

Windows user name of Bill Smith. The file would then be located in 

C:\Users\Bill Smith\AppData\Roaming\CFM\Cashflow14\Data 

You should always make a backup of your data before you close the file that you are working in. 

This means making a copy so that if something happens to your computer, or the file that 

Cashflow Manager has saved on your hard drive, you will not have lost all of your information. 

We recommend backing up to a USB drive or another drive that is different to the drive that the 

program is loaded on. 

In fact, you should always keep a recent backup in a different location so you have the 

information you need in the event of a burglary or fire. You can email your backup as well. 

The Backup and Restore utilities are a global function, meaning it affects the whole file. As the 

data file is integrated with the three programs, backing up or restoring a backup will affect all 

three programs’ data. This has the benefit of having to only back up one file containing all data. 

When restoring a backup, this will update or potentially overwrite data in the other programs, so 

caution is advised when performing this function. 

 

Back up Your Records 

1. Click on the Backup icon. 

2. Click on the [Browse] button. 

3. Click on the Save in: box and select the location for your backup file. 

4. We also recommend that you change the file name so you do not overwrite previous backups 

in case there is an issue in a newer file. (Once a month you can delete older files but we 

recommend keeping a monthly backup in your archives.) 

5. Click on [Save]. 

6. If you wish to email your file, click on Email File When Backup Complete. 

7. Click on the [Backup] button. 

8. A message will appear advising when your backup is complete. Click on [OK]. 

 

 

Restore Your Data 

To restore your backup file into the program, click on the Restore icon. 
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Click on the [Browse] button next to the Restore Source box to select the location of the backup 

file being restored. Select the file and click on [Open]. 

The Restore Destination Path will default to 

C:\Users\Username\AppData\Roaming\CFM\Cashflow14\Data as this is the first location 

that Cashflow Manager will look for your files when you want to open your files within the 

program. If you want the file to be saved in a different location, click on the [Change] button, 

and navigate to the location using the Save in box. You can also change the file name if you 

wish. For example, if you have used the date of the backup in your file name you may wish to 

edit that out. 

When you have finished these changes, click on the [Save] button. 

Click on the [Restore] button. 

A message will advise when the Restore process is complete. Click on [OK]. 

You can now open the restored file. 

 

Reminders 

You can setup Reminders from the Menu Bar at the top of the screen. 

To add a reminder, click on the Reminder Icon in the top menu bar. Select the ‘Date to Remind’ 

and click in the Description box. Type a description for the reminder and click [Save]. 

To view an existing reminder, click on the Reminder Icon in the top menu bar and select the 

[View List] button, select the reminder from the list and click on the [View] button. 

To edit an existing reminder, click on the Reminder Icon in the top menu bar and select the 

[View List] button, select the reminder from the list and click on the [View] button. You will 

now be able to edit the reminder 

To delete an existing reminder, click on the Reminder Icon in the top menu bar and select the 

[View List] button, select the reminder from the list and click on the [Delete] button. 

To delete all reminders, click on the [View List] button and click on the [Delete All] button. 

 

Passwords 

You can setup separate passwords (or none) for the Cashflow, Invoice, and Wages sections. You 

will however need to setup an administrator password before the section passwords can be setup, 

changed or deleted. The password is embedded in the file itself. This has the added benefit that 

when a file is sent to another party, or moved to another computer, it still retains the password 

for that file, and so increases security. 
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As the password is embedded into the file itself, this makes it much harder to change or remove 

the password, so extreme caution is advised when adding a password to a critical file. If the 

password is lost or forgotten, it will be exceptionally difficult to retrieve the data from any of the 

three programs. 

Please keep your password in a safe place for access if you forget it. 

1. Click on File and then Password. 

2. Select Admin and then Add to create an Administrator password. 

3. Type in your password. Press your 'Tab' key to move to the next box and type it in again to 

confirm it. You can now setup passwords for the Cashflow, Invoice, and Wages sections of 

the program as you wish. You will be prompted to enter your admin password before you can 

add, change or delete any password in the program. 

Close and re-open the program to allow the changes to take effect. 

 

Purge Old Data 

 
The program has a feature that enables you to purge old data. For example, if you have been 

using the program or parts of the program such as Invoice Manager or Wages Manager for a 

long time, you may wish to purge old data to reduce your file size and speed up your program. 

WARNING: Please ensure you have printed all reports and backup to an external source before 

you purge your data. The program will do an automatic backup when the purge is conducted, but 

we recommend that you should also do one in your normal manner and keep it in a safe location. 

The purge process removes all data up to and including the month and year selected. 

The only items that won’t be deleted are those that have outstanding balances as at the purge 

date e.g. a cheque that is still outstanding in the Bank Reconciliation, or an invoice that does not 

have a 0.00 balance as at the ‘purge date’. 

1. Ensure all reports have been printed and your file is backed up. 

2. Click on the tab for any section of the program (Cashflow, Invoices or Wages). 

3. Click on the ‘Tools’ menu. 

4. Click on ‘Purge Data’. 

 

The Data Purge window will open. 

To purge Cashflow Manager data: 

1. Click on the ‘Cashflow data up to and including’ check box. 

2. Select the Month and Year for the data to be purged. Note: The purge process removes all 

data up to and including the month and year selected. The only items that won’t be deleted 

are those with related transactions after the date e.g. a cheque that is still outstanding in the 

Bank Reconciliation. 

3. Select the Accounts to be purged. All accounts are selected by default. If you do not want an 

account to be purged, click on the check box so that no tick appears in the box. 

4. Click in the check boxes for Invoices or Wages and establish the dates if you wish to purge 

these sections at the same time. 

5. When completed, click on the [Purge] button. 

 

To purge Invoice Manager data: 

1. Click on the ‘Invoice data up to and including’ check box. 
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2. Select the Month and Year for the data to be purged. Note: The purge process removes all 

data up to and including the month and year selected. The only items that won’t be deleted 

are those with related transactions after the date e.g. invoices with outstanding balances. 

3. When completed, click on the [Purge] button. 

 

To purge Wages Manager data: 

1. Click on the ‘Wages data up to and including’ check box. 

2. Select the Year for the data to be purged. Note: Wages data will only be purged for 

Financial Years. The purge process removes all data up to and including the month (June) 

and year selected. However, as the fringe benefits tax year runs from 1st April to 31st March 

and may require to be reported on PAYG Payment Summaries, any fringe benefits paid from 

1st April will not be purged. 
3. When completed, click on the [Purge] button. 

 

Note: if you have a lot of data in your file, the process may take some time. You will receive a 

message when it is complete. Do not close the program or shut down your computer while the 

purge is in process. 

 

Technical Information 

Uninstall the program 

Windows 8 

To uninstall in Windows 8, move your mouse to the bottom-right corner of the screen to show 

side menu. Select Settings, Control Panel, Programs and Features. Select ‘Cashflow 

Manager 14’ in the list and click on ‘Uninstall’. 

Windows 10 or 11 

To uninstall in Windows 10 or 11, click on the Start button, and select Settings, System, and 

Installed Apps. Select Cashflow Manager 14 and click ‘Uninstall’. 

 

 

 

 

 

 

 

 

File Locations 

Most files are located in the C:\Users\Username\AppData\Roaming\CFM\Cashflow14 folder 

on your computer unless you have installed them elsewhere. This is a change from previous 

versions that have used the C:\Program Files folder and results from requirements for 

compatibility with recent version of Windows. 

This folder contains several sub-folders as follows: 
 

Bank For storing downloaded bank statements 

Data Stores your c14 data files 
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eAS Files for lodging your BAS electronically using the Tax Office 

Business Portal 

Export Accountant General Ledger Export files 

File Ready to 

Import 

Customer/Supplier/Inventory templates, Assets List, ready to 

import 

Import Help Instructions on how to create Customer/Supplier/Inventory 

templates 

Import 

Templates 

Customer/Supplier/Inventory Excel templates 

Reports For saving Excel, PDF and Text report files 

 

Templates 

SBR 

 

Templates for printing in Word 

Files for lodging your BAS, TFN Declarations, and PAYG 

Payment Summaries via SBR. 

User Guide Version 14 User Guide in PDF format 

The rest of the program files are located in the C:\Program Files\CFM\Cashflow14 (for 32 bit 

machines), or C:\Program Files (x86)\CFM\Cashflow14 (for 64 bit machines) folder on your 

computer unless you have installed them elsewhere. 
 

Bin Contains all the application and library files 

 

Specifications (System Requirements) 
Cashflow Manager, and associated products, are designed to run on a PC computer running 

Windows 8.1, Windows 10 Anniversary Update or later, and .Net Framework 4.7.2. In some 

cases, the software may run on Windows 7 but this will depend upon the Windows 7 updates 

installed on the computer. Please Note: Microsoft stopped support of Windows 7 from 14th 

January 2020. 

The program requires at least 4GB of RAM with a XVGA (1400x900) or higher resolution 

monitor. You will need at least 300MB of hard disk space on your computer for the Program 

files, and an Internet or phone connection for product activation. 

If you use a Mac you will need to use Bootcamp (free with a Mac) or VMFusion or Parallels 

together with Windows 8 or later. 

The Regional and Language Options (Settings) on your computer need to be set to English 

(Australia). 

 

Trademarks 

Cashflow Manager is a registered trademark of Cashflow Manager Pty Ltd in Australia and a 

trademark in other countries and use of this trademark is prohibited without prior consent. 

Invoice Manager, Wages Manager and Rent Manager are trademarks of Cashflow Manager Pty. 

Ltd. 

Windows, Microsoft Word, Microsoft Excel, Internet Explorer, Outlook and Outlook 

Express are either registered trademarks or trademarks of Microsoft Corporation in the United 

States and/or other countries. 

Other products mentioned may be trademarks or registered trademarks of their respective 

companies 
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 Cashflow Manager Version 14 
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Cashflow Manager 

Getting Started 

Introduction to Cashflow Manager 

Cashflow Manager records the money in (receipts) and money out (payments) transactions 

of your business. You can then reconcile to your bank and cash on hand, and print reports 

for managing your business, preparing your taxes including the GST report that makes 

completing your BAS a breeze. Cashflow Manager’s unique column system makes it 

amazingly simple to keep excellent records without knowing anything about accounting. 

 

Create a New Business File – Cashflow Manager 

Cashflow Manager 14 is designed to have a separate file for each business you operate. 

To create a new file, simply click on the Create New option on the welcome screen. 

Alternatively, if you already have a business file open, you can select Create New 

Business File from the File menu in the top left-hand corner of the program. 

A Wizard will assist you to set up a file for your business. Each of the steps in the wizard 

will have instructions on what to do. 

1. Business Details. 

What is the name of your business?: Enter the name of your business here. This 

will be the name of your business file, as well as what will appear on any reports or 

invoices you create in the program 

What ‘business template’ would you like to use: Several business templates are 

available to make setting up your columns easier. The Business Template you select 

will establish columns generally used by that type of business. You can then add, 

delete or modify the columns to personalise them for your business. To select a 

Business Template, click on the down arrow and then on the type of business that is 

the closest match. 

What month and year would you like to start your records?: When you start to 

enter your transactions the program will automatically take you to the selected month 

and year. You are able to go back to any date before the selected month after you have 

created the file should you wish to do so 

Is your business registered for GST?: Choose whether or not you would like 

Cashflow Manager to calculate GST when you are importing your data 

2. Create an ‘account’ for each new bank account you wish to add. 

Record a unique name for each bank account, including credit cards that you use for 

your business. If you have a separate Petty Cash system you can also create an 

‘account’ for this. 
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Helpful Hint: 

When your file saves, each of the accounts will be created with the columns from 

the ‘business template’ that you selected in Step 2. 

If you have accounts that require a different ‘business template’, add these 

accounts later. 

If you use multiple bank accounts and plan to change the standard columns, 

create one bank account for your primary account. Once this process is completed 

you can then personalise your columns and use the Duplicate Account function in 

Options to create your other accounts all with your personalised columns. 

Each account needs a unique name, so you can easily identify which account you are 

working on. 

Click in the first box and record a unique name for your main business bank account. 

Then press your Tab key to go to the next box and record the name of your second 

account. 

Continue until you have listed all accounts. 

Note: You can record up to 10 accounts in this process. If you have more than 10 

accounts, you can add more accounts from the Home page. 
 

Click on [Next] to continue. 

3. Select the General Ledger System your Accountant Uses 

Cashflow Manager will export your information to most general ledger systems and 

can match the general ledger codes those systems use to make it easier for your 

accountant. 

Even if your accountant chooses to work from your reports, the ‘Account Codes’ that 

match their system will still make it easier for them. 

Ask your accountant for the name of their general ledger system and a list of account 

codes for your columns. Your accountant can also advise you on the specific columns 

you need to customize the program for your business. 

Then click on the down arrow and select the general ledger system your accountant 

uses. 

You can also select I don’t know and change this later in Options. 

Click on [Next] to continue. 

4. Congratulations: This is simply a message advising that you have completed the 

information and your file is now ready to create. Click on [Next] to continue. 

5. Saving your file: A window will appear so you can select the location for your file. 

The standard location is 

C:\Users\Username\AppData\Roaming\CFM\Cashflow14\Data. Click on [Save] to 

save your file. 

The speed at which your file is created will depend upon the number of accounts and the 

speed of your computer. An ‘indicator bar’ will show the progress. 

When your file has been created, the program will open to the Dashboard, where you can 

select an account to start work on. 

Once you select an account you can customise your columns and options. Icons will 

appear on the tool bar, or you can use the Tools menu to select these functions. 
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Import Data from an Earlier Version File 

Cashflow Manager 14 allows users of Cashflow Manager 12 to import their version 12 

files for use in version 14.  

Any older versions of Cashflow Manager files will need support from CET. Please 

contact us if you require conversion of any version 11 or older Cashflow Manager files 

1. Convert Version 12 file: 

On the sidebar of the welcome screen you will see the Convert Version 12 file 

option. Please select the option to begin converting your file. The Convert Files 

window will load onto the screen. Click the Add files button and select a 

Cashflow Manager file to import:  

You can import Cashflow Manager data or backup files. 

When you click on the [Add Files] button it will automatically look for Cashflow 

Manager 12 data files (.c12) or Backup files (.b12). 

When you have selected the file, click on the [Open] button to confirm your selection and 

return to the convert files window. If needed you can click the Add Files button again and 

select another file to convert 

Once you have selected all the files you want to convert click the Convert button in the 

bottom right corner. A progress bar will fill to show how long is left before the conversion 

has completed. 

Once the conversion is done the program will ask you if you need to convert any more 

files. Clicking No will bring you back to the welcome screen. You will then be able to open 

your business file by selecting Open Existing Business on the sidebar 

The speed at which your file is created will depend upon the amount of data in the 

imported file and the speed of your computer. A ‘progress bar’ will indicate the 

progress. 

 

Manage your Bank Accounts 

The new Dashboard displays your business’s Bank Accounts, and their current balances. 

You can add, delete, restore, and manage your accounts. 
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Add a new Account 

1. Click on the Dashboard tab. 

2. The Bank Accounts will be displayed. You can add or manage the bank accounts from 

this section. 

3. Click on the [Add] button. A ‘wizard’ will guide you through the process of adding a 

new account which is the same as creating a new business file except that you will 

only be asked for information necessary to create the account(s). 

 

Manage an Account 

1. Click on the Dashboard tab. 

2. The Bank Accounts will be displayed. You can add or manage the bank accounts from 

this section. 

3. Click on the [Manage] button. Here, you can delete or restore an account(s) 

 

The Cashflow Manager Menus 

At the top of the screen are the File, and Tools menus that provide you with functions to 

use from time to time. When you click on these menus, a drop-down menu will appear. 

Position your mouse pointer over the option you require and click to select it. 

The following is an overview of each menu item. 

File 
 

Create New 

Business File: 

Creates a new business file 

Open Existing 

Business File: 
Opens an existing business file 

Backup: Creates a backup of your file 

Accountant Export: Exports and Imports Cashflow Manager data for selected 

accounts and time periods so you can continue working on 

your file while your accountant works on your data. 

Restore: Restores a backup file 

Export: Creates a special export file for communicating with your 

accountant's general ledger program 

Password: Options to add, change or delete a password. Passwords can 

be set for each section. 

Exit: Exit the Program 

 

Tools 
 

Purge Data Purge old data from your file 

Map Bank 

Statement 

Description 

Map your downloaded bank statement file 

Search: Search for a transaction 

Customise: Customise columns for your business 
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Options: Refer to separate section on Options that describes the 
various options that can be used with your file 

 

Options – Cashflow Manager 

Each section of the program – Cashflow Manager, Invoice Manager and Wages Manager 

has Options. Some are ‘global’ options and others are specific to the section you are in. 

To access the Cashflow Manager Options you need to be in the Cashflow Manager section 

of the program. 

Click on the Tools menu item and select Options or click on the Options icon. 

The following options are available: 

Accountant's General Ledger Format: Match the General Ledger system used by 

your Accountant and change the Accountant’s Codes for the Bank Account and Cash 

on Hand accounts for the account you have open. 

Advanced Preferences: The following options are available after selecting Advanced 

Preferences. 

Use Cheque Writer: Turns on the cheque printing module. 

Use Electronic Payments: Turns on the electronic payments module to make 

bulk electronic payments. 

Show Details Column: Select whether the Details column is displayed. 

Open Last File Used on Start-up: Opens the last file you were using to save 

time if you often use the same file. 

Sort transactions by date before locking Bank Reconciliation 

Hide ‘Money In/Out – To Add’ tabs in the Auto Bank Reconciliation: 

This is selected by default. However, you can deselect this option if you wish 

to select which transactions from your bank statement to add to your records. 

Auto Fill Options: You can turn off the Auto Fill option that automatically fills 

customers, suppliers or details that have been previously saved. For example, turn this 

option off to correct an error. 

You can also remove items recorded in Customers, Suppliers or the Money In and 

Money-Out Details column so they do not appear in the drop down Details list. Click 

on the tab to display the list. In the ‘Remove’ column, click in the box for each item 

you wish to remove or reinstate. This will place or remove a tick in this box. Click 

[Save] when finished. 

Auto Column Selection: Use this option to establish links so that when the customer 

or supplier is recorded, the column is automatically selected. Scroll to the customer or 

supplier’s name, click on the select box and select the column you require. Click 

[Save] when finished. 

Business Name and A.B.N.: Edit the Business Name, ABN or WPN. Note: any 

changes will affect the Invoice and Wages Manager as well. 

Column Colours: Customise your column colours for the file you are working on. 

System Colours are used for columns where the column name cannot be changed. 

Allocation columns are the columns used for allocation of your Receipts and 

Payments. 

Currency Symbol: Allows people from other countries to use their own currency. 

Duplicate Account: Create another account with the same columns as the account 

you have selected. 
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Financial Year Begins: In Australia, the financial year for most businesses starts on 1 

July. You can change this if yours is different. 

Grid Font Size: Increase the size of the font on your screen. 

GST Rate: Change the GST rate. 

Private Use Columns: Select the private use component and column for the balance. 

Note that you must select a column for the balance for the private use calculation to be 

made. For example, if you record 80% private use for the ‘Motor Vehicle’ column and 

‘Owners Drawings’ as the Private Use column, if you enter $100 in the ‘Motor 

Vehicle’ column, it will save $20 in the Motor Vehicle column and allocate $80 to 

Owners Drawings. 

Quantity Column & Decimals Display: Rename your Quantity column for printing 

on Reports. The new name must be no more than 8 characters. You can set the 

decimal places for the quantity from zero to two. 

Remove Recurring Transactions: Delete recurring transactions that you no longer 

require. 

Rename Account and Business File: Rename bank accounts and/or your business 

file name. 

 

The Cashflow Manager Sections (Tabs) 

Cashflow Manager consists of 6 sub-sections. The Tabs are located under the main 

Cashflow Program section, on the Side Panel. They are: 

❖ Money In– for recording money received, 

❖ Money Out – for recording money paid 

❖ Bank Reconciliation – for reconciling your Money In and Money Out records to 

your bank 

❖ Cash Reconciliation – for reconciling your cash Money In and Money Out 

❖ Account Budget – for preparing and using account-based budgets 

❖ Business Budget – for preparing and using business-based budgets 

❖ Reports – for comprehensive reports 

 

Change to a Different Month 

The month and year appear at the top of the Money In and Money Out sections. To 

change a month, click on the up arrow to go forward, or the down arrow to go back. 

To quickly go back or forward several months, click on the larger down arrow to display a 

list of all months. Click on the month you require. 

 

Change to a Different Section 

To move between different sections of the program, simply position your mouse pointer 

over the tab, on the Side Panel, and click your left mouse button. There are tabs in the 

Cashflow Manager section for Money In, Money Out, Cash Reconciliation, Bank 

Reconciliation, Reports and Budget. For example, to get to ‘Money In’ simply position 

your mouse pointer on the tab labelled Money In and press your left mouse button. 
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Customise Columns 

Customise Columns Overview 

Click on the Customise Columns icon. 

The page that appears will give you the option to customise your ‘Money In’ or your 

‘Money Out’ columns by clicking on the tab for the section you require. 

The table lists all columns that have been included from the business ‘template’ selected 

when you created the account together with any changes you have made, and includes 

four fields of information: 

1. The Column Name can be up to 50 characters in length and needs to be unique. 

2. The Accountant's Code is used to match the codes used by your accountant's general 

ledger program. If you don’t know the code your accountant uses, leave it blank. 

3. The Tax Type determines the GST calculation and reporting that applies to the 

column. 

4. The Profit/Loss status of the column: If the checkbox is ticked then the column will 

be included in the Profit and Loss report. If the column is not ticked, then it will 

appear on the Balance Sheet (Movement) Report. 

The buttons on the right side perform various functions: 

[Add New] Click on this button to add a new column. 

[Delete] Click on the line for the column you wish to delete and then click on the 

[Delete] button. The column will be deleted unless there is data recorded in that 

column. 

[Undo] The [Undo] button will be activated when you delete a column. You can click 

on this button to ‘undo’ the deletion. 

[Sort A-Z] Sort your columns alphabetically. 

[Sort Z-A] Sort your columns in reverse alphabetical order. 

[Add to All Accounts] Columns in one account can be added to all other accounts. 

[Up and Down Arrows] Move your selected column in the direction of the arrow, 

one position for each click. 

[Save] Click on this button to save the changes you have made. An information box 

will advise that your changes have been saved. 

[Cancel] Exit the Customise Columns table. Any changes you have made since you 

last clicked the [Save] button will not be saved. 

To save your changes and then exit the Customise Columns table, click on the [Save] 

button and then the [Cancel] button. 

 

Add a New Column 

1. Click on the Customise Columns icon and select the section (Money In or Money 

Out) that the column is in. 

2. Click on the [Add New] button. Type in your new column name. Press your tab key 

to move to the Accountant's Code. 

3. If you know the accountant’s code, type it in. (This is not essential unless you are 

going to export your information to your Accountant. It can also be recorded later.) 

Press your tab key to move to the Tax Type. 
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4. A drop-down box will appear at the side of the Tax Type. Click on the arrow and 

select the correct GST tax type for that column. 

5. Tab to the Profit/Loss status and ensure the box is ticked if the column forms part of 

your profit and loss, or un-ticked if it does not. Ask your accountant if you are unsure. 

6. If you wish to add the column to all accounts, click on the [Add to All Accounts] 

button. 

7. You can move the column to the position you require by clicking on the Sort buttons 

or the up and down arrow buttons. 

8. Click on [Save] when you are finished and then [Cancel] if you wish to exit. 

 

 

Change a Column Name 

1. Click on the Customise Columns icon and select the section (Money In or Money 

Out) that the column is in. 

2. Click on the Column Name that you wish to change. Type in the new name. 

3. Click on [Save] when you have finished and then [Cancel] if you wish to exit. 

 

 

Change a Column’s GST Tax Type 

Cashflow Manager has a uniquely simple system to help you calculate your GST. You 

simply allocate a GST ‘Tax Type’ that matches the boxes on the Business Activity 

Statement to your columns. 

When entering Money In you record the gross amount (including GST) into the 

appropriate column and the GST will be automatically calculated from the GST ‘Tax 

Type’ allocated to the column. 

The GST Tax Types for Money In are: 
 

 

GST: All receipts subject to GST 

Exports: All receipts from exports 

Other GST-Free: All GST-free receipts (other than exports) 

Input Taxed: Receipts that are input taxed e.g. residential rents, financial 

supplies 

Non-GST: Receipts that are not to be reported on your GST 

calculation sheet, e.g. transfers from your savings, salary & 

wages, amounts received from a hobby, trust and 

partnership distributions, dividends, loans and interest 
received (unless you make financial supplies in your 
business.) 

 

The GST ‘types’ for Money Out are: 
 

GST: All business payments subject to GST (other than Capital 

Purchases) 

Capital Purchases: Purchases of plant & equipment, property or other assets. 

There are separate GST ‘types’ for Capital Purchase that 
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 are taxable, those where you are not charged GST (GST- 

free) and those related to Input Taxed Income. 

GST-free: Payments to non-registered entities, or where you have not 

been charged GST. 

Input Taxed: Payments that you have made in respect of input taxed 

income. 

Non-GST: Payments that are not to be reported on your GST 
calculation sheet, e.g. salaries & wages, owners’ drawings, 
or other acquisitions that are not for use in your business. 

 

The GST ‘Tax Type’ of each column determines the GST calculation and reporting of any 

amounts entered into the column. 

1. Click on the Customise Columns icon and select the section (Money In or Money 

Out) that the column is in. 

2. Click on the Tax Type for the column you wish to change. A drop-down button will 

appear. Click on the button and select the type you require. 

3. Click on [Save] when you have finished and then [Cancel] if you wish to exit. 

 

Change Accountant’s Codes 

Cashflow Manager can communicate with your Accountant's General Ledger program, 

which uses numbers instead of column headings for processing your data. 

Select your Accountant’s General Ledger program by clicking on the Options icon and 

then Accountant’s General Ledger Format. You can then edit the Accountant’s Code 

for individual columns as follows. 

1. Click on the Customise Columns icon and select the section (Money In or Money 

Out) that the column is in. Click on the Accountant's Code for the column you wish to 

change. 

2. Type in the new code. 

3. Click on [Save] when you have finished and then [Cancel] if you wish to exit. 

Note: to change the Accountant’s Code for Bank and Cash on Hand accounts, go to 

Options and select Accountant’s General Ledger Format. 

 

Change the Profit/Loss Indicator of a Column 

The Profit/Loss indicator determines whether the column totals are reported in the Profit 

and Loss Report or the Balance Sheet (Movement) Report. 

If the Profit/Loss Field is ticked then that column is designated as a Profit/Loss 

column. This means that this column will be included in the Profit and Loss Report. If the 

column is not designated as a Profit and Loss column then it will be included in the 

Balance Sheet (Movement) Report. 

Click on [Save] when you have finished and then [Cancel] if you wish to exit. 

 

Move a Column 

1. Click on the Customise Columns icon and select the section (Money In or Money 

Out) that the column is in. 

2. [Sort A-Z] Click on this button to sort your columns alphabetically. 
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3. [Sort Z-A] Click on this button to sort your columns in reverse alphabetical order. 

4. The [Up and Down Arrows] will move your selected column in the direction of the 

arrow, one position for each click. 

5. Click on [Save] when you have finished and then [Cancel] if you wish to exit. 

You can also move a column from within the Money In and Money Out sections. Place 

your mouse over the column you wish to move. A box will highlight the column ‘header’. 

Hold down your left mouse button and drag the column to its new location. Release your 

left mouse button. 

 

Delete a Column 

1. Click on the Customise Columns icon and select the section (Money In or Money 

Out) that the column is in. 

2. Click on the column name to select it. 

3. Click on the [Delete] button to remove the column. Please note that if data has been 

recorded in that column at any time then the column cannot be deleted. 

4. The [Undo] button will be activated when you delete a column. You can click on this 

button to ‘undo’ the deletion. 

5. Click on [Save] when you have finished and then [Cancel] if you wish to exit. 

 

Change a Column's Width 

This function is carried out from within the Money In or Money Out sections. Columns 

have a maximum width on the screen. For example, if you want the Details column to be 

wider, there is a maximum width on the screen, but the information you type in (up to a 

maximum 150 characters) will print in your reports e.g. your Transaction Listing. 

To make a column wider, position your mouse cursor over the line at the side of the 

column. When the cursor changes to the following:  

Hold down your left mouse button and drag until the column is the width you require. 
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Record Money In and Money Out 

Money In - Overview 

The Money In Record records all receipts (money you receive) - by cheque, cash, credit 

card, or direct transfer. You will record the details of receipts, allocate them to a column 

that indicates what the receipt was for and then record what you did with it – deposit it in 

the bank or not. 

Cashflow Manager has a uniquely simple system to help you calculate your GST. You 

simply allocate a GST Tax Type that matches the boxes on the Business Activity 

Statement to your columns. When entering Money In you record the gross amount 

(including GST) into the appropriate column and the GST will be automatically calculated 

from the GST type allocated to the column. The GST types are: 

GST: All receipts subject to GST. 

Exports: All receipts from exports. 

Other GST-Free: All GST-free receipts (other than exports). 

Input Taxed: Receipts that are input taxed e.g. residential rents, financial supplies. 

Non-GST: Receipts that are not to be reported in the GST section of your BAS, e.g. 

transfers from your savings, salary & wages, amounts received from a hobby, trust and 

partnership distributions, dividends, loans and interest received (unless you make financial 

supplies in your business.) 

 

How to Record Money In (Money Received) 

Ensure that you are in the correct account and the correct month and year, and then 

follow these simple steps. 

The Money In Record has 3 primary sections. The first section is for the 'Receipt 

Information'. The second is to allocate what the receipt was for, and the third is for what 

you did with the receipt (i.e. deposit it in the bank or not.) 

The basic rule is that the Total Receipt must equal the total of the allocation columns and 

must also equal the total of the Bank Deposits and Receipts Not Banked columns. 

1. Record the date, the name of the customer or person from whom the money is 

received, any additional details that will help identify what the receipt was for later 

and the receipt number (if issued) in the appropriate columns. 

When you enter information in the Day, Customer and Details cells, you can move to 

the next cell by using either your Tab key or the Enter key. In the ‘number’ fields 

starting with the Receipt Number, you must use your Enter key to record information 

in a cell. Your tab key will simply move to the next cell. 

For example, after you record the first Receipt Number the next line will 

automatically pre-fill. Press Enter to use this Receipt Number or press Tab to leave 

the Receipt Number blank. 

When you type in the Customer and Details columns, a selection box will appear at 

the right side and the auto-fill facility will match the letters you are typing to any 

details that have been previously saved. Continue typing or click on the selection box 

to select the customer or details you input on a regular basis to save typing 

information that occurs regularly. 

Note that the Customer and Details auto-fill facility recalls information as you have 

recorded it and if you accidentally type in a lower-case letter this will appear each 
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time in the details box. To solve this, click on the Save icon, then click on the Options 

icon, select Auto Fill Options and click on the box to remove the selection to Use 

AutoFill. 

Click on the [OK] button to save the changes and exit the Options. This will allow you 

to go back into your Customer or Details and make the correction. (Go back to 

Options and select the Use Auto Fill box if you want the auto-fill facility 

again). Refer to the Tips and Tricks Section under Options, Auto Fill Options on how 

to edit the dropdown details list. 

2. Record the amount of the receipt in the Total Receipt column. 

3. Record the amount into the Allocation Column(s) applicable to the type of receipt. 

Use your Tab or arrow keys to move the amount to the appropriate column. Press your 

'Enter' key to record the amount in a column. 

If the column is a GST tax type, GST equal to 1/12th of the amount will be recorded in 

the GST column although this amount can be edited. Refer to ‘Edit the GST’ for more 

information. 

Receipts that do not occur regularly can be listed in either the Sundry GST Receipts 

or Sundry Non-GST Receipts as applicable. 

4. Record what you do with the receipt, i.e. whether you deposit it or not. 

5. If you deposit this receipt intact, then record the amount in the Bank Deposits 

column. 

❖ If you deduct cash from this receipt and deposit the balance, record the amount 

you bank in the Bank Deposits column and the amount retained in the Receipts 

Not Banked column. (The combined totals of the Receipts Not Banked and the 

Bank Deposits columns must equal the amount of the Total Receipt). 

❖ If you combine this receipt with others to deposit them all together, Tab or Arrow 

to the Receipts Not Banked column and press 'Enter'. When you have recorded 

the final receipt in the combined deposit, record the amount of your bank deposit 

in the Bank Deposit column. 

The program will allocate an adjustment in the Receipts Not Banked column 

because of the inbuilt control for each line that the Total Receipt must equal 

Receipts Not Banked + Bank Deposits. 

❖ Make sure you record details of all cash payments (including amounts taken for 

private purposes) in the Money Out Record. You can click on Cash 

Reconciliation at any time to check your records against the actual cash on hand. 

❖ Please note: For each line to balance, the amount in your allocation columns must 

equal your Total Receipt, and the combined amounts in your Bank Deposits and 

Receipts Not Banked columns must also equal the Total Receipt. If this does not 

occur, you will not be allowed to move to a new line. You will not be allowed to 

move to a new line if your line is not balanced. 

Click on the [Save] button when you have finished. (The program will automatically save 

when you change sections.) 

 

Money Out - Overview 

The Money Out section records all payments - by cheque, by cash or directly from the 

bank. It is good business practice to make all payments by cheque (or electronic bill 

payment) wherever possible because this gives you a record of your payment. 

Of course, this is not always practical, and some payments are made by cash. The best 

way to control cash payments is to use a Petty Cash System and establish a separate 
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Cashflow Manager account for Petty Cash. However, if you make cash payments from 

cash receipts or from your own resources then you should also record them in the Money 

Out Record. 

Cashflow Manager has a uniquely simple system to help you calculate your GST. You 

simply allocate a GST type that matches the boxes on the Business Activity Statement to 

your columns. When entering payments, you record the gross amount (including GST) 

into the appropriate column and the GST will be automatically calculated from the GST 

type allocated to the column. The GST types are: 

GST: All business payments subject to GST (other than Capital Purchases) 

GST Free: Payments to non-registered entities, or where the supply to you is either GST- 

free or Input Taxed so you have not been charged GST 

Input Taxed Supplies: Payments that you have made in respect of supplies by you that 

are input taxed 

Capital Purchases: Purchases of plant & equipment, property or other assets that cost 

you more than the Tax Office Expense limit. 

Capital Purchases are further classified as to whether they are taxable, GST-free or Input 

Taxed. ‘Taxable’ means that GST is included. GST-Free and Input Taxed have the same 

definitions as above. 

Non-GST: Payments that are not to be reported on your GST calculation sheet, e.g. 

salaries & wages, owners’ drawings, or other acquisitions that are not for use in your 

business. 

It is important that you set up the GST Tax Type for your columns correctly and then 

accurately allocate your payments to prepare your GST and BAS Reports. 

 

How to Record Money Out (Payments) 

Ensure that you are in the correct account and the correct month and year, and then follow 

these simple steps. 

The Money Out Record has 2 primary sections. The first is for the 'Payment 

Information'. The second is to allocate what the payment was for. 

The basic rule is that the Total Payment must equal the total of the Allocation Columns. 

1. Record the day, the name of the supplier or person to whom the money is paid, any 

extra details that are helpful in describing what the payment is for, and the cheque 

number (if applicable) in the columns titled for that information. 

When you enter information in the Day, Supplier and Details fields, you can move to 

the next cell by using either your Tab key or the Enter key. In the ‘number’ fields 

starting with the Cheque Number, you must use your Enter key to record information 

in a cell. Your Tab key will simply move to the next field. 

For example, after you record the first Cheque Number the next line will 

automatically pre-fill. Press Enter to use this Cheque Number or press Tab to leave 

the Cheque Number blank. 

2. If the payment is a cheque or other payment from your bank account such as direct 

debit, B-Pay or bank charges, record the total amount of the payment in the Total 

Bank Payments column. If the payment is cash then record the total amount in the 

Total Cash Payments column. 

3. Record the amount of the payment (including GST) in the Allocation Column(s) 

appropriate to the type of expenditure. Use your Tab or arrow keys, or the first alpha 

letter of the column header to move the amount to the appropriate column. Press your 

'Enter' key to record the amount in a column. 
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If the column is a GST tax type, GST equal to 1/11th of the amount will be recorded in 

the GST column although this amount can be edited. Refer to ‘Edit the GST’ for more 

information. 

Payments that do not occur regularly can be listed in the Sundry GST Payments, 

Sundry GST-free Payments or Sundry Non-GST Payments as applicable. 

IMPORTANT: You can only claim the GST Input Tax Credit if you have received a 

tax invoice from the supplier. If you do not have a tax invoice, then you must not put 

the payment into a GST ‘type’ column. 

When you complete a line of information so that the allocations equal the total 

payment, it will automatically jump to the next line. If you are unable to move to 

another line, it means that the line you are on is incomplete. The rule is that the Total 

Bank Payment or Total Cash Payment must equal the combined total of the Allocation 

Columns. 

Click on the [Save] button when you have finished. (The program will automatically 

save when you change sections.) 

 

Credit Card Payments 

We recommend that you create an ‘account’ for each credit card you use in your 

business so that you have a complete record that matches your credit card statement. 

In your credit card account, allocate expenses to the correct Payment columns. When 

you pay your credit card this will become a receipt in your Credit Card account. 

Either record the receipts in the Sundry Non-GST Receipts column or create a 

special column (see ‘Add a New Column’) in the Money In section of your Credit 

Card Account. Call it ‘Credit Card Payments Received’. The GST Type will be Non- 

GST and the Profit and Loss Indicator should not be ticked. 

In the account you used to pay the credit card, record your payment in the Total Bank 

Payment or Total Cash Payment column as appropriate, and then in either the Sundry 

Non-GST Payments column or in a column that you create specifically for Credit 

Card Payments. (Call it ‘Credit Card Payments’. The GST Type will be Non-GST and 

the Profit and Loss Indicator should not be ticked.) 

The ‘receipt’ column in the credit card account, and the ‘payment’ column in the 

account from which you paid the credit card will both be non-GST and not Profit and 

Loss type columns. 

 

At the End of the Month 

1. Check your bank statement to find any money in (credits) shown on the statement but 

not recorded in the Money In Record. Examples are bank interest received, and 

amounts transferred from other bank accounts. 

2. Record any amounts found into the Money In Record listing them in the Total 

Receipts column, an Analysis Column and the Bank Deposits column. (If no 

Allocation Column specifically applies, record the amount in the Sundry GST 

Receipts or Sundry Non-GST Receipts column as applicable). 

3. Check your bank statement to find any payments (debits) shown on the statement but 

not recorded in the Money Out Record. Examples are bank charges, direct debits for 

loans, leases, insurance etc. 

4. Record any amounts found into the Money Out Record listing them in the Total Bank 

Payment column and in the appropriate Allocation Column. 
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5. Go to Bank Reconciliation. 

Note: If you download your bank statements and are using the automated Bank 

Reconciliation option, you can transfer unrecorded transactions to the Money In and 

Money Out sections while doing your Bank Reconciliation. 

 

Helpful Hints for Recording Money In and Money Out 

Move around 

1. Use your arrow keys or your Tab key to move to other columns and press the 'Enter' 

key to record any information in a cell. 

2. You can also move between the Allocation Columns by pressing the first letter of the 

column name on your keyboard. 

3. If you are unable to move to another line, it means that the line you are on is 

incomplete. The rule is that the Total Receipt must equal the combined total of the 

Allocation Columns and equal the combined total of the Bank Deposits and Receipts 

Not Banked columns. 

4. When you amend a line that has been previously completed you must ensure that you 

also press 'Enter' on the Bank Deposits and/or Receipts Not Banked columns to 

confirm these amounts. 

 

Correct a Mistake 

1. To change the amount, you have already entered in a column, arrow to the amount 

you wish to change and simply start typing. 

2. To delete the amount, press the 'Delete' key on your keyboard. 

 

Copy and Paste Transactions 

1. To copy a single transaction, right click on the grey box at the left side of the line you 

wish to copy. 

2. To copy multiple transactions, click in the grey selector box at the left side of the row 

for the first transaction, then hold down the ‘Ctrl’ key on your keyboard as you select 

the other transactions you wish to include. (If all the transactions you wish to include 

are together you can also hold down your ‘Shift’ key on your keyboard and select the 

first and last transactions.) They will all be highlighted to show they have been 

selected. 

3. Then press the 'Ctrl’ and ‘C' keys together on your keyboard or right click on one of 

the grey selector boxes for a highlighted row and click on Copy. 

4. Type in a name of the account, the month and the year where you wish to paste the 

copied transactions. 

5. Click on [OK] to finish or [Cancel] to exit. 

 

Edit the GST 

In Australia, the GST Rate is 10%, which calculates as 1/11th of the GST inclusive 

amount. 

If the GST Rate changes or you are not registered for GST, you can change the rate in 

‘Options’. (If you are not registered for GST, change the rate to 0%). 
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Cashflow Manager has a simple unique system to help you accurately calculate and report 

your GST. Each column has a GST Tax Type that matches the boxes on the Business 

Activity Statement. 

When entering Money In or Money Out you record the gross amount (including GST) into 

the appropriate column and the GST automatically calculates. 

However, this gets complicated with some types of expenses where the GST is not 1/11th 

because the total includes both GST and GST-free components. An example of this is 

business insurance where the premium is subject to GST, but the stamp duty is not. 

You can overcome this by having two columns, for example Insurance-GST and 

Insurance GST-free and record the appropriate amount in each column. 

Alternatively, you can edit the amount of GST. To edit the GST: 

1. Record the receipt or payment as normal. 

2. Left click on the grey selector box to select the row. 

3. Right click on the grey selector box and select Edit GST. 

4. Record the correct GST in the box that appears. 

5. Click on [OK] to finish or [Cancel] to exit. (You can also reset the GST to the 

original calculation by clicking on the [Reset GST] button. 

The program will calculate the proportion of the total receipt that is subject to GST and 

report it in accordance with the GST Tax Type of the column. The balance will be 

included as GST-free for your GST and BAS reports. 

 

Insert a Line 

You can insert a line if you want to keep your transactions in date order (although you can 

also select to view in date order by clicking on the Date ‘header’. 

1. Right click on the grey box at the left side of the line where you wish to insert. 

2. Click on Insert New Line. 

A blank row will be inserted immediately above the line you have selected. Enter a 

transaction into this row as normal. 

You could also insert a line by arrowing to the line where you wish to insert and press the 

F8 key on your keyboard. 

 

Auto Column Selection 

To speed up your recordkeeping, you can setup the program so that whenever you type in 

a customer or supplier name, the amount automatically goes to the selected column. 

For example, you can tell the program that every time you type ‘Optus’ as the supplier 

name, you want it to select ‘Telephone’ as the allocation column. 

To do this, click on ‘Options’ and then ‘Auto Column Selection’ on the left side menu. 

Click on ‘Money Out’ and the names of Suppliers you have previously typed into the 

program will appear. 

Select ‘Optus’ as the Supplier. Click on the drop down and select ‘Telephone’ as the 

column. 

Click on [Save]. 
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Private Use Automation 

If you have a standard private use percentage that applies to payments recorded in a 

particular column, you can setup the program to calculate the amount of private use and 

record that amount in a selected ‘private use’ column. 

As an example, let’s say you have 80% private use of your motor vehicle. 

Click on the Options icon and then on ‘Private Use Columns’. 

Click on ‘Payments’ to list all your Payments/Money Out columns. 

Scroll down to the ‘Motor Vehicle’ column and click on the Percentage (it will be 0 unless 

you have previously recorded an amount of private use). Click on the drop-down box 

arrow at the right of the ‘Motor Vehicle’ line and select ‘Owners Drawings’ as the Private 

Use column. 

When you enter an amount in the Motor Vehicle column (e.g. $100), it will save the 

business proportion (e.g. 20% of $100 = $20) in the Motor Vehicle column and allocate 

the private proportion (e.g. 80% of $100 = $80) to Owners Drawings. 

Click on [Save]. 

 

Move Transactions to another account or month 

If you accidentally record transactions in a wrong month or wrong account, you can move 

them to the correct location. 

1. To move a single transaction, right click on the grey box at the left side of the line you 

wish to move. 

2. To move multiple transactions, click in the grey selector box at the left side of the row 

for the first transaction. Then hold down the ‘Ctrl’ key on your keyboard as you select 

the other transactions you wish to include. (If all the transactions you wish to include 

are together you can also hold down your ‘Shift’ key on your keyboard and select the 

first and last transactions.) They will all be highlighted to show they have been 

selected. 

3. Then press the 'Ctrl’ and ‘X' keys together on your keyboard or right click on one of 

the grey selector boxes for a highlighted row and click on Move. 

4. Type in a name of the account, the month and the year where you wish to transfer the 

transactions. 

5. Click on [OK] to finish or [Cancel] to exit. 

 

Remove a Line 

You can remove an entire line from your Money In or Money Out Records. 

1. Right click on the grey box at the left side of the line where you wish to remove. 

2. Click on Remove Line. 

You could also remove a line by pressing the F9 key on your keyboard. 

 

Recurring Transactions - Add a Recurring 
Transaction 

If you have transactions that occur regularly, you can save them in a list of transactions for 

easy input each time they occur. To add a transaction to your list of recurring transactions: 
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1. Right click on the grey box at the left side of the row for the transaction you wish to 

add. 

2. Click on Add Recurring. 

You can also do this by clicking on the grey box at the left side to select the row and 

then press the F6 key on your keyboard. 

To batch transactions together so you can insert them all at once, click in the grey 

selector box at the left side of the row for the first transaction, then hold down the 

‘Ctrl’ key on your keyboard as you select the other transactions you wish to include. 

(If all the transactions you wish to include are together you can also hold down your 

‘Shift’ key on your keyboard and select the first and last transactions.) They will all be 

highlighted to show they have been selected. 

3. Then press the F6 key on your keyboard or right click on one of the grey selector 

boxes for a highlighted row and click on Click on Add Recurring. 

4. Type in a name that identifies this transaction or group of transactions for selecting 

them later. 

5. Click on [OK] to finish. 

 

Recurring Transactions - Insert a Recurring 
Transaction 

Press the F7 key on your keyboard or right click on the grey selector box at the end of 

your transactions and select Insert Recurring. 

The transaction will be inserted at the end of your existing transactions. 

 

Recurring Transactions - Remove a Recurring 
Transaction 

1. Click on the Options icon. 

2. Click on Remove Recurring Transactions. 

3. Click on the Money In or Money Out option as appropriate. 

4. Click on the down arrow and select the transaction you wish to remove. 

5. Click on [Save] when finished. 

 

Record a Quantity 

You can record an amount (up to 2 decimal places) for Quantities or perhaps Imputation 

Credits with any of the allocation columns in your Money In and Money Out sections. 

1. Arrow to the allocation column where your amount has been recorded. 

2. Click on the [Quantities] button at the bottom of the Money In table. 

3. Record the amount in the box that appears and click on [OK]. 

The cell in your Money In or Money Out table will now have a small red marker in 

the top corner to indicate that a quantity has been recorded. 

Quantities will be included in your Transaction Listing, Cashflow and your General 

Ledger Listing Reports. 
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To rename the Quantity Column, click on Tools menu and select Options or on the 

Options icon. Click on 'Quantity Column & Decimals Displayed. Record the new 

name (up to 8 characters) and click on [Save]. 

 

Sort your Transactions 

You can sort your transactions to help you analyse your data. For example, you may wish 

to see your transactions in date order even though you have entered them in a different 

way. You may wish to see your transactions in customer order, or you may wish to look at 

all transactions for a selected Allocation Column together. 

To sort your transactions, simply click on the ‘column header’ for the column you wish to 

sort by. 

 

Search for Money In or Money Out Transactions 

1. Click on the Tools menu and then on Search. Alternatively, click on the Search icon 

at the top of the screen. 

2. A Search window will appear and default to the tab active in Cashflow (Money In or 

Money Out). You can select to search by All Accounts, Selected Accounts, Date, 

Amount, Customer and Receipt Number (if searching for receipts) or Supplier and 

Cheque Number (if searching for payments) or Details. 

3. Select your search criteria and then click the [Search] button. The search results will 

be displayed. 

4. Click on the [Open Receipt] or [Open Payment] button to view the transactions in 

your Money In and Money Out tables. 

5. Click on the [Print] button to print your results, or the [Cancel] button to exit. 

6. Click on the START OVER tab if you wish to begin the search again. 

 

Transfer Money In and Money Out from the Invoice 
and Wages Sections 

You can transfer transactions into the Money In and Money Out Records as you are 

processing them in the Invoice and Wages sections. 

Refer to Invoice Manager and Wages Manager instructions for more information. 

Note: If you delete a payment in your Invoice or Wages sections, this change will not be 

recorded in your Cashflow records. You will need to open your Cashflow Manager 

account and make any changes yourself. 
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Bank Reconciliation 

What is a Bank Reconciliation? 

A Bank Reconciliation is simply a process that matches your Money In and Money Out 

Records with your Bank Account. 

It is an important process because it provides you with a check as to the accuracy of your 

records and can therefore save your accountant a lot of time at the end of the year. 

The balance of your bank account may be different from your records because someone 

hasn’t banked the cheque you sent to them, or bank charges have been applied but you 

haven’t recorded them as you haven’t seen your statement. Or maybe someone has paid a 

direct deposit into your bank that you haven’t recorded. 

You need to record your Opening Bank Balance when you first start using the program 

and then the program will automatically track the Balance per your Records. 

The monthly Bank Reconciliation is simply checking the deposits and payments on your 

Bank Statement against your records and making sure that everything on your bank 

statement is in your records. 

Sometimes there are items in your records that are not on your bank statement, such as 

cheques you have posted that have not been banked by the persons you sent them to. 

These are called ‘outstanding’, ‘unpresented’ or ‘uncleared’ items, and when your Bank 

Statement Balance is adjusted to take these into account, your Bank Balance should be the 

same as your Records Balance. 

To process your Bank Reconciliation, click on the Bank Reconciliation tab and a ‘wizard’ 

will take you step by step through the bank reconciliation process. 

If you are doing a Bank Reconciliation for the first time, ensure that the month you have 

selected is the first month of records that you want to reconcile. 

The wizard will take you to the Opening Balance. On later occasions the Opening Balance 

wizard can be accessed from the Settings button, but you should only ever need to record 

your Opening Balance when you first start using the program. 

 

Bank Reconciliation and Financial Institution 
Settings 

When you first click on the Bank Reconciliation tab the Bank Reconciliation Settings 

section will display. 

You can choose to either reconcile your Cashflow Manager records to the paper statement 

you receive from your bank or to a downloaded file if you use Internet Banking. 

So the question asks: How do you want to reconcile your Cashflow Manager records? 

If you want to reconcile to your paper statement that option is already selected so you can 

click on the [Next] button. 

If you want to reconcile to an online file downloaded from your bank, click on that option. 

Unfortunately, the banks all have different formats for their downloaded files so you must 

select your bank from the Financial Institution list so that Cashflow Manager can match it, 

or add it if it does not appear in the list of pre-loaded banks. 
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Regardless of which option you choose to reconcile, you must record your Opening Bank 

Balance together with any transactions that relate to previous time periods but have not 

appeared on your bank statement. 

When you click on [Next], a wizard will walk you through the process of recording your 

opening bank balance. 

The Settings window will no longer be displayed once you have made your choice and 

recorded your Opening Bank Balance. You can return to it at any time by clicking on the 

[Settings] button in the Bank Reconciliation section. 

 

Adding a New Financial Institution 

If your bank is not listed, you can add it yourself by following these steps: 

1. Download a file from your Bank’s website to use as a template. 

2. Click on the “Add New” button to set your default Financial Institution. 

3. Browse to the Bank file that you downloaded. Open the file. Your data will be 

displayed on the left side of the pop-up window. 

4. Answer the questions in the bottom left of the pop-up window 

a. Is there a header? This refers to whether there are column titles in the data. 

For example, date, description etc. 

b. Are the fields separated by tabs or commas? Most banks use commas, try this 

option first. 

c. How many fields are there in each row? For example, if your data has Date, 

description, debit and credit, there are 4 fields. Note: sometimes it is difficult 

to tell if there is no header row. If you see 2 commas together, the second 

comma indicates another field, even though it is empty. For example, this will 

occur if the bank file has a separate field for debits (money out) and credits 

(money in). 

5. Assign the fields. For each of the fields in your data, select a field type to map to in 

Cashflow Manager. There is a drop-down list in the field called “Field type”. 

6. Provide a name for this Bank. 

7. Provide the URL that you use to download. This will enable you to navigate to your 

bank site and download your statement at the time you are doing your bank 

reconciliation. 

8. Click on Save. 

9. Click on Next 

You are now ready to map your bank statement and enter your Opening Bank Balance. 

 

 

Map your Downloaded Bank Statement 

Bank Statement Mappings allow you to take a portion of the transaction descriptions that 

are always present in the downloaded bank statement (typically Customer and Supplier 

names), and select which column you want these transactions placed in when 

automatically adding records to Money In and Money Out during the Automatic Bank 

Reconciliation process. 

To access the Map Bank Statement Description option, click on the [Settings] tab at the 

bottom of the bank reconciliation screen. 
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Alternatively, Map Bank Statement Description option can be accessed in the Cashflow 

section, by clicking on Tools/ Map Bank Statement Description. 

 

 

Add a Mapped Bank Statement Description 

To map your downloaded bank statement, please follow these instructions: 

1. Click on the [Map Bank Statement Description] button – here, the Map Bank 

Statement Description screen will appear showing a Money In and Money Out section. If 

you have not downloaded a Bank Statement, select a bank from the drop-down menu and 

click the [Download] button. 

2. The Map Bank Statement Description screen will default to the Money In section. 

Click on [Add], and a message will appear asking you to open a Bank Statement File 

before proceeding. Click [OK]. 

3. A window will appear, defaulting to the Cashflow 14 Bank Folder, for you to select 

your Bank Statement File (CSV). If you have downloaded the file to another location, 

navigate to this destination. Select the csv file and click [Open]. 

4. The transactions on your csv file will now load into the Money In section, and in 

specific columns depending on how the file is formatted (refer to the Adding a New 

Financial Institution section on formatting the csv). 

5. To take a portion of a transactions’ description (i.e. a “Customers” name), highlight the 

word or name by using your cursor. Then right-click on the word or name and select 

Copy. 

6. In the Mapping Data field, towards the bottom left corner of the screen, right click and 

select Paste. This will now paste the word or name in the field. (Refer to the HELP option 

next to the field for additional information about the Mapping Data field) 

7. If you wish to have this description added to the Customer column automatically every 

time you process an automatic bank reconciliation, in the Money In section, click in the 

checkbox next to Add as Customer. (Refer to the HELP option next to the field for 

additional information about the Add as Customer field) 

8. You can now select the column you wish these transactions to be allocated, by 

accessing the drop-down menu in the Money In Column To Map To field. 

9. Click on [Save]. A message will appear asking if you wish to close the screen. If you 

wish to map more transactions, click [No]. To add more transactions, repeat the mapping 

process 5 – 9. 

Once you have completed mapping the Money In section, repeat the mapping process in 

the Money Out section. To access the Money Out section, click on the Money Out tab in 

the mapping screen. This will be related to Money Out transactions, allowing you to add 

portions of the description as “Suppliers”, and allocating transactions to Money Out 

columns. 

 

 

Modify a Mapped Bank Statement Description 

On the list of Mapped Bank Statement Descriptions, you have the option to modify 

Mapped Bank Statement Descriptions. 

To modify a Mapped Bank Statement Description: 

1. Highlight the description line by clicking in the square at the beginning of the line 

2. Click on [Modify] 
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3. If a Bank Statement File (CSV) has already been opened, the transactions will be 

displayed and both the ‘Mapping Data’ and ‘Money In column to map to’ fields will be 

available to change. 

If there is no Bank Statement File (CSV) opened, no transactions will be displayed and 

only the ‘Money In column to map to’ field will be available to change. If you need to 

change the ‘Mapping Data’, click the [Open Bank Statement File] button. This will load 

the Bank Statement file transactions and enable the ‘Mapping Data’ field. 

4. Click on [Save]. A message will appear asking if you wish to close the screen. Click 

[Yes] if you have finished modifying the record. 

 

 

Delete a Mapped Bank Statement Description 

On the list of Mapped Bank Statement Descriptions, you have the option to delete Mapped 

Bank Statement Descriptions. 

To delete a Mapped Bank Statement Description: 

1. Highlight the description line by clicking in the square at the beginning of the line 

2. Click on [Delete] 

 

Please Note: The Map Bank Statement Description screen includes a link to an 

Instructional Training Video on the process. Click on the link to take you to the video. 

 

 

Record Your Opening Bank Balance 

Your Opening Bank Balance is the balance that would be in the bank if all deposits that 

have been put into the bank and all cheques written on or before the date you are starting 

to use the program appeared on your bank statement. 

If you have not previously recorded an Opening Bank Balance you will have the 

opportunity when you do your first reconciliation. 

1. Record your Closing Bank Statement Balance for the month immediately preceding 

the month of your first reconciliation (or $0 if you are reconciling a new account.) 

2. Click on [Next] to continue. 

If you are unsure at any stage, click on the [Tutor] button to view a tutorial on the 

Bank Reconciliation process. 

3. This brings us to the Uncleared Deposits (Money In) page where you need to record 

any deposits from previous months that have not yet appeared on your Bank 

Statement. 

This is unusual with Bank Deposits but sometimes might occur. If it does, you only 

need to record the total deposit, not the individual transactions as we only need the 

amount to match the amount that appears on our bank statement. 

Simply record the last day of the month in Day, tab to Total Amount and record the 

amount of the deposit. Allocate the deposit to any Allocation Column (it is before 

your records commence so should not affect your reports) and then record the amount 

in the Bank Deposits column. 
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4. Click on [Next] to go to the page for recording any Uncleared Payments. This is more 

common and will occur when you send a cheque to someone and they don’t bank it 

until after the end of the month. 

5. Record any Bank Payments from previous months that have not yet appeared on 

your Bank Statement. Remember to record the cheque number as well as the amount 

in the Total Bank Payments column. 

6. When you have recorded all uncleared deposits and payments, click on [Save] to save 

your reconciled Opening Bank Balance. 

Your Opening Bank Balance will now be displayed in the first line of the My Records 

information on the Bank Reconciliation window. 

If you wish to change between the manual and ‘downloaded statement’ options, or 

process your Opening Bank Balance again, click on the [Settings] button from the 

Bank Reconciliation window. 

 

Processing your Bank Reconciliation 

Click on the Bank Reconciliation tab. 

The opening window will show the current balances from both your Records and your 

Bank Records. To change between the ‘download’ and ‘manual’ Bank Reconciliation 

options, click on [Settings]in the centre of the bottom bar of the program. To begin 

reconciling your records to your bank statement, click on [Next]. (As an alternative, you 

can also press the Alt and N keys on your keyboard at the same time.) 

 

Reconciling with a Downloaded Bank Statement 

If you are registered with your bank for internet banking you can download your Bank 

Statements and automate much of the Bank Reconciliation process. This can potentially 

save you hours of time, particularly in looking for discrepancies. 

You will need to have selected ‘reconcile to a downloaded file’ and the name of the bank 

in the Bank Reconciliation Settings. 

There are several steps in this process as indicated by the tabs at the top of the Bank 

Reconciliation screen, but this can have a number of advantages. 

For example, many of your transactions can be automatically matched to save you hours 

of time. Some banks are better than others in this regard because some list cheque 

numbers separately, while others include the cheque number as part of a description that is 

not easy to separate. 

Plus, any transactions on your bank statement that have not been entered into Cashflow 

Manager can be imported and quickly allocated the correct columns. 

Step 1: Download your Bank Statements. 

You can do this at any time you are logged on to the internet and from within the Bank 

Reconciliation wizard. 

1. Select the name of your Bank and click on the [Download] button to go to your 

Bank's website. If you have already downloaded your bank statement, click on [Next] 

or press Alt-N on your keyboard. 

2. Login and follow the Bank's instructions to 'Download' or 'Export' transactions. For 

example, if you bank with Westpac you would do the following once you arrive at the 

Westpac Business Banking site: 

a. Sign in to your Online Banking Account. 
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b. Click on the 'Banking' Tab at the top of the screen. 

c. Click on the 'Export' tab. 

d. Click on the down arrow to select your account 

e. Select your date range. (Do one month at a time from the first to the last days of 

the month. 

f. Click on the down arrow for 'Software' and select 'Cashflow Manager'. (If your 

bank doesn't have Cashflow Manager as a software option, click on 'Date Format' 

and select 'dd/mm/yy' or 'dd/mm/yyyy' and then click on the down arrow for 'File 

Format' to select 'Comma Separated File (csv)'. 

g. Click on the 'Download Now' button. 

h. You will be asked if you wish to Open the file or Save it to your computer. Click 

on 'Save'. 

i. Change location to: 

C:\Users\Username\AppData\Roaming\CFM\Cashflow14\Bank and click on 

‘Save’ 

3. Unfortunately, the Bank's export files do not generally include the Balance so while 

you are signed in for online banking with your account selected, click on the 

'Statement' option and select the last day of the month to find out your Closing Bank 

Balance on this day. Write this balance down for future reference. 

4. Click on [Next] or press Alt-N on your keyboard to continue the Bank Reconciliation. 

Step 2: Import your Bank Statement File 

1. Browse to select your downloaded file. If you saved it in the location described in step 

1 this should be: C:\Users\Username\AppData\Roaming\CFM\Cashflow14\Bank. 

2. When you have selected the file, click on the [Next] button or press Alt-N on your 

keyboard. You should receive a message advising that your file has been successfully 

imported. 

Step 3: Closing Bank Balance 

1. Type the closing bank statement balance for the month in the box provided. 

This is the balance on your bank statement after the last transaction for the month. 

You may need to look up your closing bank statement balance in your internet 

banking statement as this information is not included in your downloaded file. 

(Hint: if the balance is in overdraft, record the amount as a minus.) 

2. Click on [Next] or press Alt-N on your keyboard to continue. 

Step 4: Reconcile Money In (Deposits) 

There are several stages in the Reconcile Deposits process. 

1. Money In – Auto-Matched. 

Your Money In Record deposits are matched to your Bank Statement on the basis of 

date and amount. Review these entries to ensure they are correct. If any are not 

correct, click on either the Records or Bank Statement checkbox to remove the 

match. Then click on [Next] or press Alt-N on your keyboard. 

2. Money In – Unmatched i.e. Deposits Not Found in Your Records 

Your unmatched entries are listed in amount order, although you can click on the 

header for any column that you may wish to sort by. 
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To match a transaction, click on the checkbox in My Records list, and the checkbox 

for the corresponding transaction in the Bank Statement list. These matched entries 

will be moved to the top of the list. 

Note: Transactions will only match if the amounts are the same. If you recognise a 

match but the amounts differ, you will need to correct the amount in your Money In 

Record before finishing your Bank Reconciliation. 

After making any corrections, any un-ticked amounts in the My Records section 

should be deposits recorded in the Money In Record but not appearing on your Bank 

Statement (i.e. outstanding deposits). 

Click on [Next] or press Alt-N on your keyboard to continue. 

3. Money In – To Add 

This will only appear if selected in Options – Advanced Preferences. It displays any 

entries for deposits listed on your bank statement but not entered in your records and 

allows you to select any entries that you wish to include in your records. Note: this 

option is turned off by default because it would be unusual not to add all such entries 

on your bank statement into your records. 

When you have done this, click on [Next] or press Alt-N on your keyboard to 

continue. 

4. Allocate Money In 

The Money In Record screen will now list the transactions you have selected to add so 

you can apply the amounts to the correct Allocation Columns. 

Arrow to or click on the amount you wish to reallocate and press your ‘Delete’ key to 

delete the amount from that column. Arrow across to the correct column and press 

‘Enter’ to save the amount in that column. 

You can also breakdown the transaction into more than one Allocation Column. 

When you have finished, click on [Next] or press Alt-N on your keyboard. 

Step 5: Reconcile Money Out (Payments) 

There are several stages in the Reconcile Money Out process. 

1. Money Out – Auto-Matched. 

The Total Bank Payment transactions from the Money Out Record are matched to 

your Bank Statement on the basis of cheque number, date and amount. Review these 

entries to ensure they are correct. If any are not correct, click on either the My 

Records or Bank Statement checkbox to remove the match. Then click on [Next] or 

press Alt-N on your keyboard. 

2. Money Out – Unmatched i.e. Payments Not Found in Your Records 

Your unmatched entries are listed in cheque number then amount order, although you 

can click on the header for any column that you may wish to sort by. 

To match a transaction, click on the checkbox in My Records list, and the checkbox 

for the corresponding transaction in the Bank Statement list. These matched entries 

will be moved to the top of the list. 

Note: Transactions will only match if the amounts are the same. If you recognise a 

match but the amounts differ, you will need to correct the amount in your Money Out 

Record before finishing your Bank Reconciliation. 

After making any corrections, any un-ticked amounts in the My Records section 

should be payments recorded in the Money Out Record but not appearing on your 

Bank Statement (i.e. outstanding payments). 

Click on [Next] or press Alt-N on your keyboard to continue. 
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3. Money Out – To Add 

This will only appear if selected in Options – Advanced Preferences. It displays any 

entries for payments listed on your bank statement but not entered in your records and 

allows you to select any entries that you wish to include in your records. Note: this 

option is turned off by default because it would be unusual not to add all such entries 

on your bank statement into your records. 

When you have done this, click on [Next] to continue. 

4. Allocate Money Out 

The Money Out Record screen will now list the transactions you have selected to add 

so you can apply the amounts to the correct Allocation Columns. 

Arrow to or click on the amount you wish to reallocate and press your ‘Delete’ key to 

delete the amount from that column. Arrow across to the correct column and press 

‘Enter’ to save the amount in that column. 

You can also breakdown the transaction into more than one Allocation Column. 

When you have finished, click on [Next] or press Alt-N on your keyboard. 

Step 6: Balance and Lock your Records 

The summary information from both your records and the bank will be displayed. If you 

reconcile then the Records Balance and the Bank Balance will agree. 

Click on the [Finish] button to continue. 

A message will ask whether you wish to lock your records. When you have completed 

recording transactions for any month and it has been reconciled it is advisable to lock your 

records to prevent any accidental changes that might affect your records. 

To lock your records, click on [Lock]. If you do not want to lock your records at this time, 

click on [Don’t Lock]. 

If there is a discrepancy between your records and bank statement, the [Finish] button will 

be replaced by a [Next] button that will save the deposits and payments you have checked 

off to give you the opportunity to find what is causing the discrepancy without having to 

check everything off when you process your Bank Reconciliation again. 

When you lock your records, a padlock will appear next to the Account Name in your 

Money In, Money Out, Bank Reconciliation and Cash Reconciliation sections. 

If you need to unlock your records for any reason such as changing an allocation, go to the 

Bank Reconciliation screen and click on the [Unlock] button. 

If you unlock a month and change anything in the Bank Deposits column of your Money In 

Record, or the Total Bank Payment column in your Money Out Record this will affect your 

reconciliation, not only for this month but for any future month as well. 

Therefore, we recommend that you print your Bank Reconciliation report every month. 

Please also see the Tips and Tricks section regarding cancelling or amending cheques 

from a previous month. 

NOTE: The Bank Reconciliation process has Tabs that allow you to select a different step 

in the process. However, we highly recommend that you use the [Next] button or press 

Alt-N on your keyboard and only use the Tabs to make changes such as changing the 

Bank Statement balance. 

 

Reconciling to your Paper Bank Statement 

Click on the Bank Reconciliation tab. 
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The opening page will show the current balances from both your Cashflow Manager 

Records and your Bank Records together with the Discrepancy. 

To begin reconciling your records to your bank statement, click on [Next] or press Alt-N 

on your keyboard. 

Step 1: Closing Bank Balance 

Type the closing bank statement balance for the month in the box provided. This is the 

balance on your bank statement after the last transaction for the month. (Hint: if the 

balance is in overdraft, record the amount as a minus.) 

Click on [Next] or press Alt-N on your keyboard to continue. 

Step 2: Reconcile Money In (Deposits) 

The Reconcile Deposits window lists all the deposits entered in the Money In Record. 

Check the deposits on your Bank Statement against the list of Deposits. When the deposit 

on your Bank Statement agrees with the deposit on your list, click in the checkbox at the 

right side of the deposit in the list. Tick them off on your Bank Statement as well. 

If a deposit on the list differs from the amount on the bank statement, it may be caused by 

an error in the bank deposit or the entry in your Money In Record. 

If it is an error in the deposit addition, a correction should appear on your bank statement 

a few days later. The two amounts added together should equal the deposit on your list. If 

so, click in the checkboxes for the two amounts. If the error is in your Money In Record 

correct the entry. 

Any entries left un-ticked should correspond to the deposits that have been put into the 

bank too late to appear on the bank statement for the month. This will be rare but may 

occur on the last day of the month. 

Generally, the deposits listed will be those that are outstanding i.e. have not yet appeared 

on your bank statement. The Reconcile View provides the opportunity to vary the list. 

Once you have checked all your deposits, click on the [Next] button. 

The Allocate Money In window will appear so you can record any transactions you have 

discovered on your bank statement that have not been entered into the program without 

having to leave the Bank Reconciliation process. As you are entering these transactions 

during the Bank Reconciliation process they will automatically be treated as reconciled. 

When you have finished, click on [Next] or press Alt-N on your keyboard to continue. 

Step 3: Reconcile Money Out (Payments) 

The Reconcile Money Out window lists all amounts recorded in the Total Bank 

Payments column of your Money Out Record. 

Check the debits on your Bank Statement against the transactions in your Reconcile 

Money Out list. When you get a match, click in the checkbox at the right side of the 

payment in the list and tick the entry on your Bank Statement. 

If a cheque on the list differs from the amount on the bank statement, you have probably 

made an error on your cheque stub. Leave the transaction unchecked. When you have 

completed the rest of the reconciliation you will need to correct this in your Money Out 

Record and then redo the Bank Reconciliation that should only require matching of this 

transaction. 

Any entries left un-ticked should correspond to the cheques you have written that have not 

yet been presented at the bank. The total of these entries will be displayed as Payments 

Not Shown in the Bank Statement information section on the Bank Reconciliation screen. 

Any cheques that are not reconciled in the current month will automatically show up in 

the following month's Reconcile Money Out list. Generally, the payments listed will be 
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those that are outstanding i.e. have not yet appeared on your bank statement. The 

Reconcile View provides the opportunity to vary the list. 

Once you have checked all your deposits, click on the [Next] button or press Alt-N on 

your keyboard. 

The Allocate Money Out window will appear, so you can record any transactions you 

have discovered on your bank statement that have not been entered into the program 

without having to leave the Bank Reconciliation process. As you are entering these 

transactions during the Bank Reconciliation process they will automatically be treated as 

reconciled. 

When you have finished, click on [Next] or press Alt-N on your keyboard to continue. 

Step 4: Balance and Lock your Records 

The summary information from both your records and the bank will be displayed. If you 

reconcile then the Records Balance and the Bank Balance will agree. 

Click on the [Finish] button or press Alt-F on your keyboard to continue. 

A message will ask whether you wish to lock your records. When you have completed 

recording transactions for any month and it has been reconciled it is advisable to lock your 

records to prevent any accidental changes that might affect your records. 

To lock your records, click on [Lock]. If you do not want to lock your record, click on 

[Don’t Lock]. 

If there is a discrepancy between your records and bank statement, the [Finish] button will 

be replaced by a [Next] button that will save the deposits and payments you have checked 

off to give you the opportunity to find what is causing the discrepancy without having to 

check everything off when you process your Bank Reconciliation again. 

When you lock your records, a padlock will appear next to the Account Name in your 

Money In, Money Out, Bank Reconciliation and Cash Reconciliation sections. 

If you need to unlock your records for any reason such as changing an allocation, go to the 

Bank Reconciliation screen and click on the [Unlock] button. 

If you unlock a month and change anything in the Bank Deposits column of your Money In 

Record, or the Total Bank Payment column in your Money Out Record this will affect your 

reconciliation, not only for this month but for any future month as well. 

Therefore, we recommend that you print your Bank Reconciliation report every month. 

Please also see the Tips and Tricks section regarding cancelling or amending cheques 

from a previous month. 

NOTE: The Bank Reconciliation process has Tabs that allow you to select a different step 

in the process. However, we highly recommend that you use the [Next] button and only 

use the Tabs to make changes such as changing the Bank Statement balance. 

 

What to do if you cannot reconcile 

1. Check that the Opening Balance per your Records is the reconciled balance from the 

month before. 

2. Check that the amount you have typed into the Bank Statement Closing Balance is the 

end of the month balance according to your Bank Statement. 

3. Check that every credit (receipt) that has appeared on your Bank Statement is entered 

into your Receipt Record. This includes transfers from other accounts and bank 

corrections. 
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4. Check that every debit (payment) that has appeared on your Bank Statement is entered 

into your Money Out Record. This includes bank charges, government charges, direct 

debits for loans or insurance and telephone banking bill payments. 

5. Check that the amounts you have typed into your Money Out or Money In Records 

are the same as the amounts on the Bank Statement. 

6. Print out a Transaction Listing for the period you are reconciling. Get a friend or 

associate to assist you with one reading from the Bank Statement and the other from 

the Transaction Listing. Tick each transaction off as you agree. The entries left 

unchecked on the Transaction Listing should be the deposits and cheques that are 

outstanding at the end of the month (together with any that are still outstanding from 

the previous month.) 

7. If you still cannot reconcile, call your Accountant for assistance. 

 

Cash Reconciliation 

What is a Cash Reconciliation? 

A Cash Reconciliation is simply a check that the Cash on Hand per your Records equals 

the Actual Balance of Cash on Hand. This can be done as often as you wish. The Cash on 

Hand per your Records automatically calculates from the Opening Cash Balance which 

transfers from the previous month, the Receipts Not Banked entries in your Money In 

Record and the Total Cash Payments column in your Money Out Record. 

The formula that is used is simply: 

Opening Cash Balance 

+ Receipts Not Banked (from your Money In Record) 

- Cash Payments (from your Money Out Record) 

= Cash on Hand per your Records. 

 

Record Your Opening Cash Balance 

1. Click on the Cash Reconciliation tab. 

2. Change to the month in which you are commencing your records. 

3. Click on the [Settings] button. 

4. Record the Opening Cash Balance. (Your records may be locked because of your 

Opening Bank Balance. If so, click on the Bank Reconciliation tab and on the 

[Unlock] button. Then return to Money In.) 

5. Click on [OK]. 

 

Reconcile Your Cash 

Click on the Cash Reconciliation tab. 

Count your cash on hand and type the amount into the box for the current amount of 

cash on hand. 
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If the Cash on Hand per your Records is the same as the Actual Cash on Hand then your 

cash reconciles. If they do not agree you should check your records and recount your cash 

on hand to see if there is an error. 

If you cannot find an error and your cash does not reconcile, the discrepancy must be 

recorded in the Money In or Money Out Records to correct the error. 

For example, if your actual cash on hand is $5.00 less than the balance per your records, 

you need to record the discrepancy in your Money Out Record. 

Open the Money Out Record and go to the next line available. 

Record the date of your reconciliation in the Day column. Arrow to the Details column 

and type ‘Cash Discrepancy’. Record the amount of the discrepancy in the Total Cash 

Payments column. Now record the amount in Sundry Other Non-GST Payments column. 

If you now click on the Cash Reconciliation tab, the Balance of Cash on Hand per your 

Records has been changed to reflect the entry you have made and should now reconcile 

with the cash amount you typed in. 

If your actual cash is greater than the amount of balance per your records, record the 

‘overage’ discrepancy in your Money In Record. 

Open the Money In Record and go to the next line available. 

Record the date you are reconciling in the Day column. Type "Cash Discrepancy" in the 

Details column. Record the amount of the discrepancy in the Total Receipts column, 

Other Non-GST Receipts and Receipts Not Banked columns. If you now click on the 

Cash Reconciliation tab, the Current Cash on Hand per My Records has now changed to 

reflect the entry you have made and should now reconcile with the cash amount you typed 

in. 

You can complete your Cash Reconciliation at any time. However, you must record any 

discrepancies in the Money In or Money Out Record at the end of every month so that you 

do not carry forward an incorrect balance to the new month. 
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Bank Feeds 
Adding bank feeds to subscription. 

Click BANK FEEDS on the side menu. 

 
Click yes on prompt to subscribe to Bank Feeds. 

 
Click OK on message to close Cashflow and open User account login screen. 

 
Login to user account and add bank Feeds to subscription. 

Reopen Cashflow, Click on BANK FEEDS on the side menu and follow prompts to connect bank feeds. 
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Connecting to bank feeds 

Click BANK FEEDS on the side menu, Click Ok to login to your online banking. 

 
The first time this is opened user will need to agree with terms and conditions, then scroll down and click 

the get started butt 

 

on. 
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If users have already agreed to terms but not yet selected their bank, they will see this prompt. Click OK 

to login to your online banking. 

 
Click the icon for your bank or search if it is not listed. 
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Enter your internet banking login details and click Submit. 

 

This will list all your available bank accounts. This may take a minute or two. 

You can remove accounts you do not want included in your bank feeds. 
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To delete accounts not required for bank feeds click on the gear icon below the account name. 

Then click Delete account. 

 

Tick check box and click delete. 

Note: Deleting an account will stop it being imported to cashflow manager, it does not remove any 

data from your bank records. 

 
Click the cross to close. 

 



85  

After checking bank account list click OK at the bottom of the screen. 

Click OK on the prompt to link bank accounts in cashflow. 

 

For each account in cashflow manager select a bank feed account from the drop-down list to link 

accounts. 
Click Save and then OK. 

You are now ready to use bank feeds. 
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Using Bank Feeds 

Click BANK FEEDS in the side menu. 

Select account and month to work on. 

Records displayed will need one or more of the following actions performed. 

Add 

Bank Statement Description linked 

Approve 
 

Adding records to Money In/Out 
Click the Add function for a transaction. 

Select Customer/Supplier. (Optional) 

Select Allocation column. 

Edit amount to split allocation if required. 

Add quantity if required 

Click Save and Close. 

Action button will change to approve. 
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Linking bank Description 
Click check box for record in Bank Statement Description Linked column. 

Select allocation column. 

Use full description or part. 

Click Save. 
Action button will change to approve. 

Ticking check box Add as Customer/Supplier will add text as a Customer/Supplier 

 

Approve records 
Click the approve button in the action column. 

Or click Approve All button. 

Records will be marked as reconciled and removed from the list. 
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Bank Feed functions 

 

Edit a record 
Change Customer/Supplier (Optional) 

Change allocations. 

Split allocations. 

Change quantities. 

Click Save and Close 

Edit option is only available for records with details in Your Records side. 
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Add Cash records 
Click Money In or Money out button. 

Add Customer/Supplier (Optional). 

Add details. 
Enter Amount. 

Select Allocation column. 

Click Save and Close. 
 

 

 

 

Approve all 
Marks all records with Approve action as reconciled and removes them from the list. 
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Reconcile and Lock 
Enter Closing balance for the month. 

Click Reconcile. 

Click Lock. 

Click OK. 

Padlock will show month is locked. 
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Manage Links 
Displays list of data links 

 
Add a Link. 

 
Select transaction type, Money In/Out 
Select Allocation Column, New column can be added if required. 

Enter linking text, View bank feed description if required. 

Tick check box if you want linking data added as a Customer/Supplier. 

Click Save. 

Modify a Link 

 
Select record and click Modify. 

Make required changes. 

Click Save. 

Delete a Link 

Select record to be removed. 

Click Delete. 

Refresh Feed 
Checks for any new records not previously downloaded. 
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Connect Accounts 
Connects to bank to add new accounts. 

Can connect to another bank to add new accounts. 

 

• Click the icon for your bank or search if it is not listed. 

• Enter your internet banking login details and click Submit. 

• This will list all your available bank accounts. This may take a minute or two. 

• After checking bank account list click OK at the bottom of the screen. 

• Click OK on the prompt to link bank accounts in cashflow. 

• For each account in cashflow manager select a bank feed account from the drop-down list to link accounts. 

• Click Save and then OK. 
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Reports – Cashflow Manager 

Reports and the GST 

If you are registered for GST, then the GST Input Tax that you pay and claim as an Input 

Tax Credit cannot be claimed as a tax deduction. Similarly, you do not pay income tax on 

the GST collected. 

The Tax Office GST Worksheet and Business Activity Statement were designed to report 

gross amounts including GST. Your GST is determined by dividing the net result by 12. 

However, for income tax purposes (and general accounting purposes) GST is not included. 

Cashflow Manager is designed to do this automatically through its unique column format 

and GST Tax Types allocated to the columns. This means that when entering your 

information, you can simply allocate the gross amount to the column, and your reports 

will calculate the correct balances. 

 

Report Options – Cashflow Manager 

Once a report is selected, there are options to select different parameters for the generation 

of the report. Different reports have different options such as the ability to select accounts, 

a date range or specific type of report. 
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The Choice of Reports table includes a column showing the different Report Options. 

These are: 

A – Account selection. Choose either All Accounts, Current Account or Select Accounts 

(brings up a list of all accounts to select from). 

C- Custom Date Only. Report relates to a specific period and the only option is to select 

a custom date. 

D – Date Period. Choose a report date range from Last Month, Last Quarter, Last 

Year, This Month, This Quarter, This Year or Custom (select report start and end 

periods where appropriate). 

E – Includes reports formatted especially for Microsoft Excel. 

F – Filter report. Report will show information based on filters e.g. Include Invoice 

Manager balances, Single or Multiple Columns etc. 

T – Type of printout. Choice of print layout or specific print media. 

 

Types of Reports – Cashflow Manager 

The following table summarises the reports available in Cashflow Manager. More 

information is included below for reports highlighted by an asterisk*. 
 

REPORT EXPLANATION Report 

Options 

Balance Sheet 

(Movement)* 

The value of the movement in each of the 

columns that relate to the Balance Sheet (i.e. 

not Profit & Loss) 

A, D, F,T 

Bank Reconciliation Compares your bank balance per your records 

and your bank statement and lists any 

outstanding deposits and cheques 

C, T 

BAS* Includes Payroll PAYG Information with GST 

Report for preparing your Business Activity 

Statement, and Simpler BAS option 

A, D, F,T 

Budget (Account) A month by month budget of your total Money 

In and Money Out for individual accounts 
C, F, T 

Budget (Business) A month by month budget of your total Money 

In and Money Out for the entire business 

C, F, T 

Cashflow Lists total Money In by column less total 

Money Out by column to calculate your net 

Money In or net Money Out 

A, D, T 

Cash Reconciliation Compares cash on hand per your records with 

actual cash on hand 

C, T 

Columns Listing A list of Money In and Money Out columns 

including Column Name, Tax Type, 

Accountant's Code, Profit & Loss Type 

A, T 

General Ledger 

Listing 

Lists the transactions for each Money In and 

Money Out column (in alphabetical order) 

A, D, F, T 

GST* Report on GST entries that match the Tax 

Office GST Calculation Worksheet 

A, D, F, T 
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Money In Record The Money In Record as it appears on your 

screen. This is a Send to Excel Only Report 
A, D, E 

Money Out Record The Money Out Record with Columns and 

Totals as they appear on your screen. This is a 

Send to Excel Only Report 

A, D, E 

Monthly Summary A month by month picture of your total Money 

In and Money Out 

A, C, E, T 

Profit and Loss* Lists P&L Money In column total less P&L 

Money Out column totals to calculate your net 

profit or loss 

A, D, T 

Transaction Listing List of every transaction entered in your Money 

In and Money Out sections. Money In is 

followed by Money Out and printed in date 

order. This report can also be filtered to just 

show transactions that have had the GST 

altered. 

A, D, F, T 

Trial Balance Totals of each column in your Money In and 

Money Out Records together with the total 

movement in your Bank and Cash on Hand 

A, D, T 

 

 

Balance Sheet (Movement) 

NOTE: Cashflow Manager is not a ‘double entry’ general ledger program that retains 

opening balances. Nor does it classify columns as Assets, Liabilities or Equity. Therefore, 

a Balance Sheet Report is not possible. 

However, the Balance Sheet (Movement) Report will report the value of the movement in 

each of the columns that relate to the Balance Sheet. These cash 'movements' can be 

added to the Opening Balance to create the Balance Sheet. 

The Balance Sheet will list Money In, followed by Money Out, then Bank, Cash on Hand 

and finally the amount of Profit or Loss. 

You will also have the option to include the Invoice balances of Opening and Closing 

Debtors or Opening and Closing Debtors and Creditors if you are using Cashflow 

Manager GOLD. 

This report will be useful to your accountant when preparing your financial statements. 

BAS 

The BAS Report includes the information in the GST Report together with the PAYG 

information from Wages for preparing your Business Activity Statement. 

If you use Cashflow Manager GOLD and your Wages reporting dates differ from your 

GST reporting dates, you can select the dates that apply for each section. 

An [Adjustments] button is included in the Report Options. Click on the button to record 

the GST inclusive totals of any Adjustments. There are three rows - for increasing, 

decreasing and private use adjustments. The row you use will allocate the adjustments to 

the appropriate box on the GST Report. 

If you lodge your BAS on the Accruals (non-Cash) basis you can also include Invoice 

balances of Opening and Closing Debtors and Creditors. 
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If you are registered with the Tax Office, you can also lodge your BAS online using the 

Tax Office portal or using the new Standard Business Reporting Lodgment system. Click 

on the button for the option you wish to use. (See more information below.) 

Cashflow (Previously called Statement of Receipts and Payments) 

Lists your total Money In and Money Out by the column titles you have in your Money In 

and Money Out Records (in alphabetical order). The total Money Out is deducted from 

total Money In to calculate your net Money In or net Money Out. 

If the amount is positive, then your Money In has exceeded your Money Out for the 

period and you have a positive cash flow. However, if the amount is negative then your 

Money Out has exceeded your Money In and you may be heading for a cash flow problem 

if you do not already have one. 

GST Report 

The Tax Office has produced a GST Calculation Worksheet with 20 boxes that, if 

completed correctly, will determine your GST Liability and your Input Tax Credits. 

The GST Report in Cashflow Manager matches the Tax Office GST Calculation 

Worksheet. If you have set up the GST types on your columns correctly, the program will 

calculate all the information except the amount of any adjustments. 

An [Adjustments] button is included in the Report Options. Click on the button to record 

the GST inclusive totals of any Adjustments. There are three rows - for increasing, 

decreasing and private use adjustments. The row you use will allocate the adjustments to 

the appropriate box on the GST Report. 

Increasing adjustments are those that either increase your GST payable or decrease your 

entitlement to input tax credits. For example, if the amount for a sale has increased and 

you have included the lower amount at G1 on your Business Activity Statement (current 

or previous). 

Decreasing adjustments either decrease your GST payable or increase your entitlement to 

input tax credits. Examples are cancellation of a sale, discounts given for early payment, 

bad debts that have previously been included at G1 etc. 

The Tax Office has instructed that if your increasing adjustments exceed your decreasing 

adjustments then you include the net amount as an increasing adjustment. On the other 

hand, if your decreasing adjustments exceed your increasing adjustments then you include 

the net amount as a decreasing adjustment. You do not use both boxes. 

Private Use adjustments relate to purchases where you are not entitled to input tax credits 

because they are either used for private or domestic purposes; or are not tax deductible for 

income tax purposes. 

For example, if your log book indicates that your motor vehicle has 30% private use, then 

you would include 30% of your motor vehicle expenses (including GST) in box G15. 

Please note that your adjustments must be GST Inclusive. 

For more information on adjustments, refer to the Tax Office Business Activity Statement 

Instructions, which also provide several worksheets that you can use in your calculations. 

Profit and Loss 

Lists Profit and Loss Money In column totals less Profit and Loss Money Out column 

totals to calculate your net profit or loss. 

You can print this as a ‘cash’ report or you can choose to include Invoice Manager totals 

if you use Cashflow Manager GOLD. 

Trial Balance 
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Lists the totals of each column in your Money In and Money Out Records together with 

the totals of your Bank and Cash on Hand amounts. Money In and Money Out columns 

are printed in alphabetical order. 

You also have the option to include Invoice Manager balances. 

This is an accounting check on your entries to ensure they balance in accordance with 

accounting principles. Therefore, this report will be useful for your accountant. 

Note: Cashflow Manager is not a general ledger program that reports opening and closing 

balances of accounts. The totals reported in the trial balance, including the bank and cash 

on hand accounts, reflect the transactions for the period selected and not the balances of 

accounts. 

Note also that it is possible for the Debit and Credit columns of your Trial Balance to 

differ by a few cents. This is not an error in your records. Rather it is due to the ‘rounding’ 

of the GST when calculating 1/11th of the column values. 

 

Lodge BAS Online 

The BAS and GST Reports include the option to Lodge Online. 

When you click on the [Lodge Online] button, the BAS information is updated ready to 

process through the ATO Business Portal. 

To use this, you must first have registered for this option with the Australian Taxation 

Office. 

A file is saved in the eAS subfolder of Cashflow Manager i.e. 

C:\Users\Username\AppData\Roaming\CFM\Cashflow14\eAS. 

When you go into the ATO Business Portal, the amounts from your GST Report should 

automatically appear in the GST section of the BAS 

(Please note that the Cashflow Manager Support Team will not be able to assist you with 

the Tax Office Business Portal process.) 

 

Lodge BAS via Standard Business Reporting 

The BAS and GST Reports include the option to Lodge via SBR. 

When you click on the [Lodge via SBR] button, the BAS information is updated ready to 

process through the new ATO Standard Business Reporting. 

To use this, you must first have registered for this option with the Australian Taxation 

Office and connected to the Internet. 

Select the dates for your BAS and then click on the [Lodge by SBR] button. 

The SBR Settings page will open. 

The first time you use this you will need to create the settings. Your Lodgement Details 

and MyGovID Credentials will be information supplied from the Tax Office when you 

registered for Standard Business Reporting. 

The ‘Keystore’ or ‘MyGovID’ is a file supplied by the ATO, needs to be saved on 

your computer and selected in the setup process. 

The Payer Information is for your business. The Intermediary Information relates to any 

intermediary such as your accountant who lodges this information on your behalf. 

When you have completed this information, click on [Next]. 
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Note: This information will automatically appear when you next open this section. 

However, you will need to type in the ‘Keystore or MyGovID’ Password’ supplied to you 

by the ATO each time you use the SBR lodgement. 

When you click on [Next] the program sends a request to the ATO for any forms that 

apply to that period. If there is only one form outstanding, this will open in the next 

window. If there is more than one form outstanding, they will be listed, and you will need 

to select the form you wish to complete and click on the [Prefill Form] button. 

The form is prefilled on the left side with information from Cashflow Manager in relation 

to the BAS Report as well as other information from the ATO. 

Fields that can be edited are highlighted in blue. 

The GST Reporting field has a 0 that needs to be changed to a 1 or 2, depending on 

information from the ATO. 

Once you have completed the form, click on [Pre-lodge] to have the ATO check your 

form, or [Lodge] to lodge your form. 

 

 

 

Budget 

Version 14 allows you to create Account-based & Business-based budgets. 

This means you can produce budgets for specific Cashflow “accounts”, or for the entire 

“business”. 

Both the ACCOUNT and BUSINESS BUDGETS can be accessed via the Side Panel. 

 

 

Account-based Budget 

How do I create, save and delete an Account Budget? 

In Cashflow Manager you can create a budget which is based on the estimation on the 

total income and expenses for each month. 

To create and save a new Account Budget: 

1. Click on the ACCOUNT BUDGET tab on the Side Panel. 

2. Use the ACCOUNT-selector at the top of the screen to ensure you are in the 

correct account. 
3. Click on the NEW tab – a “New Budget” window will appear 

4. Type in a name for your new budget. Please note: only letters and numbers can be 

used. 
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5. If you have not entered any data into Cashflow, and just want to obtain a budget 

set up first, choose “No Initial Data”, and then click [OK]. 

6. Your budget will appear ready for the months of the Financial Year and categories 

to be filled in. The amounts can only be entered in full dollar amounts. 

7. To the far right it will total the entire ‘Allocation Columns’. Down the bottom of 

the budget it will give you your monthly totals. 
8. Click the [Save] button towards the bottom of the budget screen. 

 

To delete an Account Budget: 

If you need to delete a budget, ensure that you have the correct budget name in the 

BUDGET-selector at the top of the screen. 

Click the [Delete] button at the bottom of the screen. 

Select the budget you wish to delete from the drop-down list and click [OK]. 

 

How do I increase the estimated figures in the Account Budget? 

If you have loaded historical data to help create your budget, you may wish to increase 

your totals by a set percentage for inflation. In fact, you can also use this option to 

increase the whole budget, a time-period or a selected column by an amount. 

To do this: 

1. When in your budget, click on the [Increase] button at the bottom of the screen. 

2. A "Percentage Increase" box will appear. This will then allow you to increase to 

*Dollar* Value or *Percentage* Value, for a specific time-period, or allocation 

column. 

3. Click on the [OK] button to apply the increase. 

 

How do I save the Account Budget as a CSV file? 

1. While in the Budget, click on the [Save As..] button at the bottom of the screen 

2. In the bottom, left corner where it says, "File name", be sure to type in a name for 

the Budget that you have just created 
3. Navigate to the location you wish to save your budget [e.g. Desktop] 

4. Click on the [Save] button in the bottom right corner and you can also see that this 

will then save your Budget as a csv file. 

 

How do I print my Account Budget? 

1. Click on the Cashflow REPORTS tab on the Side Panel. 

2. Double left click on the BUDGET (ACCOUNT) report 
 

 

3. You can then select the month and year of the Budget and the Budget you would 

like to print 

4. On the bottom right hand corner, you can either chose to click on [Preview] or 

[Print] your Budget. 

5. The report will display the type and name of the budget 
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Account Budget Comparison – comparing your Actual Cashflow to the Account 

Budget 

Comparing actual results with your account budget each month highlights the differences 

between your budget and your performance. This enables you to examine the reasons for 

the differences and to act on the reasons to improve future performance. 

1. When in your budget, click on the [Comparison] button at the bottom of the 

screen. 
2. Select the period you want to compare using the options at the top of the screen. 

3. Click on [Compare]. 

4. Type in any comments or action required. 

5. Click on the [Print] button to print or email your comparison. You can also export 

your comparison by clicking on [Export] to create a comma separated value 

delimited text file that can be opened in programs such as Microsoft Excel. 
6. Click on [OK] when you have finished. 

 

How do I save the Budget Comparison as a CSV file? 

1. While in the Budget, click on the [Comparison] button at the bottom of the screen 

2. Then click on the [Save As..] button at the bottom of the screen 

3. In the bottom, left corner where it says, "File name", be sure to type in a name for 

the Budget Comparison you have created 

4. Navigate to the location that you would like to save your Comparison [e.g. 

Desktop] 

5. Click on the [Save] button in the bottom right corner. The Comparison will then 

be saved as a csv file. 

 

Business-based Budget 

How do I create, save and delete a Business Budget? 

In Cashflow Manager you can create a budget which is based on the estimation on the 

total income and expenses for each month. 

To create and save a new Business Budget: 

1. Click on the BUSINESS BUDGET tab on the Side Panel. 

2. Click on the NEW tab – a “New Budget” window will appear 

3. Type in a name for your new budget. Please note: only letters and numbers can be 

used. 

4. If you have not entered any data into Cashflow, and just want to obtain a budget 

set up first, choose “No Initial Data”, and then click [OK]. 

5. Your budget will appear ready for the months of the Financial Year and categories 

to be filled in. The amounts can only be entered in full dollar amounts. 

6. To the far right it will total the entire ‘Allocation Columns’. Down the bottom of 

the budget it will give you your monthly totals. 
7. Click the [Save] button towards the bottom of the budget screen. 

 

To delete a Business Budget: 

If you need to delete a budget, ensure that you have the correct budget name in the 

BUDGET-selector at the top of the screen. 

Click the [Delete] button at the bottom of the screen. 

Select the budget you wish to delete from the drop-down list and click [OK]. 
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How do I increase the estimated figures in the Business Budget? 

If you have loaded historical data to help create your budget, you may wish to increase 

your totals by a set percentage for inflation. In fact, you can also use this option to 

increase the whole budget, a time-period or a selected column by an amount. 

To do this: 

1. When in your budget, click on the [Increase] button at the bottom of the screen. 

2. A "Percentage Increase" box will appear. This will then allow you to increase to 

*Dollar* Value or *Percentage* Value, for a specific time-period, or allocation 

column. 

3. Click on the [OK] button to apply the increase. 

 

How do I save the Business Budget as a CSV file? 

1. While in the Budget, click on the [Save As..] button at the bottom of the screen 

2. In the bottom, left corner where it says, "File name", be sure to type in a name for 

the Budget that you have just created 
3. Navigate to the location you wish to save your budget [e.g. Desktop] 

4. Click on the [Save] button in the bottom right corner and you can also see that this 

will then save your Budget as a csv file. 

 

How do I print my Business Budget? 

1. Click on the Cashflow REPORTS tab on the Side Panel. 

2. Double left click on the BUDGET (BUSINESS) report 
 

 

 

3. You can then select the month and year of the Budget and the Budget you would 

like to print 

4. On the bottom right hand corner, you can either chose to click on [Preview] or 

[Print] your Budget. 

5. The report will display the type and name of the budget 
 

 

 

 

 

 

 

 

Business Budget Comparison – comparing your Actual Cashflow to the Business 

Budget 
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Comparing actual results with your business budget each month highlights the differences 

between your budget and your performance. This enables you to examine the reasons for 

the differences and to act on the reasons to improve future performance. 

1. When in your budget, click on the [Comparison] button at the bottom of the 

screen. 
2. Select the period you want to compare using the options at the top of the screen. 
3. Click on [Compare]. 

4. Type in any comments or action required. 

5. Click on the [Print] button to print or email your comparison. You can also export 

your comparison by clicking on [Export] to create a comma separated value 

delimited text file that can be opened in programs such as Microsoft Excel. 
6. Click on [OK] when you have finished. 

 

How do I save the Budget Comparison as a CSV file? 

1. While in the Budget, click on the [Comparison] button at the bottom of the screen 

2. Then click on the [Save As..] button at the bottom of the screen 

3. In the bottom, left corner where it says, "File name", be sure to type in a name for 

the Budget Comparison you have created 

4. Navigate to the location that you would like to save your Comparison [e.g. 

Desktop] 

5. Click on the [Save] button in the bottom right corner. The Comparison will then 

be saved as a csv file. 

 

 

Helpful Hints to Create a Budget 

❖ Use the Enter, Tab and arrow keys to move around the screen. 

❖ Remember to estimate when you are likely to receive payment where goods are sold 

on credit. Don't forget receipts from loans, sales of plant and your own money. 

❖ Some Money Out such as rent and loan repayments may be the same each month. 

Others, such as Stock Purchases, will vary with the expected level of sales. Other 

payments, such as equipment replacements will vary for other reasons. 

❖ Be realistic - sometimes it is valid to take last year's amount but often it is not. 

❖ Remember that holiday pay means a big payment followed by a reduction in wages 

for the next few weeks. 

❖ Don't forget that some payments such as insurance and income tax only occur 

occasionally, or commitments recently entered or planned. 

❖ REMEMBER - you are looking at when the payment will be made, not when you 

receive the bill. 

❖ If you have an amount that will repeat, type the amount in the first month and click on 

the amount to highlight it. Then right click on the amount and select ‘Copy’. Right 

click on the next cell and select ‘Paste’ to paste the amount into that cell. 
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Tips and Tricks 

Cancelling or Amending Cheques for a Previous 
Month 

Going back and amending the original transaction in past months that have been 

reconciled can cause problems with your Bank Reconciliations. 

To cancel a cheque, enter the same cheque details in the current month but with a negative 

amount. When you process your Bank Reconciliation, the same cheque number will 

appear twice, one with a positive amount and the other with a negative amount. Click 

them both as if they have been presented. 

To adjust the amount of a cheque, make the adjustment in the current month. If the cheque 

amount is more than your records show, the adjustment will be positive, but if it is less, 

the adjustment will be negative. Click both amounts off in the Bank Reconciliation. 

 

Duplicate an Account. 

You can quickly and easily create new accounts with the same columns by duplicating an 

account that you have already customised. 

1. Open the account you wish to duplicate from the Dashboard. 

2. Click on the Options icon. 

3. Click on Duplicate Account. 

4. Enter the name of the new account in the white box that appears. Click on [Save]. A 

new account with the same column headings but no data will be created. 

 

Lock and Unlock your Records 

Once you have completed your Bank Reconciliation for the month, your records will be 

locked. This is to protect you from accidental changes that will not only affect that 

month's reconciliation, but also any reconciliation you have completed for future months. 

The reconciled bank balance carries forward from month to month. Also, deposits and 

cheques that were outstanding at the end of a month may have subsequently appeared on 

your Bank Statement and are no longer recognised as outstanding. 

Consequently, if you make a change to an earlier month you can create yourself a disaster 

and must complete your reconciliation again. Provided you have reconciled correctly, the 

only time you should need to make a change is when you have entered an amount into an 

incorrect column and you want to move it to another column. 

However, extreme care is required to ensure that you do not alter anything affecting your 

Bank Reconciliation. (If you have already transferred information to your Accountant you 

should only make changes advised by your Accountant.) 

To unlock a month, you must first click on the Bank Reconciliation tab. Now click on the 

[Unlock] button. Your Money In and Money Out Records will also be unlocked. 

You can now make the changes you wish. To lock it again, return to the Bank 

Reconciliation. If you have not made any changes that affect the reconciliation, the 

[Finish] button will be displayed, and you can click on that button followed by the [Lock] 

button. If the [Next] button is displayed, you will need to go through the Bank 

Reconciliation process again. 
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Providing Information to your Accountant 

There are four ways to transfer information to your accountant. 

 

1. Printed Reports 

Your accountant may want you to provide printed reports. If so, print them and provide a 

copy. You can also save reports in a PDF for to give them electronic ‘printed’ reports. 

 

2. A Complete Backup of your File 

Most accountants who have Cashflow Manager on their computers would prefer to get a 

backup of your file as it allows them to review your work in Cashflow Manager before 

transferring the information into their general ledger programs. 

The simplest way to accomplish this is to send a backup file to your accountant. 

However, if your accountant is going to send you back any changes to incorporate into 

your file, anything you have done since creating the backup file you sent to the 

accountant, including transactions recorded in the invoice and wages sections of the 

program, will be lost. The program has a feature that enables you to export information 

from your Cashflow Manager accounts to your accountant, continue working and then 

import the data back into your file when the accountant sends it back to you – see below. 

 

3. Export Cashflow Manager Accounts to and 
Import Accounts from Your Accountant 

Cashflow Manager Version 14 has a feature that enables you to: 

1. Export Cashflow Manager data to your accountant 

2. Continue working in your program, and then 

3. Import Cashflow Manager data received back from your accountant. 

Prior to version 8, when you sent your file to the accountant you either needed to delay 

doing any other work, or manually make any changes advised by your accountant. But 

now you can send your data to the accountant, continue working in the program, and 

import any changes from your accountant back into the program. 

Another excellent feature is that you can just export the data for a selected period instead 

of the whole file. 

 

 

3a. Export Cashflow Manager Data TO Your Accountant 

1. Click on the File menu. 

2. Click on ‘Accountant Export’ 

3. Click on ‘Export to Accountant’ 

4. Select the account(s) you wish to export. ‘All Accounts’ is the default selection, but 

you can change this to Current Account you are working in, or you can click on 

‘Select Accounts’ and choose the accounts to be included. 

5. Choose the starting month and year, and the ending month and year for the data you 

wish to be included by clicking on the up and down arrows. 
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6. We are now ready to select the Export File Name. 

a. Click on Browse. 

b. The Windows ‘Save As’ window will appear, so you can choose a location 

and file name for the export file. 

c. The default location for the file to be saved is the 

C:\Users\Username\AppData\Roaming\CFM\Cashflow14\Data folder. 

d. The default file name is the name of your current business file with 

information about the dates you are exporting. For example, if my current file 

name is Sample and I am exporting from January 2014 to March 2014, the file 

name for the export file will be Sample Jan2014-Mar2014. 

e. The file will be saved as an Accountant Export File with an .e14 extension. 

f. The months will be locked for each of the accounts included in the export, so 

you do not make any unwanted changes. A red padlock will appear next to the 

account name in your Cashflow Manager work area to indicate that the month 

is locked. (See ‘Unlock Months Exported to Accountant’) 

7. If you wish to email the file to your accountant, click so a tick appears in the 

checkbox for ‘Email File When Export Complete’. 

8. Click on the [Export] button. The program will now create the file. 

If you select ‘Email File When Export Complete’ the ‘Email Document’ window will 

appear. 

1. Type in your accountant’s email address in ‘Send To:’ (or select the address by 

selecting from ‘Show Contact Emails’. 

2. Type in a Subject for the email e.g. Cashflow Manager Files 

3. Type in any additional text for the email. 

4. Click on the [Send] button. 

Note: you can also add attachments such as PDF copies of your reports by clicking on the 

‘Add Attachment’ button. 

 

 

3.b. Import Files Returned FROM Your Accountant 

3.b.1. Selecting the File 
 

Important: Please back up your file before importing files from your accountant. 

Note: If your accountant emails your file to you, you will need to right click on the file in 

your email, select ‘Save As’ and save the file to a location on your computer before 

completing the following steps. 

1. Open your Cashflow Manager program and the normal business file. 

2. Click on the File menu when in the Cashflow section. 

3. Click on ‘Accountant Export’ 

4. Click on ‘Import from Accountant’ 

5. Click on the [Browse] button for the Import File Path. 

6. Navigate to the location of the file that your accountant returned to you and select the 

file. 

Note: The file name will generally be the same as the file you sent to the accountant but 

will have the addition of the date that the accountant created the file to return to you. 
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For example, if the export file you sent to the accountant was Sample Jan2014- 

Mar2014.e14, the file that you receive back from the accountant will generally be Sample 

Jan2014-Mar2014_20140430.e14 if the accountant created the file on the 30th April 2014 

(The dates are in YYYYMMDD order so they appear chronologically when your files are 

sorted in ‘name’ order.) 

 

3.b.2. Importing the Data 

Once you have selected the file, the information in that file will display in a table with 

columns as follows: 

• ‘Account Name’: the Cashflow Manager account name 

• ‘Month’ and ‘Year’: each month that has data in it will be listed separately. 

• ‘Bank Rec. This File’: advises whether the Bank Reconciliation in the current file 

(before import) is locked or unlocked. 

• ‘Bank Rec. Import File’: advises whether the Bank Reconciliation in the file being 

imported is locked or unlocked. 

• ‘Locked State’: advises whether the month in the current file (before import) is locked 

because it was exported to the accountant, or whether it has subsequently been 

unlocked. 

• ‘Action’: the action that will occur when the [Import] button is activated. 

o ‘Replace’: replaces all the existing month’s data and bank reconciliation 
information with the data in the accountant’s file. 

o ‘Merge’: merges the existing month’s data with the data in the accountant’s file 
(import file). 

▪ Each receipt and payment transaction in the import file is compared to the 

existing file. 

▪ If it is a ‘full match’, the existing transaction is not changed. 

A ‘Full Match’ is when all fields for both records are equal. 

▪ If it is a ‘partial match’, the existing transaction will be replaced by the 
transaction in the import file. 

A ‘Partial Match’ is when 

• Dates and Receipt Totals are equal, or 

• Dates, Customers and Details are equal, or 

• Dates and Total Bank/Cash Payments are equal or 

• Dates, Suppliers and Details are equal. 

▪ If there is ‘no match’ the transaction from the import file is added to the 
existing file. 

No match is when there is neither a full match nor a partial match. 

WARNING: The ‘Merge’ option is not recommended because any bank 

reconciliations that have previously been processed will be lost and will need 

to be done again. However, it is an option if you have added transactions to 

that month after you exported to your accountant. 

o ‘Ignore’: ignores the data in the accountant’s file. 

 

1. Review the information on each line (for each separate month for each account) and 

select the action to be taken. 
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a. The default action is ‘Replace’ which will replace your existing data with the 

data in the file sent to you by the accountant. 

b. If your accountant advises they have only made changes to one or two 

months, you can select ‘Ignore’ for all other months to reduce the time it takes 

to do the import. Alternatively, you can simply choose to ‘Replace’ all 

months if you have not made any changes since you sent the file to the 

accountant. 

c. If you have unlocked and made any changes to transactions in a month sent to 

the accountant, the ‘Merge’ option is available. However, this should only be 

used with great care, as any bank reconciliations that have previously been 

processed will be lost and will need to be done again. 

2. When you are ready to proceed, click on the [Import] button. A message will appear 

to confirm you wish to proceed. Click on [Yes] and the import will take place. 

Once the import is completed: 

1. The file will be reloaded, 

2. the ‘Export Lock Icon’ will have disappeared on any months imported, 

3. and you can check the information. 

 

 

3.c. Unlock Months Exported to Your Accountant 

If you have exported information to your accountant, you can unlock months that have 

been exported if you need to make some changes for some reason. 

Note: Extreme care is needed in making changes to the information sent to your 

accountants, particularly if they are unaware of the changes you are making. If you 

subsequently receive adjusted files back from your accountants you will lose the changes 

you have made unless you use the ‘Merge’ import option, and in that case, you will need 

to redo your bank reconciliations. 

To unlock months exported to your accountant: 

1. Click on the File menu. 

2. Click on ‘Accountant Export’ 

3. Click on ‘Unlock Months’ 

4. Click in the ‘Unlock’ check box for any months you wish to unlock. 

5. Click on the [Unlock] button. 

6. A message will ask you to confirm that you wish to do this. Click on [Yes]. 

7. The ‘Export Lock Icon’ will be removed, and you can process the month as normal. 

 

4. Export to Accountant’s General Ledger 

You can also export to a file that your accountant's general ledger program can read as 

Cashflow Manager has automatic export routines for most software packages used by 

accounting firms. You will need to find out the general ledger package that your 

accountants’ use and the account code number for each of your columns. 

If you have not previously established the export format used by your accountants, click 

on the Options icon at the top of the screen and select Accountant’s General Ledger 

Format. Select the name of your accountant's general ledger system from the drop-down 

list and record your accountant's code for your Bank Account and Cash on Hand account. 
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To export: 

1. Print a Trial Balance Report and check that the accountant's codes are the same as 

those advised by your accountant. If you need to change any codes, refer to the 

instructions on ‘Customising your Columns’. 

2. When you have checked these details, and made any required changes, select Export 

from the File menu. 

3. Select the From and To dates for the data you wish to export. 

Extreme care needs to be taken to avoid either missing transactions or duplicating 

transactions that have already been supplied to your accountants. Only export when a 

month has been reconciled and locked, and then select the beginning date and ending 

date of the month. 

4. Click on the [Browse] button for Destination File Name. 

5. Select a location and type a file name for your export file. If you export a monthly file, 

identify the export file for each month separately. By giving each file a unique name, 

you have protection if something is wrong with the information in a file. 

6. Click on the [Save] button. This will return you to the export window and the 

destination will now appear in the Destination Filename box. 

7. Click on [Export]. Your export file will be created for you to send to your accountant 

and a message will advise when the export is complete. 

 

Information for Accountants When Clients Export 
Cashflow Manager Accounts 

1. Restoring the Client’s Exported File 

1. Open your Cashflow Manager program and click on the ‘Restore’ icon. 

2. Click on the [Browse] button for ‘Restore Source’ and navigate to the location where 

the client export file is located. 

3. Click on the File Type button to change the file type from ‘Backup Files (*.b14)’ to 

‘Accountant Export Files (*.e14)’ 

4. The “Restore Destination Path” will automatically pre-fill and default to the Cashflow 

14 Data Folder. 

5. If you wish to change the “Restore Destination Path”, click on the CHANGE tab, and 

navigate to the location where the file is to be saved. 

Note: You can change the name of the file if you wish, but the file will have a normal 

Cashflow Manager (.c14) file type so be careful not to duplicate the name with any 

other files. 

6. Click on [Restore]. 

The file will now open as a normal Cashflow Manager file although only the 

relevant Cashflow Manager sections will be active. 

You can now make any changes that are required including processing any Bank 

Reconciliations that are required. 

 

2. Backing up the File for Return to the Client 

1. Click on the ‘Backup’ icon on your toolbar. 

a. The Backup File Name will auto-fill. 
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b. The date (in format YYYYMMDD) will be added to the Backup File Name 

so it is easy to identify the correct file. 

c. The Backup File Type is e14 to indicate it is an Accountant Export backup 

file. 

2.  If you wish to email the file to your client, click so a tick appears in the checkbox for 

‘Email File When Export Complete’. 

3. Click on the [Backup] button. 

The backup file will now be created ready to send to the client. 

 

Import an Account from another Cashflow Manager 
File 

You can transfer an account in one Cashflow Manager file to another. For example, if you 

create an account and record transactions in a business file and then realise it is the wrong 

business, you can use this process to transfer the account into the correct business file. 

Step 1: Export the data from the first file by following the ‘Export Cashflow Manager 

Data TO Your Accountant’ instructions. If you wish to transfer the complete account, 

choose all months where data is recorded. Save the ‘export file’. 

Step 2: Import the data into the second file by following the ‘Import Files Returned 

FROM Your Accountant’ instructions. 

 

Examples where the Export/Import Feature Can Be 
Used 

The most obvious example is in sending information to your accountants and being able to 

continue working in the rest of the file while they are reviewing the information. 

Another example may be where one person processes the wages and another process the 

Cashflow Manager transactions. You can export from the ‘Cashflow Manager’ file and 

import into the ‘Wages’ file to combine the information. (Note: Please ensure that you are 

not breaching your Cashflow Manager license in this practice. If you have your Cashflow 

Manager program installed on more than one computer, you may be in breach of the 

license. See the license agreement for more details.) 

A further example we have seen is where two partners would like to keep their own 

accounts and then merge them together which is now possible with this feature. 

 

What Changes Can Be Made and Imported Back into 
the File 

Probably the most frequent changes that accountants need to make are correcting 

allocations to ensure they are in the right column. But other changes can also be made, 

such as: 

1. Add a New Account: However, there must be at least one transaction in the file. 

2. Add a New Column 

3. Add Transactions 

4. Delete Transactions 

5. Bank Reconciliations can be processed and locked 
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6. Move Columns 

 

Rename an Account or Business File Name 

1. Click on the Options icon: 

2. Click on Rename Account & Business File. 

3. The Current Account Name and Current Business File Name will be displayed. Type 

the new name and click on [Save]. 



111  

Troubleshooting 
 

Problem Potential Solution 

Program jumps to the end of the 

section instead of typing a number. 

Check the 'Number Lock' on your keyboard is 

switched on. 

Unable to enter a date in Day 

column. 

Check the 'Number Lock' on your keyboard is 

switched on. 

Unable to edit information in Money 

In or Money Out. 

Is there a padlock at the top of the section? This 

means your records are locked. Unlock your 

records to make the changes. (Click on the 

padlock in the Bank Reconciliation section). 

Money Out transactions are missing 

from My Records section in the 

Bank Reconciliation. 

Open Money Out section. Check that missing 

payments are not in the Total Cash Payments 

column. If so, arrow to the total and press your 

'Delete' key. Arrow back to Total Bank 

Payments column and press 'Enter'. 

Don't know whether backup has 

worked. 

Use Windows Explorer to navigate to the 

location you selected for the backup. Ensure that 

your backup file (filename.b14) is there. Backup 

regularly to more than one drive. 

Printing a report and print preview 
screen displays a blank page or 
words are overlapping. 

Check the printer settings are set as A4 (i.e. 

paper size) and portrait (i.e. orientation). 
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 Invoice Manager Version 14  
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Invoice Manager 

Getting Started 

Introduction to Invoice Manager 

Controlling money owed is one of the most vital parts of business. There is an old saying that 

goes “The sale is not made until the money’s in the bank”. 

From a legal viewpoint, this saying is not true. The sale is made when you provide the goods or 

services and the customer incurs the liability to pay. So, while your profit or loss can include 

sales made on credit, your cash flow can be severely affected if you are not collecting the money 

owed to you for goods or services provided on credit. 

You must have procedures in place to ensure that they are collecting money owed to you and 

that you are collecting it as quickly as possible. Invoice Manager will help you to prepare your 

invoices and manage the money owed to you. 

It is very easy to use so that it becomes a valuable tool in running your business. However, while 

it will provide you with the information you need, it cannot collect the money for you. 

Many people dislike following up outstanding debts and therefore procrastinate in attending to 

this function. 

Bear in mind that you are providing interest free credit to your customers and many customers 

(particularly those in financial trouble) will use this facility for as long as you let them. We again 

emphasise that properly managing money owed to you is one of the most vital management roles 

in business. 

Invoice Manager has 4 sections: 

1. Creating sales invoices and managing money owed to you for sales on credit (your debtors). 

This section is included with Cashflow Manager. 

2. Creating purchase orders and managing money owed by you for purchases on credit. 

3. Tracking inventory on goods purchased and sold. 

4. Reports 

Sections 2 and 3 form part of Cashflow Manager GOLD. 

 

Open Invoice Manager 

To open Invoice Manager, click on Invoice on the Side Panel. 

 

Create a New Invoice Manager Account 

You will have already created your business file when you first started to use Cashflow 

Manager. If you have recorded, imported or rolled over any information into either the Cashflow 

or Wages sections please backup before creating your Invoice Manager account. 

When you first click on the Invoice tab, you will need to complete the information required for 

Invoice Manager. A Wizard will assist you to set up your Invoice Manager account. Each of the 

steps in the wizard will have instructions on what to do. 
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1. Business Details: Record your Business Name, ABN or WPN. Details already recorded in 

other areas of the program will automatically pre-fill and any changes will apply across the 

whole program. Click on [Next] to continue. 

2. Street Address: Record the street address of your business. Click on [Next] to continue. 

3. Postal Address: Record the postal address for your business. If the postal address is the 

same as your street address, tick the Use Street Address checkbox. Click on [Next] to 

continue. 

4. GST Calculation: When preparing sales invoices, GST can be added to your GST 

Exclusive Prices or calculated from GST Inclusive Prices. Select the method you wish to use 

and click on [Next] to continue. 

5. Congratulations: Click on [Next] to add the data you have just recorded to your Invoice 

account. The program will then open to the Customers page. 
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Menus - Invoice Manager 

At the top of the page, you will find the File, and Tools menus that provide you with functions 

to use from time to time. When you click on these menus, a drop-down menu will appear. 

Position your mouse pointer over the option you require and click to select it. 

The following is an overview of each menu item: 

File 
 

Create New Business File: Creates a new business file 

Open Existing Business 

File: 
Opens an existing business file 

Backup: Creates a backup of your file 

Restore: Restores a backup file 

Import: Imports customer, supplier or inventory data. 

Export: Export customer, supplier or inventory data. 

Password: Options to add, change or delete a password. Passwords can be 

set for each section. 

Exit: Exit the Program 

 

Tools (Customers) 
 

Purge Data Purge old transactions 

Search: Search for a transaction 

Invoice Setup Wizard The easy way to customise Invoice Layouts 

Customised Layouts Customise layouts – more technical than the Invoice Setup 

Wizard 

Change Decimal Points Change from 2 to 3 decimal points for invoice calculations 

Move Invoice to Another 

Customer (Supplier) 
Move an invoice from one customer (supplier) to another 

Remove Credit 

(Overpayment) 

Remove Credit and Overpayment amounts that have been 

applied to invoices 

Remove Money In 

(Money Out) Transaction 

Remove receipts (payments) that have been applied to 

invoices. 

Restore Default Column 

Widths 

Restore the column widths in work areas back to the default 

widths 

Unfinalise Invoice Unfinalise an invoice that has been previously finalised 

Jobs List: Create and manage jobs 

Email: 

Cheque Writer 

Electronic Payments 

Create an email 

Print individual or multiple cheques (appears if selected in 

Options) 

Create an Electronic Payments File for online banking 

(appears if selected in Options) 

Options: Refer to separate section on Options in Tips & Tricks – 

comprehensive options that can be used with your file 
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Icons – Invoice Manager 

See ‘Icons’ in ‘Functions Common to All Programs’. 

 

Options – Invoice Manager 

Each section of the program – Cashflow, Invoice and Wages has Options. Some are ‘global’ 

options and others are specific to the section you are in. 

To access the Invoice Manager Options, you need to be in the Invoice section of the program. 

Click on the Tools menu and select Options, or click on the Options icon on the tool bar: 

The following options are available: 

Address Details: Change the street or postal address. 

Advanced Preferences: The following options are available after selecting Advanced 

Preferences. 

Picking Slip Name: Change the name to print on Picking Slips (E.g. Packing Slip, 

Delivery Docket etc.) 

Customer: Change the title to match your business. For example, you might have 

clients, or patients. Personalise the program for your type of customers. 

Extra Column: If you require an extra column in your invoices, click in the 

checkbox for Show extra column on all forms and then type the name for the 

column. 

Other Preferences: Default Money In Transfers to Bank Deposits or Receipts Not 

Banked. 

Use Cheque Writer: Turns the Cheque Writing Option on and off. (This is a global 

option that will also affect Cashflow and Wages Manager). 

Use Electronic Payments: Turns the Electronic Payments Option on and off. (This 

is a global option that will also affect Cashflow and Wages Manager). 

Use Job Numbers: Turns the Job Number Option on and off. 
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Use Taxable Payments for Contractors: Turns the ‘Taxable Payments for 

Contractors’ reporting options on. 

Use Transfers: Turns the transfer function on and off. When the transfer function 

is on you can use this function to batch money received at the time of creating the 

invoice to transfer to Cashflow Manager. 

Business Details: Change the Business Name, ABN or WPN, and License Number. 

Cash Invoice Settings: Select the settings for transferring Cash Invoice receipts to 

Cashflow Manager. Select ‘Always’ to have cash transferred every time you create a cash 

invoice, ‘Never’ if you wish to use the ‘Transfers’ function or you also have the option to 

make the decision at the time by selecting ‘Ask me each time a Cash Invoice is Finalised’. 

There is also an option to generate a message to print the Receipt after the Cash Invoice is 

finalized. 

Contact Details: Change the phone numbers, fax number and email address. 

Currency Symbol: Change the currency symbol used in your business. 

Customer Types Settings: Select to use and record descriptions for multiple customer types 

with different selling prices. 

Customised Layouts: (This will only appear if you have customised layouts). Customise 

layouts for your Invoices, Adjustment Notes, Purchase Orders, Picking Slip, Receipts, 

Returns and Statements. One of the Customised Invoice Layouts can be selected to use as 

the layout for the Picking Slip. 

Grid Font Size: Increase the size of the font on your screen. 

Invoice Layout Settings: Select the default layout for your invoices and whether to include 

a remittance advice that also includes credit card options. You can also add your logo if this 

is the only customisation you require. 

Print Settings: Choose whether to use your pre-printed letterhead or print your company 

details. Also select margins and fonts for your invoices. 

Microsoft Word Settings: Set up templates to print invoices etc. using Word. 

Rename Business File: Change the file name. 

Tax Settings: Select the GST Rate and whether to calculate GST using Exclusive or 

Inclusive prices. 

 

Customer Types 

The program allows you to record different Customer Types that can have different prices e.g. 

Retail and Wholesale customers. Use Customer Type 1 for your most regular customer group. 

1. Click on the Options icon and select Customer Types. 

2. Click on the checkbox for Use Customer Types. 

3. Click on the checkbox for each customer type you wish to use and type a description e.g. 

‘wholesale’ into the Description box. 

4. Click on the [Save] button. 
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When adding or modifying a customer you can assign a Customer Type. This will appear when 

adding invoices and will default to the unit sale price for that Customer Type. 

 

Invoice Layouts 

The program includes standard layouts for your type of business (and you can choose whether to 

include your company details or print on your company's pre-printed letterheads) 

The standard layouts include: 

❖ General Invoice – Item Code Layout 

❖ General Invoice – No Item Code Layout 

❖ Service Invoice 

❖ Professional Invoice 

❖ Medical Layout 

You can view each of the invoice layout settings by clicking on the Options icon when you are 

in Invoice Manager. Then click on Invoice Layout Settings. Click on the [View] button next to 

Default Layout to view the selected layout. Click on the dropdown for the Default Layout, select 

an alternative layout and then click on the [View] button again to view the alternatives. 

You can customise your layouts if the standard layouts do not meet your needs. 

1. The ‘Invoice Setup Wizard’ is an easy way to customise your invoice layout. 

2. There is an option to ‘Customise your Layouts’ including invoices, statements, picking slips, 

purchase orders and more. This is a more flexible but complicated process than the ‘Invoice 

Setup Wizard’. If you need assistance, you can also call the CARE Support Team who can 

customise layouts for you. However, a fee is charged for this service. 

3. You can print some reports such as invoices to Microsoft® Word if you have Microsoft 

Word 2007 to 2016 installed. Select templates by clicking on the Options icon and then 

Microsoft Word Settings. Templates are in the folders specified. You can use these or 

create your own. If you create your own templates, click on the Browse button and browse to 

select your template files. More information is included in the section on ‘Printing with 

Microsoft Word’. 

Information regarding Standard Layouts and the Invoice Setup Wizard are included here. 

Information about ‘Customise Layouts’ and ‘Word’ are included under ‘Other Functions’ 

 

Standard Layouts 

To select a standard layout: 

1. Click on the Options icon and select Invoice Layout Settings. 

a. Click on the down arrow for Default Layout and select the layout you require. 

b. To include a Remittance Advice, click on the checkbox for Include Remittance Advice 

and Credit Card Options. 

c. You can upload your corporate logo by “browsing’ to a .bmp, .jpg or .gif file on your 

computer. For best results use a 339 x 154-pixel image. 

2. Click on the Options icon and select Print Settings 

a. Select whether to use your own pre-printed letterheads or to print your company details 

on your invoices. 

b. You can also change the type of font and font size you wish to use in your reports. To 

change the font, click on the Font down arrow to select one that is available on your 

system. 
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c. You can also adjust your margins. 

3. Click on [Save] when you have finished. 

Note: If you change your standard layout, the new layout will only apply to customers added 

after the change. To use the new layout with existing customers, select to Modify Customer and 

change the standard layout selection in the customer details. 

 

 

Invoice Layout Wizard 

The Standard Layouts are designed to meet most business’s needs. However, if you need to 

change your layout further, you also have that opportunity. 

Click on ‘Tools’ in the menu, and then ‘Invoice Setup Wizard’. This will open the wizard to 

customize your layout. 

Step 1 is the ‘Invoice Template Layout’. You can choose to create a new layout in which case 

you need to type in a name for the template or select an existing layout to modify. Click on 

[Next] to continue. 

Step 2: Now we can begin to change the layout by selecting what to include. In this step, we can 

edit Company Details, Invoice Details, Customer Postal Address, Customer Delivery Address, 

Invoice Line Details, Invoice Totals and Extra Fields. 

Simply click on the [Edit] button for the fields you wish to edit. This will open another window 

that enables you to select which fields you want to appear on your invoice. In some cases, there 

will also be the opportunity to change the label that appears on the invoice as well. 

When you edit the ‘Invoice Line Details’ you will also have the option to have lines printed 

around the data fields. 

When you have finished editing each section, click on [Save] which will save the changes and 

return you to the main ‘Customize Layout’ screen. 

You will see a [Preview] button at the bottom of the window that will give you a preview of the 

changes you have made. However, note that changes must be saved before they will display on 

the preview. 

When you have finished editing the fields and labels, click on the [Next] button. 

Step 3: Select whether you wish to include a remittance advice and then click on [Next]. If you 

answered ‘No’ go to step 9. 

Step 4: Select your company details that you wish to appear on the remittance advice and then 

click [Next]. 

Step 5: Select the Customer Details you wish to appear on the remittance advice and click on 

[Next]. 

Step 6: Select the invoice details you wish to appear on the remittance advice and click [Next]. 

Step 7: Select whether you wish to give your customers the opportunity to pay you by direct 

bank deposit (electronic funds transfer) and if so, type in your bank details. Click on [Next]. 

Step 8: Select whether you accept payment by credit card and setup the details. Click [Next]. 

Step 9 enables you to upload your logo. The recommended size is 339 x 154 pixels. However, if 

your logo is a different size the program will resize it for you. 

Click on [Save-Finish] to complete your customized logo. 

To use this layout, return to Options > Invoice Layout Settings and select your new layout as 

‘Layout in use’. Click on [Save]. 
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Sections (Tabs) in Invoice Manager 

There are four sub-sections of Invoice Manager. The Tabs are located under the main Program 

Tabs on the Side Panel. They are: Customers, Suppliers (GOLD only), Inventory and Reports. 

Each of these Tabs is outlined in sections of this user guide. 

 

Customers and Sales 

Note: Throughout this section we will refer to ‘Customers’. However, there is an option in 

‘Options’ to change that title if another such as ‘Clients’ or ‘Patients’ is more suitable. 

The Customers tab is located on the Side Panel. 

This consists of: 

Customer List: The Customer List is the main window of the Sales section of Invoice Manager 

and includes a list of your customers. 

The Customer List can be sorted by Customer Code, Company Name, Contact Name or Phone 

by clicking on the column heading at the top of the list. 

A triangle to the right of the column name will indicate the sort order of the column: an ‘up’ 

triangle indicates ascending order, and a ‘down’ triangle descending order. 

To quickly and easily search for an existing customer, sort by Company Name and then type the 

first letter of the Company Name. The closest match will be highlighted in the list. 

Function Buttons: To the right of the Customer List are buttons for the common functions 

undertaken in the program. These are divided into groups: Functions, Information and 

Customers. 

Each function button performs a different task in the program. They allow you to add or edit 

invoices, adjustment notes, apply receipts and credit amounts. To use a function, select a 

customer by clicking on their name, and then click the function button desired. 

For example, if you need to edit a customer’s details, select the customer in the Customer List by 

clicking their name, and then click on the [Modify Customer] button. 

 

Add, Modify or Manage a Customer 

To add a new customer, click the [Add Customer] button. 

Record the customer’s details, and make sure a unique Customer Code is included. You can 

‘Tab’ through the fields, or press ‘Enter’. 

Click on the [Save] button to save and exit, or [Save & New] to add another customer. 

To avoid retyping the same information if your shipping/delivery address is the same as the 

mailing address, tick the checkbox next to Use Company Address. 

There are four extra fields that can be used for any extra information you require for this 

customer. To enable these extra fields, click the [Extra Fields] button, and a new window will 

appear. Record the details you require and click [Save]. You can rename the title of these extra 

fields by positioning your mouse over the name and double clicking. A box will appear to 

change the title. 

Layouts: You can select a Default Layout for customer invoices and you can also select 

customised layouts for each customer. 

Once a customer is added, you can modify their details by selecting them from the list, then 

clicking the [Modify Customer] button. 
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To hide a customer, click on the [Manage Customer] button. Tick the checkbox, next to the 

customer, in the [Hide] column, and click [Save]. A customer can only be hidden from the list if 

there has been no activity for that customer in the last 12 months (i.e. created invoices, 

outstanding payments, etc.). 

NOTE: The Customer Code used by the deleted customer cannot be re-used. However, you can 

change the Customer Code in the customer’s details before deleting. 

 

Show a Hidden Customer 

If you have hidden a customer, they can be restored or shown. 

Click on the [Manage Customer] tab and click the [Hidden] option. 

 

Customer Diary 

The Customer Diary allows you to record notes in relation to the Customer. These are purely for 

your records, and do not affect any other part of the program. 

To add, view or delete entries in the Customer Diary, select the customer in the Customer List 

and then click on the [Customer Diary] button. 

A list of recorded notes is displayed together with the date. You can sort the list by clicking on 

the column headings. Clicking again will sort the list in reverse order. 

1. To add a new note, click on the [Add] button. 

2. Type in the note, with a maximum of 250 characters. 

3. Set the date for the note at the top. Today’s date will be set as default. 

4. Click on [Save] to record the note or click [Cancel] to exit without saving. 

To edit a note, select the note in the list, and click on the [View/Edit] button. Make the changes 

and click [Save] to save changes. 

To delete a note, select the note in the list, and click the [Delete] button. The note will be 

removed. 

To print diary notes, click on the [Preview] button to show a print preview. 

 

Customer Inquiry 

The Customer Inquiry page shows a history of transactions in your customer's account. This will 

include Finalised Invoices, Adjustment Notes and Money In. A transaction can be viewed by 

double-clicking on it. 

NOTE: Unfinalised Invoices and unassigned Adjustment Notes will not appear in the Customer 

Inquiry list of transactions. 

To print a selection of the Customer Inquiry transactions, click on the [Print Inquiry] button. 

Select the dates to include and click on [Print]. 

 

Change Decimal Points 

By default, Invoice Manager uses 2 decimal places for all Unit Price currency values. You can 

toggle between using 2 Decimals Format or Variable Decimal Format. Click on the Tools 

menu and select Change Decimal Points to toggle between the options. A message will appear 

to inform you of which format is now in use. 
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Opening Balances (Customers) 

The Opening Balance is the amount the customer owes you before you create any more invoices 

in the program. 

If you already have customers with outstanding balances when you start to use Invoice Manager, 

you will need to record sales invoices for the balance outstanding. This is particularly important 

if you issue statements. 

For the most accurate reporting, add the outstanding invoices. If those invoices have had Money 

In applied to them you will need to decide whether to record both invoice and receipt, or an 

invoice for just the balance outstanding, 

If you just want to have an accurate opening balance for statements, you can record one invoice 

for outstanding balance. (Make sure the invoice date is prior to any transaction in your first 

statement.) 

Also see ‘Sales’ Invoices’ 

 

Sales Invoices 

Sales Invoices are the bread and butter of your business, so to speak. For goods that you sell, or 

services you provide, a tax invoice is issued, and payment is expected from the customer. 

Invoice Manager helps you keep track of outstanding invoices and which customers owe you 

money. 

The Invoices page allows you to see what invoices you have for the selected customer and when 

they were created. It also shows the total of the invoice and the current amount owing. 

You can create new sales invoices and view/edit existing invoices from the buttons on the right. 

At the top are four options to filter the viewable list: This Month’s Customer Invoices, 

Outstanding Customer Invoices, All Customer Invoices and Show Quotations. Select the 

required function. 

 

Add a New Sales Invoice 

Select the customer from the Customer List. Click on the [Add Invoice] button. 

The top left corner displays the Customer Code and Company Name. Underneath this is the 

Invoice Number. The next numerical sequenced invoice number is generated but can be changed 

e.g. to set a manual invoice number by typing the new number in the box. 

The Invoice Date displayed at the top of the next column defaults to today’s date per the 

computer, but you can change this as necessary. 

The Invoice Status or Invoice Options are then displayed, and the choices are: 

❖ Order/Invoice: A standard tax invoice or agreement for provision of goods & services 

❖ Quotation: Quote a customer for goods or services, expecting an order. When the quote is 

successful, the status can be changed to Invoice 

❖ Hold Open: Create an invoice but do not allow finalising just yet 

❖ Finalised: A tax invoice issued to a customer ready for payment (also referred to as ‘posted’ 

or ‘closed’, but does not necessarily mean ‘paid off’) 

The P.O. Number field can be used to reference a Purchase Order that may have been placed in 

relation to this invoice. 



109  

If payment has been received at the same time the invoice is created, click in the Cash Invoice 

checkbox. When the invoice is finalised, a receipt will be applied automatically for the amount 

owing and for the same date as the invoice. 

NOTE: If using a Cash Invoice, you can set up automatic transfer to Cashflow Manager of the 

receipt. See ‘Cash Invoice Settings’ in ‘Options – Invoice Manager’. Alternatively, if you 

have a lot of Cash Invoices, you can select not to transfer each individual invoice to Cashflow 

Manager and just record the total at the end of the day or use ‘Transfers’ to batch receipts and 

transfer them as one entry. 

The Credit Limit and Current Balance are references to the credit limit you have established 

for the customer together with the current balance of their account, for ease of use. 

If there is a credit on the customer’s account this will be displayed. Click on the [Credit 

Amounts] button to apply the credit amount to the current invoice. 

If Use Customer Types has been selected in Options, a Customer Type field and the Customer 

Type allocated to this customer in Add Customer/Modify Customer will display under the 

Current Balance. You can click on the down arrow and select a different Customer Type if 

required. To change the Customer Type permanently, click on [Modify Customer] next to the 

Customer List. The prices for items chosen from inventory will default to that mapped price list 

for that Customer Type. 

If Use Jobs Number has been selected in Options, a Job Number field will display under the 

Current Balance and Customer Type. The invoice can be assigned to a Job from the drop- 

down arrow so you can allocate invoices to track specific jobs. 

 

Add Items to Your Sales Invoice 

Adding items to an invoice can be done in two ways. You can simply type in the details of the 

item to be included on the invoice, or you can choose from the Item Code or Description drop 

downs that list items recorded as Sell or Buy/Sell in Inventory. 

Note: Management Sales Reports designed to give you information to analyse your sales and 

purchases only include items that are listed in Inventory and require selection from the Inventory 

List to be included in these reports. 

Cashflow Manager GOLD can also track inventory on items that are purchased and sold. To use 

this feature, you must add inventory items to invoices through the Item Code or Description 

selections. 

On a Sales Invoice, only inventory items marked as Sell or Buy/Sell will appear in the list to 

choose from. If Inventory Tracking is enabled, these items will then be deducted from your item 

count. 

If you know the Item Code, start typing this into the Item Code field, and as the right code 

appears, press ‘Enter’. Alternatively, click on the drop-down arrow and choose the item from the 

inventory list. 

The item’s stored details will be pre-filled into the Description, Tax Type and Unit Price fields, 

which can be edited if required. Enter the quantity of items supplied, and press ‘Enter’. The next 

line will become available for more items. Continue filling in item details for your Sales Invoice, 

and press ‘Enter’ at the end of each line. 

If you simply type in a description, the tracked inventory will not automatically adjust the item 

count or be included in the Sales Reports. 

NOTE: The Description can be a maximum of 250 characters. If you wish to type more, go to 

the next line, and type the rest in the next description field. 

Each of the column widths can be resized. For example, if you wish the Description column to 

be wider, position your mouse cursor over the right side of the Description Column Header. 

Hold down your left mouse button and drag the column to the width you require, and then let go. 
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The grey box at the left side of the invoice work area indicates the line you are working on as 

well as offering several other functions for editing the lines in the invoice. 

To access these functions, left-click on the grey box on the left side of the line. An arrow will 

appear to indicate the row is selected. Right-click to list the functions and then left-click on the 

function you require. The functions are: 

❖ Insert Blank Line – Insert a blank line above the currently selected line 

❖ Remove Line – Remove a line permanently (you will be prompted) 

❖ Move Line Up – Move the currently selected line above the preceding line 

❖ Move Line Down – Move the currently selected line below the following line 

You can delete multiple lines at a time by holding down the ‘CTRL’ key and selecting each row 

for deletion. Then press the ‘DELETE’ key. You will be prompted if you wish to remove the 

selected lines permanently. 

There is also an option to add an additional column to your invoice. For example, some 

businesses create one invoice for transactions that span more than one day so the extra column 

can be used for the transaction date. To enable this extra column, click on the Options icon and 

select Advanced Preferences. 

 

Adding a Message to Your Sales Invoice 

The Message field is used for a brief note, usually such as “Thank you for your business” or 

“Terms 30 days”. It normally shows near the bottom of the invoice printout. To add a message, 

click in the box below the invoice items work area, and type your message. You can save this 

message in a list to add to other invoices by clicking on the green tick button. To use a 

previously saved message, click on the drop-down arrow and select the saved message from the 

list. The message can be up to 150 characters long. 

To delete an existing message, select the message and then click on the red ‘cross’ button. 

 

Extra Details 

In the bottom left corner of the Invoice page are some Extra Fields for information you may 

require including on the invoice. For example: a construction job’s building address, or more 

details for the job. The Extra Field titles can be changed by double-clicking on the title. A text 

box will appear to change the name. Press ‘Enter’ when done. The title of the Extra Field is 

global; therefore, all customers’ invoices will show the same Extra Fields titles. If using Extra 

Fields, you will need to add these fields to a Customised Layout, as they are not shown by 

default. See the section ‘Invoice Setup Wizard’ on how to add text boxes and turn them into 

data fields. 

 

Apply Discount 

Click on the Discount tab in the bottom left corner and type in the amount or rate of discount in 

the box. 

Choose either Percent (%) or Dollar ($) and click on the [Apply Discount] button below. A 

line will be added to the invoice items showing the discount in the Line Total column as a 

negative as well as calculate the adjustment to the GST for the items discounted. 

NOTE: The discount you add will be calculated from the invoice balance at the time the 

discount is added, so if you add more lines to the invoice and then another discount the original 

items will be discounted further. You can remove a discount line like any other invoice item line 

(i.e. select the row, click on the Delete key on your keyboard). 
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Cash Invoices 

The Cash Invoice option allows you to quickly and easily finalise the invoice and process the 

receipt and can be used with any customer. However, you may also want to establish a ‘Cash 

Customer’ for cash sales where you do not want to record the customer’s details. 

Select this as your customer each time you have such a cash sale and tick the Cash Invoice 

checkbox on the Invoice page. (Remember that GST tax invoices greater than $1000 require the 

customer’s name and address or ABN on a valid tax invoice.) 

Process the Cash Invoice and click on the [Finalise] button. A receipt will be automatically 

applied to the invoice and the balance reduced to ‘$0.00’. 

The process that follows depends on the Cash Invoice Settings set in Options. Click on the 

Tools menu, select Options and then Cash Invoice Settings. You can choose to transfer Cash 

Invoice receipts to Cashflow Manager in three ways: 

1. Always 

2. Never 

3. Ask me each time a Cash Invoice is Finalised 

If you choose Always or Ask me... to transfer the Cash Invoice Receipt to Cashflow Manager, 

make sure you also select the Cashflow Account and Receipt Column in which the amount will 

be recorded. 

If you process a lot of Cash Invoices you may wish to select Never and then use the Transfers 

function to transfer one entry to your Cashflow Money In Record for the total batch. You will 

also need to select ‘Use Transfers’ in Options > Advanced Preferences. 

A message to print a receipt, after a cash invoice is finalised, will be automatically generated if 

this option has been selected in Tools/Options/Cash Invoice Settings. 

 

Recurring Invoices 

If you have invoices that are repeated, or have similar item details, you can save them as a 

Recurring Invoice to save time preparing your Sales Invoices. 

First, create or open an invoice that has the relevant item details filled in. Save the invoice by 

clicking on the [Save] button. 

Click on the [Recurring] button (You cannot make a finalised invoice recurring). 

A window will appear prompting you to type in a description for the new Recurring Invoice. 

Click the [Add] button when done. 

To use a Recurring Invoice for a new invoice, add a new invoice, then click the [Recurring] 

button at the bottom of the New Invoice page, and click the Use Recurring Invoice tab. 

Select the description of the saved Recurring Invoice from the list and click the [Use] button. 

The item details will be loaded into the current invoice. Then close this window and save the 

new invoice. 
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Finalise an Invoice. 

‘Finalising an Invoice’ signifies it is ready to issue to the customer, no changes will be made, 

and to expect payment. In accountant terminology, it is often referred to as ‘Posting’ because it 

is when the invoice is finalised that it is ‘posted’ into the Debtors Ledger. In other words, it is at 

this point that the sale is made and the customer becomes liable to pay. 

Similarly, in Invoice Manager an invoice is not treated as a sale and therefore not included in 

statements, sales reports, Aged Debtors or the Customer Inquiry until it is finalised. 

When preparing an invoice, you are given the option to Hold Open the invoice if you do not 

wish to finalise it, for example, if delivery has not been made prior to statement date. 

The invoice is treated as a draft (or ‘open’) until it is finalised. 

To finalise the invoice currently displayed, click on the [Finalise] button. 

Invoices can also be finalised all at once by clicking on the Finalise Invoices icon on the 

toolbar. This will open a window displaying all Sales Invoices whose status is Order/Invoice, 

but not any with status of Hold Open. Tick the checkboxes for the invoices to be finalised and 

click the [Finalise] button. Or if you want to finalise all invoices, click the [Select All] button. 

 

Amount Received 

Once the invoice is finalised, an [Amount Received] button will appear to record a deposit or 

part payment received. 

Click on the [Amount Received] button in the bottom right corner above the Balance Due field. 

An Amount Received window will appear to record the Receipt Reference, Receipt Date, 

Amount to Pay and transfer to Cashflow Manager. 

 

View or Edit an Invoice 

Select the customer from the Customer List and click the [Invoices] button. 

The Invoices page will list any created invoices for the selected customer. Options above filter 

the list, by This month’s, Outstanding, or All invoices. Normally it is set to show Outstanding 

Customer Invoices and will show all Open (unfinalised) invoices and, when ticked, Quotations. 

Select an invoice from the list and click the [View/Edit] button or double-click on the invoice. 

Any invoice / quote can be viewed to reprint or print a picking slip, but only open invoices can 

be edited. If an invoice is finalised, it will need to be unfinalised. See the section ‘Unfinalise an 

Invoice’ below. 

 

Print a Sales Invoice 

If the invoice is displayed, click the [Print] button. If not, open the invoice for viewing/editing 

as per section above. When the Print Preview appears, there are options to [Email], [Save As] a 

file, or [Print] it to the printer. Click the required button at the bottom. 

Other features when printing include: 

❖ Choosing a different customised layout (assuming you have more than one layout) and 

❖ Picking Slips (which does not show prices) 

For more information on printing and emailing reports, see the section on Reports in Functions 

Common to all Programs. 
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Picking Slips, Packing Slips, Delivery Dockets 

You can print an invoice that does not show prices to use for picking inventory or as a despatch 

notice. Print the Picking Slip by clicking on the [Picking Slip] button. 

The layout for the Picking Slip can be customized if it needs to be adjusted to meet your needs. 

See the section Customise Layouts. 

You can also rename the title ‘Picking Slip’ e.g. ‘Packing Slip’ or ‘Delivery Docket’. Click on 

the Options icon and select Advanced Preferences. Type in the new Picking Slip Name and 

click [Save]. 

 

How to Correct Sales Invoice Mistakes 

NOTE: Please make a backup of your file before making changes. Extreme care should be used 

in fixing mistakes, as you do not want to compound the problem. We recommend that these 

options should only be used by, or under supervision of, business management. 

The most common mistakes are forgetting an item, putting the wrong price on an invoice, or 

creating an invoice under the wrong customer. These can be corrected, if the problem isn’t made 

worse by not understanding what is happening. If you are unsure, contact Support for help. 

The process of invoicing is sequential and must be reversed if changes need to be made. 

❖ Sequential: An invoice is created then saved, finalised, then a receipt is added. 

❖ Reversal: To edit the invoice directly, remove the receipt, then unfinalise the invoice, 

make the changes, finalise, and then reapply the receipt if necessary. 

If changes need to be made to the invoice and it is not fully paid off, an Adjustment Note can be 

used to remove items or reduce the price. See the section ‘Adjustment (Credit) Notes’. 

 

Unfinalise an Invoice 

An invoice can be ‘unfinalised’ only if it has not had a Receipt, Credit Amount or 

Adjustment Note applied to it. 

There are two options. 

One is to select the [View/Edit] the invoice and click on the [Unfinalise] button. 

You can also Unfinalise an invoice from the Tools menu. This may be the better option of 

you need to remove a receipt first as this can also be done from the Tools menu. 

Click on the Tools menu, select Remove Receipt, and then Unfinalise Invoice. If an 

Adjustment Note needs to be removed, you will need to unassign and then click the [Delete] 

button. 

Select the Invoice Number from the drop-down arrow and click the [Unfinalise] button. 

The invoice’s status will now be marked as open, and changes can be made. 

For more information, see the sections ‘Unassign/Delete an Adjustment Note’ and ‘Remove a 

Receipt’. 

 

Move an Invoice to another Customer 

If the invoice was created under the wrong customer, it can be reassigned to another customer, 

but only if the invoice does not have a Receipt or Adjustment Note applied to it. Remove these 

first if necessary. 

Click on the Tools menu and select Move Invoice to Another Customer. 
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Under Select Invoice, choose the Invoice Number from the drop-down arrow. The Company 

Name the invoice is assigned to will also show. 

When selected, the invoice details will show underneath, including the Customer Code and 

Company Name. At the bottom, select the intended Customer from the drop-down arrow. 

Click the [Move] button. 

The invoice will now be located under the new Customer Code and will be viewable in the 

Invoices section. 

 

 

Adjustment (Credit) Notes 

An Adjustment Note usually occurs when goods are returned for credit, or there is a dispute with 

a customer that results in a negotiated reduction in an account. 

In other words, an adjustment note applies a credit to an account. In fact, they used to be called 

‘Credit Notes’ but the GST Legislation requires the term ‘Adjustment Note’ to be used. 

Select the customer from the Customer List and click the [Adjustment Notes] button. 

The Adjustment Notes List has two views: This Month’s Adjustment Notes, and All 

Adjustment Notes to select from. You can also choose to include Overpayments in the list by 

ticking the Show Overpayments checkbox. 

To view an existing Adjustment Note, select it from the list and click the [View/Edit] button. 

You cannot edit an Adjustment Note that has been assigned. 

To add a new Adjustment Note, click the [New] button. 

The top left corner displays the Customer Code and Company Name. Underneath this is the 

Adjustment Note Number. The next numerical sequenced number is generated but can be 

changed by typing the new number in the box. 

The Adjustment Date displayed at the top of the next column defaults to today’s date per the 

computer, but you can change this as necessary. 

Next is the Invoice Number. Click on the drop-down arrow to choose the Invoice Number the 

Adjustment Note will be assigned to. All Adjustment Notes must be assigned to an invoice. 

When chosen, the Invoice details will appear in the bottom left corner. 

Choose the Adjustment Type from the drop-down arrow. 

There are three Adjustment Types: 

1. Assign to Invoice is used to reduce the amount of an invoice that has a balance outstanding. 

If the amount of the Adjustment Note exceeds the balance outstanding, when you click on 

the [Assign] button a message will advise to select either the Write a Refund or Assign a 

Credit and click on the [Assign] button again. This will advise what to do with the excess 

balance. 
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2. Write a Refund reduces the balance owing on an invoice and refunds the surplus to the 

customer. Note: the payment to the customer needs to be recorded manually in Cashflow 

Manager. 

3. Assign a Credit can be used the same way as a refund, but instead of refunding the surplus 

to the customer, you hold it in credit to apply to future or other outstanding invoices. In the 

Type drop-down box, choose the Assign a Credit option. 

You can allocate a Reference Number if required. Beneath that the Customer Type and Job 

Number details from the invoice will be displayed. 

Record the items that apply to the Adjustment Note. Note that if you are tracking inventory 

(GOLD) you will need to select the item using the Item Code or Description drop down 

selections to accurately adjust the inventory count. 

Record or select a message under the Items work area if required. 

When finished, click the [Save] button to save the Adjustment Note for later use, or click the 

[Assign] button to finalise and assign the Adjustment Note. 

Click on the [Print] button to print the Adjustment Note. You can also save as an Excel, PDF or 

rtf document or email the Adjustment Note. 

NOTE: If the amount of the Adjustment Note is less than or equal to the balance remaining on 

the selected invoice, the adjustment will be deducted from the invoice. If the amount of the 

Adjustment Note is greater than the balance remaining on the selected invoice, then the balance 

remaining on the invoice will be reduced to $0.00. The surplus can either be refunded to the 

customer or added to the customer’s credit balance by selecting the appropriate Adjustment 

Type option. 

 

Unassign / Delete an Adjustment Note 

You can delete an Adjustment Note that has been saved but not assigned. An Adjustment Note 

that has been assigned to an invoice can be unassigned for editing or removal. 

To unassign and/or delete an Adjustment Note, click on the [Adjustment Notes] button next to 

the Customer List and click on the [Unassign] or [Delete] button as appropriate. (An Adjustment 

Note needs to be unassigned in order to delete it.) 

 

Money In 

Process a Receipt 

Select the customer from the Customer List and click the [Money In] button. 

Record the Receipt Date. This defaults to today’s date per the computer but can be edited. 

Record a Reference Number if required. 

The Current Balance for the customer will display. 

Select from the Auto-Apply options. 

1. Earliest Date First is the default selection. While this is selected, when you enter the 

total amount received in the Amount Received box and press ‘Enter’, the receipt will be 

automatically applied to the oldest invoices first. 

2. Lowest Invoice Number First applies the receipt in sequence starting with the lowest 

invoice number. 

3. Don’t Use Auto Apply allows you to select the invoices yourself. 
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To use either of the Auto-Apply options, select the option, record the receipt amount in the 

Amount Received box and press ‘Enter’. Alternatively, record the amounts next to each invoice 

listed in the grid in the Amount Received column. 

If this is the first receipt applied to an invoice, you have the option to apply a discount. Click the 

[Add Discount] button for the invoice, enter the amount, and choose whether it is a percentage 

of the total or a dollar amount. Click the [Apply Discount] button. 

To transfer the amounts received into a Cashflow Manager Account: 

1. Click in the Transfer to Cashflow Manager Checkbox. 

2. Select the Cashflow Manager Account in which to record the receipt 

3. Select the Banked or Not Banked option where applicable. 

4. If you want to combine into a single transaction, tick the Group as one entry checkbox 

5. Click the [Continue] button 

6. Allocate the amount(s) to the appropriate Allocation Column(s) 

7. Click the [Save] button. 

 

Remove a Money In Transaction 

The Remove Money In Transaction option allows you to remove a Receipt that has been 

applied in error. Click on the Tools menu and select Remove Money In Transaction. From the 

drop-down box, select the Receipt. Click the [Remove] button. 

If the Money In transaction has resulted in a credit that has been applied to any invoices, the 

invoices will be listed and when you remove the Money In transaction, the credits will also be 

removed from those invoices. 

 

Apply Credit Amounts 

A Credit Amount can occur when a customer pays more than the balance of their outstanding 

invoices or pays a deposit for an invoice that has not yet been prepared. 

When applying a receipt for more than the total of the invoice, the surplus is saved as a Credit. 

This can also happen when assigning an Adjustment Credit Note to an invoice for greater than 

the amount owing. The surplus is added to the customer’s Credit Amount. 

To refund a credit balance or apply it to an invoice, click on the [Apply Credit Amounts] 

button on the Customer List page. 

Change the ‘Credit date’ as necessary. 

1. To apply the credit balance to an invoice, click on the down arrow next to the Invoice 

Selected box to display a list of the customers’ ‘Finalised’ invoices with outstanding 
balances. Select the required invoice. 

The details of the invoice will appear and the Credit to Apply will pre-fill with the amount 

of credit remaining or the ‘Balance Outstanding’ on the invoice. Edit the amount if 

necessary. 

Click on the [Save] button. 

2. To refund the credit, click on the [Refund] button rather than selecting an invoice. 

To transfer the receipt to Cashflow Manager: 

1. Click on the Transfer to Cashflow Manager Checkbox. 

2. Another field will appear to select the Cashflow Manager account in which to record 

the payment. 
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3. Click on [Continue]. 

4. Allocate the amount to the appropriate Allocation Column 

5. Click on [Save]. 

Alternatively, a credit amount can be applied to an invoice at the time you create it. (Refer to 

‘Add a New Sales Invoice’) 

 

Remove Credit Amounts 

Credits can be removed from Invoices without the need to remove the Receipt that created the 

credit. 

Click Tools>Remove Credit. Select the credit amount by clicking in the checkbox and click 

[Remove]. 

When a receipt is removed that created a credit, the credit amount is also removed. 

 

Statements 

A Statement summarises transaction activity and balances for each customer. Businesses that 

issue statements usually do so at the end of each month. 

Many programs’ statements tend to list the age of the amount outstanding and classify these into 

30, 60, 90, >90-day amounts. As this signals to your customers that you expect delayed receipts, 

Invoice Manager does not do this. 

The standard statement includes a summary that displays Opening Balance + Net Transactions = 

Balance Due. 

An alternative would be to display this as Overdue + Current Transactions = Balance Due. To 

use this alternative, click on the Tools menu, select Customised Layouts and then Statement. 

Edit the text boxes accordingly. 

Prior to version 7, ‘processing statements’ was required to accurately track outstanding invoices 

and print customer statements. This is no longer required. All invoices, adjustment notes and 

receipts need to be processed and finalised, but there is no requirement to process statements. 

Simply click on the Reports tab and select the Statements Report. 

The Statement Period is now set each time a report is generated by the report dates chosen. 

There are choices, governed by Windows’ set time and date, to print the report for This Month, 

This Quarter, This Year, Last Month, Last Quarter or Last Year or for Custom Dates (select start 

and end period dates) 

There is an option to Exclude Nil Transactions that will exclude statements for any customers 

who have a zero balance and no transactions during the period, and to select the Statement Type. 

There is also an option to Exclude Nil Balances that will exclude statements that have a zero 

balance even though they may have had transactions during the period. 

Normal Statements show the Opening Balance for the period start date, and then separately lists 

receipts, invoice balances outstanding from prior periods, and current transactions to arrive at the 

Closing Balance. 

History Statements show the Opening Balance and then list all transactions for the selected 

period. 

Note: Any transactions for the Statement Period that are processed after you print the statements 

will affect the balances. So, it is important to ensure that all transactions for the period have been 

completed before printing statements. 
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Print Statements 

To print Statements for your customers, click on the Reports tab, select the Statements Report 

from the list and click on the [Continue] button. 

Choose the options for the report as detailed in the above section. 

Click on the [Preview] or [Print] button as required. The Preview also allows you to email your 

statements or save as an Excel, PDF or rtf document. 

WARNING: If you choose to Email the statement to your customer, make sure you select that 

customer only. If you select multiple customers, the email will include all those selected. 

 

Reports (Customers and Sales) 

The Reports tab in the Invoice Manager section lists reports for Sales, Purchases (GOLD only) 

and Inventory. 

 

Report Options - Sales 

Once a report is selected, there are options to select different parameters for the generation of the 

report. The Report Options listed in the following table are: 

C – Customer selection. Choose either All Customers or Select Customers (opens a list of all 

customers to select from). 

D – Date Period. Choose a report date range from Last Month, Last Quarter, Last Year, This 

Month, This Quarter, This Year or Custom (select report start and end periods where 

appropriate). 

eD- End Date Only. Report relates to a specific time period and the only option is to select an 

end date for the report. 

E –Includes reports formatted especially for Microsoft Excel. 

F – Filter report. Report will show information based on filters e.g. Detailed or Summary, 

Include Invoice Manager balances, Single or Multiple Columns etc. 

T – Type of printout. Choice of print layout or specific print media. 

 

 

Types of Reports – Customers/Sales 

The following table summarises the reports available in the Invoice Sales (Customer) section. 

More information is included below for reports highlighted by an asterisk*. 
 

 

REPORT DESCRIPTION Report 

Options 

Activity: Summary of sales and customer activity for the period. D 

Adjustment 

Notes: 

Includes all Adjustment Notes for the period. Options are to 

print all or unassigned Adjustment Note as well as to include 

overpayments. 

C, D, F 

Adjustment 

Notes List: 

Lists Adjustment Notes. D, T 
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Aged Debtors: Classifies outstanding balances according to age from the date 

of the finalised invoice. Net invoices are classified into ‘0-30’ 

days, ‘31-60’ days, ‘61-90’ days & ‘91+’ days from the 

selected Date. 

C, eD, E, 

F, T 

Customer 

List: 

List of customers including customer name, contact, address, 

phone, fax and e-mail details. The Detailed list also includes 

the shipping address. Labels can also be printed. 

C, E, F, T 

GST:* The totals from the GST types used in your invoices and your 

adjustment notes for the selected period 

D, F, T 

Order Status: Lists invoices in the period with the selected Invoice Status. C, D, F, T 

Processed 

Receipts List: 

Lists receipts (money in) processed C, D, T 

Receipts: Actual receipts (money in) recorded C, D 

Sales by 

Customer: 

Lists Total Sales including GST, GST and Total Sales 

excluding GST per customer and also calculates the average 

sale per invoice and the average sale per customer based on the 

Total Sales Excluding GST. The Detailed report also shows 

specific sales details per item. 

C, D, eD, 

F, T 

Sales by 

Product:* 

Lists the item, unit price and number of items in the Inventory 

List sold to each customer, as well as the total sales. 

C, D, F, T 

Sales Invoices: Sales invoices created during the period. C, D, F 

Sales Invoices 

List: 

A list of invoices created during the period with options to 

include All, Selected, Finalised, Unfinalised or Unprinted 

Invoices. You can also choose to include Quotations. 

C, D, F, T 

Statements: Lists all transactions for each customer during the period and 

is combined with the opening balance to determine the 

customer’s outstanding balance. 

C, D, T 

 

Sales by Product: This report lists the item, unit price and number of items in the Inventory List 

sold to each customer, as well as the total sales. 

NOTE: Items need to be listed in Inventory to be included. However, prices are updated 

from invoices. 

You can choose to print either a Sales Report with Summary or Detailed formats or a Sales 

& Profit Report. 

You can also order by any of the column titles. For example, if you want to know which 

products give the highest level of sales, order by the ‘Total’ column. 

The Sales and Summary options list the item, the unit price, the number of products sold to 

each customer, and the total sales. (The Detailed option provides a list of volume sold and 

total for each customer who has purchased each product.) 

The Sales & Profit option provides an indication of the contribution each Inventory Item 

makes to the profitability of the business. For each item, it advises the number sold, Total, 

Average Sale Price, Unit Cost (as per the Inventory List), Profit per Unit and Total Profit. 

GST: There are four choices for printing the GST report: 
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1. The Sales GST Report is designed to match the Outputs section of the Tax Office GST 

Calculation Worksheet. It reports the totals from the GST types used in your invoices and 

your adjustment notes for the selected period. 

Section 1 calculates the total from your Invoices. 

Section 2 calculates the total from your Adjustment Notes. These would be a decreasing 

adjustment. The amount at G6 in section 2 can be either transferred to box G18 on the GST 

worksheet (after considering any other adjustments outside of this system) or can be used to 

negatively adjust boxes G1 to G4. 

Section 3 provides adjusted totals that can be used for adjusting boxes G1 to G4. 

The Detailed option includes the GST components for customers and invoices. 

2. The Sales GST (Closing Balances) Report provides the same information as the Sales GST 

Report but only includes closing balances at the selected date. This will provide you with the 

closing balance information to combine with your Cashflow Manager GST Report if you are 

lodging your BAS on the ‘accruals’ method. 

3. The Sales and Purchases GST Report (GOLD) provides the GST Calculation Worksheet 

information for both sales and purchases. 

4. The Sales and Purchases GST (Closing Balances) Report (GOLD) provides the GST 

Calculation Worksheet information for both sales and purchases but only includes closing 

balances at the selected date. 

 

Suppliers and Purchases (GOLD) 

If you have Cashflow Manager GOLD, a tab labelled Suppliers will be included in the Invoice 

section of the program. Click on this tab to access Suppliers and Purchases. 

 

Suppliers 

When you click on the Suppliers tab in the Invoice section, the Supplier List will display. 

This consists of: 

Supplier List: The Supplier List is the main window of the Purchases section of Invoice 

Manager. 

The Supplier List can be sorted by Supplier Code, Supplier Name, Contact Name or Phone by 

clicking on the column heading at the top. 

A triangle to the right of the column name will indicate the sort order of the column: an ‘up’ 

triangle indicates ascending order, and a ‘down’ triangle descending order. 

To quickly and easily search for an existing supplier, sort by Supplier Name and then type the 

first letter of the name. The closest match will be highlighted in the list. 

Function Buttons: To the right of the Supplier List are buttons for the common functions 

undertaken in the program. These are divided into groups: Functions, Information and 

Suppliers. 

Each function button performs a different task in the program. They allow you to add or edit 

purchase orders, purchase invoices, returns, apply payments and overpayments. To use a 

function, select a customer by clicking on their name, and then click the function button desired. 

For example, if you need to edit a supplier’s details, click on their name in the Supplier List and 

then click on the [Modify Supplier] button. 
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Add, Modify or Manage a Supplier 

To add a new supplier, click the [Add Supplier] button. 

Record the supplier’s details, and make sure a unique Supplier Code is included. You can ‘Tab’ 

through the fields, or press ‘Enter’. 

Click the [Save] button at the bottom to save and exit the supplier’s details or click [Save & 

New] to add another supplier. 

To avoid retyping the same information if the shipping/delivery address is the same as the 

mailing address, tick the checkbox next to Use Company Address. 

Four extra fields can be used for any extra information you require for this supplier. To enable 

these extra fields, click the [Extra Fields] button, and a new window will appear. Record the 

details you require and click [Save]. You can rename the title of these extra fields by positioning 

your mouse over the name and double clicking. A box will appear to change the title. 

Each supplier can also make use of customised layouts. Click the [Customised Layouts] button 

to choose which layouts will be used for printing. You can change the layout used for the 

Purchase Order, Purchase Invoice and Return printouts. 

If you have selected the ‘Use Taxable Payments for Contractors’ option in Options, Advanced 

Preferences, a check box will appear to identify whether that supplier is a ‘Taxable Payments 

Contractor’ for Building and Construction Industry Taxable Payments Reporting requirements. 

Ensure a tick appears for any supplier that meets the criteria. 

Note: If the ‘Taxable Payments Contractor?’ button has been checked, and no ABN is recorded, 

the program will advise that you need to withhold PAYG. This will be automated at the time of 

recording a payment to the contractor. 

Once a supplier is added, you can modify their details by selecting them from the list, then 

clicking the [Modify Supplier] button. 

To hide a supplier, click on the [Manage Supplier] button. Tick the checkbox, next to the 

supplier, in the [Hide] column, and click [Save]. A supplier can only be removed from the list if 

there has been no activity for that supplier in the last 12 months (i.e. created invoices, 

outstanding payments, etc.). 

NOTE: The Supplier Code used by the deleted supplier cannot be re-used. However, you can 

change the Supplier Code in the supplier’s details before deleting. 

 

Restore a Hidden Supplier 

If you have hidden a Supplier, they can be restored, or shown. 

Click on the [Manage Supplier] tab and click the [Hidden] option. 

Supplier Diary 

The Supplier Diary allows you to record notes in relation to the employee. These are purely for 

your records, and do not affect any other part of the program. 

To add, view or delete entries in the Supplier Diary, select the supplier in the Supplier List and 

then click on the [Supplier Diary] button. 

A list of recorded notes is displayed together with the date. You can sort the list by clicking on 

the column headings. Clicking again will sort the list in reverse order. 

1. To add a new note, click on the [Add] button. 

2. Type in the note, with a maximum of 250 characters. 

3. Set the date for the note at the top. Today’s date will be set as default. 
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Adding items to your Purchase Order is the same as preparing an invoice. However, the 

Item Code column will only list the inventory items marked as Buy or Buy/Sell 

See Add Items to Your Sales Invoice and Add a Message to Your Sales Invoice in the 

Customers and Sales for more information. 

4. Click on [Save] to record the note or click [Cancel] to exit without saving. 

To edit a note, select the note in the list, and click on the [View/Edit] button. Make the changes 

and click [Save] to save changes. 

To delete a note, select the note in the list, and click the [Delete] button. The note will be 

removed. 

To print diary notes, click on the [Preview] button to show a print preview. 

 

Supplier Inquiry 

The Supplier Inquiry page shows a history of transactions in your supplier's account. A 

transaction can be viewed by double-clicking on it. 

You can select to view Financial Transactions Only, and All Transactions. Financial 

Transactions Only will not display Purchase Orders. 

To print a selection of the Supplier Inquiry transactions, click on the [Print Inquiry] button. 

Select the dates to include and click on [Print]. 

 

Purchase Orders 

Purchase Orders are used to order goods from your suppliers. The Purchase Orders page allows 

you to see what orders you have for the selected supplier and when they were created. You can 

create new Purchase Orders and view/edit existing orders from here. At the top are two options 

for viewing: This Month’s Purchase Orders, and All Purchase Orders. 

 

Add a New Purchase Order 

To create a Purchase Order, select the Supplier in the Supplier List and click on the [Purchase 

Orders] button. Then click on the [New] button to the right of the Purchase Orders list. 

The top left corner displays the Supplier’s Details and the Purchase Order Number. The next 

numerical sequenced number is generated but can be changed e.g. to set a manual Purchase 

Order Number by typing the new number in the box. 

Record a Purchase Order Date and a Reference Number if required. 
 

Click the [Save] button. 

Print the Purchase Order by clicking on the [Print] button. 

To close the page, click the [Cancel] Button. However, click on [Save] first to save the Purchase 

Order before closing. 

 

Purchase Invoices 

Purchase Invoices are generally recorded when you have received the goods and have an invoice 

from your supplier. This enables you to keep track of payments you owe to your suppliers. It is 

also used for inventory control as Purchase Invoice items update your inventory list, and 

therefore increase the number of items on hand. 
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Adding items to your Purchase Order is the same as preparing an invoice. However, the 

Item Code column will only list the inventory items marked as Buy or Buy/Sell. 

See Add Items to Your Sales Invoice and Add a Message to Your Sales Invoice in the 

Customers and Sales for more information. 

Select the supplier from the Supplier List and click on [Purchase Invoices]. Existing purchase 

invoices will be displayed according to the filter selection of: This Month’s Purchase Invoices, 

Outstanding Purchase Invoices and All Purchase Invoices. 

 

Add a New Purchase Invoice 

Select the supplier from the Supplier List. Click on the [Purchase Invoices] button and then 

click on the [New] button. 

The top left corner displays the Supplier’s Details and the Purchase Invoice Number. The next 

numerical sequenced number is generated but can be changed e.g. to set a manual Purchase 

Invoice Number by typing the new number in the box. 

The Invoice Date defaults to today’s date per the computer. Change this to reflect the date on 

the supplier’s invoice. 

The Payment Terms pre-fill from the information stored in your Supplier’s Details. You can 

type in amended payment terms if this invoice is different to the normal terms offered by this 

supplier. 

The Due Date is automatically calculated from the date of the invoice and the payment terms. 

This can be changed by clicking the drop-down arrow next to the date. 

The Reference Number can be used to record the invoice number on your supplier's invoice. 

If this Purchase Invoice relates to a previously saved Purchase Order for the same supplier, you 

can load in the item details from the Purchase Order. Click on the drop-down arrow and choose 

the P.O. Number from the list. Then click the [Load P.O.] button to load the order’s item details 

into your invoice. You can then make any modifications to it in order to coincide with the 

invoice supplied with the goods. 

A checkbox that says, ‘Include on Taxable Payments Report?’ will display if you have 

selected the 'Use Taxable Payments for Contractors' checkbox in 'Options' and the 'Taxable 

Payments Contractor' checkbox in 'Supplier Details'. If this invoice meets the criteria, ensure the 

box is ticked. 
 

Click the [Save] button. 

When the invoice is complete, click on the [Lock] button to lock the invoice to stop unwanted 

editing. 

Click on the [Print] button if you wish to print the Purchase Invoice. 

To close the page, click the [Cancel] Button. However, click on [Save] first to save the Purchase 

Invoice before closing. 

 

Apply Discount 

Type in the amount or rate of discount in the ‘Apply Discount’ box. 

Choose either Percent (%) or (Dollars $) and click on the [Apply Discount] button. A line will 

be added to the invoice items showing the discount in the Line Total column as a negative as 

well as calculate the adjustment to the GST for the items discounted. 

NOTE: The discount will be calculated from the invoice balance at the time the discount is 

applied, so if you add more lines to the invoice and then apply another discount, the original 
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items will be discounted further. You can remove a discount line like any other invoice item line 

(i.e. select the row, click on the Delete key on your keyboard). 

 

 

Recurring Purchase Invoices 

If you have invoices that are repeated, or have similar item details, you can save them as a 

Recurring Invoice to save time preparing your Sales Invoices. 

First, create or open an invoice that has the relevant item details filled in. Save the invoice by 

clicking on the [Save] button. 

Click on the [Recurring] button (You cannot make a finalised invoice recurring). 

A window will appear prompting you to type in a description for the new Recurring Invoice. 

Click the [Add] button when done. 

To use a Recurring Invoice for a new invoice, add a new invoice, then click the [Recurring] 

button at the bottom of the New Invoice page, and click the Use Recurring Invoice tab. 

Select the description of the saved Recurring Invoice from the list and click the [Use] button. 

The item details will be loaded into the current invoice. Then close this window and save the 

new invoice. 

 

 

Unlock a Purchase Invoice 

If you have locked an invoice, an [Unlock] button will appear on the Purchase Invoice window. 

Click on the [Unlock] button to unlock it and make changes. 

 

Opening Balances (Suppliers) 

If you already have suppliers with outstanding balances when you start to use Invoice Manager, 

you will need to record the balances for accurate reporting. 

The most accurate way is to record each invoice that has a balance outstanding. As a shortcut, 

you may wish to record one invoice for the Opening Balance, so you can apply payments to that 

invoice. 

 

Returns 

Process a Return 

Returns apply when goods you have purchased are returned to the Supplier. To process a Return, 

select the supplier from the Supplier List and click the [Returns] button. 

Click on the [New] button. 

The top left corner displays the supplier’s details and the Return Code. The number will be 

automatically generated based on the next available number. You can change this number if you 

wish, if there is no other saved Return with the same number. 

Record the date you returned the goods. 

Select the Purchase Invoice No. that the returned item applies to using the drop-down arrow. 

The Purchase Invoice details are then displayed, including Invoice Number, Date, Total and 

Amount Owing. 
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Select the Return Type, either a ‘Credit’ when you are expecting a credit to your account or 

‘Refund’ if the value of the return exceeds the outstanding amount on the invoice. 

You can record a Reference Number for the return, for example, if the supplier issues an RA 

(Return Authorisation) consignment. 

Record the item(s) being returned with their tax, price and quantity details. If you wish to 

include an explanation of the return, use the description field to type in the details. This can be 

up to 250 characters. 

You can add a shorter message at the bottom but keep this under 150 characters. 

The [Save] button will save the Return but not assign it. When you are ready to assign it the 

selected invoice, click the [Assign] button. 

A credit will be applied to your invoice and then a credit or refund will be recorded depending 

on the Return Type selected. When you select Refund the amount of the refund will be included 

in the Supplier Inquiry. However, you will need to manually record the refund in Cashflow 

Manager. 

Note: When you click the [Assign] button the Return will be locked from further editing. 

 

Unlock / Unassign a Return 

If changes need to be made to an Assigned Return, you can unassign it, make the changes, and 

then re-assign it again. 

Open the Return from either the Supplier’s Inquiry (by double-clicking the Return) or open the 

Returns List and View/Edit the required Return. 

Click on the [Unassign] button and the Return will be available to edit. 

Make sure you assign it again once editing is completed. 

Money Out 

Process a Payment 

Open the Money Out section by clicking on the [Money Out] button to the right of the Supplier 

List. This will list all the Purchase Invoices waiting to be paid for all suppliers. 

The Payment Date will automatically have today’s date per the computer, but you can change 

this to the actual date the amounts are paid. 

The list of unpaid invoices can be filtered by the Display Options drop-down box. Selection can 

be Show This Month’s Invoices, Show Overdue Invoices or Show All Outstanding Invoices. 

The Select Supplier option allows you to select an Individual Supplier or All Suppliers. 

Record the amounts in this Payment under Amount To Pay next to each invoice. You can also 

select Payment options at the top, from the following options: 

❖ Pay All will record the Amount to Pay column with the total amount owing for each 

invoice listed. 

❖ Pay Overdue will only update the Amount to Pay column with amounts for the overdue 

invoices only. 

❖ Clear All will clear all the amounts in the Amount to Pay column. 

To transfer the payment to Cashflow Manager: 

1. Tick the Transfer to Cashflow Manager Checkbox. 

2. Select the Cashflow Manager account in which to record the payment. 
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3. Select the Column to allocate the payment. 

4. To record the payment on a single line, click in the Group as one entry checkbox. 

5. Click on the [Continue] button. 

6. Allocate the payment to the appropriate allocation column(s), if not already selected 

Click on the [Save] button. Each invoice being paid off will be assigned a separate Payment 

Number so that if a Payment needs to be removed in the future, it won’t affect other invoices that 

were paid at the same time. 

 

Payments for Taxable Payments Contractors with No ABN 

If you have invoice payments due for a supplier that has been identified as a ‘Taxable Payments 

Contractor’ and the invoice is identified as ‘Include in Taxable Payments Report’ and no ABN 

has been recorded for that Supplier, two lines will display. The first will be the amount payable 

to the contractor (net of PAYG Withheld) and the second will be the amount calculated by the 

program as payable to the ATO for PAYG Withheld. 

There is an option to 'Hide PAYG Withholding Records'. This allows you to hide the PAYG 

component, so you can process the payment to the contractor using the ‘Pay All’ or ‘Pay 

Overdue’ options, and then process the payment to the ATO separately. 

 

Printing Cheques 

To use the Cheque Writer module to print cheques for the payments, open the Money Out 

section in Cashflow Manager and add the selected transactions to Cheque Writer from there. 

For more information on printing cheques, see the section on ‘Cheque Writer – Printing 

Cheques’ in ‘Functions Common to All Programs’. 

 

Remove a Money Out Transaction 

1. Select the Supplier and click on the [Supplier Inquiry] button to ascertain the Payment 

Number of the payment to be removed. 

2. Click on the Tools menu and select Remove Money Out Transaction. 

3. Select the Payment Number from the drop-down box and click the [Remove] button. 

4. A message informing you the payment has been deleted. If you had entered this payment 

into Cashflow Manager, you will need to manually remove it from Money Out. 

 

Apply Overpayments 

An overpayment may occur if you pay more than the balance of an invoice. The overpayment 

amount will be saved as credit with the Supplier, to be used to pay off another invoice. Note: 

Overpayments cannot be applied where you are using Taxable Payments for Contractors and the 

supplier does not provide an ABN. 

To apply the overpayment to another invoice, select the supplier in the Supplier List and click on 

the [Apply Overpayment] button. 

1. Change the date as necessary. 

2. Click on the drop-down arrow next to the Invoice Selected box to display a list of the 

supplier’s invoices with outstanding balances. Select the required invoice. 

The invoice details will display and the Credit to Apply will pre-fill with the amount of 

credit remaining or the ‘Balance Outstanding’ on the invoice. Edit the amount if necessary. 
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Click on the [Save] button. 

3. If the credit is refunded to you, click on the [Refund] button rather than selecting an invoice. 

To transfer the receipt to Cashflow Manager: 

1. Tick the Transfer to Cashflow Manager Checkbox. 

2. A field will appear to select the Cashflow Manager account for recording the payment. 

3. Click on the [Continue] button. 

4. Allocate the amount to the appropriate allocation column. 

5. Click on the [Save] button. 

 

 

Remove an Overpayment 

Overpayments can be removed from Invoices without the need to remove the payment that 

created the overpayment/credit. 

To remove an overpayment, click on Tools/Remove Overpayment. Select the overpayment by 

clicking in the checkbox and click [Remove]. 

 

Reports (Suppliers and Purchases) 

The Reports tab in the Invoice Manager section lists reports for Sales, Purchases (GOLD only) 

and Inventory. 

 

Report Options - Purchases 

Once a report is selected, there are options to select different parameters for the generation of the 

report. The Report Options listed in the following table are: 

D – Date Period. Choose a report date range from Last Month, Last Quarter, Last Year, This 

Month, This Quarter, This Year or Custom (select report start and end periods where 

appropriate). 

eD- End Date Only. Report relates to a specific period and the only option is to select an end 

date for the report. 

E – Includes reports formatted especially for Microsoft Excel. 

F – Filter report. Report will show information based on filters e.g. Detailed or Summary, 

Include Invoice Manager balances, Single or Multiple Columns etc. 

S – Supplier selection. Choose either All Suppliers or Select Suppliers (open a list of all 

suppliers to select from). 

T – Type of printout. Choice of print layout or specific print media. 

 

 

Types of Reports – Suppliers/Purchases 

The following table summarises the reports available in the Invoice Purchases (Suppliers) 

section. More information is included below for reports highlighted by an asterisk*. 
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REPORT DESCRIPTION Report 

Options 

Activity: Summary of purchases and supplier activity for the period. D 

Aged 

Creditors: 

Classifies outstanding balances according to age from the 

date of the finalised invoice. Net invoices are classified into 

‘0-30’ days, ‘31-60’ days, ‘61-90’ days & ‘91+’ days from 

the selected Date. 

eD, E, F, T 

GST:* The totals from the GST types used in your invoices and 

your returns for the selected period 

D, F, T 

Processed 

Payments 

List: 

Lists all payments (money out) applied to invoices S, D, T 

Purchase 

Invoices: 

Invoices created during the period with options to include 

All, Outstanding or Unprinted Invoices. 

S, D, F, T 

Purchase 

Orders: 

Purchase orders created. S, D, F 

Purchases by 

Item: 

Lists the item, unit price and number of all or selected items 

in the Inventory List purchased from each supplier together 

with the total purchases 

D, E, F, T 

Purchases by 

Supplier: 

Invoices recorded for each supplier. Also has choices for 

sorting the information. 
S, D, F, T 

Returns: Documentation to accompany your returns S, D, F 

Supplier 

Balance: 

Lists the balance owed to suppliers. The detailed report also 

includes the outstanding invoices. 

S, E, F, T 

Supplier 

List: 

The summarised supplier list provides a list of suppliers 

including supplier name, contact, address, phone, and fax 

details. The detailed list also includes the second phone, e- 

mail and terms. 

S, E, F, T 

Taxable 

Payments: 

Reports Total Payments, GST and PAYG Withheld to 

suppliers identified as subject to the Building and 

Construction Taxable Payments Reporting requirements 

(Note: This report will only appear if the option to ‘Use 

Taxable Payments for Contractors’ has been selected.) 

S, D, F, T 

 

GST: 

❖ The Purchases GST report is designed to match the ‘Inputs’ section of the Tax Office GST 

Worksheet. It reports the totals from the GST ‘types’ used in your invoices and your 

adjustment notes. 

Section 1 calculates the totals from your Supplier Invoices. 

Section 2 calculates the total from your Returns. The amount at G17 in the Returns section 

of the report can be transferred to box G7 on the GST Worksheet as they are an increasing 

adjustment. Alternatively, you can subtract the amounts from boxes G10 to G17. 

Section 3 provides adjusted totals that can be used for adjustments to boxes G10 to G17. 

❖ The Sales and Purchases GST Report provides the GST Calculation Worksheet 

information for both sales and purchases. 
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❖ These reports are also available as ‘Closing Balance’ reports providing the same information 

as the primary reports but only including closing balances at the selected date. This will 

provide you with the closing balance information to combine with your Cashflow Manager 

GST Report if you are lodging your BAS on the ‘accruals’ method. 

 

Inventory 

Inventory Items make it easy to prepare your invoices and provide you with management 

information to help run your business. 

Some features of the Inventory are only available in the Cashflow Manager GOLD edition. 

However, both versions of Cashflow Manager allow you to list Sell Items for use in Sales 

Invoices, manage Sell Prices, and Import and Export Inventory data. 

The GOLD edition includes extra features such as Supplier, Category, Buy Items, Sell/Buy 

Items, Reorder Levels and Quantities, automatically adjusted On Hand values and track 

inventory on items that are bought and sold. 

When you click on the Inventory tab in the Invoice section, the Inventory List will display. 

This consists of: 

Inventory List: The Inventory List lists your inventory together with ‘summary’ information 

about each item. Generally, all items will be listed, but you can select to just see Buy Items, Sell 

Items or Sell/Buy Items by selecting that option on the top left of your screen. 

Note that if you have Cashflow Manager then the Inventory section will only include the Sell or 

Customer options. If you have Cashflow Manager GOLD, the Inventory will include both 

Customer and Supplier (Sell and Buy and Track Inventory) options. 

The Inventory List can be sorted by any of the columns by clicking on the column heading at the 

top of the list. 

A triangle to the right of the column name will indicate the sort order of the column: an ‘up’ 

triangle indicates ascending order, and a ‘down’ triangle descending order. 

To quickly and easily search for an inventory item, sort by Description and then type the first 

few letters of the Description. The closest match will be highlighted in the list. 

Function Buttons: To the right of the Inventory List are buttons for the common functions 

undertaken in the program. These are divided into groups: Items and Inventory. 

Each function button performs a different task in the program. They allow you to add, edit or 

delete items as well as track inventory (GOLD), modify prices and import inventory items. 

 

Inventory Items 

The Inventory consists of Items. Items make it easy to create all sorts of invoices, orders and 

adjustments. An Item can be: 

• A physical item that you buy and sell. 

• A physical item you buy. For example: you may buy items that are incorporated as 

components into a manufactured product. 

• A physical item you sell. For example: a manufactured product. 

• A service item that you record in the inventory section, so you have standard 

descriptions and prices to make invoicing easier. 

‘Labour’ is an example of a ‘service’ item. 
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Another example is the standard descriptions that some businesses have for numerous 

services that make up an invoice. These can be recorded as inventory items and selected 

when the invoice is being created. 

If you are using Cashflow Manager GOLD, you can also track physical inventory items that are 

bought and sold so that you know the number and value of items in stock. 

 

Track Inventory Overview (GOLD Only) 

You can track inventory items that are bought and sold so that you know the number and value 

of items in stock. 

Not all inventory items are tracked. Only items that are Buy/Sell can be, and only those where 

you select to track inventory in the Add Inventory or Modify Inventory functions will be tracked. 

When you first commence to track an inventory item you need to record the quantity on hand 

(opening quantity) and the opening value of that item. 

Thereafter, transactions affecting that item are tracked as follows. 

1. Supplier Transactions 

a. Items in purchase invoices will increase Inventory on Hand 

b. Returns will decrease Inventory on Hand 

2. Customer Transactions 

a. Items in sales invoices will decrease Inventory on Hand 

b. Adjustment Notes will increase Inventory on Hand 

Then there is the unknown. The Inventory on Hand may change because of pilferage, 

breakage, or other reasons. These require manual adjustments which are performed in 

[Modify Item] for individual items, or by using the [Track Inventory] button on the 

Inventory List page. 

The following diagram provides an overview of the Track Inventory process. 
 

 

 

Add a New Item 

To add a new item to the inventory, click the [Add Item] button. The New Inventory Item 

window will appear. Depending on which version of Cashflow Manager you have, different 
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options may appear. Therefore, some of the following descriptions will only be relevant if you 

have Cashflow Manager GOLD or if you have selected the Sell/Buy option. 

NOTE ON PRICING AND GST: The values you enter for price depends on whether you have 

chosen for Invoice Manager to use GST Inclusive or GST Exclusive prices. GST Exclusive 

means the program will add GST to any values you enter. 

1. Select whether the item is one that you Sell Only (including physical and service items), one 

that you Buy Only, or one that you both sell and buy (Sell/Buy). 

2. Select the Category that applies to the item (refer to Maintain & Assign Categories) 

3. Sell Details: Sell Details are only active if Sell Only or Sell/Buy item types are selected. 

a. Type in a unique Sell Code for the product. (If you type in a code that already exists 

you will receive a message asking you for a new code when you click on [Save].) 

b. Record the description (up to 250 characters) that you want to generally appear onyour 

invoices in the Sell Description box. 

c. Select the Sell Tax Code to allocate the correct GST to the product. Note that the 

Description, Sell Tax Code and Sell Price can be changed for individual invoices 

where the standard option does not apply. 

d. Record the Sell Price. 

i. If you use GST Exclusive Prices, the Sell Price would be excluding GST. If you 

have selected to use GST Inclusive Calculations, then record the GST Inclusive Sell 

Price. 

ii. If you are using different Customer Types, record the Sell Price for each Customer 

Type. 

Note: There is no need to record a price for a ‘Service Item’ that will form part of a 

composite list of items with one overall price at the end of the list. 

4. Buy Details 

a. If you have selected Buy/Sell, as you record your ‘Sell’ information the Buy Code, Buy 

Description and Buy Tax Code duplicate what has been entered. Change these as 

required. For example, the Buy Code should match the Item Number of your main 

supplier. 

b. Record the current Buy Price. 

c. Record the Supplier Code. This is not mandatory as sometimes the same item may be 

purchased from more than one supplier. However, selecting the Supplier Code will 

match the Buy Code to a Supplier to make it easier when you are creating Purchase 

Orders and recording invoices from suppliers. 

5. Quantities 

Quantities only apply if you want to track inventory levels for an item. For such items the 

opening quantity and value needs to be recorded for accurate reporting. 

a. To track inventory levels on an item, click on the Track Inventory? Checkbox. 

b. Click on the [Opening Inventory] button. 

i. Record the Initial Value Date. This is the date from which you are commencing to 

track inventory. See ‘Inventory Tracking’ for more details. 

ii. Record the Initial Quantity on hand for this item. 

iii. Record either the Average Cost per Item or the Total Value of Opening Inventory. 

(The alternate field will calculate for you.) 

iv. Click [Close]. 

c. Record the Reorder Level for this item if you have one. 
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d. Record the standard Reorder Quantity for this item. 

6. Click on [Save] to save and exit or [Save & New] to save this item and add another. 

 

 

Modify an Item 

To modify an item’s details, including adjusting stock levels and pricing, select the item from the 

Inventory List and click the [Modify Item] button. 

The Quantities section now has a [Current Inventory] button instead of [Opening Inventory] 

as well as On Hand information for any items that are tracked. Sometimes your inventory will 

require manual adjustment, e.g. because of loss, theft or breakage. You can adjust the amount 

shown by clicking on the [Adjust] button and entering the amount in the box provided. 

The Current Inventory Value summarises the quantity on hand and value of inventory on hand at 

any time. It will include the Opening Inventory plus any transactions that have occurred since 

the Opening Inventory date. Click [Close] to return to the Inventory Item. 

To start tracking an inventory item, click on the Track Inventory checkbox. Click on the 

[Current Inventory] button, then on [Opening Inventory] and record the Opening Quantity 

and Value. Click on [Close] to return to the Current Inventory Value and [Close] again to 

return to the Edit Inventory Item page. 

Make the required changes, and click the [Save] button, or click the [Cancel] button to exit 

without saving changes. The Sell and/or Buy Code must still be unique. 

 

Delete an Item 

Select the item from the list and click the [Delete Item] button. You will be prompted if you are 

sure you wish to delete the item, click [Yes] to do so. The item and all its details, including stock 

levels will be permanently deleted. This will not affect previously saved invoices. 

 

 

Categories 

Inventory Items can be assigned to a Category to give flexibility in reporting, price changes etc. 

 

Manage Categories 

To add a new category, click on the [Manage Categories] tab on the main Inventory List screen. 

The ‘Add’ option will automatically be selected. Type in the category name and press [Save]. 

To edit the name of an existing category, click on the [Manage Categories] tab. Select the 

‘Edit’ option, choose the category from the drop-down menu, edit the name, and click [Save]. 

To delete a category, click on the [Manage Categories] tab. Select the ‘Delete’ option, choose 

the category from the drop-down menu, and click [Delete]. 

 

Assign Categories 

You can assign a category to an individual item by selecting a category from the “Category” 

drop-down menu when adding or modifying the item. 

To assign categories to multiple items, click on the [Assign Categories] button on the main 

Inventory List screen. 
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The inventory items for all Suppliers are loaded by default. You can filter the list by using the 

Select Supplier drop-down menu. Tick the checkbox next to the Supplier(s), and select the 

category from the Category to Assign dropdown list. To save the selections, click the [Assign] 

button. 

The Supplier & Category names can be seen on the Inventory List screen. 

 

Modify Prices 

1. Individual Items 

Select the item from the Inventory List and click on the [Modify Item] button. Change the price 

and click [Save]. 

2. Multiple Items 

To modify the Sell or Buy prices for multiple items marked as Sell, Buy, or Sell/Buy, click the 

[Modify Prices] button to the right of the Inventory List. 

This will display the list of items (which can be sorted by clicking on the column headers) 

together with the Sell/Buy Code, Sell/Buy Description, Supplier, Category, Sell/Buy Price 

(including prices for Customer Types you have established) and the date last modified. 

Click on the price you wish to change and record the new price. 

To decrease the price, type in a negative amount. If this occurs, the price will not be changed if 

the result is less than zero. There will be no modifications to zero prices that are loaded. 

If you wish to modify all prices at once, ensure you have a backup and then click on the [Modify 

All] tab at the bottom of the screen. 

1. Select the prices you wish to modify, by clicking in the appropriate checkbox. 

2. Select the type of price change, by clicking on the drop-down menu and selecting 

Percent or Dollar. 

3. Type the amount of the change. (Type in as a negative if prices are being decreased.) 

4. Click [OK]. 

Click on the [Save] button when you have finished. In fact, we would recommend to periodically 

click the [Save] button to save along the way. Then click on the [Cancel] button to close the 

page and return to the Inventory list. 

 

 

Count Inventory Items (Stock-take) 

An Inventory Count (or Stock-take) is a count of your inventory to ensure that the physical count 

agrees with your accounting records. 

Make sure all Invoices, Adjustment Notes and Returns are processed before counting your stock 

to ensure that your Adjusted Inventory is accurate. 

Before beginning, it is recommended to back up your data file. 

Click on the [Track Inventory] button. 

Click on the [Print] button to print an ‘Inventory Count’ report that lists tracked items ready 

for physical counting. The ‘On Hand’ quantity on the report will be the quantity per your records 

at that time. 

Count the actual items in stock and record the amount on the ‘Inventory Count’ report printout. 

NOTE: You can exit from the Track Inventory page while the count is being conducted but the 

‘On Hand’ quantity will change if you record an Invoice, Adjustment Note or Return prior to 

recording the count. It is therefore advisable not to process Invoices, Adjustment Notes or 
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Returns while an Inventory Count is being conducted. If you do, the changes need to be 

manually accounted for in the count. 

Once the count is complete, enter the counted quantities into the Count column for each item. 

To carry out the adjustment, click on the [Adjust Inventory] button (make sure all invoices that 

affect your inventory up to and including the Count Date have been recorded first). The On 

Hand values will be updated to reflect the quantity entered into the Count column. 

If you need to exit this page before adjusting amounts, click the [Save] button to save the Count 

entries, but not adjust the On-Hand amounts just yet. 

 

 

 

 

Reports (Inventory) 

The Reports tab in the Invoice Manager section lists reports for Sales, Purchases (GOLD only) 

and Inventory. 

 

Report Options - Inventory 

Once a report is selected, there are options to select different parameters for the generation of the 

report. The Report Options listed in the following table are: 

D – Date Period. Choose a report date range from Last Month, Last Quarter, Last Year, This 

Month, This Quarter, This Year or Custom (select report start and end periods where 

appropriate). 

eD- End Date Only. Report relates to a specific period and the only option is to select an end 

date for the report. 

E –Includes reports formatted especially for Microsoft Excel. 

F – Filter report. Report will show information based on filters e.g. Detailed or Summary, 

Include Invoice Manager balances, Single or Multiple Columns etc. 

I – Item selection. Choose either All Items or Select Items (open a list of all items to select 

from). 

T – Type of printout. Choice of print layout or specific print media. 

 

 

Types of Reports – Inventory 

The following table summarises the reports available in the Invoice Purchases (Suppliers) 

section. More information is included below for reports highlighted by an asterisk*. 
 

 

 

REPORT DESCRIPTION Report 

Options 

Inventory 

Adjustments: 

(GOLD only) 

A report of all adjustments made to your tracked 

inventory items including the Buy Code and Buy 

Description, together with the Adjustment Quantity. 

D, T 
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Inventory 

Count: (GOLD 

only) 

A list of tracked inventory items together with the current 

quantity on hand for conducting a manual inventory 

count. 

T 

Items List: A list of items in your inventory. 

Options are to include All Items or Selected Items. 

Cashflow Manager GOLD also has the options to include 

Buy Only, Sell Only or Buy/Sell items and includes the 

Quantity On Hand. 

I, T 

Price List: A list of Sell items including descriptions and prices. If 

you use Customer Types, you can choose to print the 

report for a selected Customer Type. 

I, T 

Inventory 

Movement: 

(GOLD only) 

Reports the movement in your tracked inventory items. 

The Summary report summarises the total movement 

while the Detailed reports include details of transactions. 

D, F, T 

Inventory 

Reorder:(GOLD 

only) 

A list of tracked inventory items where the reorder level 

has been reached. 
T 

Inventory 

Valuation: 

(GOLD only) 

A list of tracked inventory items including on hand values 

and total inventory valuation. 

The summary report lists the Quantity On Hand, the 

Average Cost and the Value of the Inventory Items on 

Hand. The detailed report also includes the Opening 

Quantity and Opening Value as well as the Movement in 

Quantity. 

NOTE: Invoice Manager uses the Average Cost method 

to value inventory. The Average Cost is calculated by 

combining the Total Cost of Purchases with the Opening 

Value and dividing this by the Opening Quantity plus 

Quantity Purchased. The Average Cost is then multiplied 

by the Quantity on Hand to calculate the Closing Value. 

eD, F, I, T 

 

Other Functions 

Customise Layouts 

Sales Invoices, Adjustment Notes, Picking Slips, Purchase Orders, Purchase Invoices, Receipts 

or Statements 

Invoice Manager has standard layouts for Invoices, Adjustment Notes, Picking Slips, Purchase 

Orders, Purchase Invoices, Receipts and 2 standard layouts for Statements included with the 

program. To use these standard layouts, see the section ‘Invoice Design (Layouts)’ in the 

‘Options’ section. 

If you have Microsoft® Word installed, another alternative is to print your invoices and others 

using Microsoft Word. If you would like to use Word, see the section on ‘Printing Invoices 

Using Microsoft Word’. 
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You can also follow these steps to customise the layouts for your requirements. 

To customise the layout for any printout within Invoice Manager, click on the Tools menu, 

select Customised Layouts and then choose which layout you wish to customise. 

The Customise Layout page will open, showing a menu and icons at the top, the layout area on 

the left and the object properties on the right. 

The icons (from left to right) are as follows: 
 

1. Load a Layout 

2. Save a Layout 

3. Cut 

4. Copy 

5. Paste 

6. Delete Selected Item 

7. Change Font of All Text 

8. Insert Text Box 

9. Insert a Line 

10. Insert a Box 

11. Insert Picture Box 

 

Load a Layout 

The first step is to load an existing standard layout. 

The standard layouts include: 

❖ General Invoice – Item Code Layout 

❖ General Invoice – No Item Code Layout 

❖ Service Invoice 

❖ Professional Invoice 

❖ Medical Layout 

There is also an option to include a remittance advice with credit card options in the standard 

layout. 

If you have not already selected your standard layout and options, click on the Options icon and 

select Invoice Layout Settings. Make your selections and click on [Save]. 

Now you are ready to Load the Layout. 

You will be given the option to ‘Load Invoice Layout’ when you first select to customise a 

layout. If the Customise Layout window is already open, click on the File menu on the 

Customise Layout screen and select Load Layout, or click on the Load Layout icon. Select the 

Default Layout and click on the [Load] button. 

This will load the default layout into the Layout section. 

The layout consists of 3 sections: 

❖ Header: includes Company and Customer/Supplier information 

❖ Detail: includes the transaction information 

❖ Footer: includes totals and remittance information 

There are four main elements in a Customised Layout: 

1. Text Boxes (boxes that contain text) 

2. Lines 

3. Picture Boxes (boxes that contain pictures such as your logo) 

4. Data Line Control (Detail section) 

To edit an individual object, click on the object to select it. The object name will show at the top 

right. You can then drag it to a different location, resize it by positioning your mouse over the 

edit nodes and dragging, or edit it using the properties in the top right corner. 
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To select multiple objects, click and draw a box around the objects to be selected. 

 

Text Boxes 

Text Boxes serve three purposes: 

1. Labels. Normally to identify data fields on the printout, can also be plain text, which does 

not change. These types of text boxes have a fuzzy grey border. 

2. Data field with global information. Contains constant information, such as: your Company 

Name or Company Address. It is a Constant Text Box for all layouts. These types of text 

boxes have a solid blue border. 

3. Data field with dynamic information. Contains information gathered from the specific 

document being printed i.e. customer invoice, receipt, purchase order, etc. Information for 

example: customer details, item details, date, invoice number, etc. These types of text boxes 

also have a solid blue border. 

To create a new Text Box, click on the Insert Text Box icon on the tool bar or click on the 

Insert menu and select Insert Text Box. You can also right-click on the layout page and select 

the Insert Text Box menu option. 

The new Text Box will be created in the top left-hand corner of the page, with a name like 

‘Label2’. 

Drag the Text Box to where you want it on the layout by clicking and holding the left mouse 

button on the Text Box, and then moving the mouse to the new position. When in position, let go 

of the mouse button. 

To edit the displayed text in a Text Box, right-click on the Text Box, select Edit Text, and 

change the ‘Text’ field in the object properties on the right side of the screen. If you right click 

on a Text Box you can also edit the font type, style and size, copy the text box or delete it. 

To change the Text Box into a Data Field, change the Data property from ‘False’ to ‘True’. 

Then right-click the box, and select Set Data Field, and choose the data field from the pop-up 

window. There are three tabs separating different information, with fields in each. The third tab 

will contain fields relevant only to the current layout, such as the Invoice Details in the case of 

an Invoice Layout. 

 

Lines 

To create a new Line, click on the Insert Line icon on the tool bar or click on the Insert menu 

and select Insert Line. You can also right-click on the layout page and select the Insert Line 

menu option. 

The new Line will be created in the top left-hand corner of the page, with a name like ‘Line2’. 

Drag the Line to where you want it on the layout by clicking and holding the left mouse button 

on the Line, and then moving the mouse to the new position. When in position, let go of the 

mouse button. 

When you select a Line, a small red resizing square appears at either end of the Line. Hold and 

drag your left mouse button on the square to reposition the end point of the Line. 

The thickness and colour of a Line can be edited by the Line Width and Line Colour 

properties. The Line style can also be edited with the Line Style property. 

To delete a Line right-click on the Line and select ‘Delete’. 
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Picture Boxes 

To create a new Picture Box, click on the Insert Picture Box icon on the tool bar or click on the 

Insert menu and select Insert Picture Box. You can also right-click on the layout page and 

select the Insert Picture Box menu option. 

The new Picture Box will be created in the top left-hand corner of the page, with a name like 

‘Picture2’. 

Drag the Picture Box to where you want it on the layout by clicking and holding the left mouse 

button on the Picture Box, and then moving the mouse to the new position. When in position, let 

go of the mouse button. You may have to move slowly as it redraws the box as it moves. 

To Set or Change the picture in a Picture Box right click on the box and select Set Picture. 

Choose a valid picture file in the format of a BMP, GIF, JPG or JPEG, and click the [Open] 

button to add the picture to your layout. 

Once you have inserted a picture you may need to resize the box to fit the picture. To do this, use 

the properties on the right side. The properties include the distance from the top and the left of 

the page as well as the Height and Width of the picture box. It also contains Size Mode that 

provides options for Normal, Stretch Image, Auto Size and Centre. 

To avoid loss of quality, it is preferable for the original image file to be the right size for the 

document. To determine the size of the original image, change the Size Mode property to ‘Auto 

Size’, and then click on the Picture Box so the Height and Width of the Picture Box will be 

displayed in the properties. You can change the Height and Width properties to adjust to the size 

you require, ensuring that you keep them in proportion to the original picture size. 

Change the Size Mode property again to ‘Stretch Image’. You may need to click on the Picture 

Box again to view the adjustment. 

To delete a Picture Box right-click on the box and select ‘Delete’. 

 

Detail Section (Data Line Control) 

The Data Line Control applies to all layouts except the Receipt and Statement layouts. 

The Data Line Control is the only object in the Detail Section. It includes data fields for the 

transaction details. For example, on a Sales Invoice the Data Line Control has fields for Item 

Code, Description, Unit Price, Quantity, GST and Total Price. 

The individual fields are always kept on the same horizontal line to ensure they are aligned 

correctly when they print. 

To change the fields that display in the Invoice Details (e.g. to include the extra ‘Date’ column 

or to remove the ‘Item Code’) right click in white space in the Detail Section and click on the 

box to select or deselect the field. 

Added fields will appear at the beginning of line. Click and drag the fields to change the order. 

You can also resize the fields but make sure they do not overlap to avoid printing over each 

other. 

Individual fields can be edited for their size, font and colour as appropriate using the properties 

on the right side of the window. 

 

Save and Load Customised Layouts 

To save your Customised Layout, click on the Save Layout icon from the toolbar or click on the 

File menu and select Save Layout. There are three slots to save each layout into. Select the slot 

to save into and name the layout. Click the [Save] button. 
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Print Invoices with Microsoft Word 

To print using Microsoft Word you must have Microsoft Word installed on this computer. 

Version 14 is compatible with MS Word 2007-2016. The option to use Word for printing must 

be enabled in the Options. To do this, click on the Tools menu, select Options and then 

Microsoft Word Settings. 

Tick the sections you wish to use Word for printing and click the [Browse] button for each to 

select the Word template file to use. A default template will be selected if no change is made. 

Once you have chosen to print using Microsoft Word, your selected printouts will automatically 

open Microsoft Word when you click on the [Print] button. 

When you close the Microsoft Word page you have the option to save the document if you wish, 

the default location is the ‘C:\Users\Username\AppData\Roaming\CFM\Cashflow14\Data’ 

folder. 

To remove the option to print using Word, click on the Options, select Microsoft Word 

Settings and un-tick the selection boxes for the items you do not wish to use. 

 

Creating a Word Template 

To set up your own template, start by using an existing template that comes with the Invoice 

Manager program. Make a copy of the original before making changes. 

The existing templates are stored in subfolders of the program folder, by default installed to 

“C:\Users\Username\AppData\Roaming\CFM\Cashflow14\Templates”. There is a subfolder 

for each template type i.e. Invoice, Adjustment Note, Purchase Invoice, Purchase Order, 

Receipts, Returns and Statements. 

Invoice Manager fills in the data fields from the information gathered from the document, and 

company details. On the template, each data field is denoted by square brackets. For example, 

[MyCompName] will display your Business Name. It will NOT print the words 

“MyCompName”. 

A list of field markers is set out in the table below. You can add each field marker as many times 

as you like. However, the field marker will need to match exactly to the one in the list, including 

capitals. 

 

Special Considerations 

The template has three parts: 

1. Supplier and Customer address details 

2. Transaction Details 

3. Totals 

The Transaction (Invoice Line) Details and Totals must be kept in the tables already provided. 

If you add other tables to the templates, use the ‘Advanced Template Settings’ in Options – 

Microsoft Word Settings to control the position of the tables required by the template to work 

correctly. 

 

Codes / Field Markers for Word Templates 
 

Marker Field Description Invoice Adjust- 

ment 

Note 

Purchase 

Invoice 

Purchase 

Order 

Receipts Returns Statements 
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My Company Details        

[ABN] Your ABN ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

[WPN] Your WPN ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

[MyCompName] Your Company Name ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

[MyAdd1] Your Address Line 1 ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

[MyAdd2] Your Address Line 2 ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

[MyCity] Your City ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

[MyState] Your State ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

[MyPC] Your Post Code ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

[MyPhone] Your Phone Number ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

[MyFax] Your Fax Number ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

[MyEmail] Your Email Address ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

[MyCountry] Your Country ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

[MyPhoneAlt] Your Phone Alternate ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

[MyPhoneMob] Your Phone Mobile ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

[MyLicenseNo] Your license Number ✓ 
      

[MyWebAddress] Your Web Address ✓ ✓ 
 

✓ ✓ ✓ ✓ 

Customer Details        

[CustCode] Customer Code ✓ ✓ 
  

✓ 
 

✓ 

[CustABN] Customer ABN ✓ ✓ 
  

✓ 
 

✓ 

[CustName] Customer Contact Name ✓ ✓ 
  

✓ 
 

✓ 

[CustCompName] Customer Company Name ✓ ✓ 
  

✓ 
 

✓ 

[PAdd1] Postal Address Line 1 ✓ ✓ 
  

✓ 
 

✓ 

[PAdd2] Postal Address Line 2 ✓ ✓ 
  

✓ 
 

✓ 

[PCity] Postal City ✓ ✓ 
  

✓ 
 

✓ 

[PState] Postal State ✓ ✓ 
  

✓ 
 

✓ 

[PPC] Postal Post Code ✓ ✓ 
  

✓ 
 

✓ 

[PCountry] Postal Country ✓ ✓ 
  

✓ 
 

✓ 

[DAdd1] Delivery Address Line 1 ✓ ✓ 
  

✓ 
 

✓ 

[DAdd2] Delivery Address Line 2 ✓ ✓ 
  

✓ 
 

✓ 

[DCity] Delivery City ✓ ✓ 
  

✓ 
 

✓ 
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[DState] Delivery State ✓ ✓ 
  

✓ 
 

✓ 

[DPC] Delivery Post Code ✓ ✓ 
  

✓ 
 

✓ 

[DCountry] Delivery Country ✓ ✓ 
  

✓ 
 

✓ 

[Phone] Customer Phone Number ✓ ✓ 
  

✓ 
 

✓ 

[PhoneAlt] Customer Phone Alternate ✓ ✓ 
  

✓ 
 

✓ 

[PhoneMob] Customer Phone Mobile ✓ ✓ 
  

✓ 
 

✓ 

[Fax] Customer Fax Number ✓ ✓ 
  

✓ 
 

✓ 

[Email] Customer Email Address ✓ ✓ 
  

✓ 
 

✓ 

[CustE1] Customer Details Extra Field 1 ✓ ✓ 
  

✓ 
 

✓ 

[CustE2] Customer Details Extra Field 2 ✓ ✓ 
  

✓ 
 

✓ 

[CustE3] Customer Details Extra Field 3 ✓ ✓ 
  

✓ 
 

✓ 

[CustE4] Customer Details Extra Field 4 ✓ ✓ 
  

✓ 
 

✓ 

Supplier Details        

[SupCode] Supplier Code 
  

✓ ✓ 
 

✓ 
 

[SupABN] Supplier ABN 
  

✓ ✓ 
 

✓ 
 

[SupName] Supplier Contact Name 
  

✓ ✓ 
 

✓ 
 

[SupCompName] Supplier Company Name 
  

✓ ✓ 
 

✓ 
 

[PAdd1] Postal Address Line 1 
  

✓ ✓ 
 

✓ 
 

[PAdd2] Postal Address Line 2 
  

✓ ✓ 
 

✓ 
 

[PCity] Postal City 
  

✓ ✓ 
 

✓ 
 

[PState] Postal State 
  

✓ ✓ 
 

✓ 
 

[PPC] Postal Post Code 
  

✓ ✓ 
 

✓ 
 

[PCountry] Postal Country 
  

✓ ✓ 
 

✓ 
 

[DAdd1] Delivery Address Line 1 
  

✓ ✓ 
 

✓ 
 

[DAdd2] Delivery Address Line 2 
  

✓ ✓ 
 

✓ 
 

[DCity] Delivery City 
  

✓ ✓ 
 

✓ 
 

[DState] Delivery State 
  

✓ ✓ 
 

✓ 
 

[DPC] Delivery Post Code 
  

✓ ✓ 
 

✓ 
 

[DCountry] Delivery Country 
  

✓ ✓ 
 

✓ 
 

[Phone] Supplier Phone Number 
  

✓ ✓ 
 

✓ 
 

[PhoneAlt] Supplier Phone Alternate 
  

✓ ✓ 
 

✓ 
 

[PhoneMob] Supplier Phone Mobile 
  

✓ ✓ 
 

✓ 
 

[Fax] Supplier Fax Number 
  

✓ ✓ 
 

✓ 
 

[Email] Supplier Email Address 
  

✓ ✓ 
 

✓ 
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[SupE1] Supplier Details Extra Field 1 
  

✓ ✓ 
 

✓ 
 

[SupE2] Supplier Details Extra Field 2 
  

✓ ✓ 
 

✓ 
 

[SupE3] Supplier Details Extra Field 3 
  

✓ ✓ 
 

✓ 
 

[SupE4] Supplier Details Extra Field 4 
  

✓ ✓ 
 

✓ 
 

[PONo] Purchase Order Code 
   

✓ 
   

[PODate] Purchase Order Date 
   

✓ 
   

[PORef] Purchase Order Reference 

Number 

   
✓ 

   

[POMess] Purchase Order Message 
   

✓ 
   

[PINo] Purchase Invoice Code 
  

✓ 
    

[PIDate] Purchase Invoice Date 
  

✓ 
    

[PITerms] Purchase Invoice Terms 
  

✓ 
    

[PIDueDate] Purchase Invoice Due Date 
  

✓ 
    

[PIRef] Purchase Invoice Reference 

Number 

  
✓ 

    

[PIMess] Purchase Invoice Message 
  

✓ 
    

[RetNo] Return Code 
     

✓ 
 

[RetDate] Return Date 
     

✓ 
 

[RetMess] Return Message 
     

✓ 
 

Document Details        

[InvNo] Invoice Code ✓ ✓ 
     

[InvDate] Invoice Date ✓ 
      

[InvTy] Invoice Type ✓ 
      

[InvPON] Purchase Order Number ✓ 
      

[JobNo] Job Number ✓ 
      

[InvE1] Invoice Extra Field 1 ✓ 
      

[InvE2] Invoice Extra Field 2 ✓ 
      

[InvE3] Invoice Extra Field 3 ✓ 
      

[InvE4] Invoice Extra Field 4 ✓ 
      

[InvST] GST: Invoice Total Inc GST ✓ 
      

[InvET] Invoice Total Ex GST ✓ 
      

[InvT] GST: GST Total ✓ 
      

[InvAP] Invoice Amount Received ✓ 
      

[InvIB] Invoice Balance Owing ✓ 
      

[InvMess] Invoice Message ✓ 
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[PONo] Purchase Order Number 
   

✓ 
   

[PODate] Purchase Order Date 
   

✓ 
   

[POST] Purchase Order Total Inc GST 
   

✓ 
   

[POET] Purchase Order Total Excl GST 
   

✓ 
   

[POT] Purchase Order Total GST 
   

✓ 
   

[POMess] Purchase Order Adj Message 
   

✓ 
   

[PIET] Purchase Invoice Total Exc GST 
  

✓ 
    

[PIST] Purchase Invoice Total Inc GST 
  

✓ 
    

[PIT] Purchase Invoice Total GST 
  

✓ 
    

[PIAP] Purchase Invoice Amount Paid 
  

✓ 
    

[PIIB] Purchase Invoice Balance 
  

✓ 
    

[RetET] Return Invoice Total Exc GST 
     

✓ 
 

[RetST] Return Invoice Total Inc GST 
     

✓ 
 

[RetT] Return Invoice Total GST 
     

✓ 
 

[AdjNo] Adjustment Note Code 
 

✓ 
     

[AdjDate] Adjustment Note Date 
 

✓ 
     

[AdjST] GST : Adjustment Total Inc GST 
 

✓ 
     

[AdjET] Adjustment Total Ex GST 
 

✓ 
     

[AdjT] GST : GST Total 
 

✓ 
     

[AdjMess] Adjustment Note Message 
 

✓ 
     

[RecNo] Receipt Number or Code 
    

✓ 
  

[RecDate] Receipt Date 
    

✓ 
  

[RecAmt] Receipt Total 
    

✓ 
  

Transaction Details        

[ILA] Invoice Line Sell Price x Quantity ✓ 
      

[ILC] Invoice Line Sell Code ✓ 
      

[ILD] Invoice Line Description ✓ 
      

[ILG] Invoice Line GST/Tax amount ✓ 
      

[ILUP] Invoice Line Unit Sell Price ✓ 
      

[ILNU] Invoice Line Number of Units 

Quantity 

✓ 
      

[ILT] Invoice Line Total ✓ 
      

[ILDT] Invoice Line Extra Field Custom ✓ 
      

[ALA] Adjustment Line Sell Price x 

Quantity 

 
✓ 
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[ALC] Adjustment Line Sell Code 
 

✓ 
     

[ALD] Adjustment Line Description 
 

✓ 
     

[ALG] Adjustment Line GST/Tax 

amount 

 
✓ 

     

[ALUP] Adjustment Line Unit Sell Price 
 

✓ 
     

[ALNU] Adjustment Line Number of 

Units Quantity 

 
✓ 

     

[ALT] Adjustment Line Total 
 

✓ 
     

[ALDT] Adjustment Line Extra Field 

Custom 

 
✓ 

     

[POLC] Purchase Order Buy Code 
   

✓ 
   

[POLD] Purchase Order Description 
   

✓ 
   

[POLG] Purchase Order GST/Tax Amount 
   

✓ 
   

[POLUP] Purchase Order Unit Price 
   

✓ 
   

[POLNU] Purchase Order Number of Units 

Quantity 

   
✓ 

   

[POLT] Purchase Order Total 
   

✓ 
   

[PILC] Purchase Invoice Buy Code 
  

✓ 
    

[PILD] Purchase Invoice Description 
  

✓ 
    

[PILG] Purchase Invoice GST/Tax 

Amount 

  
✓ 

    

[PILUP] Purchase Invoice Unit Price 
  

✓ 
    

[PILNU] Purchase Invoice Number of 

Units Quantity 

  
✓ 

    

[PILT] Purchase Invoice Total 
  

✓ 
    

[PILDT] Purchase Invoice Total 
  

✓ 
    

[RetLC] Return Invoice Buy Code 
     

✓ 
 

[RetLD] Return Invoice Description 
     

✓ 
 

[RetLG] Return Invoice GST/Tax Amount 
     

✓ 
 

[RetLUP] Return Invoice Unit Price 
     

✓ 
 

[RetLNU] Return Invoice Number of Units 

Quantity 

     
✓ 

 

[RetLT] Return Invoice Total 
     

✓ 
 

[RetLDT] Return Invoice Total 
     

✓ 
 

[RecLIN] Receipt Invoice Number 
    

✓ 
  

[RecLDT] Receipt Invoice Date 
    

✓ 
  

[RecLDoc] Receipt Doctor Field 
    

✓ 
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[RecLID] Receipt ID Field 
    

✓ 
  

[RecLPN] Receipt Patient Name Field 
    

✓ 
  

Statement History Fields        

[StaOB] Opening Balance 
      

✓ 

[StaDP] Date Printed 
      

✓ 

[StaCB] Closing Balance 
      

✓ 

[StaNT] Closing Balance – Opening 

Balance 

      
✓ 

Statement History Line Fields        

[StaLDT] Item Date 
      

✓ 

[StaLD] Description 
      

✓ 

[StaLDR] Debit Amount 
      

✓ 

[StaLCR] Credit Amount 
      

✓ 

[StaLRT] Running Balance 
      

✓ 

Statement Header Fields        

[StaOB] Opening Balance 
      

✓ 

[StaDP] Date Printed 
      

✓ 

[StaOBD] Start Date 
      

✓ 

[StaCBD] End Date 
      

✓ 

Statement Payment Fields        

[x][StaPLDT] Payment Date 
      

✓ 

[x][StaPLD] Description 
      

✓ 

[x][StaPLT] Amount 
      

✓ 

Statement Overdue Fields        

[x][StaOLDT] Overdure Date 
      

✓ 

[x][StaOLD] Description 
      

✓ 

[x][StaOLT] Amount 
      

✓ 

Statement Current Fields        

[x][StaILDT] Current Date 
      

✓ 

[x][StaILD] Description 
      

✓ 

[x][StaILT] Amount 
      

✓ 

Statement Footer Fields        

[StaPLGT] Running Total Payments 
      

✓ 

[StaOLGT] Running Total Overdue 
      

✓ 
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[StaCGT] Running Total Invoices       ✓ 

[StaNT] Running Total Invoices – 

Running Total Payments 

      ✓ 

[StaCB] Closing Balance       ✓ 

Job Numbers (GOLD Only) 

Job Numbers allow you to apply invoices to jobs to give you information on the income and 

costs for those jobs. For example, a builder may be working on several projects and require 

invoices to be applied to each project. 

If you did not elect to use Job Numbers when setting up your file, click on the Tools menu, 

select Options, then Advanced Preferences and tick Use Job Numbers. 

To open the Jobs List, click on the Tools menu and select Jobs List. 

The Jobs List page will appear. Any existing jobs will be listed. 

For example: a firm of builders has a job to supply and lay bricks at 1 Smith Street. For ease of 

identification they use the address as the job name. 

They have already created a Job and have decided to use sub-jobs to get better information on 

their business. They have created a sub-job for the Supply and now wish to do the same for the 

Lay. 

1. Click on the [New] button. 

2. Record a unique Job Number and Job Name. 

3. Record a Description for the job. 

4. Record the expected Start Date and End Dates for the job to assist you with your project 

management. 

5. Click on the arrow next to the Customer Code to select the customer for the job. 

You will also notice an [Inactive] button. When the job is completed, this button is used to 

remove this job from the list (and reports) of active jobs. 

6. Once you have completed the information, click on [Save]. 

The Jobs List will now include the job at the end of your list of jobs and positioned on the left to 

indicate that this is currently reporting as a job on its own. 

If you wish to move the Job up or down in order, click on the Up or Down arrows at the right of 

the window. 

To find a specific job, enter the job number in the box below the [Find] button, then click [Find] 

to move directly to that job. 

In our example, we wish to make this a sub-job of the 1 Smith Street job (Job 2014-1). With the 

line selected and in the location, we want it (under the master job), click on the right arrow at 

the right of page. This will indent the job and make it a sub-job of the master job above. If you 

wished this to be a sub-job of the 2014-1a job, simply click the right arrow again. We will not do 

this as we just want it to report as a sub-job of 2014-1. 

Click on [Save] to save the changes and then [Cancel] to exit the Jobs List page. 

We now have a Job No. column when recording the supplier’s invoice. When recording the 

invoice for the supply of bricks, select Job No. 2014-1a. When the invoice for bricklaying is 

received, select Job No. 2014-1b. (If the invoice for the supply covers more than one job then 

each line can be allocated a different job number.) 
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When creating an invoice for our customer, we can select the job number in the bottom left 

corner of the Invoice page. 

Having recorded our suppliers’ invoices and invoiced our customer, if we now return to our Jobs 

List we will see the following information: 

The master job 2014-1 has income of $10,000 (excluding GST), total costs of $7000 (made up of 

$5000 for sub-job 2014-1a and $2000.00 for sub-job 2014-1b) and net profit of $3000. If you 

click on the Show Detail button at the top right of the page, the Jobs List will also show the 

invoice numbers and amounts that make up the total. 

If you wish to edit the details of a job, click on the [Edit] button. This will open the same page 

as the [New] button but will include the details you have recorded for the job. 

Click on the [Print] button to print your Jobs List information. You have the choice of a 

Summary Report or one that also includes Details. If you want to include the details, click on the 

Show Detail checkbox on the Jobs List page prior to clicking on the [Print] button. 

You can also choose to [Print Selected Jobs]. This will print the selected job including any sub- 

jobs that apply. 

Please note: the example has used sub-jobs for demonstrating how the program works. 

However, we would normally only have used sub-jobs if they were large jobs and we wanted 

information about them. In normal circumstances for this example we would have just used the 

one job number. 

 

 

Reports (Jobs) 

The Reports tab in the Invoice Manager section lists reports for Sales, Purchases (GOLD only) 

and Inventory. 

 

Report Options - Jobs 

Once a report is selected, there are options to select different parameters for the generation of the 

report. The Report Options listed in the following table are: 

D – Date Period. Choose a report date range from Last Month, Last Quarter, Last Year, This 

Month, This Quarter, This Year or Custom (select report start and end periods where 

appropriate). 

eD- End Date Only. Report relates to a specific period and the only option is to select an end 

date for the report. 

E –Includes reports formatted especially for Microsoft Excel. 

F – Filter report. Report will show information based on filters e.g. Detailed or Summary, 

Include Invoice Manager balances, Single or Multiple Columns etc. 

J – Job selection. Choose either All Jobs or Select Jobs (open a list of all Jobs to select from). 

T – Type of printout. Choice of print layout or specific print media. 

 

Types of Reports – Jobs 

The following table summarises the report available in the Jobs section. 
 

 

REPORT DESCRIPTION Report 

Options 



148  

 

Jobs Summary of Income and Expenses involved 

in Jobs to determine Profit and Loss 

J 

 

 

Email An Invoice, Order, Report, Statement, etc. 

Anything you create in Invoice Manager that can be printed can also be emailed as an Adobe 

PDF Document. This includes Invoices, Purchase Orders, and Statements but also more 

‘internal’ reports like Order Status reports or Sales reports. Customised Word Documents can 

also be attached and emailed if you wish. 

Whenever you print preview a document or report, simply click the [Email] button and the email 

page will appear. For more information, see ‘Email Reports’ in the ‘Functions Common to All 

Programs’ section of this guide. 

 

 

Import Customers, Suppliers and Inventory 

Cashflow Manager allows you to import Customers, Suppliers, and Inventory Items (GOLD) by 

going to the File menu and selecting Import. 

Version 14 includes a user-friendly import routine, by selecting the type of data you wish to 

import and providing ready-made templates to add your data. 

The ready-made templates can be found in the following location; 

C:\Users\Username\AppData\Roaming\CFM\Cashflow14\Import Templates. These templates 

have fixed column headings, allowing you to add the relevant information into the correct 

columns. You can then save these templates ready for import. 

Cashflow Manager also provides additional instructions on how to create import templates. 

These documents can be found in the following location; 

C:\Users\Username\AppData\Roaming\CFM\Cashflow14\Import Help. 

The following information will use importing “Customers” as an example. 

 

The Import Process 

To begin, click on the File menu, and select Import File. 

The Import Data screen will appear, outlining the following information: 

To import your Customers, Suppliers, and Inventory into Cashflow Manager you must ensure 

that the file you wish to import is formatted correctly. 

 

There are basically 3 steps you need to follow: 

1. Select the Type of data you want to Import 

2. Copy the data from your own spreadsheet and paste it into the template provided or Proceed to 

Step 3 if you already have an import file prepared. 

3. Import your file 

Once you are ready to begin, click [Start] 
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Step 1: Select the type of data you want to import 

Select Customers, Suppliers or Inventory (We will use Customers as an example) 

Select Customers and [Next] 

 

Step 2: Your current import 

a. For this current import, have you already used the Customers Import Template to create your 

Customers import file? 

Or, 

b. For this current import, have you already created an Export file you wish to import? 

 

If you select YES, and click [Next], you will automatically be taken to Step 3 (see Step 3 for 

instruction), where you can import your already formatted file or template. 

Step 3: Import Your File 

1. Select one of the following options relevant to you; 

• Add and Update Records 

• Only Update Records 

• Only Add New Records 

2. Click on [Browse] to select your import file. The program will default to 

C:\Users\Username\AppData\Roaming\CFM\Cashflow14\Files Ready To Import pathway for 

file selection. If your file is in another location, navigate to this destination, select your file and 

click [Open]. 

3. Click [Import] 

4. An Import Complete message will appear, asking if you would like to import another file. 

Click on Yes or No. If you click Yes, repeat the import process. If you click No, your 

Customer’s will be added and updated. 

 

If you select NO, and click [Next], a spreadsheet will open on your screen, or on your task bar. 

You can copy the data from your provided spreadsheet and paste it into the one that opens (see 

How to Create your Customer Import Template below). Once you are finished adding your 

data, click [Create File] in the top left of the spreadsheet, and choose a location to save it (the 

default location is recommended; 

C:\Users\Username\AppData\Roaming\CFM\Cashflow14\Files Ready To Import 

 

Please Note: the same processes apply for Importing Suppliers and Inventory 

 

How to Create your Customer Import Template 

1. Open your file that contains the Customers you want to import. 

2. Check the file for any fancy formatting, report titles, graphs and blank rows and get rid of 

these features. 

3. Compare the Headings in your file to the Headings in the Template. 

4. Once you have identified corresponding data, select the data from your file and add to the 

Customer Import Template by following the steps below. 

 

• From your file, select the first cell in the column. (Do not select your Headings) 
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Sample of your file 
 

 

• Press the Ctrl + Shift + Down Arrow keys on your keyboard. This will select every 

record in the column. 
 

 

• Right click your mouse inside the selected area and select ‘Copy’ from the pop-out 

menu. 
 

 

 

 

 

 

• In the Customer Import Template, select the first cell in the column you want to paste 

the records into. 

 

In our example, you would select the B2 cell because the ‘Customer Code’ records that were 

copied from your file are compatible to the ‘Customer Code’ in the Customer Import Template. 
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• On your keyboard, press the Ctrl + V keys to paste the records into the Customer 

Import Template file. 

• Repeat this process for all other data you need to take form your Customer list file. 

 

Information: Please note that any record you add to the Customer Import Template that have 

a ‘Customer Code’ that already exists in your Invoice Manager Program Customer List, will just 

be updated. Any ‘Customer Code’ added to the Customer Import Template that do not exist in 

your Invoice Manager Program Customer List will be added as new Customer records. 

 

• Once you have pasted all the data from your file, click the [Create File] button. 

 

• If you have recorded any invalid data into the Customer Import Template, the cells 

will be highlighted with a Colour. You can click the Red ‘Colour Error Codes’ tab at the 

bottom of the Template to see an explanation of the error. 

 

 

• If all of the data you recorded into the Customer Import Template is valid, you will 

see the following ‘Save’ dialogue screen. 
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The default location will be set to the Cashflow Manager Applications location. This location is 

automatically used when it comes time to import the Customer Import File you created so it is 

best to leave it as it is. 

 

Please Note: the same processes apply for Importing Suppliers and Inventory 

 

Export Data 

Invoice Manager can export Customer, Supplier, and Inventory lists. 

These files will have the following name and extensions: 

• Customer Import.cif 

• Supplier Import.sif 

• Inventory Import.iif 

Click on the File menu and select Export. 

An Export Data screen will appear, asking you to select the following information to export: 

Customers, Suppliers, Inventory, or Mail Merge 

Select the type of data to be exported and click the [Export] button. A “Save As” window will 

appear, defaulting to C:\Users\Username\AppData\Roaming\CFM\Cashflow14\Files Ready To 

Import. If you wish to save the file in a different location, navigate to this destination. Click 

[Save]. 

An Export Complete message will then appear once the process has completed. 

 

 

Change the GST Rate 

The GST rate is set by default at 10%. To change the GST rate, click on the Tools menu, select 

Options and then select from the Tax Settings list. Type in the new GST Rate. Click on [Save]. 

 

 

Restoring Default Column Widths 

If you have changed the column widths in your input pages and you wish to restore the default 

column widths, click on the Tools menu and select Restore Default Column Widths. 

 

 

Taxable Payments Reporting for the Building and 
Construction Industry 

From the 2012/2013 Financial Year, businesses in the Building and Construction Industry who 

pay contractors for building and construction services are required to provide a ‘Taxable 

Payments Annual Report to the ATO. 
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The report includes the contractors’ details, Total Gross Payments (inc GST) and the amount of 

GST. If the contractor has not provided an ABN, PAYG Withholding must also be reported. 

More information can be obtained from http://www.ato.gov.au Search for ‘Taxable Payments’. 

 

Step 1 –Select the option to 'Use Taxable Payments for Contractors'. 

Open Invoice Manager to the Suppliers section and click on the Options icon. Click on 

‘Advanced Preferences’ and check the option to 'Use Taxable Payments for Contractors'. 

NOTE: A valid ABN is required because of validation rules when submitting Taxable Payments 

to the ATO via Standard Business Reporting. If you have not recorded this previously, click on 

‘Business Details’ while in ‘Options’ and record it. 

 

Step 2–Identify the suppliers who are contractors for ‘Taxable Payments Reporting’. 

Select a Supplier to whom the rules apply and click on the ‘Modify Supplier’ button. Click on 

the 'Taxable Payments Contractor?' option. 

NOTE: This option will NOT be visible unless the 'Use Taxable Payments for Contractors' 

checkbox in 'Options' is switched on. 

If the 'Taxable Payments Contractor' option is switched on and no ABN has been recorded, a 

message will advise that PAYG Withholding is required. You will be able to continue if no ABN 

is supplied but it will affect Supplier Payments. 

Due to validation rules when submitting Taxable Payments to the ATO via Standard Business 

Reporting, you will also receive messages if there are no values recorded for the Address, City, 

State and Postcode. 

 

Step 3 –Identify Purchase Invoices to be included in the Taxable Payments Report. 

When creating a 'Purchase Invoice' that meets the requirements, select the 'Include on Taxable 

Payments Report' option. 

NOTE: This option will only be visible if the 'Use Taxable Payments for Contractors' checkbox 

in 'Options' and the 'Taxable Payments Contractor' checkbox in 'Supplier Details' are selected. 

 

Step 4 - Record the Payment (Money Out) to the contractor 

If all suppliers have an ABN, recording ‘Money Out’ is the same as for any other supplier 

payment. 

However, if a Supplier does not have an ABN recorded and the invoice has been marked as 

reportable, the business has to withhold 46.5% in PAYG Withholding. 

In this case, there will be 2 lines generated for each Purchase Invoice: 

Line1is the amount the business must pay the Supplier which is Invoice Amount minus the 

PAYG Withholding Amount. 

Line 2is the PAYG Amount that needs to be withheld. 

Note: NO Overpayments can be made on either of the 2 lines. 

The 'Hide PAYG Withholding Records' check box also allows you to hide the PAYG record as 

you could be paying the PAYG Withheld to the ATO on a different date than paying the 

contractor. When you select to ‘Hide PAYG Withholding Records’ you can select the ‘Pay All’ 

or ‘Pay Overdue’ options and they will only apply to what is on the screen. You can then 

deselect the ‘Hide’ option to pay the ATO. 

http://www.ato.gov.au/content/00313486.htm
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Step 5– Print/lodge the 'Taxable Payments' report. 

 

NOTE: This report will only be listed if the 'Use Taxable Payments for Contractors' checkbox 

has been selected in 'Options'. In that case, it will be listed in the ‘Purchase’ reports for Invoice 

Manager. 

 

There are 3 report options and Standard Business Reporting (SBR) can also be used with this 

report. 

Suppliers Annual Report: Summary information in a format to send to your contractors. 

Summary: The one-line totals for each Supplier to match the numbers on the Suppliers 

Annual Report (whole dollars only). 

Detailed 

The Detailed Report lists all Payments, Invoices and Returns (and includes cents). 
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Troubleshooting 
 

Problem Potential Solution 

The page freezes when printing 

through Microsoft Word. 

You must have Microsoft Word installed to print with 

this program. Click on the Tools menu, Options and MS 

Word Setup. Click on the boxes to remove any selection 

ticks. 

Some anti-virus programs also prevent invoices being 

printed through Word. 

Printed invoice says Draft. Finalise the invoice and print it again. 

My Customer Inquiry balance does 

not equal a Statement or the Aged 

Debtors Report. 

You may have Credit Amounts or Adjustment Notes that 

have not been assigned to invoices. Outstanding Credit 

Amounts are advised at the bottom of the Customer 

Inquiry page. Click on the [Adjustment Note] button 

and check the Assigned column for any adjustment notes 

that have not been assigned. 

Unable to delete an invoice. Invoices cannot be deleted once saved. 
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 Wages Manager Version 14 
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Wages Manager 

Getting Started 

Introduction to Wages Manager 

Wages Manager is a very flexible, easy to use program to assist employers to manage their 

salaries, wages, and superannuation obligations. It has several unique features that make it 

simpler to use and to give peace of mind to employers. 

For example, Wages Manager automatically selects the tax withholding scale based on the 

information the employee completes on the Tax File Number Declaration Form they are required 

to fill in for the Tax Office. Other programs require the employer to choose the correct scale 

from one of more than 33 alternatives. 

Another example is that Wages Manager automatically applies the Tax Office rules about 

allowances to ensure that they are reported correctly on PAYG Summaries, that the correct 

amount of tax is withheld and that the correct amount of employer superannuation is calculated. 

There is even report (based on ordinary time earnings) that could save hours of time in the event 

of a Superannuation Guarantee Audit. 

Wages Manager has five primary functions: 

1. Adding and managing employee information 

2. Processing Pays 

3. Calculating, paying and reporting superannuation 

4. End of year reporting to employees, and 

5. End of year reporting to the Tax Office 

Each of these functions has been designed to be as simple as possible and to provide as much 

protection as possible for you, the employer. 

Wages Manager is available in two forms: as a standalone product, or as part of Cashflow 

Manager Gold. If you are an existing Cashflow Manager user and wish to purchase a licence to 

use Wages Manager, contact Customer Service on 1300 88 78 68. 

 

 

Open Wages Manager 

Click on the program icon on your desktop to open the program. For more information see 

‘Open the Program’ in ‘Functions Common to All Programs’. 

To then open the Wages Manager Program click on Wages tab on the Side Panel. 

 

Terminology 

Wages Manager has several acronyms that primarily relate to Tax Office terminology. The 

following is a glossary of these terms. 
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ABN Australian Business Number 

BAS Business Activity Statement 

CDEP Community Development Employment Program 

ETP Employment Termination Payment 

FTB Family Tax Benefit 

HECS Higher Education Contribution Scheme 

HELP Higher Education Loan Programme 

SSL Student Start-up Loan 

TSL Trade Support Loan 

OTE Ordinary Time Earnings 

PAYG Pay As You Go 

RDO Rostered Day Off 

SFSS 

SBR 

STP 

Student Financial Supplement Scheme 

Standard Business Reporting 

Single Touch Payroll 

WPN Withholding Payer Number 

YTD Year To Date 

 

Create a New Wages Manager Account 

If you are using Cashflow Manager GOLD, you will have already created your business file 

when you first started to use Cashflow Manager. If you have recorded or imported any 

information into either the Cashflow or Invoice sections, please backup before creating your 

Wages Manager account. 

When you first click on the Wages tab you will need to complete the information required for 

Wages Manager. A Wizard will assist you to set up your Wages Manager account. Each of the 

steps in the wizard will have instructions on what to do. 

Step 1: Business Details 

Record your Business Name, ABN or WPN and the Financial Year Ending for your wages 

records. 

This information is compulsory as it is required for employee and Tax Office reporting. Your 

Business Name will also appear on reports and be the default name for your file. (Note that if 

you are using Cashflow Manager GOLD and change the Business Name, it will be changed for 

the whole program.) 

Select the Financial Year Ending date from the drop-down box. (If your Financial Year is from 

1/7/2022 to 30/6/2023 then you would use the 2023 option). 

Click on the [Next] button. 

Step 3: Record your Postal Address and then click on the [Next] button. 

Step 4: Record the Extra Information details including the name of the person who will be 

the signatory on the PAYG Summaries for employees. Then click on the [Next] button. 
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Step 5: Congratulations 

This is simply a message advising that you have completed the information and your account is 

now ready to create. Click on [Next] to continue. If you are using Cashflow Manager GOLD 

your account will now be created. If you are using Wages Manager as a standalone program step 

6 will apply. 

Step 6: (Wages Manager Standalone) A window will appear so you can select the location for 

your file. The standard location is C:\CFM\Program FilesWages14\Data. Click on [Save] to save 

your file. 

 

Import Data from an Earlier Version File 

Note: Wages Standalone files prior to Version 12 cannot be imported into the latest version. If 

you have been using Wages Manager 12 and are upgrading to Cashflow Manager GOLD to 

begin using the other features, you can import your Wages Manager (.cf*) file when creating 

your business in version 14. 

If you are using Wages Manager only, the following steps apply when you are creating a new 

business file or Wages account and select [Yes] to import an earlier version file. 

NOTE: You can only import one earlier version file, and it is critical that you backup your 

business file before processing. 

 

When you are creating a new business file and select [Yes] to import an earlier version file, the 

next step will be to record the name of your business. Then click [Next]. 

 

1. Please select a Wages Manager file to import: Click on the button to browse to the location 

and select the file. 

You can import Wages Manager data or backup files. When you click on the [Browse] 

button it will automatically look for Wages Manager 12 data files (.c12) or Backup files 

(.b12). 

2. Record or update your Business Details. Details already recorded in other areas of the 

program will automatically pre-fill and any changes will apply across the wholeprogram. 

3. Record or update your Postal Address. 

4. Record or update the Extra Information required for your Wages Manager file. 

5. Congratulations: This is simply a message advising that you have completed the information 

and your information is now ready to import. Click on [Next] to continue. 

You will be asked if you wish to back up the business file prior to importing the data. If you 

have recorded information in any other section of the program and have not backed up prior 

to importing, click on [Yes]. Process the backup. The data will be imported, and the 

program will then open to the Employees window. 
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Menus - Wages Manager 

At the top of the page you will find the File, and Tools menus that provide you with functions to 

use from time to time. When you click on these menus, a drop-down menu will appear. Position 

your mouse pointer over the option you require and click to select it. 

The following is an overview of each menu item: 

File 
 

Create New Business 

File: 

Creates a new business file 

Open Existing Business 

File: 
Opens an existing business file 

Backup: Creates a backup of your file 

Restore: Restores a backup file 

Password: Options to add, change or delete a password. 

Passwords can be set for each section. 

Exit: Exit the Program 

 

Tools Menu 
 

Purge Data 

Adjust Employee 

Superannuation Rates 

Purge old data 

Adjust employee superannuation rates 

Record Fringe Benefits Records Fringe Benefit payments for an employee 

Financial Year  

> View Current Financial 

Year 
Rolls on to current financial year 

> View Previous Financial 

Year 

Rolls back to previous year to view records 

> Start New Financial Year Rolls over to new year ready to process wages 

> Remove Financial Year Remove financial years with no data 

Minutes Converter Small utility for converting minutes to hours 

Cheque Writer Opens cheque printing module 

Electronic Payments Opens electronic pay method module 

Termination Pays  

> Record New Pay Record a termination pay for employee 

> View Existing Pay Open saved termination pays 

Lodge PAYG Payment 

Summaries via SBR 

Use the new ATO SBR to lodge PAYG Payment 

Summaries online 

Lodge TFN Declaration via 

SBR 

Use the new ATO SBR to lodge Tax File Number 

Declarations online 

Options Opens Wages Manager Options 
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Options – Wages Manager 

To access the Wages Manager Options, you need to be in the Wages section of the program. 

Click on the Tools menu and select Options, or click on the Options icon on the tool bar:  

The following options are available: 

Advanced Preferences: The following options are available after selecting Advanced 

Preferences. 

Use Cheque Writer: Turns on the cheque printing module. 

Use Electronic Payments: Turns on the electronic payments module to make bulk 

electronic payments. 

Use Daily Hours: Record daily hours for employees. 

Show Extra Columns on Employee List: Displays columns for Pay Structure, Pay 

Frequency and Pay Type in the Employee List. 

Automatically Create Email When Saving Pays: When saving pays an email is 

automatically generated in the user’s default email program with Pay Advice attached. 

Use SuperStream: Turns on the SuperStream option 

Registered Holiday Makers: Related to the Backpacker’s Tax. It allows you to customise 

dates for PAYG Payment Summaries related to Holiday Maker’s Rates. 

Bank Details: The accounts details for the ‘Combined Employee Fringe Benefit Bank Account’ 

when salary sacrifice amounts are transferred to a combined account for all employees. 

Business Address: The address of the business paying the wages. This information may appear 

on some reports, Pay Advices and other printouts. 

Business Details: The name of the business, ABN or WPN number. This information is required 

for ATO reporting. 

Contact Details: Details for contacting the business. Includes: ‘Phone Number’, ‘Fax Number’, 

‘Email’, ‘PAYG Payment Summary Signatory’. This information may appear on some reports, 

PAYG Summary and other printouts. 

Choice of Super Details: When printing the Choice of Super Fund Form for employees, this 

information provides the ‘Part A: Employer to Complete’ section. Complete the 4 steps. 

Grid Font Size: Increase the size of the font on your screen. 

Printing Options: Includes options for Pay Advice printouts including ‘Print Personal/Carers 

Leave Accruals’, ‘Print Annual Leave Accruals’, ‘Print RDO Accruals’, ‘Print Superannuation’, 

‘Print Annual Salary’, ‘Print Pay Advice on Pre-Printed Payslips’, and ‘Print General Message 

on All Employee Pay Advices’. Tick these boxes to print these on the employee’s pay advice. 

 

Rename Business File: Renames the business database file. 
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Withholding Payer Number (WPN) 

The “Withholding Payer Number” (WPN) is allocated to clients who have withholding 

obligations under Pay As You Go (PAYG) withholding but who do not have an “Australian 

Business Number” (ABN). Its primary purpose is for quotation on payment summaries issued to 

their employees. For example, private individuals not carrying on an enterprise employing a 

nanny or housekeeper, would be allocated a WPN. The WPN reported must belong to the payer 

named in any lodgement 

Where do I add my WPN? 

If you are setting up the Wages Manager section for the first time, and creating your account, 

you can enter the WPN when following the wizard; 
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The WPN option is universal. It can be added in Cashflow, Invoice or Wages Manager. 

To add your WPN, click on TOOLS/OPTIONS/BUSINESS NAME & ABN; 

 

 

The WPN will affect the following sections of the program; 

 

SBR Lodgement – PAYG Payment Summaries, TFN Declaration, Taxable Payments Reporting 

(Payer & Intermediary). The SBR lodgement screen will include a field for the WPN to be 

entered. 
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Create PAYG Payment Summary File – Supplier Information. The WPN field must be 

entered and must correspond with the PAYER’s name on the WPN registration. 

 

 

 

Sections (Tabs) in Wages Manager 

There are three sub-sections within Wages Manager, accessible from the Side Panel. They are: 

Employees, Superannuation and Reports. When Wages Manager is opened, the Employees 

Tab is displayed showing the list of employees. 

 

Employees 

When you select the Wages Tab, the Employees Tab will appear. This is considered the ‘main’ 

page, or the ‘Home’ page of the Wages Manager program. This consists of: 

Employee List: A list of employees currently employed, or who have been employed at some 

time during the current Financial Year. The Employee List will be blank until you add 

employees. 

The list includes the Employee Number, First Name, Surname and Active. There is also an 

option to include extra columns that display Pay Structure, Pay Frequency and Pay Type. To 

include these extra columns, click on the Options icon, select ‘Advanced Preferences’ and then 

click in the option for ‘Show Extra Columns on Employee List’. 

All employees will be 'active' unless they have terminated employment during the Financial 

Year. 

You can sort your Employee List by Employee Number, First Name, Surname and Active by 

clicking on the title for the column you wish to sort by. For example, if you wish to sort by First 

Name, click on the First Name column title. To reverse the order (from Z-A), click on it again. 
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Function Buttons: To the right of the Employee List are buttons for the common functions 

undertaken in the program. These are divided into groups: Functions, Information and 

Employees. 

Each function button performs a different task in the program. They allow you to edit or change 

details, record pays, or perform other tasks. To make use of a function, select an employee by 

clicking on their name, and then click the function button desired. 

For example, if you need to edit an employee's details, select the employee in the Employee List 

by clicking their name, and then click on the [Modify Employee] button. 

 

Add an Employee 

To add a new employee, click on the [Add Employee] button to the right of the Employee List. 

This will begin a wizard with steps that will guide you through completing the necessary details 

about the employee. You must complete the required information before proceeding to the next 

step. 

Most of the preliminary details are collected from the Employee’s Tax File Number Declaration 

form that must be completed by all new employees for the Tax Office. In fact, at the end of 

entering a new employee, you will be asked whether you wish to lodge the Tax File Number 

Declaration using Standard Business Reporting. Note: You must be registered with the ATO for 

Standard Business Reporting to do this. You can also do it separately using the ‘Lodge TFN via 

SBR’ link in the Tools menu. 

Note that you must complete the wizard and click on the [Save] button to save the information. 

Any premature exit from the wizard will not save any of the information you have recorded. 

For details of the steps, see the section on Employee Details. 

If you are adding an employee who already has Year to Date wages, see the section on Opening 

Balances under Processing Pays. 

 

Modify an Employee’s Details 

To modify the details of an existing employee, select the employee in the Employee List by 

clicking their name, and then click on the [Modify Employee] button. 

This will open a panel containing the selected employee's details with tabs for each section of 

information. Select the tab for the information you wish to change. Click on the [Save] button 

when you have finished. You will be asked if you wish to close the Employee’s Details. If you 

select [Yes], it will take you back to the Employee List. If [No], you can continue to make 

changes to the Employee’s Details. If you click on [Cancel] you will exit without saving any 

changes made since the last time you clicked on [Save]. 

For details of the information, see the section on Employee Details. 

 

Employee’s Tax Withholding Scale 

Wages Manager has a unique and simple way of selecting the correct tax withholding scale for 

your employee. 

While other payroll programs require you to make the correct choice from 30+ options, Wages 

Manager calculates the right withholding scale for you. 

Each employee is required to complete a Tax File Number Declaration Form and provide it to 

you together with any other Tax Office forms that justify claims for tax offsets or Medicare 

rebates. 
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When adding a new employee, the Add Employee wizard will step you through entering the 

required information necessary to determine the correct tax scale. 

 

Different tax scales can apply when the employee is in an industry that has special tax rates, such 

as shearers, seasonal workers in the horticultural industry or actors. If this is the case, choose the 

applicable category in the Employee’s Details under Tax Scales. 

The program will determine and use the appropriate tax scale and will list the selected scale in 

the Tax Scales section in the Employee’s Details. 

 

Employee Details 

The term ‘Employee Details’ refers to the information recorded for an employee. This 

information is initially recorded when you click on the [Add Employee] button and can be 

viewed or modified by selecting the employee from the Employee List and clicking on the 

[Modify Employee] button. 

A wizard will take you through the following steps when you add a new employee. You need to 

complete the wizard because the Employee Details are not saved until you click on the [Save] 

button at the end of the process. 

When you click on the [Modify Employee] button, each section will have its own Tab, so you 

can select and modify individual sections, and you will need to click on the [Save] button to 

accept any changes. 

 

Section 1 – Tax Scales 

Each employee needs a unique employee number that is stored in the database as a unique 

reference. It can only be letters or numbers and no two employees can have the same number, 

including previously terminated employees. You can change this number later but not to a 

number that is already in use. 

Here you can also choose a special tax scale category or industry the employee may fall into and 

has special tax withholding scales, for example; Shearer, Horticultural worker, Holiday Maker, 

Actor, Closely Held Employee and Seasonal Worker program. 

NOTE: When a tax scale category or industry is chosen, other areas may be altered or disabled 

due to tax offset conditions. 

NOTE: The 3 Tax Scales for the Senior Australian Tax Offset (Single, Illness Separated and 

Couple) have been moved to Section 2 – TFN Declaration. This is due to changes made by the 

ATO to the Tax File Number Declaration form. Once you have added an employee, the Tax 

Scales page will also list their Employee Tax Withholding Scale. 

 

Section 2 – TFN Declaration& Validation 

There are 12 steps that correspond to the steps on the Tax File Number Declaration Form the 

employee completes for the Tax Office. Copy the information onto this page. On most 

occasions, all the information will come from the declaration form. However, if the employee is 

claiming other tax benefits, other forms may also be required. 

For example, if the employee is claiming a Medicare Levy Variation he or she will provide you 

with a Medicare Levy Variation form. 

By ticking the box next to the question that asks whether such a form has been received, you can 

then input the information from the employee's form so that the program calculates the 

adjustment. 
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Question 1 is where you record the employee’s Tax File Number. If he or she has not provided 

one, you can leave this blank, but must choose an option from the drop-down list beside it. The 

choices are: Applying to ATO, Under 18 Exempt, or Pensioner Exempt. Choosing Applying 

to ATO means the employee has 28 days from starting to provide a TFN, or the highest 

marginal rate of tax will be calculated. 

NOTE: If the Working Holiday maker tax scale is selected then country of Origin drop down 

box will show and country selection is required. 

NOTE: The Date of Birth can be set by using the calendar from the drop-down arrow or typing 

in the correct date in the fields. The calculated age will be shown automatically. 

NOTE: The option to authorise the employer to give the employee’s TFN to the trustee of a 

superannuation fund has been removed due to changes made by the ATO to the Tax File 

Number Declaration form. 

NOTE: When adding a new employee, the program will run a validation on the TFN. If the TFN 

is invalid, a message will appear, but the user will have the opportunity to continue using the 

TFN they have recorded. The Validation will not occur when saving in the ‘Modify Employee’ 

section. 

 

Tax Offsets 

If your employee is claiming tax offsets for Zone, Dependant Spouse or Special Rebate 

entitlements, he or she must provide you with a Withholding Declaration form. 

At question 10 in the TFN Declaration section, tick the box to enable the offset, and transfer the 

information from the Withholding Declaration form (Table J – Total Tax Offsets) into the box 

provided. 

The tax offsets will be automatically calculated when you process the employee's wages. 

 

HELP/SSL/TSL/VSL/SFSS Debt 

The Higher Education Loan Programme (HELP) is designed for students to pay for their post- 

secondary studies. The student is required to commence paying back the debt once a certain 

level of income is reached as part of their PAYG. This also applies for students with a Student 

Start-up Loan (SSL), or a Trade Support Loan (TSL), Student Financial Supplement Scheme 

(SFSS) and Financial Supplement Debt (FSD). 

If an employee has a HELP/SSL/TSL/VSL/SFSS debt, they must notify their employer, who is 

required to increase the tax withheld from their salary or wages. 

If an employee advises that they have a HELP/SSL/TSL/VSL/SFSS debt, the 

HELP/SSL/TSL/VSL/SFSS Debt option must be selected at question 11 of the TFN 

Declaration Tab of the Employee’s Details. 

Wages Manager will automatically calculate the additional tax to be withheld when wages reach 

the threshold. 
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Medicare Levy Adjustments 

If your employee supplies you with a Medicare Levy Variation form, you need to record this 

information in the TFN Declaration Tab of the Employee’s Details. Tick the box next to 

Medicare Levy Variation Form Received? at question 11 and answer the questions in the page 

that appears. Answering certain questions may disable other questions. 

NOTE: The Medicare Levy Adjustment option may be disabled depending on the tax 

withholding scale appropriate to the employee. 

Note: When you have completed adding a new employee you will also have the option to 

lodge their Tax File Declaration form online using Standard Business Reporting. 

 

 

Section 3 – Pay Details 

Conditions and options for processing pays and calculating wages are in the Pay Details section 

which includes Contact Information, Start Date, Job Classification, Branch Number*, Pay 

Structure, Pay Options and the End Date (if the employee has been terminated). 

Pay Information and Pay Options are explained further in the following sections. 

*Branch Number is the reference for businesses with multiple locations or offices that need to be 

specified as per ATO requirements. Most reports can also be filtered by Branch numbers. 

 

Pay Information 
 

Normal Hours (per 

Week) 

Record the normal hours that an employee works per week. This 

establishes the basis for calculation of entitlements. 

This field requires the Normal Hours PER WEEK regardless of 

the pay frequency (i.e. Fortnightly, Monthly etc.) 

Pay Structure Options are: Hourly (for hourly paid employees), Salary (for 

salaried employees), Nominated Gross (for situations where 

'Hourly' or 'Salary' is not appropriate, and you nominate the gross 

pay) or Piece Work (the employee is paid in number of units or 

pieces processed). See more information on ‘Piece Work’ below. 

Hourly Rate/Base 

Annual Salary 

The Hourly Rate or Base Annual Salary is the gross rate for the 

employee. If you record a Salary Sacrifice using the Salary 

Sacrifice tab, the amount of salary sacrifice will reduce this 

amount. (The amount of salary sacrifice will also be shown on 

pay slips. If you do not want the amount of salary sacrifice to be 

shown on pay slips, only include the net rate in this field and do 

not use the Salary Sacrifice tab.) 

Pay Period Options are: Weekly, Fortnightly, Bi-monthly and Monthly. 

Pay Method Options are: Cash (where you pay by cash – rounded to nearest 5 

cents), Cheque (where you can write cheques manually or use the 

Cheque Writer system) and Electronic Pay (where amounts are 

included in a combined file for transfer to your bank). See more 

information on Electronic Pay and Paying Employees by Internet 

Banking below. 
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Paying Employees by Internet Banking 

 
Paying by Internet Banking is not the same as paying ‘electronically’. 

Electronic Pays allow you to create one file that combines all pays so that this one file is 

sent to your bank. This generally requires that you have the bank’s proprietary software, 

but some banks may allow you to attach it while you are in internet banking. 

Piece Work 
 

When the employee’s Pay Structure is Piece Work, you need to use Custom Rates (see section 

on Custom Rates) to define the units and the rate that will apply to each unit to calculate pays. 

Selecting Piece Work will modify other areas of the program. 

1. The following areas will be disabled: 

1. Shift Allowances 

2. RDOs 

3. Overtime 

4. Annual Leave and Personal/Carers Leave 

5. Leave Loading 

6. Long Service Leave 

2. The Normal Hours (per week) and Hourly Rate boxes will be cleared and disabled in the 

Pay Details Tab, and in the Summary Page the Hours column will be renamed Units. 

3. In the Pay Advice Report, the title Hours will be replaced with Units and the title Rate will 

be replaced with Rate per Unit. 

4. The title Hours will also be replaced with Units in the Payroll Categories (Detail) report. 

NOTE: Employees with Piece Work selected will not appear in the list of employees when 

using the Multiple Pays option unless Daily Hours have been recorded. 

 

 

Electronic Pay 

Electronic Pays are wages paid via a funds transfer from the company’s bank account to the 

employee’s bank account. It is done through an electronic transfer of a file containing employee 

wage details and bank account details. Wages Manager will create this file as an .ABA file (an 

Australian bank standard format). This is NOT the same as Internet Banking – see below. 

When you select Electronic Pay as the Pay Method you need to record their Bank Details. You 

will be prompted to do this when you select an employee to be paid electronically and save the 

changes. 

For information on setting up employee bank accounts, see information on Bank Details. For 

paying employees into more than one bank account, see information on Multiple Bank 

Accounts under Bank Details. 

For more information on processing electronic pays, see Paying Employees Electronically in 

Processing Pays. 
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Pay Options 

Increasing or Decreasing Tax Withheld 
 

Wages Manager can increase or decrease the amount of tax for occasions when the automatically 

calculated tax withheld needs to be manually modified on a regular basis. An example of this 

scenario is an employee who has a Tax Office approved variation to reduce their tax withheld 

because of rental property negative gearing deductions. You can specify whether a dollar amount 

or percentage is adjusted per pay. 

To adjust the amount of tax withheld from the employee's pay, click on the [Modify Employee] 

button and select the Pay Details Tab. 

In the Pay Options section, next to Manual Tax Adjustment, select whether to ‘Increase’ or 

‘Decrease’ the amount of tax withheld. In the next box, type in the amount of the adjustment and 

then choose either Dollars or Percent. 

If Percent is selected, then the tax calculated will be increased or decreased by the selected 

percentage amount. 

NOTE: You should only decrease the amount of tax withheld when the Tax Office has given 

authorisation in writing. 

You can also adjust the amount of tax calculated when you are processing a pay for a single 

employee. However, this will only affect that pay. 

 

Allowances 
 

Overview - Allowances 

When an employee receives allowances or reimbursements this needs to be specified in the 

Employee’s Details when adding a new employee or modifying an Employee’s Details. 

Employees may be paid allowances for a variety of reasons such as industrial award 

entitlements, use of private motor vehicle etc. In fact, there are 18 Allowance Types (or 

reimbursements) that are included under the Tax Office guidelines. 

Some require tax to be withheld. Some are reported in gross income while others are reported 

separately on the PAYG Payment Summary. Some are ordinary times earnings (OTE) for 

superannuation guarantee purposes while others are not but still defined as salary and wages. 

It is very confusing. However, Wages Manager has made it very simple by automating all the 

requirements when you select which of the 18 types of allowances that applies. There are also 

several additional allowance types that you can select for other allowances or if professional 

advice you receive indicates that they apply. 

The 18types of allowances and their treatments are: 

However, if you pay your employees using internet banking, do not select Electronic 

Pay as the option because this will not transfer the information you need to Cashflow 

Manager to reconcile your records. 

Choose Cheque as the Pay Method. This will enable you to record a transactionnumber 

(instead of a cheque number) and transfer each payment to your Cashflow Manager file 

to match with your bank statement. 

You can still record your employee’s bank details so that you have them available when 

paying wages. 
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Type Description Withhold 

PAYG 
Show on 

Payment 

Summary 

Super? 

1 Allowance for working conditions, 

qualifications or special duties 

✓ ✓* ✓ 

2 Allowance for non-deductible expenses ✓ ✓* - 

3 Allowance for expected deductible 

expenses 

✓ ✓ - 

4 Cents per kilometre car expense up to 

5000k using ATO rates 

- ✓ - 

5 Cents per kilometre car expense over 5000k 

using ATO rates 

✓ ✓ - 

6 Award transport payments for deductible 

transport costs 

- ✓ - 

7 Laundry (not dry cleaning) allowance for 

deductible clothing (up to ATO threshold) 
- ✓ - 

8 Laundry (not dry cleaning) allowance for 

deductible clothing (over ATO threshold) 

✓ ✓ - 

9 Award overtime meal allowance (up to 

ATO reasonable amount) 

- - - 

10 Award overtime meal allowance (over 

ATO reasonable amount) 

✓ ✓ - 

11 Travel allowance with overnight absence 

up to ATO reasonable amount 

- - - 

12 Travel allowance with overnight absence 

over ATO reasonable amount 

✓ ✓ - 

13 Other reimbursements - - - 

14 Allowance by way of unconditional extra 

payment 

✓ ✓* ✓ 

15 Other allowances that require PAYG and 

Super 

✓ ✓ ✓ 

16 Other allowances that do not require PAYG 

or Super 
- - - 

17 Other allowances that require Super but not 

PAYG 

- ✓ ✓ 

18 Other allowances that require PAYG but 

not Super 

✓ ✓ - 

19 Qualification allowance ✓ ✓* ✓ 

20 Task Allowance ✓ ✓* ✓ 

21 Tool allowance that is expected to be 

expended in full 

✓ ✓ - 

22 Tool allowance that is not expected to 

be expended in full 

✓ ✓ ✓ 

* included in Gross amount on PAYG Summary 
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Note: if an allowance or reimbursement is a fringe benefit expense, then it needs to be reported 

separately on the PAYG Payment Summary. To record fringe benefits, click on ‘Tools’ > 

‘Record Fringe Benefits’ 
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Add an Allowance 

1. In the Employee’s Details, click on the Pay Details Tab, and then click on the Allowances 

Tab under Pay Options. 

2. Click on the [Add] button. A page appears where you can choose the allowance type (see 

table above). 

3. Enter a description to identify the allowance. A brief description of the chosen allowance 

type and its effect on the PAYG is shown below to help identify the correct allowance 

category. 

4. If there is a single rate that applies, click on ‘Single Rate’ and type in the amount. In some 

industries, the number of hours worked on a given day determines the allowance rate that is 

paid. If this applies, select Multiple Rates and click on the Add/Modify button. Add the rates 

and click on [OK]. Select the type of hours to be included when calculating the number of 

hours per day for the allowance calculation. (Note: The Multiple Rate feature requires the 

‘Daily Hours’ option to be activated: Options > Advanced Preferences > Use Daily Hours. 

5. Click on [OK] to accept the allowance. You will see the allowance added to the list in Pay 

Options to be used in processing pays. 

A check box to the right signifies that the allowance is in use: uncheck this box to 

temporarily or permanently disable the allowance. 

6. If you have clicked on [Modify Employee] to add the allowance, when you have finished all 

changes to the Pay Details information, click on the [Save] button. 

When processing pays, a button will allow you to edit payroll options including allowances. 

 

Modify an Allowance 

1. In the Employee’s Details, click on the Pay Details Tab, and then click on the Allowances 

Tab in Pay Options. 

2. Click on the allowance you wish to modify and then click on the [Edit] button. This will 

open the page to adjust the allowance details. 

3. Once modifications have been made, click on [OK] to accept changes. 

4. When you have finished all changes to the pay information, click on the [Save] button. 

When processing pays, a button will allow you to edit payroll options including allowances. 

Delete an Allowance 

1. In the Employee’s Details, click on the Pay Details Tab, and then click on the Allowances 

Tab under Pay Options. 

2. Click on the allowance you wish to delete and then click on the [Delete] button. You will be 

prompted if you are sure you wish to remove the allowance. The allowance will be removed 

from the Allowances list provided it has not been included in any pays. 

 

 

Deductions 
 

Overview - Deductions 

Deductions are amounts deducted from the employee's after-tax pay, which the employer pays 

on their behalf. Examples might be health benefits or insurance funds. 

A common deduction is for Union Fees but there is a separate category for Union Fees as this is 

required to be shown on PAYG Payment Summaries. See ‘Union Deductions’ for more 

information. 
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Employees may also ask you to deduct an amount to pay to a superannuation fund as employee 

contributions. This is also catered for separately. See Section 5 – Superannuation. 

You need to specify when an employee has deductions in the Employee’s Details. This can be 

done when you add a new employee or modify an Employee’s Details. 

 

Add a Deduction 

1. In the Employee’s Details, click on the Pay Details Tab, and then click on the Deductions 

Tab under Pay Options. 

2. Click on the [Add] button. A page appears where you can enter a name or description of the 

deduction. 

3. Record the amount to deduct per pay. 

4. Click on [OK] to accept the deduction. You will see the deduction added to the list in Pay 

Options to be used in processing pays. 

A check box signifies the deduction is in use: uncheck this box to temporarily or 

permanently disable the deduction this box. 

5. If you have clicked on [Modify Employee] to add the deduction, when you have finished all 

changes to the Pay Details information, click on the [Save] button. 

When processing pays, a button will allow you to edit payroll options including deductions. 

 

Modify a Deduction 

1. In the Employee’s Details, click on the Pay Details Tab, and then click on the Deductions 

Tab under Pay Options. 

2. Click on the deduction you wish to modify and then click on the [Edit] button. This will 

open the page to adjust the deduction details. Once modifications have been made, click on 

[OK]. 

3. When you have finished all changes to the pay information, click on the [Save] button. 

When processing pays, a button will allow you to edit payroll options including deductions. 

Delete a Deduction 

1. In the Employee’s Details, click on the Pay Details Tab, and then click on the Deductions 

Tab under Pay Options. 

2. Click on the deduction you wish to delete and then click on the [Delete] button. You will be 

prompted if you are sure you wish to remove the deduction. The deduction will be removed 

from the Deductions list provided it has not been included in any pays. 

 

Union Deductions 
 

1. Select the employee from the Employee List and click on the [Modify Employee] button. 

2. Click on the Pay Details Tab and then on Union. 

3. Enter the union name, the employee’s membership number, and the union fee to be deducted 

from their NET pay each time a pay is processed. 

4. Click on the [Save] button to save changes or [Cancel] to exit without saving. 

When processing pays, a button will allow you to edit payroll options including Union Fees. 

 

Overtime 
 

Overtime is a special category of wages that is not included in Ordinary Time Earnings (OTE), 

and hence does not normally have superannuation calculated on it. 
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1. Select the employee from the Employee List and click on the [Modify Employee] button. 

2. Under the Pay Details Tab, click on Overtime to show overtime rates. 

3. Select from the standard rates of 1.5 times and 2 times the normal rate or record a custom 

overtime rate; just enter the amount by which to multiply the normal rate in the field 

provided. Tick the options you wish to include. (Custom overtime rates can be added in 

Custom Rates.) 

4. Click on the [Save] button to save changes, or [Cancel] to exit without saving any changes. 

When processing pays, a button will allow you to edit payroll options including Overtime. 

Rostered Days Off (RDOs) 
 

When an employee has rostered days off you can stipulate for the program to 'hold back' time 

paid each pay so that the employee is paid a consistent wage when he or she has their rostered 

day off. 

1. Select the employee from the Employee List and click on the [Modify Employee] button. 

2. Under the Pay Details Tab, click on RDOs. 

3. Enter the number of hours to be held back (and hence not paid in wages) per pay. These 

hours will accumulate in the Hours Owing field. 

4. When adding an employee who already has accrued RDO hours, record the opening balance 

of hours in the Hours Owing field. (You can click in the box and type over any value 

shown.) 

5. Click on the [Save] button to save changes, or [Cancel] to exit without saving changes. 

When processing pays, a button will allow you to edit payroll options including RDOs. 

NOTE: The RDO function is not available to salary, nominated gross, or piece work employees. 

 

Processing Pays with RDOs 

When processing pays for an employee with RDOs, the employee's pay will be reduced by the 

RDO hours nominated multiplied by the hourly rate. This will show on the pay summary. 

When the employee takes their Rostered Day Off, the number of hours taken is recorded in the 

RDO Hours column. The employee will be paid for this time at their normal rate and the 

accruals will also be adjusted. 

 

Salary Sacrifice 
 

Overview – Salary Sacrifice 

Sometimes employees may sacrifice part of their salary to have pre-taxed income converted into 

superannuation payments or fringe benefits. The advantage is that sacrificed amounts are 

deducted before tax is calculated, and so reduces the gross income and amount of tax withheld. 

Salary sacrifice amounts are shown on pay advices. 

Any amounts of Salary Sacrifice for Superannuation will report on the Superannuation 

Remittance Report to be included with Superannuation Payments. 

Employees of some non-profit and religious organisations can allocate a percentage of their total 

pay to be paid as fringe benefits. This can be done by selecting ‘Fringe Benefit’ as the salary 

sacrifice ‘type’ and record the percentage per pay that is set aside for that purpose. 

You need to specify in Employee Details (Add Employee or Modify Employee) when an 

employee is using the salary sacrifice option. This can be done when you add a new employee or 

modify an Employee’s Details. 
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NOTE: If you do not want any reference to the sacrificed amount shown on pay advices, the 

alternative is not to select the Salary Sacrifice option and only include the reduced amount of 

salary (or wage) in the Pay Structure. However, in this case you may not be able to monitor 

superannuation payments related to the salary sacrifice. 

 

Add a Salary Sacrifice’ 

1. In the Employee’s Details, click on the Pay Details Tab, and then on the Salary Sacrifice 

Tab under Pay Options. 

2. Click on the [Add] button. 

3. Record a name or description for the salary sacrifice. 

4. Next to Calculate, type in the amount or percent to be sacrificed, and choose the option in 

the drop-down list next to ‘per pay’. 

5. Select the Type of salary sacrifice from the drop-down list. Options are Superannuation, 

Fringe Benefit or Tax-Exempt benefit. 

Note: If Fringe Benefits is selected, the ‘salary sacrifice’ will record the amount that is 

allocated or transferred to a bank account for the expected payment of fringe benefits. The 

actual fringe benefits payments need to be recorded under Options > Fringe Benefits. 

6. If you select Superannuation, choose the name of the fund in the drop-down list to which the 

salary sacrifice payments will be paid. If the fund has not already been added in the program 

you can click on [Add] and record the details now. Enter the employee’s account number as 

well. 

7. Click on [OK]. You will see the salary sacrifice added to the list in Pay Options to be used 

in processing pays. 

A check box signifies the salary sacrifice is in use: uncheck this box to temporarily or 

permanently disable the salary sacrifice. 

8. If you have clicked on [Modify Employee] to add the salary sacrifice, when you have 

finished all changes to the Pay information, click on the [Save] button. 

When processing pays, a button will allow you to edit payroll options including salary sacrifice. 

 

Modify a Salary Sacrifice’ 

1. In the Employee’s Details, click on the Pay Details Tab and then on the Salary Sacrifice 

Tab under Pay Options. 

2. Click on the salary sacrifice you wish to modify and then on the [Edit] button. This will 

open the page to adjust the salary sacrifice details. 

3. When finished, click on [OK]. 

4. When you have finished all changes to the Pay information, click on the [Save] button. 

When processing pays, a button will allow you to edit payroll options, including salary 

sacrifice. 

 

 

Delete a Salary Sacrifice’ 

1. In the Employee’s Details, click on the Pay Details Tab, and then on the Salary Sacrifice 

Tab under Pay Options. 

2. Click on the salary sacrifice you wish to delete and then on the [Delete] button. You will be 

prompted to make sure you wish to remove the salary sacrifice. The sacrifice will be 

removed from the Salary Sacrifice list provided it has not been included in any pays. 
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When processing pays, a button will appear, so you can edit payroll options, including salary 

sacrifice. 

 

Custom Rates 
 

Custom Rates are for additional rates that differ from normal hours and can include overtime and 

shift allowances. Customising a rate allows you to specify the rate, category and leave accrual 

options. It is also used for piece work wages where each unit and its rate are specified (e.g. sheep 

shorn, kilograms of grapes picked, etc.) 

Custom Rates give the program a lot of flexibility. For example, it is perfect for the hospitality 

industry where an employee may have several different rates depending on the days and times 

they work. 

1. Select the employee from the Employee list and click on the [Modify Employee] button. 

2. Under the Pay Details Tab, click on Custom Rates. Any existing custom rates will be 

displayed. 

3. To add a new rate, click on the [Add] button. 

4. Record a name for the rate, the rate amount and whether it is a dollar amount or a percentage 

of normal hourly rate. 

5. Choose the wage category it falls into (see table below). 

6. Click in the Apply Accruals checkbox if leave is accrued for this rate, and in the Use in Pay 

checkbox if this rate is to be used in the payroll. (Uncheck the Use in Pay checkbox if you 

do not want the rate to display when processing pays.) 

 

The Wage Category selected will determine if the amounts calculated are classified as Ordinary 

Time Earnings (OTE) for superannuation calculations. For example, if the rate is a result of a 

‘shift’, the wage category will be Shift Loading. 

 

Wage Category 
OTE for 

superannuation 

calculations 

Annual Leave taken Yes 

Casual Loading Yes 

Cash out of Annual Leave No 

Compassionate Leave Yes 

Long Service Leave taken Yes 

Over Award Payments Yes 

Overtime No 

Payments when on Maternity or Paternity leave No 

Personal/Carers Leave taken Yes 

Piece Work Yes 

Public Holidays Yes 

Shift Loading Yes 

Top up payments - serving jury duty or reserve forces etc. No 
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Workers compensation where work is performed Yes 

 

When processing pays, a button will allow you to edit payroll options, including Custom Rates. 

 

 

Shift Allowances (Shift Loading) 

A Shift Allowance allows you to establish a percentage loading for afternoon and night shifts. 

When calculating pays, the hours recorded in this category will have the hourly rate increased by 

the shift loading percentage. 

1. Select the employee from the Employee list and click on the [Modify Employee] button. 

2. Under the Pay Details Tab, click on Shift Allowance. 

3. There are boxes for an Afternoon Loading and/or a Night Loading. These amounts are 

percentages on top of the normal hourly rate. For example, if you wish to have a night 

loading of time and a half, the Night Loading field should have 50 in it, as 50% on top of the 

normal hourly rate is 150%, or 1.5 times the normal rate. 

NOTE: Shift Allowance loading forms part of ordinary time earnings for superannuation 

calculations and leave entitlement accruals. It is not a part of Overtime. 

The Shift Allowance selection is limited to afternoon and night shift. However, additional 

loading rates can be established for any employee in the Custom Rates section (see above). 

When processing pays, a button will allow you to edit payroll options, including Shift 

Allowances. 

 

Section 4 – Leave 

This section manages entitlements for Personal/Carers Leave (formerly known as Sick Leave), 

Annual Leave, Leave Loading and Parental Leave. 

NOTE: Long Service Leave is not included as there are many variations in legislation between 

states and territories within Australia. However, you can manually keep track of dates and leave 

payments in the Employee Diary and Leave Register. 

There are three sub-tabs under the Leave tab: Personal/Carers Leave, Annual Leave and Parental 

Leave. The two pages are identical in their layout and have the same options except that Annual 

Leave also has the option for Leave Loading. (See section on Leave Loading for further details.) 

The following information addresses Annual Leave, but also applies to Personal/Carers Leave. 

When the employee is entitled to Annual Leave, click on the checkbox for Does this employee 

have Annual Leave?’ 

This will activate the Annual Leave option as well as the three radio (round) options to 

determine how the leave is calculated. 

Option 1 is to accrue leave based on hours worked. The amount accrued is equal to the number 

of days per year divided by the normal hours per week multiplied by the number of hours 

worked. In other words, it calculates leave on the basis of 20 days entitlement being 4 weeks or 

1/13th of a year. If the employee’s award or agreement requires you to divide by 12 to calculate 

prorate leave, use the ‘Nominate Hours per Pay’ option. 

You then have the choice to: 

1. Prorate leave indefinitely – so the leave is calculated on the hours worked per pay, or 
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2. Prorate leave for first year only. This option is used for employees whose leave is prorated 

over the first year of employment but then receive the next year’s full entitlement on the 

anniversary of their employment. 

On the anniversary date of employment, you will need to manually add the next years leave 

entitlement to the Annual Leave Balance (Hours). For example, if the employee is entitled to 10 

days sick leave and the employee works 8-hour days, you would add 80 hours (10 days x 8 

hours) to the balance in Sick Leave Accrued (Hours). 

Option 2 is Nominate hours per pay where you nominate the number of hours to accrue 

regardless of hours worked or any other factor. Each time a pay is processed, this number of 

hours will be accrued. 

Option 3 is User to control manually. This option requires you to accrue leave manually by 

adding the accrued leave to the Annual Leave Balance (Hours) or editing the Accruals on the 

Pay Summary page. Leave taken will still be recorded automatically. 

The Annual Leave Balance (Hours) box reports the amount of annual leave that an employee 

has accrued at a point in time. 

When adding an employee who already has leave accrued, record the opening balance of leave 

accrued in the appropriate boxes. 

However, the Leave Balance box advises the current balance of leave accrued and updates 

whenever you process a pay. So, if you do not record the opening balance prior to processing 

pays in Wages Manager you will need to add the opening balance to the amount of any accruals 

calculated by the program and record the total balance. 

The Leave Taken section advises the amount of leave that an employee has taken. When adding 

an employee who has already taken leave, record the opening balance of leave taken in the 

appropriate boxes. 

However, as the Leave Taken updates whenever you process a pay, if you do not record the 

opening balance prior to processing any pays in Wages Manager you will need to add the 

opening balance to the amount of any leave taken calculated by the program and record the total 

balance. 

 

Leave Loading 

Under the Annual Leave Tab, you can enable Leave Loading by ticking the box Does this 

employee have Leave Loading? 

The Leave Loading Rate defaults to 17.5% but can be customised by typing over the default rate. 

Click on [OK] to save changes, or [Cancel] to exit without saving. 

Parental Leave 

A ‘Parental Leave’ tab is included in the Leave section of ‘Employee Details’ where you can 

record the pay rate and set the period the employee will be absent for any employees taking Paid 

Parental Leave. 

When you select that the employee has parental leave, the ‘Pay Rate (per hour)’ prefills with the 

rate applicable at the time the program was released. This amount can be edited if it is different. 

When you select this option for an employee, a ‘Paid Parental Leave’ column will display in the 

‘Pay Single Employee’ work area and in the optional ‘Daily Hours’ window. 

When the pay includes paid parental leave, the system will check to see if the Pay Date falls 

within the date range specified in the ‘Parental Leave’ section of Employee Details and produce 

a message if it is not. This will also occur in the ‘Multiple Pays’. 

A ‘Paid Parental Leave’ column has also been added to the Leave register. Use this instead of 

the old Maternity Leave column that is still listed. 
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Paid Parental Leave does not attract superannuation. It is included in the calculations for the 

Employer Cost report even though the employer does not actually incur the cost as the money is 

derived from the government to avoid different totals in different reports that might lead to 

confusion. 

 

Section 5 - Bank Details 

The Bank Details Tab enables you to record one or more bank accounts for the employee’s pay 

to be paid into when using either Electronic Pay or Cheque payment methods. The pay method is 

chosen under the Pay Details Tab in the Employee’s Details. 

1. Click on the Bank Details Tab to show a list of bank accounts for the employee. 

2. To add a new account, click on the [Add] button. 

3. If the account is going to receive normal pay transfers, ensure that the selector for ‘Normal 

Pay’ is highlighted. If the account is going to receive transfers of salary sacrificed fringe 

benefits amounts, highlight (click on) the selector for Fringe Benefit. See below for more 

information. 

4. Enter the details of the account. The BSB number must in the form XXX-XXX, where X is a 

number. 

5. For one account only, the Default Account and Allocate options are disabled. They will be 

activated for multiple accounts. For more information, see Multiple Bank Accounts below. 

6. Click on [OK]. 

7. Once an account is listed, you can edit the details by clicking on the account name, and on 

the [Edit] button. 

8. Make the required changes and click [OK]. 

9. If you have clicked on [Modify Employee] to do this process, when you have finished all 

changes to the Pay Details information, click on the [Save] button. 

 

Multiple Bank Accounts 
 

Paying an employee electronically requires you to record at least one bank account to pay into. 

Wages Manager gives the option for an employee to split their wages into multiple bank 

accounts, one of which must be the default account. 

Let’s say an employee wishes to have most of their pay paid into their normal account but would 

like $50 of their wage put into a savings account. By providing the details of both accounts, 

Wages Manager can distribute the wage into these accounts. 

In the Bank Details section, click on [Add] to set up a new account. 

Record the details including: Bank Name, Account Name, BSB Number and Account Number. 

The first bank account recorded will be the Default Account but when setting up multiple 

accounts, the Default Account check box will be enabled. Click on the checkbox for the account 

you wish to be the default. Any amounts not allocated to other accounts will be paid into the 

Default Account. 

For non-Default accounts you also need to specify how much of the wage is to be allocated to 

this account. Record the Allocate amount and choose Dollars or Percent from the drop-down 

list. 

Click [OK] to finish. 

 

Bank Accounts for Fringe Benefits Transfers 
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When an employee sacrifices a portion of their pay to receive fringe benefits, it is common to 

transfer an amount per pay into a bank account that is then used to pay the fringe benefits. 

Some employers transfer this into a separate account for each employee whereas others transfer 

the sacrificed pay for all employees into one combined account. 

Note: If you use one combined account it will be necessary to record the account details in 

Options > Bank Details before selecting this option for any employees. 

1. When the salary sacrificed amount is being transferred into a ‘fringe benefits’ account, click 

on the ‘Use for Fringe Benefit’ option so that it is highlighted. 

2. If one combined ‘employer’ account is used for all employees, click in the check box for 

‘Use Combined Account’. (This will select the Combined Employee Fringe Benefit Bank 

Account Details’ recorded in Options > Bank Details.) 

3. If a unique account is used for each employee, leave the ‘Use Combined Account’ 

unchecked and add the details of the account. 

4. To enable reporting of the balance in the employee’s fringe benefit account (i.e. transfers in 

from pays – fringe benefits paid) record the date and the employee’s balance prior to the first 

pay in the Opening Balance box. 

 

 

Section 6 – Superannuation 

Under the Superannuation Guarantee laws, employers are required to make at least a minimum 

level of superannuation contributions on behalf of employees or face large tax penalties. 

(Consequently, another special section is devoted to superannuation requirements because of its 

importance – see ‘Superannuation’). 

Section 5 of the Employee’s Details allows you to record the superannuation details for your 

employee to ensure you contribute the appropriate amount as required. 

You can also detail any employee contributions - where the employee has requested you to 

deduct an amount of superannuation from their after-tax income - and pay this amount to a 

superannuation fund on their behalf. 

 

Employer Superannuation 

Record the details of the superannuation fund used for contributions made by the employer. 

 

Superannuation Fund 
 

Choose a fund from the drop-down list, or if a new fund needs to be created, click on the [Add] 

button. Complete the required information about the fund and click [Save]. Clicking [Cancel] 

will exit without saving. 

Record the Employee Account Number as provided by the employee. If the employee does not 

currently have an account number, this can be recorded later but must be completed before 

recording super payments. 

 

Calculation Options 
 

Specifying how the employee superannuation contributions are to be calculated is one of the 

most complicated aspects of being an employer, because the amount of superannuation you must 

contribute is determined by awards, workplace agreements and the Tax Office superannuation 

guarantee legislation. 
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Under the superannuation guarantee legislation, you must contribute 10 % of the employee’s 

‘earnings base’ from 1 July 2014. The ‘earnings base’ can vary depending on awards and 

agreements, but it cannot be less than ‘ordinary time earnings’. Consequently, you are given 

several options to calculate super. 

1. Pay X percent on ordinary time earnings where X is nominally 10 to meet the current 

Superannuation Guarantee Laws but can be changed. For a definition and more information, 

see Ordinary Time Earnings in Superannuation. 

You can also choose to pay superannuation on items that are not defined as ordinary time 

earnings (such as leave loading, overtime, non-performance bonuses and each type of salary 

sacrifice) by ticking the appropriate boxes. For example, if an employee has fringe benefits 

deducted as salary sacrifice, but the employer has agreed to also pay superannuation on this 

amount, check the box next to Salary Sacrifice Fringe Benefits for inclusion when 

calculating super amounts. 

2. Pay X percent on Y dollars per pay is for entering a percentage of a set dollar amount to 

be calculated for super, where the percentage and the dollar amount can be specified. 

3. Pay X dollars per pay specifies an amount of superannuation is to be paid per pay 

regardless of the pay details. 

NOTE: RDO Hours paid are not included in superannuation calculations as the superannuation 

is calculated from normal hours prior to time being held back for the RDO. 

 

Other Options 
 

If no superannuation is to be contributed by the employer at all, tick the box next to Do not 

calculate super for this employee. All fields relating to employer contribution will be disabled. 

If the employee is under 18 years of age and has worked 30 hours or less in a pay period, or the 

employee is 70 years of age or over, the employer is not required to pay super. Tick the box next 

to Calculate super regardless of employee’s age to override these rules. 

 

 

Reportable Employer Superannuation Contributions 

From the 2009/2010 financial year employers are required to include ‘Reportable Employer 

Superannuation Contributions’ on the employee’s PAYG Payment Summary and in the End of 

Year information supplied to the ATO. If your employer contributions are more than the amount 

required under the superannuation guarantee law, an industrial agreement, the trust deed or 

governing rules of a super fund, or a federal, state or territory law and the amount you contribute 

was influenced by the employee, see the information on ‘Reportable Contributions’. 

 

Employee Superannuation 

This option is available when employees request their employers to deduct superannuation from 

their after-tax pay and send it to the superannuation fund on their behalf. 
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This is NOT used where the employee has foregone some salary or wages under a salary 

sacrifice agreement and had the employer contribute additional superannuation from their pre- 

tax pay. 

(See Salary Sacrifice for more information in this regard.) 

 

Superannuation Fund 

Choose a fund from the drop-down list, or if a new fund needs to be created, click on the [Add] 

button. Complete the required information about the fund and click [Save]. Clicking [Cancel] 

will exit without saving. 

Record the Employee Account Number as provided by the employee. If the employee does not 

currently have an account number, this can be recorded later but must be completed before 

recording super payments. 

 

Calculation Options 
 

There are two options. 

1. Pay X percent of Gross pay where X is a specified percentage of the gross pay. The 

employer will withhold this amount from wages to be paid to the super fund on the 

employee’s behalf. It is important for the employer to ensure this rate is correct, particularly 

as the government has signalled potential change from previously announced rates.) 

2. Pay X dollars per pay where X is a specified amount for contribution to the chosen fund. 

In either case, an employee cannot contribute more than their net wages. The employee 

contribution is derived after all allowances, salary sacrifice, tax, deductions and union fees are 

considered from gross wages. 

 

 

 

 

Reportable Superannuation Contributions 

From the 2009/2010 financial year employers are required to include ‘Reportable Employer 

Superannuation Contributions’ on the employee’s PAYG Payment Summary. 

Reportable employer super contributions are those contributions you make for an employee 

where all the following apply: 

❖ your employee influenced the rate or amount of super you contribute for them, and 

❖ the contributions are additional to the compulsory contributions you must make under 

any of the following: 

o superannuation guarantee law 

o an industrial agreement 

o the trust deed or governing rules of a super fund 

o a federal, state or territory law. 

If the superannuation calculated by the ‘Employer Superannuation’ calculation criteria in the 

Employee Details is reportable, you will need to advise the percentage or amount that is 

reportable using the ‘Reportable Superannuation’ tab in the Employee Details. 

For example, if you are required to contribute 10.5% of Ordinary Time Earnings but your 

employee has requested you to contribute 12.5% of Ordinary Time Earnings as Employer 

Superannuation, then the reportable amount would be 2%. 
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Please note: We are unable to provide Tax Advice. If you are unsure as to whether an amount is 

reportable or not, please contact the Tax Office or your Tax Professional. 

 

Employee Diary 

The Employee Diary allows you to record notes in relation to the employee. These are purely for 

your records, and do not affect any other part of the program. 

To add, view or delete entries in the Employee Diary, select the employee in the Employee List 

and then click on the [Employee Diary] button. 

The Employee Diary can also be accessed from the Processing Pays page by clicking on the 

[Employee Diary] button. 

A list of recorded notes is displayed together with the date. You can sort the list by clicking on 

the column headings. Clicking again will sort the list in reverse order. 

1. To add a new note, click on the [Add] button. 

2. Type in the note, with a maximum of 250 characters. 

3. Set the date for the note at the top. Today’s date will be set as default. 

4. Click on [Save] to record the note or click [Cancel] to exit without saving. 

To edit a note, select the note in the list, and click on the [View/Edit] button. Make the changes 

and click [Save] to save changes. 

To delete a note, select the note in the list, and click the [Delete] button. The note will be 

removed. 

To print diary notes, click on the [Preview] button to show a print preview. 

 

Terminate an Employee 

NOTE: Before terminating an employee, please ensure that all wages have been processed as 

you will not be able to process any pays for this employee once they have been terminated. A 

termination pay can be recorded as part of the process to pay out any remaining leave 

entitlements. 

Terminating an employee will have their status set to Active: No. This is for employees who no 

longer have wages processed. 

To terminate an employee, select them from the Employee List and click on the [Terminate 

Employee] button. 

A message will appear "Are you sure you want to terminate (this employee)?" Click [Yes] to 

terminate or [No] to cancel. 

Select the date of termination and click [OK] to continue. (Click [Cancel] to cancel the 

termination.) 

You will then be asked if you wish to record a termination pay for this employee. 

If you click on [Yes], a page will show with a wizard to step you through processing a 

termination pay. For more information on processing termination pays, see Termination Pays in 

Processing Pays. 

Once terminated, the termination date will be shown in the Employee’s Details under the Pay 

Details Tab next to End Date. 

NOTE: You will still be able to print reports for the employee after terminating but will be 

unable to process pays. 
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Show Terminated Employees 

Employees who are terminated in a Financial Year will be removed from the list for the next 

financial year. They will remain in the current Financial Year list as inactive. 

To show any terminated employees in the Employee List, click on the checkbox next to Show 

Terminated. 

Conversely, to hide terminated employees, uncheck this box. 

 

Re-instate an Employee 

If an employee resumes work or was accidentally terminated, they can be re-instated. 

To re-instate a terminated employee, make sure you have the Show Terminated box ticked to 

see all employees. 

Select the employee from the Employee List and click the [Re-instate Employee] button. 

If the employee had any accrued hours at the time of termination, you will be asked if you wish 

to clear any accruals. Click in the box next to Clear leave accruals and click the [OK] button. 

If accrued hours are not cleared, they will be immediately available again so if this is not the 

intention, ensure you clear leave accruals when reinstating the employee. 

NOTE: Any termination pays recorded will not be removed, but the recorded termination date 

will be cleared from the Employee’s Details. 

 

 

Holiday Makers Tax 

From 1 January 2017, tax rates will change for working holiday makers who are in Australia on a 417 or 462 

visa. These rates are known as working holiday maker tax rates. 

What does this mean for you, the Employer? 

If you employ a working holiday maker in Australia on a 417 or 462 visa: 

Holiday makers are taxed based on total earnings for the financial year. 

Tax is withheld at the following rates: 
 

Taxable income Tax rate 

$0 – $45,000 15% on each $1 up to $45,000 

$45,001 – $120,000 32.5% on each $1 over $45,000 to $120,000 

$120,001 – $180,000 37% on each $1 over $120,000 to $180,000 

$180,001 and over 45% on each $1 over $180,000 

 

 

Penalties may apply if you employ holiday makers but don't register. 
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How does this new tax work in Wages Manager? 

Wages Manager allows you to choose a special tax scale category or industry, specifically for “Holiday 

Makers”. This must be selected, in the Tax Scales section of an employee’s details, to calculate the correct 

PAYG specific to Backpackers. Refer to the Tax Scales section for this information. 

 

 

Domestic Violence Leave 
All employees in the Fair Work system (including part-time and casual employees) will be entitled to 10 days of paid 

family and domestic violence leave in a 12-month period. This new entitlement replaces the existing entitlement to 5 

days of unpaid family and domestic violence leave under the National Employment Standards (NES). 

 

Employees are entitled to the full 10 days upfront, meaning they won’t have to accumulate it over time. The leave 

doesn't accumulate from year to year if it isn’t used. 

 

Family and domestic Violence Leave should be recorded with in pays from February 1st, 2023 for businesses with 

more than 15 employees and August 1st, 2023, for businesses with less than 15 employees. 

Further information about Family and Domestic Violence Leave can be found here. ATO Information 

Domestic Violence Leave tab 
 

A new section has been added to the Leave tab in the employee details. 

 
The first time a file is opened it will set each employee to have 10 days remaining, and Days used will be 0. The 

figures can be manually adjusted if required. 

When a pay is processed with Domestic Violence Leave recorded, the Days Remaining and Days Used balanced will 

be adjusted accordingly. The same will apply if a pay is removed. 
Recording a pay that includes Domestic Violence Leave 

Time taken for Domestic Violence leave is recorded in the Domestic Violence leave tab in the other payments section 

when processing a pay. 

Information on this tab will be tailored to the Pay Structure of the employee. For example, if an employee is on Salary 

then ‘Include in Normal hours’ would change to ‘Include in Base Salary’. 

https://www.fairwork.gov.au/about-us/legislation/the-fair-work-system#who-is-covered
https://www.fairwork.gov.au/newsroom/news/new-paid-family-and-domestic-violence-leave?gclid=CjwKCAiAuOieBhAIEiwAgjCvctTpt0TeRNUrxdn0fXhPT_RESc-yLdIetP1Qv7v76oWCc0nE0YfnWhoCFCcQAvD_BwE&gclsrc=aw.ds
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Click pay Single Employee and enter hours then click Other payments, and select the Domestic Violence Leave tab. 

The user needs to record values for ‘Number of Hours’ and ‘Number of Days’ to ensure correct leave accruals in the 

employee details when pays are processed. 

Select how these payments are to be included in the pay. You can opt to have the Domestic Leave amounts to be 

included in the normal pay hours, or have them listed as a separate line item on the Pay Advice. 

If ‘Include in Normal Hours’ is selected, the Domestic Violence Leave will not show as a separate amount on the Pay 

Summary screen and Pay Advice report. The ‘Normal Hours’ amount will include amounts for Domestic Violence 

Leave. 

If ‘Existing payment name’ is selected, the user can select a name they previously used to disguise Domestic Leave 

Violence. The dropdown list will be empty until a pay has been saved using the ‘New payment name’ option. 

 

If either of the ‘Existing payment name’ or ‘New payment name’ options are used, the amount calculated for Domestic 

Violence Leave will be itemised on the Pay Summary screen and Pay Advice report and the amount for Normal Hours 

automatically reduced. The user does not have reduce the number of hours they enter into the Normal Hours column in 

the initial Single Pay screen to cater for Domestic Violence Leave. 

There are some restrictions of words (Domestic, Violence and Abuse) that cannot be used for the payment name. If the 

payment name contains these words, the user will get the following message. 

 
Once Domestic leave amounts are recorded click OK to save the details and complete the pay processing. 
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Process Pays 

 
Pay Single Employee (Hourly & Salary) 

To process a pay for an individual employee, select the employee from the Employee List and 

then click on the [Pay Single Employee] button. 

A new page will appear to specify the details of the pay. It also lists all previously recorded pays. 

At the top is a description Select the dates for this pay period followed by From and To date 

boxes. Type the dates or click the drop-down arrow to choose from the calendar. (Once a pay has 

been saved, the From and To dates will pre-fill automatically with the next pay period. 

The first column heading is the Pay Process Date, which is the date the employee is paid. It 

does not have to fall within the Pay Period dates and will default to the date of your computer 

settings. To change this, click on the date and use the drop-down calendar. 

The columns that follow the Pay Process Date are for recording the hours or units for which you 

are paying the employee. 

For Hourly Pay Structure employees, there will be a Normal Hours column, followed by any 

other custom rates, shift allowance rates, overtime rates or RDO hours taken that have been 

selected in the Employee’s Details. The normal hours will be automatically loaded from the 

Employee’s Details. To change any amounts, simply click in the cell and type over the amount 

you want. 

For Salary Pay Structure employees, there will be an Unpaid Hours column instead of 

Normal Hours. When the employee has time off without pay, or starts or stops within a working 

period, record the hours not worked in this column. The number of hours recorded is deducted 

from the ‘Normal Hours per week’ recorded in the Employee’s Details to reduce the salary paid. 

For example, if an employee starts 3 days (24 hours) into a working week, and the normal hours 

per week is 40, then you would enter 24 into the Unpaid Hours column. The salary will be 

reduced accordingly. 

For employees with leave entitlements, columns will appear to record leave hours taken. 

A Long Service Leave column can be created for employees with a Salary pay structure, and this 

can also be created for employees on ‘Hourly’ rates using the Custom Rates function. 

If ‘Salary’ is selected from the Pay Structure drop-down menu, the ‘Custom Rates’ tab in the 

‘Pay Options section is renamed to ‘Long Service Leave’. 

To add ‘Long Service Leave’ taken, click on the [Add] button. Long Service Leave will 

automatically pre-fill, allowing you to select ‘Apply Accruals’ and ‘Use in Pay’ if applicable. 

Click [OK]. 

A ‘Long Service Leave’ column will then appear in the ‘Pay Single Employee’ section. 

Note: If you have selected to use the ‘Daily Hours’ option and both the Pay Date and Pay 

Periods match, the columns will be pre-filled from the hours you recorded in the ‘Daily Hours’ 

section. 

The grey columns will be calculated when you click on the [Calculate] button. 

They are followed by a column that allows you to enter a Pay Advice Note. This note will appear 

on the employee’s printed pay advice and may be useful to communicate with an employee or 

notify staff of events or issues. If you wish to include a note for all employees, you can do this 

using Options > Printing Options > Print General Message on All Employee Pay Advices’. 

Buttons on the right are for viewing/deleting previously recorded pays, making changes to this 
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employee’s payroll details, and entering notes in the Leave Register and Employee Diary. For 

more information on these functions, see Pay Employee Options/Buttons. 

Once you have completed the pay details, click on the [Calculate] button to calculate and 

display the Pay Summary, showing gross income, tax and deduction amounts. 

Note: If hours are recorded for Personal/Carers Leave, Annual Leave or RDO’s and the 

employee does not have enough accrued hours to cover the amount recorded, a message will 

notify you of this and give you the option of continuing. 

If necessary, you can change the tax withheld by clicking on the amount and typing in the 

correct amount. You can also edit Leave Accruals if applicable. 

Click on the [Save] button to record the pay. 

NOTE: You can only process one pay per date per employee. If more than one pay is required to 

be processed, you may want to change the Pay Process Date to another day, such as consecutive 

days. 

 

Calculate tax on amounts paid over ‘1’ pay period(s) 

When processing a pay that covers more than one pay period (e.g. when paying employees in 

advance for annual leave), specify the number of pay periods so that tax is calculated correctly. 

For example, if the normal pay period is weekly and you are processing a pay for a week’s work 

and two weeks’ leave, specify ‘3’ Pay Periods for calculation of tax. 

Type the number in the box at Calculate tax on amounts paid over … Pay Periods at the top 

of the Pay Employee page. 

 

Paid Parental Leave 

When Parental Leave is selected for an employee (in the Employee Details section), a ‘Paid 

Parental Leave Hours’ column will display in the ‘Pay Single Employee’ work area. 

When you use this column, the system will check to see if the pay date falls within the date 

range specified in the ‘Parental Leave’ section of Employee Details and produce a message if it 

is not. (This will also occur in the ‘Multiple Pays’). 

 

 

Processing for Allowances, Deductions, Custom Rates, 
Overtime and Shifts 

If you selected any of the custom payroll options in the Employee’s Details, there will be extra 

columns to record the hours for those rates. 

If the employee receives allowances, or pays deductions, the amounts specified in the employee 

details will automatically be considered when calculating the pay. If you wish to review or edit 

these amounts, you can click on the [Edit Payroll Options] button before calculating and make 

the necessary changes. 

For information on editing employee details, see Pay Options. 

(Superannuation and leave entitlements will be calculated based on the chosen Allowance Type, 

Wage Category and Accruals when establishing the Pay Options.) 

NOTE: Shift Loading is part of Ordinary Time Earnings, and hence is included for leave 

accruals and Superannuation calculations. It is not part of Overtime. 
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NOTE: Some functions of the program that are based on ‘time’ (such as Personal/Carers Leave, 

Annual Leave and Leave Loading) will not function under this option. 

For other purposes, the ‘nominated gross amount’ functions in the same way as if you had 

recorded normal hours. 

This means that allowances, commissions and bonuses all add to the nominated gross amount. 

Similarly, deductions and salary sacrifice reduce the nominated gross amount. 

Superannuation is calculated on the basis that the nominated gross is ‘Ordinary Time Earnings’. 

To illustrate how it works, let’s use an example of a truck driver who receives $1000 for the 

load. In addition, he or she is paid $50 for accommodation allowance. 

You would record the Nominated Gross as $1000 (as you have specified the allowance in the 

Allowances section of the Employee’s Details). However, the employee’s gross pay would 

report as $1050 ($1000 for the load + $50 accommodation allowance). 

If the employee has a salary sacrifice amount of $100 then you would still record $1000 as the 

Nominated Gross when processing the pay. However, the gross pay reported would be $950 

($1000 for the load + $50 allowance - $100 salary sacrifice). 

Pay Single Employee (Nominated Gross) 

An employee, whose pay is based on something other than hours, can be calculated using the 

Nominated Gross Pay Structure option. 

 

To use this option the employee’s Pay Structure needs to be Nominated Gross in the Pay 

Details Tab of Employee Details. 

1. To process a Nominated Gross pay for an employee, select the employee from the Employee 

List and then click on the [Pay Single Employee] button. 

The Pay Employee page will be slightly different to normal because a Nominated Gross 

box will appear under the Pay Period date boxes, and there will be no reference to Hours in 

the calculation columns. 

2. Record the total gross wages in the Nominated Gross box. 

3. Make any adjustments to Allowances, Deductions or Salary Sacrifice by clicking on the 

[Edit Payroll Options] button, and then click on the [Calculate] button. 

4. The Pay Summary page will display. Click on the [Save] button to record the pay. 

NOTE: Nominated Gross pays cannot be processed through the Multiple Pays option. 

 

Pay Single Employee (Piece Work) 

The Piece Work Pay Structure is for employees who are paid based on the number of units or 

‘pieces’ completed. 

When a Piece Work Pay Structure is specified, Custom Rates need to be established for each 

unit. 

1. To process a pay for a Piece Work employee, select the employee from the Employee List 

and then click on the [Pay Single Employee] button. 

2. The Custom Rates you have established will appear as columns next to the Pay Process Date 
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column. Record the number of units into each appropriate column. 

3. Make any adjustments to Allowances, Deductions or Salary Sacrifice by clicking on the 

[Edit Payroll Options] button, and then click on the [Calculate] button. 

4. The Pay Summary page will display. Click on the [Save] button to record the pay. 

NOTE: Piece Work pays cannot be processed through the Multiple Pays option. 
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Pay Employee Options/Buttons 

These options are available by clicking on the button on the Pay Employee page when 

processing pays. Select the employee from the Employee List and click on [Pay Single 

Employee]. 

 

View Pay 

To view a previously recorded pay, select the pay from the list and click on the [View Pay] 

button. 

The Pay Summary page will be displayed allowing you to check the details of a previous pay or 

re-print the pay advice. 

Click [Back] to return to the Processing Pays page, or [Cancel] to exit to the Employee List. 

 

Delete Pay 

To delete a pay, select it from the list and click on the [Delete Pay] button. 

To delete multiple pays, click and drag down the left side of the list to select consecutive pays, 

or hold the CTRL key to select any pays. Then click the [Delete Pay] button. 

You will be prompted “Are you sure you want to remove…” with the number of pays selected. 

Click [Yes] to remove the pays or [No] to cancel. 

Deleting pays will automatically adjust any amounts or accruals previously added to the 

employee. However, it will NOT remove entries added to Cashflow Manager, Cheque Writer, 

Electronic Payments or Recorded Super Payments. These will need to be removed manually. 

 

Edit Payroll Options 

This button displays the employee’s payroll details where allowances, deductions, overtime 

rates, custom rates, shift loading rates, union fees, salary sacrifice and RDOs can be added, 

deleted or modified. 

For more information regarding these payroll options, see ‘Pay Options’ in the ‘Employee 

Details’ section of this Guide. 

 

Other Payments 

There are six payments that can be added into a pay in addition to the normal wages and custom 

payroll options. They are Commission, Bonus, CDEP, Back Pay, Unused Fringe Benefits and 

Time off in Lieu, and can be added to a pay by clicking on the [Other Payments] button. 

They are each once-off payments; i.e. the amount will not be automatically added to any future 

pays unlike Allowances that are ongoing payments. 

The tax calculated on the Commission, Bonus, Back Pay and Unused Fringe Benefits payments 

can be adjusted by changing the amount in the box Calculate tax on amounts paid over ‘1’ pay 

period(s). 

For an explanation of this feature, see Calculate tax on amounts paid over ‘1’ pay period(s) 

under Pay Single Employee. 

These payments can be processed without the need to process wages as well. Remember though, 

that only one pay can be processed per pay date per employee. 
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Commission 

To pay a commission to an employee, click the [Other Payments] button on the Process Pays 

page and then the Commission Tab. 

Enter the gross amount of commission to be paid in the Amount box. 

There are two acceptable ways tax can be calculated on commission payments: Option A or 

Option B. 

Option A is the default selection and determines the tax to be withheld by applying the 

commission over the period for which it is paid. 

Option B calculates the tax to be withheld by reference to the progressive total earnings for the 

year to date. 

Select the option under Use Tax Method. 

If the commission relates to a period that extends beyond the normal pay period, record the 

number of pay periods over which the tax calculation is to be made. 

Click on the [OK] button. The Commission will be added to the normal pay when you click on 

the [Calculate Pay] button. 

 

Bonus 

To pay a bonus to an employee, click the [Other Payments] button on the Process Pays page, 

and click the Bonus Tab. 

There are two categories of bonuses: Performance Related and Non-Performance Related 

Bonuses. Performance Related bonuses form part of the Tax Office definition of Ordinary 

Time Earnings and therefore require Employer Superannuation Contributions whereas Non- 

Performance Related Bonuses do not. 

Record the gross amount into the correct box. 

If the bonus relates to a period that extends beyond the normal pay period, record the number of 

pay periods over which the tax calculation is to be made. 

Click on the [OK] button. The Bonus will be added to the normal pay when you click on the 

[Calculate Pay] button. 

 

 

 

 

CDEP 

CDEP payments are payments made from the Community Development Employment Program 

(wages or grants received from the Aboriginal and Torres Strait Islander Commission). 

Unlike commissions, bonuses or back pays, CDEP payments will appear on the PAYG Payment 

Summary as a separate amount. 

To add a CDEP payment, click the [Other Payments] button on Process Pays page, and click 

the CDEP Tab. 

Enter the CDEP payment into the Amount box. 

Click on the [OK] button. The CDEP payment will be added to the normal pay when you click 

on the [Calculate Pay] button. 

 

Back Payments 
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Back Payments are amounts to be paid to the employee that relate to previous pay periods. An 

example of Back Payment is when there is an award pay rise that applies from an earlier date. 

To record a Back Payment, click on the [Other Payments] button on Process Pays page, and 

click the Back Payments Tab. 

To add a new Back Payment, click the [Add] button. 

Choose the Back-Payment Type from the drop-down list. The Tax Office provides a table of 

Back Payment Types that determines whether the payment is to be included for superannuation 

purposes (OTE), and where the amount is shown on the employee’s PAYG Payment Summary. 
 

 

 

Back Payment Type OTE 

Normal Wages or Salary Yes 

Allowances (Ordinary Time Earnings) Yes 

Allowances (Not Ordinary Time Earnings) No 

Superannuation, pensions, retiring allowances or annuities No 

Payments relating to incapacity for work No 

Commonwealth education or training programs No 

Pensions, Benefits covered by Div 52, 53 or 55 of the Income Tax 

Assessment Act 1997 

No 

Directors Fees Yes 

Payments to a religious practitioner No 

 

Choose the Period Accrued from the second drop-down list. 

The period over which the Back Payment is accrued influences how it is taxed and whether or 

not it is classified as Salary and Wages or a Lump Sum E on the PAYG Payment Summary. 

Consequently, if the back payment covers more than one payment period, you will need to 

divide the amount into the separate periods. 

If the period selected is Earlier Financial Year more than 12 months ago you will need to 

specify the financial year accrued. 
 

NOTE: If you have a Back Payment that is $1200 or more accrued more than 12 months ago, 

it will become a Lump Sum E but if the amount is less than $1200 it will form part of Wages 

and Salary. 
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Enter the amount of the back pay into the Amount box. 

Click on the [OK] button. The Back Payment will be added to the normal pay when you click on 

the [Calculate] button. 

If the Back Payment relates to a period that extends beyond the normal pay period, enter the 

number of pay periods over which the tax calculation is to be made. 

The Back Payment will show on the Pay Summary as a separate item. 

 

 

Unused Fringe Benefits 

Unused Fringe Benefits occur when an employee has had ‘salary sacrifice’ amounts deducted for 

the purposes of paying fringe benefits, but it has not been fully used and the decision has been 

made to pay some or all of the balance to the employee as normal salary and wages. 

lick the [Other Payments] button on the Process Pays page, and click the Unused Fringe 

Benefits Tab. 

Record the amount. 

If Superannuation is to be calculated on the payment, click in the ‘Calculate Superannuation’ 

checkbox. (This will probably depend on whether superannuation was calculated on the original 

salary sacrifice.) 

If the unused fringe benefit relates to a period that extends beyond the normal pay period, record 

the number of pay periods over which the tax calculation is to be made. 

Click on the [OK] button. The Unused Fringe Benefit will be added to the normal pay when you 

click on the [Calculate Pay] button. 
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Time Off in Lieu 

STP2 has 2 types of Time Off In Lieu 

1. Hours taken (Leave Type O) 

2. Hours cashed out (Overtime) 

These hours are accumulated when an employee works more hours in a day/week than their 

employment conditions stipulate. 

Once there are extra hours worked, the employee can either 

1. Take time off and still get paid in an agreement with employer that it is 

• Hour for Hour – employee worked 2 hours extra so gets paid 2 hours 

• Hours plus Penalty – employee worked 2 hours extra at time and a half so gets paid 3 hours 

 

2. Cash In the value of the hours in an agreement with employer that it is 

• Hour for Hour – employee worked 2 hours extra so gets paid 2 hours 

• Hours plus Penalty – employee worked 2 hours extra at time and a half so gets paid 3 hours 

NOTE: Time Off In Lieu can only happen if the employee is in a Modern Award or Enterprise 

Agreement. 

To record Time Off In Lieu there is a new Tab in the ‘Other Payments’ section when processing a single 

pay. 
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The option selected will determine if the Time off in Lieu is classified as a Leave Type of “O” (Hours 

Taken) or “Overtime” (Hours Cashed Out) for STP2. 

Time off in Lieu will appear in the ‘Pay Summary’ screen for new and existing pays. 
 

 

Time off in Lieu will appear on the following reports. Pay Advice, Payroll Categories Detailed, 
Combined Payroll Summary, Combined Payroll summary drill down. 

 

Entitlement Balances (Report) 

When your employee is taking leave, you may wish to view their entitlement balance as you 

process their pay. Click on [Entitlement Balances] button to preview the Entitlement Balance 

Report and see at a glance how many hours are available for Annual Leave, Personal/Carers 

Leave and RDOs. 

You can also access this report from the Reports section of the program. 
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Leave Register 

The Leave Register keeps a record of leave taken. You can record the date, type of leave and 

hours taken, and any notes about the leave. It can also be used to help keep track of Long Service 

Leave. It is not linked to any other part of the program, and so is not automatically updated by 

processing pays. 

To open the Leave Register, click on the [Leave Register] button on the Employees screen. 

Alternatively, to open the Leave Register, when in the Processing Pays page, click on the [Leave 

Register] button. 

Choose the date for the entry and enter any amounts of hours into the columns marked Annual, 

Personal/Carers, Paid Parental Leave, Long Service, Parental, Unpaid and Other Leave. 

(Use the ‘Paid Parental Leave’ column for paid parental leave and ‘Parental Leave’ for unpaid 

parental leave). 

Record any notes in the Notes column. 

Click the [Save] button to save the entry or [Cancel] to exit. 

You can edit any entry by simply typing over an amount and click the [Save] button again. 

If you want to delete an entry, select the entry from the left-hand side where the arrow is, and 

click the [Delete] button. You can also click and drag the arrow to select multiple entries. 

To close the page, you must click the [Save] button. 

To print the Leave Register, a Leave Register report for either All or Select Employees is 

available in the Reports section. 

 

Employee Diary 

The Employee Diary allows you to record notes in relation to the employee. These are purely for 

your records, and do not affect any other part of the program. 

For information about using the Employee Diary, see Employee Diary under Employees. 
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Pay Summary 

When you click on the [Calculate] button when processing a pay, the Pay Summary page will 

display a breakdown of the components making up the pay, so you can review the details to 

make sure everything is correct. 

The Pay Description column lists the items on the pay, with symbols showing additions (+), 

deductions (-) and totals (=). The Hours column shows the total hours for that rate, and the 

Amount column shows the calculated total for the rate multiplied by the hours. 

If an employee is paid by Piece Work’, the Hours column will be renamed Units. 

If the hours or inclusions in the pay need to be edited, click [Back] to return to the Process Pays 

page to make the changes. 

Lines that have a grey background in the Pay Summary cannot be modified whereas those with a 

white background can be modified. This includes PAYG Withholding’ so you can edit the tax if 

necessary. Click on the cell in the Amount column and type in the required amount. 

WARNING: Reducing the calculated tax is not recommended unless authorised by the ATO as 

employers are responsible to withhold the correct amount of tax. 

Click the [Save] button to record the pay. A message will appear saying “Pay successfully 

saved. Would you like to close?” If you wish to print the Pay Advice now, select [No] and click 

on the [Print Pay Advice] button. Otherwise, click [Yes] to go back to the Employee List. 

You can print Pay Advices for all employees by selecting Pay Advice from Reports. 

To view a Pay Summary for a previously recorded pay, see View Pay under Pay Employee 

Options/Buttons. 

Note: A PDF Pay Advice is created and saved in the Reports > Pay Advice sub-folder of the 

program every time a pay is saved. 

 

Multiple Pays 

The Multiple Pays option allows for processing multiple pays at one time and can be used for: 

1. Employees for whom you have used the Daily Hours option (including Piece Work 

employees), or 

2. Employees on hourly wages or salary that have not: 

1. Taken Annual Leave, 

2. Taken Personal/Carers Leave, 

3. Taken a Rostered Day Off, 

4. Worked Overtime, 

5. Worked a shift where Shift Allowance applies, 

6. Received Commissions or Bonuses, 

7. Received Back Pay, or 

8. Had any variances in allowances, deductions or salary sacrifice. 

If you have employees where you use Daily Hours (option 1 above), the multiple pay 

calculations will be based on those hours. 

If you have employees in situation 2 (i.e. normal hours) then the program will calculate pays 

based on the Normal Hours. Note: As the program will process all allowances, deductions and 

salary sacrifice amounts enabled for an employee, any adjustments to these amounts should be 

made before processing multiple pays. 

NOTE: Employees with pay structures of Nominated Gross cannot be processed using this 

method and employees on Piece Work rates can only be processed if Daily Hours are recorded 

for them. 
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If you have selected the option to use ‘Daily Hours’, an extra column will appear in the 

Multiple Pays screen that will allow you to select to use Daily Hours recorded for the 

corresponding Pay Date and Pay Period. If you select to ‘Use Daily Hours’ for an employee 

but no records exist with a matching Pay Date and Pay Period then no pay will be processed. 

This will be documented on the message generated after multiple pays have been processed in 

the Multiple Pays Summary Report. 

1. To process multiple pays, click on the [Multiple Pays] button. 

2. A message will appear notifying you of the conditions required for multiple pays. Click 

[Yes] to continue. 

3. Select the Pay Frequency for the group of employees - Weekly, Fortnightly, Monthly or Bi- 

monthly. Only employees with this pay frequency will be displayed. 

4. Set the Pay Date’, i.e. the date that the pays will be processed. (This will pre-fill based on 

the latest pay date saved and pay frequency selected.) 

5. Set the Pay Period dates FROM and TO. (This will pre-fill based on the latest pay date 

saved and pay frequency selected.) 

6. The first column shown contains check boxes to select which employees are to be included. 

There are buttons to [Select All] listed employees, or [Unselect All]. At least one employee 

must be selected. 

7. You can also enter a note (to appear on the pay advice) for each employee in the Pay Advice 

Note cells. 

8. Click on the [Process Pays] button. 

9. A progress bar will appear at the bottom indicating the program is processing wages. A 

message will appear when the pays have been processed, saying “You have successfully 

paid x employees”. Click the [Exit] button to close or the [Print Report] button to print a 

report. This will display a Print Preview of the information about the processed pays. Click 

the [Print] button to print. 

Note: This report is not available in the Reports section and can only be printed while in the 

process of Multiple Pays. 

Note: A PDF Pay Advice is created and saved in the Reports > Pay Advice sub-folder of the 

program every time a pay is saved. 

 

 

 

Pay Employees by Cash 

After processing pays, you can view the Cash Denominations report from the Reports section 

of the program and select either All Employees (for the total cash denominations to be obtained 

from the bank) or Select Employees (for details of the cash denominations for individual pays). 

Only employees with a Pay Method of Cash will be included in the report. 

 

Pay Employees by Cheque or Internet Banking 

Cheques and individual Internet Banking Payments need to be recorded in Cashflow Manager 

(unless using Wages Manager as a standalone product). 

If you would like to use the Cheque Writer module to print the cheques, the Transfers function 

is used to transfer them to both Cheque Writer and Cashflow Manager. See section on 

‘Transfers’. 
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The process is as follows: 

1. Process all required pays for employees with Cheque as the Pay Method 

2. Open the Transfers function page by clicking on [Transfers] on the Employee List page. 

3. Choose Transfer to Cashflow and Cheque Writer option (Transfer to Cheque Writer 

for Wages Manager only.) If you are hand writing the cheques or paying individually by 

Internet Banking, choose the Transfer to Cashflow option (GOLD only). This will transfer 

them to Cashflow Manager where you can simply record the cheque/reference numbers. 

4. Select the date, the employees to be included in the transfer, as well as the Cashflow account 

and column if you are using GOLD. 

5. Click [Save]. 

6. Use the Cheque Writer module to print cheques. See section on ‘Cheque Writer’ for more 

information. 

 

Pay Employees Electronically 

When paying employees by Electronic Banking, the payment needs to be transferred to the 

Electronic Payments module and into Cashflow Manager (unless using Wages Manager as a 

standalone product). 

The Transfers function on the main Employee List page (see the section on ‘Transfers’) is used 

to transfer the payment to the Cashflow Manager account and add it to the Electronic Payments 

list to be processed. 

The process of paying electronically is as follows: 

1. Process all required pays for employees with Electronic Pay as the Pay Method. 

2. Open the Transfers function page by clicking on [Transfers] on the Employee List page. 

3. Choose Transfer to Cashflow and Electronic Payments option for GOLD or Transfer to 

Electronic Payments for Wages Manager. 

4. Select the date, the employees to be included in the transfer as well as the Cashflow account 

and column. 

5. Click [Save]. 

6. A message will appear stating the transfer is complete and asks if you would like to 

open Electronic Payments. Click YES. 

7. Alternatively, open the Electronic Payments module to process the Electronic Payments file. 

8. Send file to bank for funds distribution. 

 

Daily Hours 

The ‘Daily Hours’ option allows you to record the number of hours that an employee works each 

day and break those hours down into their various potential categories. 

When processing Single Pays, the hours for all Pay Categories will be automatically loaded into 

the calculation table if the Pay Date and Pay Period dates match. 

If you use Multiple Plays, Daily Hours gives you more flexibility as it allows you to have 

multiple rates for an allowance as well as calculate Carers Leave, Annual Leave, Overtime etc. 

These are now possible with multiple pays by using Daily Hours although Commissions, 

Bonuses, CDEP, Back Payments and Unused Fringe Benefits are still not able to be processed 

through Multiple Pays. 
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To use the ‘Daily Hours’ function, click on the Options icon and select ‘Use Daily Hours’ in 

Advanced Preferences. 

A [Daily Hours] button will be displayed in the main Employee List window. 

To record the daily hours for an employee, click on the employee in the Employee List and then 

on the [Daily Hours] button. 

Any Pay Dates and Pay Periods previously recorded will be listed. 

To add a new Pay Date, click on the ‘Add’ button. 

Select the ‘Pay Date’ and the ‘Pay Period’ that applies. 

A new window will appear that has a row for each day together with columns for the day, date 

and the pay categories for that employee i.e. Normal Hours, Annual Leave etc. 

Simply record that time that applies into each column, and then click [Save]. 

If you are adding to a record that already exists, click on it to select, and then click on the 

[Modify] button. Make the changes and click on the [Save] button. 

 

Transfers 

This process transfers pays; fringe benefit pay deductions and termination pays from Wages 

Manager into the Money Out section of Cashflow Manager as well as the Cheque Writer and 

Electronic Payments modules. 

For example, Transfers holds pays processed in Wages Manager for payment by cheque or 

electronic methods and then allows the payments to be bulk-transferred to the module handling 

the payments as well as transferring the details to your chosen Cashflow Account and Column. 

Once the transfer has been made, a message will appear stating the transfer is complete. It will 

also ask if you would like to open the Cheque Writer or Electronic Payments screens 

automatically. 

You can also open the Cheque Writer or Electronic Payments module to print out pay cheques or 

complete the necessary electronic banking routine. 

 

Transfers has three steps: 

1. Choose the Transfer Type. 

2. Select the payments to be transferred. 

3. Transfer into either Cheque Writer or Electronic Payments as well as Cashflow Manager (if 

you are using Cashflow Manager GOLD). 

Click on the [Transfers] button on the Employee List page to open the Transfers page. 

The diverse types of transfers are processed separately, so select which of these you wish to 

process. Note: Fringe Benefit Bank Account Transfers relate to salary sacrifice deductions from 

pays that are paid into a separate bank account for paying fringe benefits. 

 

1. Transfer Type 

Transfer to Cashflow Manager Only’: (GOLD only) Enters the wages payment into Cashflow 

Manager, but not make them available for use in the Cheque Writer or Electronic Payments 

modules. 

Transfer to Cashflow Manager and Cheque Writer’: (Wages Manager only will have 

Transfer to Cheque Writer): Use this type if you are using Cheque Writer to print cheques. 

Payments are entered into Cheque Writer as well as Cashflow Manager if you are using GOLD. 
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Transfer to Cashflow Manager and Electronic Payments’: (Wages Manager only will have 

Transfer to Electronic Payments): Use this type for wages paid by electronic banking. 

Payment entered into in the Electronic Payments module as well as Cashflow Manager if you are 

using GOLD. 

Click the [Next] button to proceed. 

 

2. Select Payments 

Once a Transfer Type is chosen, the next page will display any pays processed for the Pay 

Method selected (cash, cheque or electronic). Note: The Pay Method does not display for Fringe 

Benefit Account Transfers. 

Select the Pay Date from the drop-down list at the top. 

Select the Pay Method: Cash, Cheque or Electronic (if applicable). All available pays are 

automatically selected for transfer, but you can unselect items not ready for transfer by un- 

checking the box in the Select column. 

You can use the buttons on the right to select all or none of the items. 

If you are using Cashflow Manager GOLD, select the Cashflow Account and Allocation Column 

the transfer will go into. (The information saved in the first transfer will default for future 

transfers but can be changed.) 

If you are using the Cash or Electronic Pay Methods, you also have the option to Batch as one 

entry in Cashflow Manager. This will record one transaction for the total amount of the 

transfer instead of a separate transaction for each person. 

When this is done, click the [Next] button. 

 

3. Transfer and Enter into Cashflow Manager (GOLD only) 

A page that matches the Cashflow Manager Money Out page will display the transfers to be 

entered into Money Out. You can make any changes such as recording cheque numbers for hand 

written cheques. 

When ready, click the [Save] button. 

The transferred pays will not show up again in the Transfers list but will now be available in the 

Cheque Writer or Electronic module, if chosen. 

For information on using the Cheque Writer module, see Pay Employees by Cheque. 

For information on using the Electronic Payments module, see Pay Employees 

Electronically. 

 

Termination Pays 

Termination Pays calculate payments for Annual Leave, Leave Loading and Long Service Leave 

entitlements on termination of an employee. They can also be used to calculate Redundancy or 

Retirement payments. 

There are two ways to start a Termination Pay: 

1. When terminating an employee, you will be asked if you want to process a Termination 

Pay. Click [Yes] to do so, or 

2. Select the employee from the Employee List. Click on the Tools menu, then 

Termination Pays and then Record New Pay. 

In Wages Manager 14, Termination Pays use a wizard: a step-by-step guide to make it easier to 

process. 
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The first step is to enter the Date of Termination Pay (the date of payment). 

Click on the drop-down arrow to choose the date from the calendar, or type in the box. The date 

must fall in the current Financial Year and must be after the employee’s start date. 

Next, choose the Type of Termination from either Normal Termination or Redundancy…’ 

The Average Weekly Gross Pay defaults to the Hours per Week multiplied by the Hourly Rate 

in the Employee’s Details. If the gross pay often differs from the norm in the Employee’s Details 

you may need to calculate the average weekly gross pay as it is important for calculating the 

correct tax withholding on the termination pay. 

The current Hourly Rate, Annual Leave Balance, Annual Leave Owing (based on hours 

multiplied by the hourly rate) and Leave Loading Owing are also displayed. 

Click on the [Next] button. 

The next page provides boxes to enter the termination pay amounts owing for Long Service 

Leave Entitlements, Annual Leave and Annual Leave Loading and these in turn need to be 

dissected into amounts that relate to the specified date periods. 

(Annual Leave Loading would normally be 17.5% of the relevant Annual Leave amount.) 

Click the [Calculate] button. 

If Redundancy… is the Type of Termination, there will be two more boxes at the bottom to 

record a Bona Fide Redundancy or Early Retirement Payment amount. 

Record the payment amount and the number of completed years of service. Then click on the 

[Calculate] button. The program will check the maximum tax-free amount (according to the 

ATO) based on the amount and the number of completed years recorded. 

If the amount exceeds the tax-free portion, a message will display with the amount to be 

included in an Employment Termination Payment (ETP). Please make a note of the ETP 

amount, as the termination pay will then only include the tax-free portion of the redundancy 

payment. 

Note: Wages Manager does not process Employment Termination Payments (formerly 

called Eligible Termination Payments). If you pay an employment termination payment to an 

employee, you will need to process this manually and report it separately to the Taxation 

Office. 

The portion of the Bona Fide Redundancy or Early Retirement Payment not classified as 

ETP will be saved as Lump Sum D amounts and printed on the PAYG Payment Summary. 

When you are satisfied with the details of the termination pay, click the [Save] button to record 

it. You will be asked if you wish to close but click [No] if you want to print the Pay Summary 

now. 

You can record more than one Termination Pay per employee, providing the date is unique to 

any other Termination Pay record for that employee. 

 

View/Delete Termination Pays 

To view an existing Termination Pay, select the employee from the Employee List. Click on 

the Tools menu then Termination Pays and then View Existing Pay. 

A page will appear where you can choose the Date of Termination Pay from the drop-down 

list. 

Click the [Next] button. 

The Pay Summary will be displayed. Click on the [Print] button to print the pay or click 

[Delete] to remove the record. 
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Lump Sum Payments 

Lump Sum Payments that appear on the employee’s PAYG Payment Summary are determined 

automatically. 

Lump Sum A, B and D amounts are derived from Termination Pays. 

Lump Sums that result from a Normal Termination Pay for resignation or terminated 

employment are: 

Lump Sum A 

❖ Long Service Leave accrued between 16th August 1978 and 17th August 1993. 

❖ Annual Leave accrued prior to 18th August 1993. 

❖ Leave Loading accrued prior to 18th August 1993. 

Lump Sum B 

❖ Long Service Leave accrued Pre-August 16th 1978. 

 

Lump Sums that result from redundancy or early retirement are: 

Lump Sum A 

❖ Long Service Leave accrued 16th August 1978 to the current date 

❖ All Annual Leave 

❖ All Leave Loading 

Lump Sum D 

❖ If the employee is receiving a Bona Fide Redundancy or Early Retirement Payment, 

there are thresholds set by the ATO as to how much the employee can be paid (Tax 

Free) per year of service. These Tax-Free amounts are considered as Lump Sum D. Any 

amounts that exceed the threshold form part of an Employment Termination Payment, 

which is different from the normal Termination Payment. 

Note: Lump Sum E is established and saved if Back Payments of $400 or greater and more than 

12 months before the payment are recorded. 

 

Employment Termination Payments (ETP) 

Wages Manager does not process Employment Termination Payments (formerly called Eligible 

Termination Payments). If you pay an employment termination payment to an employee, you 

will need to process this manually and report it separately to the Taxation Office. 

 

Fringe Benefits 

Fringe Benefit Pay Deductions 

Employees can allocate an amount per pay, or a percentage of their total pay to be paid as fringe 

benefits and have this amount transferred to an account that is used for paying the fringe 

benefits. 

Refer to ‘Salary Sacrifice’ for information on processing the salary sacrifice and ‘Transfers’ for 

information on transferring the deducted amounts to a Cashflow Manager account. 
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Fringe Benefit Payments 

Fringe Benefits Payments are required to appear on your employee’s PAYG Payment Summary. 

To record Fringe Benefits Payments, click on the Tools menu and then Record Fringe Benefits. 

A page will appear listing all recorded Fringe Benefits for this employee. 

To edit a recorded Fringe Benefit, select it from the list and click the [Edit] button. 

To remove a recorded Fringe Benefit, select it from the list and click the [Delete] button. 

To record a new Fringe Benefit, click the [Add] button. 

1. Select the Date of Payment. 

2. Type in the amount to be paid, and a description of the payment (which will show on the 

PAYG Summary). 

3. Select a Tax Category. The options are: Category 1 (includes GST)’, Category 2 (excludes 

GST) or Tax Exempt. 

Category 1 applies if you (the employer) can claim a refund of the GST component of the fringe 

benefit, whereas Category 2 applies where no GST can be claimed. 

(Category 1 amounts are ‘grossed-up’ by multiplying the amount paid by 2.0802and the 

Category 2 amount is ‘grossed-up’ by multiplying the amount paid by 1.8868for calculating 

Fringe Benefits Tax. However, both categories are ‘grossed up’ by 1.8868for reporting on the 

employee’s PAYG Payment Summary for the FBT year commencing 1 April 2014.) 

Select the Tax-Exempt category if it is an exempt fringe benefit. For more information about 

fringe benefits, we recommend that you talk with your tax advisor. 

NOTE: Wages Manager automatically calculates the grossed-up value required to be shown on 

the PAYG Payment Summary for the Fringe Benefits. Fringe Benefits will only be reported on 

the PAYG Payment Summary when the total exceeds $2000 (formerly $1000) during the Fringe 

Benefits Tax Year (1st April to 31st March). 

Also note that Fringe Benefit Payments do not transfer to Cashflow Manager and will need to be 

recorded separately in Cashflow Manager. 

 

Single Touch Payroll 

The program allows you to report payments such as salaries and wages, PAYG withholding 

each time you pay your employee using Single Touch Payroll. 

Cashflow manager uses a third-party provider (Super Choice) to handle the lodgement of payroll 

reporting to the ATO. 

 

Lodger Details 

Before lodging through Super Choice, the first time, lodger details need to be entered. 

If lodger details have not been entered, they will receive a prompt when they click on Validate or Send. 

They can also open this form by clicking the Lodger Details button. 

Users lodging their own payroll select individual as lodger type and fill in Payer information fields and 

click return to go back to main STP form. 

Users lodging on behalf of somebody else need to select Intermediary or Tax Agent as lodger type and 

fill in the client details in the Payer information and enter their details in the Intermediary section, then 

click Return to go back to the Main STP Form. 
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Once Lodger details have been entered the user can enter Name and tick Declaration check box ready to 

send or validate data. 

 

Running Single Touch Payroll 
Run the Single Touch Payroll function by clicking on the Single Touch Payroll button in the Employee 

screen or clicking on the Tools menu and selecting Single Touch Payroll. 

A window will open listing all employees included in the latest pay event. 

Enter the name of the person making a declaration and click [Send]. 

There are three lodgement times available: 

i. New File (Used for a new pay run) 

ii. Update (Allows you to update a record in a previously lodged file) 

iii. Replacement (Full replacement of a previously lodged file. Can only be used for the most recent 

payevent.) 

 

 

Validating data 
To check data without lodging click the Validate button, this will run data integrity checks on your data 

but not lodge with the ATO. If no issues are reported then data is ready to be lodged. 

 

Other Functions 

The [Other Functions] button will allow you to make any adjustments to previous lodged 

data. 

 

Reset : Allows the user to reset a payevent that has been sent. 

 

Create: This will create a payevent entry for selected pays but does not lodge it. 

 

Mark as Sent: This will mark pays selected as sent 

 

View History : This allows the user to view payevents lodged through Super Choice. 

 

 

Confirming Lodgement is Successful 

A message will display to show if lodgement has been successful or if there are issues with the 

data being lodged. 

Final payevents 
 

Pay records need to be marked as finalised at the end of the financial year or upon last pay for an 

employee for that financial year. 

This can be done in three ways. 

 

1) Pay records will have the Final Event indicator ticked automatically when the software 

calculates the next pay date will be in a new financial year. 

 

2) Termination pays will have the Final Event indicator ticked automatically. 

 

3) The final Event Indicator can be ticked manually on and pay record. 
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Superannuation 

Superannuation Guarantee 

The Superannuation Guarantee (Administration) Act (SGAA) was enacted in 1992. The SGAA 

imposes a tax on employers who do not make a minimum superannuation contribution on behalf 

of each employee. 

The minimum contribution is a percentage (currently 10.5%) of an employee’s notional 

earnings base. The Australian Taxation Office has issued several rulings that you can access 

from their website at www.ato.gov.au such as Superannuation Guarantee Ruling SGR 2009/2 

which addresses the meaning of ‘ordinary time earnings’ and ‘salary or wages’. Ordinary Time 

Earnings is relevant to employers for calculating the minimum level of superannuation support 

required for individual employees under the SGAA. 

 

Calculating the Correct Amount of Superannuation 

Wages Manager has incorporated several features to assist you to pay the correct amount of 

superannuation. 

1. Allowances (including reimbursements) have been dissected into several types that conform 

to the required Tax Office treatment for inclusion in ordinary time earnings, salary and 

wages, and printing on the PAYG Payment Summary. 

2. Several options have been included for calculating employer contributions. These include: 

3. A percentage (which needs to be at least 10.5%) of ordinary time earnings 

4. Options to increase this by including leave loading, overtime, non-performance related 

bonuses and salary sacrifice amounts that do not come under the definition of ordinary time 

earnings 

5. A percentage of a nominated amount. This could be used where the employee’s earnings 

base exceeds the maximum contribution base defined by the ATO 

6. A fixed dollar contribution each pay 

 

Please note that the above information and the program calculations are based on contributing to 

an accumulation fund. If you contribute to a Defined Benefit Fund (where an actuary calculates 

the required contribution each year) other rules may apply and you will need to consult your 

professional advisor. 

 

Superannuation Contribution Payment and Reporting 
Rules 

 
Under the Quarterly Superannuation Guarantee that became effective from 1 July 2003, 

employers need to: 

1. Calculate an amount equal to 10.5% of each employee’s earnings. 

2. Pay this amount to a complying superannuation fund at least every quarter, and 

3. Keep a record of all contributions made 

The dates are as follows: 

http://www.ato.gov.au/
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Superannuation Guarantee Quarter Cut-off date for superannuation guarantee 

contributions 

1 July to 30 September 28 October 

1October to 31 December 28 January 

1 January to 31 March 28 April 

1 April to 30 June 28 July 

 

Superannuation Guarantee Audits 

At the request of accountants who have experienced Superannuation Guarantee Audits that have 

caused substantial inconvenience, we have included a Superannuation Guarantee Audit 

Report. 

Because of the wide variety of possibilities when it comes to the earnings base, this report has 

been based only on Ordinary Time Earnings. 

If you review this report, you will notice that it also refers to Salary and Wages. If there is a 

shortfall in contributions, the penalties are based on total salary and wages rather than the lesser 

earnings base. 

Once again, the program automatically includes such items as overtime, leave loading etc. that 

do not form part of ordinary time earnings but are part of salary and wages. 

It must be noted that this report is based on ordinary time earnings and may only be used as a 

guide if your employee has a different earnings base. 
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Add a Superannuation Fund 

A Superannuation Fund needs to be set up before any contributions can be paid into it. There are 

three ways to add a new fund. 

1. In the Employee’s Details, under the Superannuation Tab, there is an [Add] button to add a 

new super fund. 

2. In the Superannuation section of the program, click the [Add Fund] button. 

3. When adding a Salary Sacrifice in the Employee Details section. 

Either one will open the page to fill in the Super Fund details. This consists of: Fund Name, 

Employer ID Number, the Fund’s Phone Number, and the Address of the fund. You must at least 

complete the Super Fund Name (max. 50 characters) and Employer ID (max. 20 characters). 

Click the [Save] button to add the fund. 

Fund details can be modified in the Superannuation section of the program by selecting the 

fund from the list and clicking the [Modify Fund] button. 

This will open the same page with the Super Fund details, which you can modify, then click on 

[Save] to save changes, or [Cancel] to exit without saving. 

NOTE: Once a fund has been added, it can only be removed if it has not been used in any saved 

pays. 

 

Record Superannuation Payments 

Employers are required to make a minimum of 4 Superannuation contributions (quarters) per 

year to the employee’s Super fund. Employers also have the option to pay once a month. As pays 

are processed in Wages Manager, the program keeps track of Super calculated on each pay in 

each month or quarter and stores them under the employee’s chosen Super fund. It is here that 

you can see what payments are to be made to the fund. 

It is recommended that you record your superannuation payments as you make them for accurate 

reporting. If you make superannuation payments monthly, then record the payments the month 

that the contribution applies to. If you make quarterly payments, then record these payments 

each quarter. 

To view and/or record a Super contribution, open the Superannuation section of the program. 

Select the Super Fund from the list and click the [Pay Fund] button. 

Choose the Contribution Period from the drop-down list, either a quarter or a month. 

Set the Payment Date’, the date the payment is made to the fund. 

To record the payment in Cashflow Manager and either Cheque Writer or Electronic Payments 

(depending on how you pay the Superannuation Fund), click on the button for the option you 

require. 

Click the [Next] button. 

The list will show any employees who currently have Superannuation to be paid to the fund for 

this period. If no employees are listed, there are either no payments to be made for this period 

(processed pays have not calculated Super), or payments have already been recorded. 

Employees can be selected or unselected to be included in the Super Payment, by clicking the 

tick box in the first column. 

The amounts in the Employer Contribution, Employee Contribution, and Salary Sacrifice 

columns can be adjusted. This is a voluntary adjustment and will not affect the amounts 

calculated in future. Click in the cell to change the amount. NOTE: you should not reduce the 

contribution amount to less than your legal requirement. 
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The Total Payment column shows the amounts that will be paid when recorded, while the 

Amount Owing column shows the minimum requirement on the employer’s behalf. 

When ready to record the payment, click the [Save] button in the bottom right corner. 

If you are using Cashflow Manager GOLD and have selected to transfer the payment into a 

Cashflow Manager Account, the button will be [Continue] instead of [Save]: 

 

1. Select the Cashflow Account in which to record the payment. 

2. Select the Allocation Column. 

3. If you want to combine into a single transaction, tick the Group as one entry checkbox 

4. Click the [Continue] button 

5. Allocate the amount(s) to the appropriate Allocation Column(s) 

6. Click the [Save] button. 

 

 

 

View/Delete Superannuation Payment History 

To view previously recorded Superannuation payments, select the fund from the list and click 

the [History] button. 

Choose the Contribution Period for which the payment would have been made. 

Click the [Next] button. 

The page will display a list of any payments that have been made to the chosen Superannuation 

Fund for the period chosen. 

You should see the employee’s name, payment date, the employer and employee contributions 

and salary sacrifice amounts, and the total for each payment. 

The first column has check boxes to select payments to delete. 

Click on the payments you wish to remove, and then click the [Delete] button. 

 

Delete/Hide Superannuation Funds 

A superannuation fund that has not had any transactions can be deleted by selecting the fund and 

clicking on the [Delete Fund] button. 

However, if the fund has transactions such as superannuation allocations for an employee, it 

cannot be deleted. Click on the [Manage Fund List] button. By clicking in the ‘Hide’ check 

box, the fund will no longer appear in the list of Funds under the Superannuation tab. 

 

 

SuperStream 

The ATO has made it compulsory for small business employers to meet the SuperStream 

standard by June 30, 2016. In the past, most employers have had to process employee super 

contributions to numerous funds in different formats. Under SuperStream, the data is sent 

electronically in a standardised format. This means you will spend less time dealing with 

employee data issues and fund queries. Most small businesses will use a single channel called a 

clearing house to pay contributions to multiple funds. There are multiple different options of 

clearing houses in Australia, some that charge for the service and some that are free. The ATO 
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also offers a clearing house service, which is free for small businesses with less than 20 

employees and turnover less than two million dollars. 

Here are the steps you need to take to ensure that you are SuperStream compliant at 30 June. 

NOTE: This information is being written in June 2016. For employers with less than 20 

employees, and who pay superannuation quarterly, the first SuperStream lodgement will occur in 

late October. 

 

Are you SuperStream Ready? 

 

Before you get started with SuperStream you must make sure you have downloaded 

Version 14 of Cashflow Manager GOLD or Wages Manager from our website. 
http://www.cashflow-manager.com.au/Support/Downloads.aspx 

 

1.  Choose a SuperStream Option 

Before you get started with SuperStream you need to think about which payment option will be 

best for your business. 

There are currently two ways in which you can make your SuperStream payment: 

 

Manual Method 

• Register your company and employees with the clearing house of your choice. 

• Create a Superannuation Remittance report in your payroll software. 

• Login to your clearing house and manually enter the super payment for each employee. 

Make a single payment. 

 

File Method 

• Register your company and employees with the clearing house of your choice. 

• Create a Superstream SAFF (SuperStream Alternative File Format) in your small 

business payroll software. 

• Login to your clearing house and import your SuperStream file. 

 

2.  Choose a Clearing House 

A clearing house is an organisation that pays super to your employees’ funds for you. You send 

a single electronic payment to the clearing house together with the contribution data for your 

employees and they do the rest. 

Some clearing houses such as ClickSuper charge a fee per employee, and some like Australian 

Super provide the service for free. Many superannuation funds have clearing house capabilities, 

and these be free or a paid service, we recommend you talk to your superannuation fund if you 

wish to use this option. There are also other specialist businesses who offer a full clearing house 

facility for a small fee per employee. 

Another option is to use the ATO’s free small business super clearing house. With this clearing 

house option, you can only use the manual SuperStream method. 

NOTE: Cashflow Manager is not a clearing house and does not recommend any provider. 

 

3.  Collect information and update employee records 

http://www.cashflow-manager.com.au/Support/Downloads.aspx
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To use SuperStream you will need to obtain some additional information from your employees, 

in addition to the information you already have. 

Once you have this information you will need to enter it into Cashflow Manager, along with the 

other details you use to pay super. 

 

You need to collect this information for current employees: 

Employee tax file number 

Superannuation fund ABN 

Superannuation fund unique super identifier (USI) 

 

If your employees have a self-managed super fund (SMSF), they need to give you: 

Employee tax file number 

Superannuation fund ABN 

Fund bank account details 

Fund electronic service address 

 

Employees can find this information on their last super statement or by calling their fund. 

 

4.  Enable SuperStream within your Cashflow Manager Program 

 

When you first open Wages Manager in Version 14 you will be asked if you would like to use 

SuperStream. Click [Yes]. 

You will be taken to the Options menu. Tick the box that says ‘Use SuperStream’ 

 

5. Upload your files to your clearing house or enter manually, depending on the method 

you have chosen, then make payment. 

SuperStream – Manual Method 

For employers choosing the Manual Method: 

• Register your company and employees with the clearing house of your choice. 

• Create a Superannuation Remittance report in your payroll software. 

• Login to your clearing house and manually enter the super payment for each employee. 

Make a single payment. 

The Version 14 program includes a Report Option to cater for people using a clearing house for 

super payments. 

The Superannuation Remittance Report allows you to select ALL FUNDS within your business 

file. 

This allows a comprehensive report for all employees, for all funds, without having to generate a 

report for each individual fund. 

You can then manually enter these figures online using the “Superannuation Clearing House”. 
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To do this in Version 14, please follow these instructions: 

1. Click on the [Reports] tab. 

2. Select the SUPERANNUATION REMITTANCE Report and click [Next]. 

3. Please specify the options for this report, by selecting the applicable Employees and 

Contribution Period. For a comprehensive report, select ALL FUNDS. Click [Preview]. 

4. A preview of the report will now appear. You can print, email, or save the report as a PDF. 

This report will display the employees, super payment amounts, for each fund. 

You can now login to your Clearing House, and manually enter the super payment for each 

employee. 

For information on this process, please contact your Clearing House. 

 

SuperStream – File Method 

For employers choosing the File Method: 

• Register your company and employees with the Clearing House of your choice. 

• Create a Super Stream SAFF (Superannuation Alternative File Format) in your small 

business payroll software. 

• Login to your Clearing House and import your Super Stream SAFF file. 

The Cashflow Manager GOLD and Wages Manager Version 14 programs are Super Stream 

ready and compliant. 

The program is designed to create an electronic SAFF file. The Clearing House then pays super 

to your employee’s funds for you. You simply upload the SAFF file to the clearing house, and 

they do the rest. 

For more information on which Clearing House to use, please contact your Super Fund to see 

what they offer. 

 

The Super Stream File Method Process: 

 

1.  INITIAL SUPER STREAM SET-UP: 

To enable the Super Stream functionality, it must first be turned on, and an initial set-up 

complete. 

 

To do this, please follow these instructions: 

1. Once you have installed Version 14, and converted your previous Version 12 file, click on the 

Wages tab. A message will automatically appear asking if you would like to switch on Super 

Stream. Click [Yes] (if you decide NO, you can switch Super Stream on later via 

Tools/Options). 

2. Once you click YES, tick the option USE SUPER STREAM 

3. Once the option is selected, the SUPER STREAM SET-UP screen will appear 

4. The Super Stream Set-up screen requires you to record Super Fund and Employee Information 

that has not been previously recorded. Each super fund name, and if they are Super Stream 

Ready will appear. Each fund needs to be selected individually and modified. To do this, select 

the appropriate fund, and click MODIFY FUND. 
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The MODIFY SUPER FUND screen will then appear. You will then need to select the following 

options: 

FUND TYPE – select either APRA (a fund regulated by the Australian Prudential Regulation 

Authority or a retirement savings account RSA), or SMSF (Self-Managed Super Fund). 

FUND DETAILS – the program includes a complete list of Super Fund Names, with their 

corresponding ABN, USI (Unique Super Identifier), and Product Name. 

For APRA fund types, click on the Fund Name drop down menu, and select the correct fund (for 

further information on choosing your Fund Type, and Super Fund Product, please contact your 

Superannuation Fund). 

This will automatically pre-fill the Fund ABN and USI. 

For SMSF types, you will need to enter the Fund Name, Fund ABN, Fund Electronic Service 

Address, and Fund Bank Details. 

The fund address and phone number can also be added. 

Once the process is complete, click [Save]. 

Repeat this process for all individual funds 

Once this process is complete, click on [Next]. 

You then need to select a GENDER from the drop-down list in the “Gender” column for each 

employee. 

Once all the employees have been allocated a gender, click [Save]. 

The Super Stream set-up is now complete. 

 

2.  CREATING THE SAFF ELECTRONIC FILE: 

 

Once you have set-up the Super Stream option, you are now ready to create your electronic file. 

The program is designed to create an electronic payment file, known as SUPERANNUATION 

ALTERNATIVE FILE FORMAT (SAFF), to be uploaded to a Clearing House of your choice. 

The Clearing House then pays super to your employee’s funds for you. You simply upload the 

SAFF file to the clearing house, and they do the rest. 

 

To Create the SAFF file, please follow these instructions: 

 

1. Click on the SUPERANNUATION tab at the top of the screen. 

Here, you will find the list of super funds, and a SUPER STREAM button. 

Please Note: for further information on Super Stream, please click on the “Super Stream 

Info” link. 

2. Click on the [SuperStream] button. 

3. The SUPERANNUATION PAYMENTS screen will then appear. Here, select the correct 

“Contribution Period”. The “Payment Date” will default to “today’s” date. You also have the 

option to transfer the payment to Cashflow Manager. Once selected, click [Next]. 

4. A Superannuation Payments screen will then appear. This section will show the following: 

• Employee Name 

• All Fund Names (the SAFF file will contain ALL funds and relevant employees) 

• Employer Contribution Super Guarantee amount 

• Employer Contribution Voluntary amount (if applicable) 
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• Employer Contribution Award amount (if applicable) 

• Salary Sacrifice amount (if applicable) 

• Employee Contribution amount (if applicable) 

• Total Super amounts for each individual employee 

• Total Super amount for all employees. 

 

5. Click on the [Create SuperStream File] button. 

6. The SENDER & PAYER INFORMATION screen will then appear. Here, the Organisation 

Name and ABN will automatically pre-fill. Type in the following information: 

• Given Name/Other Given Name 

• Surname 

• Email 

• Phone 

• BSB 

• Account Number 

• Account Name 

# All information must be entered before creating the SAFF file. 

7. Click on the [Create SAFF] button. 

8. The SAFF file will be in a CSV format. The FILE NAME will automatically pre-fill, and the 

file location will default to C/Users/Username/AppData/Roaming/CFM/Cashflow14/SBR (you 

can change the file location by navigating to it (E.g. Desktop). 

Click on the [Save] button. 

The SAFF file has now been created, and the Superannuation Payment successfully recorded. 

The SAFF file can now be uploaded to your Clearing House. For instructions on this process, 

please contact your Clearing House. 

 

# PLEASE NOTE: 

The CARE Support Team provide support on how to use the Super Stream function, 

within our program, only. We cannot advise on your type of fund, super fund product, or 

clearing house functionality. 

For further information on choosing your Fund Type, and Super Fund Product, please 

contact your Superannuation Fund. 

For further information on uploading the SAFF file to your Clearing House, please contact 

your Clearing House. 

For more information on Super Stream, please visit the ATO website by clicking on the 

following link: 

https://www.ato.gov.au/Super/SuperStream/In-detail/Contributions/Contribution-data-for- 

SuperStream/ 

Reports 

The Reports section has comprehensive reports including analysis reports, ATO requirements, 

PAYG Summaries, Superannuation payments, and Pay Slips. 

https://www.ato.gov.au/Super/SuperStream/In-detail/Contributions/Contribution-data-for-SuperStream/
https://www.ato.gov.au/Super/SuperStream/In-detail/Contributions/Contribution-data-for-SuperStream/
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Report Options – Wages Manager 

Once a report is selected, there are options to select different parameters for the generation of the 

report. Different reports have different options depending on the type of report, but most have 

similar options, such as selected employees, a date range or specific type of report. 

The Choice of Reports table includes a column showing the different Report Options. These 

are: 

B – Branch filter. Option to report for a selected branch 

D – Date Period. Choose a report date range from Last Month, Last Quarter, Last Year, This 

Month, This Quarter, This Year or Custom (select report start and end periods). 

E – Employee selection. Choose either All Employees, or Selected Employees (brings up a list 

of all employees to tick selected or not). 

F – Filter report. Report will show information based on filters e.g. Summary or Detailed 

P – Pay Process Date. Will list any processed pay dates to view information on pays. 

T – Type of printout. Choice of print layout or specific print media. 

 

Types of Reports – Wages Manager 

Wages Manager includes the following reports: 
 

 

REPORT DESCRIPTION Report 

Options 

Allowances Summary of all allowances for all employees or for 

each individual allowance 

B, D, E, F 

BAS Information required for preparing your Business 

Activity Statement or Instalment Activity Statement 

D, E 

Cash 

Denominations 

The cash denominations needed to pay employees in 

cash 
B, D, E, P 

Choice of Super 

Form 

Employee Choice of Superannuation Form - 

Combined Payroll 

Summary 

Summary of all payroll categories for all employees. 

(Has option to include Termination Pays) 

B, D, E 

Deductions Summary of all deductions for all employees or for each 

individual deduction 

B, D, E, F 

Employee 

Address Labels 

Prints Employee Name and Address Details using 

Avery labels 

E 

Employee Bank 

Accounts 

Lists bank accounts setup for employees E 

Employee Custom 

Rates 

Lists Custom Rate Columns setup for employees E 

Employee Details Contact and pay information for employees B, E 

Employer Costs Identifies the costs the employer incurs B, D, E 
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Entitlement 

Balance 

Balance of leave and RDO entitlements B, E 

Entitlement 

History 

History of leave and RDO entitlements B, D, E 

Fringe Benefits 

Account Balances 

Tracks the balance of an employee’s fringe benefit 

account after pay deductions, fringe benefit payments 

and account adjustments 

B, E. D 

Fringe Benefits 

Paid 

Lists Fringe Benefits paid together with ATO ‘gross-up’ 

for reporting on PAYG Payment Summaries 

B, D, E 

Leave Register Show all details of the type of leave taken and when it 

was taken 
B, D, E 

Pay Advice Pay Advice for employees’ pay B, E, P, T 

Pay Advice List A list of pays detailing Pay Categories, Pay Rates and 

Amounts (Excel only) 
B, E, P 

Pay Advice 

Summary 

Summary of pay advices including Gross Pay, PAYG 

Withholding and Net Pay 

B, E, P 

Pay History Pay history for all employees or selected employees B, D, E 

Pay Hours Lists total hours worked for each pay category (Excel 

only) 

B, D, E, F 

PAYG Payment 

Summary 

PAYG Payment Summaries for employees B, E, T 

PAYG Summary 

List 

Summary of PAYG Payment Summaries for all or 

selected employees 

B, E 

Payroll 

Categories 

Pays dissected into different payroll categories of 

wages, deductions, PAYG Withholding, Net Pay and 

Superannuation 

B, E, D, F 

Salary Sacrifice Salary Sacrifice broken into the categories nominated B, E, D 

Superannuation 

Contribution 

Report for employees on superannuation contributions 

made by the employer 
B, E, D, F, T 

Superannuation 

Remittance 

Remittance amounts by nominated Super fund B, E, D, F 

Superannuation 

Guarantee Audit 

Matches the requirements of the Tax Office when 

auditing employers re the Superannuation Guarantee 

legislation. NOTE: This report uses Ordinary Time 

Earnings and will not apply for any employees with a 

different earnings base 

E, D 

Superannuation 

Payments 

Payments made to superannuation funds B, E, D, F 

Termination Pays Report of employees Termination Pay B, E, D, F 

Union Summary Union deductions from employee pays B, E, D, F 
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NOTE: The Entitlement Balance Report can also be viewed/printed from the Processing Pays 

page by clicking on the [Entitlement Balances] button. The Pay Advice can also be printed 

when viewing the Pay Summary. All other reports are printed from the Reports section only. 

An additional report not included above is a PDF report that is created and saved in the Reports 

> Pay Advice sub-folder of the program every time a pay is saved. 

 

 

 

End of Year Requirements 

Employee PAYG Payment Summaries 

Employers are no longer required to provide their employees with a PAYG Payment 

Summary but can print one for an employee if requested. 

 

With STP pay lodgement employees can view and print payment summaries from their 

myGov accounts. 

Employees can print their own payment summaries from within their myGov account. 

Employee will show as ‘year to date’ throughout the financial year. After July 1 the figures 

will show as ‘Not Tax ready’ until the employer has lodged a final pay indicator. 

Figures will show as ‘Tax ready’ once the final pay indicator has been sent to the ATO. 

 

Tax Office Reporting 

End of year reporting is done through STP. 

 

To full fill your end of year reporting obligations, pay records need to be marked as finalised at the end of 

the financial year or upon last pay for an employee for that financial year. 

 

 

Commence a New Financial Year 

Once all pays are processed, PAYG Summaries are printed and the Annual Report is submitted 

to the Tax Office, you can roll forward to commence a new financial year. 

Click on the Tools menu, then Financial Year and then Start New Financial Year. 

A page will appear showing you the new financial year ending. 

Click the [Save] button to proceed, or [Cancel] to remain in the current year. 

A message will say ‘New Financial Year Created. Would you like to adjust 

your employee’s superannuation rates?’ 

Click yes to update rates to New rate listed for all selected employees. 

Click No if you wish to update the rates individually for your employees. 
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Tips, Tricks & Other Features 

Lodge Tax File Number Declarations via Standard 
Business Reporting 

Every time a new employee starts employment, the employer is required to have them complete 

a Tax File Number Declaration form and send it to the Tax Office. 

It is this Tax File Number Declaration Form that provides the information to add the employee 

to Wages Manager and determine the Tax Withholding Scale that applies. 

The new ATO Standard Business Reporting allows you to lodge the Tax File Declaration Data 

directly from the program. 

To use this, you must first have registered for this option with the Australian Taxation Office and 

connected to the Internet. 

Click on Tools > Lodge TFN Declaration via SBR 

The SBR Settings page will open. 

The first time you use this you will need to create the settings. However, if you have already 

done this for lodging your BAS or PAYG Payment Summaries via SBR, the details previously 

recorded. 

So, it may simply be a case of typing in your Password and then clicking on [Next]. 

If you are setting up for the first time, the Lodgement Details and Auskey Credentials will be 

information supplied from the Tax Office when you registered for Standard Business Reporting. 

The ‘Keystore’ or ‘Auskey’ is a file supplied by the ATO, needs to be saved on your computer 

and selected in the setup process. 

The Payer Information is for your business. The Intermediary Information relates to any 

intermediary such as your accountant who lodges this information on your behalf. 

When you have completed this information, or entered your password when you return, click on 

[Next]. 

Note: This information will automatically appear when you next open this section. However, you 

will need to type in the ‘Keystore or Auskey ‘Password’ supplied to you by the ATO each time 

you use the SBR lodgement. 

When you click on [Next] you can select the employee(s) for lodgement. 

Note: if you are doing this for the first time and have previously lodged Tax File Number 

Declarations for some employees, select those employees and then click on [Mark as Lodged]. 

Then select and lodge the TFN Declaration for the new employee(s) as required. 

Once you have completed the form, click on [Prelodge] to have the ATO check your form, or 

[Lodge] to lodge your form. 

Note: Fields that can be edited are highlighted in blue. 

 

View Previous Financial Year Records 

To roll back to a previous financial year’s records to view or edit, click on the Tools menu, then 

Financial Year and then View Previous Financial Year. 

You can choose which previous year to roll back to if there are records to view. 
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Once a previous financial year is rolled back, you can make changes to records. 

WARNING: If you have already reported to the ATO about wages records for that 

financial year, any changes may need to be re-sent to the Tax Office. Only make changes if 

necessary. 

To return to the Current Financial Year Records, click on the Tools menu, then Financial Year 

and then View Current Financial Year. 

If you are in a prior financial year and close the program, the current financial year will 

automatically open next time you open the file. 

 

Minutes Converter 

A small utility is included which converts minutes into hours and decimals of hours. For 

example, 90 minutes will be converted to 1.5 hours. You can run this utility by clicking on the 

Tools menu and then Minutes Converter. All you need to do is type in the number of minutes 

in the top box and click the [Convert] button. The converted hours will show in the bottom box. 

Tax Office Changes to Withholding Scales 

When the Government effects changes to the Income Tax Withholding Scales, the Wages 

Manager software needs to be updated to conform to those tax calculation changes. 

This is important because it is not only the Tax Withholding Scales that change on a regular 

basis. Every year there are changes to various thresholds and functions that affect several 

calculations within the program. 

Registered users of Wages Manager who are current CARE members will be notified of the 

procedures required to update the program. 

Users who are not CARE members will need to purchase the update or manually calculate the 

correct tax to avoid being fined by the Tax Office. For further information, please call Cashflow 

Manager on 08 8275 2000. 
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Assets Manager 

What is a Depreciating Asset? 

A depreciating asset is an asset that has a limited effective life and can reasonably be expected to decline in 

value over the time it is used. Depreciating assets include such items as computers, electric tools, furniture 

and motor vehicles. 

Land and items of trading stock are specifically excluded from the definition of depreciating asset. Most 

intangible assets are also excluded from the definition of depreciating asset. Only the following intangible 

assets, if they are not trading stock, are specifically included as depreciating assets: 

• in-house software 

• certain items of intellectual property (patents, registered designs, copyrights and licences of these) 

• mining, quarrying or prospecting rights and information 

• certain indefeasible rights to use a telecommunications cable system 

• certain telecommunications site access rights 

• spectrum licences, and datacasting transmitter licences. 

 

Improvements to land or fixtures on land (for example, windmills and fences) may be depreciating assets and 

are treated as separate from the land, regardless of whether they can be removed or not. 

 

In most cases, it will be clear whether something is a depreciating asset or not. If you are not sure, contact 

the ATO or your recognised tax adviser. 

 

Definitions 

The most commonly used terms regarding depreciating assets, are: 

 

Adjustable value: A depreciating asset’s adjustable value at a particular time is its cost (first and second 

elements) less any decline in value up to that time. 

 

The opening adjustable value of an asset for an income year is generally the same as its adjustable value at 

the end of the previous income year. 

 

Balancing adjustment amount: The balancing adjustment amount is the difference between the termination 

value and the adjustable value of a depreciating asset at the time of a balancing adjustment event. 

If an asset’s termination value is greater than its adjustable value, the difference is generally an assessable 

balancing adjustment amount. 

If the termination value is less than the adjustable value, the difference is generally a deductible balancing 

adjustment amount. 

Balancing adjustment event: Generally, a balancing adjustment event occurs for a depreciating asset if you 

stop holding it (for example, if you sell it) or you stop using it and you expect never to use it again. 

Car limit: If the first element of cost of a car exceeds the car limit for the financial year in which you start to 

hold it, that first element of cost is generally reduced to the car limit. The car limit for 2016–17 is $57,581. 

Decline in value: Deductions for the cost of a depreciating asset are based on the decline in value. 

 

For most depreciating assets, you have the choice of two methods to work out the decline in value of a 

depreciating asset: the prime cost method or the diminishing value method. 

 

Depreciating asset: A depreciating asset is an asset that has a limited effective life and can reasonably be 
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expected to decline in value over the time it is used. 

Effective life: Generally, the effective life of a depreciating asset is how long it can be used by any entity for 

a taxable purpose or for producing exempt income or non-assessable non-exempt income: 

• having regard to the wear and tear from your expected circumstances of use 

• assuming it will be maintained in reasonably good order and condition, and n having regard to the 

period within which it is likely to be scrapped, sold for no more than scrap value or abandoned. 

 

First element of cost: The first element of cost is, broadly, the amount paid (money or the market value of 

property given) or the amount taken to have been paid to hold the asset. It also includes amounts incurred 

after 30 June 2005 that are taken to have been paid for starting to hold the asset. The amounts must be 

directly connected with holding the asset. 

Holder: Only a holder of a depreciating asset may deduct an amount for its decline in value. In most cases, 

the legal owner of a depreciating asset will be its holder. 

Indexation: Indexation is a methodology used in calculating a cost for capital gains tax for depreciating 

assets acquired before 21 September 1999 that have been used partly for a private purpose. 

Second element of cost: The second element of cost is, broadly, the amount paid (money or the market 

value of property given) or the amount taken to have been paid to bring the asset to its present condition and 

location at any time, such as the cost incurred to improve the asset. It also includes expenses incurred after 

30 June 2005 on a balancing adjustment event occurring for the asset, such as advertising or commission 

expenses. 

Start time: A depreciating asset’s start time is generally when you first use it (or install it ready for use) for 

any purpose, including a private purpose. 

Taxable purpose: A taxable purpose is the purpose of producing assessable income, the purpose of 

exploration or prospecting, the purpose of mining site rehabilitation, or environmental protection activities. 

 

Termination value: Generally, the termination value is what you receive or are taken to receive for an asset 

because of a balancing adjustment event. For example, the proceeds from selling an asset would be the 

asset’s termination value. 
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Recording Depreciating Assets 

The Cashflow Manager GOLD program includes an “Assets” section, accessible via the “Side Panel”. 

This section allows you to record depreciating assets and generate a comprehensive report. 

Cashflow Manager GOLD calculates your figures automatically, based on the ATO formulae built into the 

program, thresholds and depreciating method rates. 
 

 

 

 

 

Add a Depreciating Asset 

Depreciating Assets can be added to the “Asset Register”. The Asset Register is accessed via the 

Side-Panel. 

The Asset Register allows you to add, edit, and delete depreciating assets. 

The recorded transaction includes Cost, Opening Deducted Cost, Depreciation Method, Rate, 

Depreciation, Closing Undeducted Cost, Recouped Depreciation, Gain, and Status of the asset. 

There are 5 different Depreciation Methods to select from. Each has a different Rate built into 

the program. The Depreciation, Closing Undeducted Cost, Recouped Depreciation, and Gain are 

automatically calculated based on the Cost of the asset, and Depreciation Method chosen. 

 

These depreciation methods and rates include: 

• Prime Cost = 10% 

• Diminishing Value = 10% 

• Diminishing Value – Low Value Pool = 40% 

• Low Value Pool = 37.5% 

• Write-Off = 100% 

 

The Asset Register operates via Financial Year. It is important to be in the correct Financial Year 

before recording your assets. 
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How do I add a depreciating asset in the Asset Register? 

 

1. Make sure you are in the correct Financial Year Ending – this selector is located in 

the top right corner of the register. 

2. Select the asset purchase date, by accessing the date selector in the DATE 

PURCHASED column. 

3. Select the asset, by accessing the drop-down list in the ASSET column. This list 

includes 6000 or more assets. It is very important to select the correct asset. A 

helpful hint to find your asset – at the top of the register screen, you can filter assets 

based on Business Type, Asset Type, or searching for a specific asset. 

4. Enter any details regarding the asset if required, in the DETAILS column. Tab or 

Enter to the next column. 
5. Type in the cost of the asset, in the COST column. Press Enter. 

6. Select the depreciation method, in the DEPRECIATION METHOD column, by 

using the drop-down menu. Press Enter. 

7. The depreciation rate will automatically pre-fill, in the RATE column, based on the 

depreciation method chosen. 

8. The depreciation, closing undeducted cost, recouped depreciation, gain, and asset 

status will also automatically pre-fill based on the depreciation method chosen. 
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Sell a Depreciating Asset 

How do I sell a depreciating asset in the Asset Register? 

 

If an asset has been sold, right click in the cell at the start of the line, select SELL ITEM. A 

SELL ITEM window will appear, with the name of the asset. Here, you can select the SELL 
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DATE, using the calendar option, and the SELL PRICE. Once this is complete, click SAVE. The 

“Status” of the asset will then show as SOLD. 

 

 

 

 

Edit a Sold Asset 

How do I edit a sold asset in the Asset Register? 

 

To edit a “sold” item, right click in the cell at the start of the line, and select EDIT SOLD ITEM. 

An Edit Sold Item window will appear, allowing you to edit the sell date and sell price. Save 

your changes. 

 

 

Mark an Asset Un-Sold 

How do I mark a “sold” asset as Un-Sold in the Asset Register? 

 

To mark an item un-sold, right click in the cell at the start of the line and select MARK AS UN- 

SOLD. 

 

 

Delete an Asset 

How do I delete a line in the Asset Register? 

 

To delete a line of entry, right click in the cell at the start of the line, select REMOVE LINE and 

click YES. 
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Options – Assets Manager 

The Assets Manager options can be accessed via the options icon at the top of the screen. 

The Assets Manager options include the following: 

 

9. Thresholds: 

• Write-Off Threshold = $20000 

• Low Value Pool Threshold = $1000 

• Low Value Pool Rate = 37% 
 

 

10. Download & Import Asset List: 

 

If an asset is not included in the Asset list of the Asset Register, you can download a new Asset 

List, in the form of a txt file, and then import it into the program. 
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Simply click on the DOWNLOAD button. The Asset List.txt will automatically be saved in the 

Cashflow 14 FILES TO IMPORT folder. 

 

 

Once the file has downloaded, click on the SELECT FILE AND IMPORT button. A window 

will open to the FILES TO IMPORT folder, where the Asset List.txt file can be selected and 

opened. 
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Select the file and click OPEN. The assets will now begin importing. 
 

 

 

 

 

 

 

 

 

Once the assets have imported, click OK. Then SAVE the changes. 
 

 

 

 

 

Reports 

Report Options – Assets Manager 

The Assets Manager section also allows you to preview, save as excel or PDF files, email and 

print a comprehensive Assets report, based on the data you have entered into the system. 
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The Report tab can be accessed via the Side Panel. 
 

 

 

 

 

 

 

 

 

To generate the report, click on the Reports tab. 

 

This is a Financial Year Ending report, not allowing to customise dates. You do have the option 

to select All assets, Unsold Items Only, or Sold Items Only. 
 

Once you have made your selection, and to generate the report, click on PREVIEW. 
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Assets Dashboard 

The Asset Dashboard shows the total Opening Undeducted Cost, Depreciation, Closing 

Undeducted Cost, Recouped Depreciation, and Gain of all assets, in real-time. 
 

 

 

Please Note; the Cashflow Manager CARE Support Team are not Accountants, ATO 

representatives, Financial or Tax Advisers. For information regarding depreciating assets, please 

consult your Accountant, registered tax adviser or the ATO. 

For further information regarding depreciating assets, please visit the ATO website: 

 
https://www.ato.gov.au/individuals/tax-return/2017/in-detail/publications/guide-to-depreciating-assets-2017/

https://www.ato.gov.au/individuals/tax-return/2017/in-detail/publications/guide-to-depreciating-assets-2017/
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Loans Manager 
The Cashflow Manager GOLD program includes a “Loan” section, accessible via the “Side Panel”. This 

section allows you to record any type of loan, in the “Loans List”, and generate comprehensive reports. 

The Loan section also includes a Loan Calculator, designed to automatically calculate your loan repayments 

based on the data you enter. These repayments can then be automatically mapped to a Cashflow account, and 

allocation column. 

 

The Report section allows you to preview, email, and save “Actual Loan Data”, and “Scheduled Loan Data”. 
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Loans List 

The Loans List allows you to add, modify and delete loans. 

You can access the Loans List via the Side-Panel option. 

A Loan will include the following: 

 

• Loan Name 

• Loan Type 

• Amount Borrowed 

• Loan Term 

• Interest Rate 

• Frequency of Payment 

• Balance 

 

Add a Loan 

To add a Loan, click on [Add]. 

 

 

 

A Loan screen will then appear, including the Loan SET-UP, DETAILS, ACCOUNT FEES, and 

CASHFLOW ACCOUNT MAPPING. 

 

 

 

In the SET-UP section, complete the following: 

 

• Loan Name (E.g. Car Loan) 
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• Repayments – Have any repayments been made on this loan? Select YES or NO from the drop-down 

menu. 

• Current Balance – What is the current balance owing on the loan? 

 

 

 

 

In the LOAN DETAILS section, complete the following: 

 

• Type of Loan – select either Principal/Interest, Interest Only, or Lease Loan from the drop-down list 

(for information on which loan to select, contact your Lender). 

• Loan Amount – How much did you borrow? 

• Term (Years) – How many years do you have to pay back the loan? 

• Interest Rate (%) 

• Payment Frequency – How often do you make loan repayments? Select weekly, fortnightly, or 

monthly from the drop-down list. 

• Settlement Date – When did your loan begin? Select the date from the calendar selector. 

• Balloon Amount - A balloon payment mortgage is a mortgage which does not fully amortize over 

the term of the note, thus leaving a balance due at maturity. The final payment is called a balloon 

payment because of its large size. 

• Payment Made At – Select Start of Period, or End of Period, from the drop-down list. 
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In the ACCOUNT FEES section, complete the following: 

 

• Monthly Account Fee 

 

In the CASHFLOW ACCOUNT MAPPING section, complete the following: 

 

The Loans section allows you to select the Cashflow Account and Loan Payments Column you wish 

repayments to be recorded in the Money Out section. 

 

As records are added into the relevant Money Out columns that are mapped to the Loan, the Balance of the 

loan is calculated and updated in the Loans List. 

 

• Map Columns – select this option if you wish to set up the Cashflow Account and Column. 

• Loan Payments Column – select the Money Out column from the drop-down list or click [Add] to 

add a new column. 

• Extra Payments Column – if you wish to record extra payments, select the Money Out column from 

the drop-down list, or click [Add] to add a new column. 
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Once you have saved your Loan, it will then appear in the Loans List: 

 

 

 

 

Modify a Loan 

To Modify an existing loan, select the loan and click [Modify]. 

 

 

 

 

Delete a Loan 

To Delete an existing loan, select the loan and click [Delete]. 

 

 

 

Loan Calculator 

A Loan Calculator, accessible via the Loans List, is used to calculate loan payments for existing loans, or for 

users to perform analysis on loans they are looking to take for their business. 
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The Loan Calculator has its own list of Loans. They can be added, modified or deleted. 

 

 

 

 

Add a Loan in the Loan Calculator 
 

 
To add a Loan, in the Loan Calculator, click on [Add]. 

 

The options for loans in the Loan Calculator “mirror” all the options in the actual Loans setup, including 

Loan Name, Type, Amount, Terms, Interest Rate, Payment Frequency, Settlement Date, Payments made at 

start or end of period, and Monthly Fee Amounts. 

 

Once all the loan information is recorded, the [Calculate] button is used to display the forecast repayments 

for the loan. 
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The LOAN SUMMARY, in the top right corner, displays more information on the loan. 

SAVE the calculated loan before exiting. 

You can PRINT the calculated loan from this screen, by clicking [Print] in the bottom right corner. 

 

 

 

Modify a Loan in the Loan Calculator 

To Modify an existing loan, in the Loan Calculator, select the loan and click [Modify]. 

 

 

 

Delete a Loan in the Loan Calculator 

To Delete an existing loan, in the Loan Calculator, select the loan and click [Delete]. 

 

Loan Reports 

There are two types of Loan Reports, that can be accessed via the Loan Reports option on the Side-Panel. 

 

1. Actual Loan Data: 

 

This report generates the Loan Repayments that have been recorded into the “mapped” Money Out columns 

for the loan. 

 

2. Scheduled Loan Data: 

 

This report generates a forecast of the loan based on values setup for the loan. 

 

These reports can be saved in csv and PDF file format, previewed, emailed and printed. 
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Customer Support 
 

Type of Support 
 
The Customer Engagement Team provide software and program support to clients with general queries on how to use the 

software, program errors, database issues, and technical support. 

It is important to note: 

The Customer Engagement Team are not Accountants, Bookkeepers, Financial or Tax Advisors. They cannot offer or provide 

this type of support or information. It is illegal for them to do so. If you wish for this type of support please consult your 

Accountant, Bookkeeper, Financial or Tax Advisor. 

 

Contact Us 
The Customer Engagement Team is here to help you. 

If you require assistance, please call the Customer Engagement Team on 08 8275 2000. 

 

Our operating hours are 7:00am – 7:00pm Monday to Friday (Adelaide time). Public holidays excluded. 

Alternatively, you can email us at info@cashflow-manager.com 

Cashflow Manager Pty Ltd is located at: 

Suite 4.02, 30 Currie Street, Adelaide, South Australia, 5000 

mailto:info@cashflow-manager.com
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